
AUTODESK® 
3DS MAX®  
8 

Tutorial Guide
Volume I 

Date: 

09.09.05

Autodesk Part No.: 

 12811-050000-5000A

Colors: Black

K

Description:

3dsMax8_TutGd_BW_Mcvr.ai

Dimensions:
7" x 9" or
177.8mm x 228.6mm
front only



Copyright © 2005 Autodesk, Inc. All rights reserved.
This publication, or parts thereof, may not be reproduced in any form, by any method, for any purpose.

AUTODESK, INC., MAKES NO WARRANTY, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE REGARDING THESE MATERIALS, AND MAKES
SUCH MATERIALS AVAILABLE SOLELY ON AN "AS-IS" BASIS.

IN NO EVENT SHALL AUTODESK, INC., BE LIABLE TO ANYONE FOR SPECIAL, COLLATERAL, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES IN CONNECTION WITH OR ARISING OUT OF PURCHASE OR USE OF THESE MATERIALS. THE SOLE AND EXCLUSIVE
LIABILITY TO AUTODESK, INC., REGARDLESS OF THE FORM OF ACTION, SHALL NOT EXCEED THE PURCHASE PRICE OF THE
MATERIALS DESCRIBED HEREIN.

Autodesk, Inc., reserves the right to revise and improve its products as it sees fit. This publication describes the state of this product at the time of its
publication, and may not reflect the product at all times in the future.

Autodesk Trademarks
The following are registered trademarks of Autodesk, Inc., in the USA and other countries: 3D Studio, 3D Studio MAX, 3D Studio VIZ, 3ds Max,
ActiveShapes, Actrix, ADI, AEC-X, ATC, AUGI, AutoCAD, AutoCAD LT, Autodesk, Autodesk Envision, Autodesk Inventor, Autodesk Map, Autodesk
MapGuide, Autodesk Streamline, Autodesk WalkThrough, Autodesk World, AutoLISP, AutoSketch, Backdraft, Biped, Bringing information down to
earth, Buzzsaw, CAD Overlay, Character Studio, Cinepak, Cinepak (logo), Civil 3D, Cleaner, Codec Central, Combustion, Design Your World, Design
Your World (logo), EditDV, Education by Design, Gmax, Heidi, HOOPS, Hyperwire, i-drop, IntroDV, Lustre, Mechanical Desktop, ObjectARX,
Physique, Powered with Autodesk Technology (logo), ProjectPoint, RadioRay, Reactor, Revit, VISION*, Visual, Visual Construction, Visual Drainage,
Visual Hydro, Visual Landscape, Visual Roads, Visual Survey, Visual Toolbox, Visual Tugboat, Visual LISP, Volo, WHIP!, and WHIP! (logo).

The following are trademarks of Autodesk, Inc., in the USA and other countries: AutoCAD Learning Assistance, AutoCAD Simulator, AutoCAD
SQL Extension, AutoCAD SQL Interface, AutoSnap, AutoTrack, Built with ObjectARX (logo), Burn, Buzzsaw.com, CAiCE, Cinestream, Cleaner
Central, ClearScale, Colour Warper, Content Explorer, Dancing Baby (image), DesignCenter, Design Doctor, Designer’s Toolkit, DesignKids,
DesignProf, DesignServer, Design Web Format, DWF, DWFit, DWG Linking, DXF, Extending the Design Team, GDX Driver, Gmax (logo), Gmax
ready (logo), Heads-up Design, Incinerator, jobnet, ObjectDBX, Plasma, PolarSnap, Productstream, Real-time Roto, Render Queue, Topobase,
Toxik, Visual Bridge, and Visual Syllabus.

Autodesk Canada Co. Trademarks
The following are registered trademarks of Autodesk Canada Co. in the USA and/or Canada and other countries: Discreet, Fire, Flame, Flint, Flint
RT, Frost, Glass, Inferno, MountStone, Riot, River, Smoke, Sparks, Stone, Stream, Vapour, Wire.

The following are trademarks of Autodesk Canada Co., in the USA, Canada, and/or other countries: Backburner, Multi-Master Editing.

Third-Party Trademarks
All other brand names, product names or trademarks belong to their respective holders.

Third-Party Software Program Credits
© 2005 Microsoft Corporation. All rights reserved.
ACIS © 1989–2005, Spatial Corp.
AddFlow Copyright © 1997–2005 Lassalle Technologies.
Certain patents licensed from Viewpoint Corporation.
clothfx is a trademark of Size8 Software, Inc.
OpenEXR Bitmap I/O Plugin © 2003–2005 SplutterFish, LLC
OpenEXR © 2003 Industrial Light and Magic a division of Lucas Digital Ltd. LLC

Portions Copyrighted © 2000-2005 Joseph Alter, Inc.
Licensing Technology Copyright © Macrovision Corp. 1996–2005.
Portions Copyrighted © 1989–2005 mental images GmbH & Co. KG Berlin, Germany.
Portions Copyrighted © 2000–2005 Telekinesys Research Limited.
Portions Copyrighted © 2005 Blur Studio, Inc.
Portions Copyrighted © 2005 Intel Corporation.
Portions developed by Digimation, Inc. for the exclusive use of Autodesk, Inc.
Portions developed by Lyric Media, Inc. for the exclusive use of Autodesk, Inc.
Portions of this software are based on the copyrighted work of the Independent JPEG Group.
JSR-184 Exporter Copyright (c) 2004 Digital Element, Inc.
QuickTime © 1992–2005, Apple Computer, Inc.
REALVIZ Copyright © 2005 REALVIZ S.A. All rights reserved.
ZLib © 1995–2003 Jean-loup Gaily and Mark Adler
This product includes Radiance software (http://radsite.lbl.gov/radiance) developed by the Lawrence Berkeley National Laboratory
(http://www.lbl.gov). Copyright © 1990–2005 The Regents of the University of California, through Lawrence Berkeley National Laboratory. All
rights reserved.
Wise Installation System for Windows Installer © 2004 Wise Solutions, Inc. All rights reserved.

GOVERNMENT USE
Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in FAR 12.212 (Commercial Computer Software-Restricted
Rights) and DFAR 227.7202 (Rights in Technical Data and Computer Software), as applicable.

http://radsite.lbl.gov/radiance
http://www.lbl.gov


toc

1 Introduction ................................................. 1
Welcome to the World of 3ds Max .............................. 1
Where to Find Tutorial Files........................................ 3
How to Learn 3ds Max ................................................ 3
Working with the Tutorials Online ............................. 4
User Showcase ............................................................. 6

2 Welcome to 3ds Max 8 ............................... 11
New to 3D.................................................................. 11
What’s New in 3ds Max 8 .......................................... 13
Game Design ............................................................. 14
Design & Visualization.............................................. 16
Film & TV Effects ...................................................... 17

3 Getting Started .......................................... 21
Modeling ................................................................. 21
Modeling a Chess Set ............................................. 21
Modeling a Chess Set ................................................ 21
Modeling a Pawn ....................................................... 21
Modeling a Bishop..................................................... 29
Modeling a Rook ....................................................... 31
Modeling a Knight..................................................... 35
Modeling an Airplane............................................. 46
Modeling an Airplane ............................................... 46
Setting Up the Airplane Scene .................................. 47
Setting Up Viewport Backgrounds ........................... 48
Creating the Wings.................................................... 51
Adding the Stabilizer and Rudders ........................... 57
Creating the Sponsons............................................... 61
Creating the Gondola ................................................ 68
Finishing the Plane .................................................... 76
Refining the Airplane ............................................. 78
Refining the Airplane ................................................ 78
Using the Vertex Weld Modifier................................ 79

Using the Editable Poly Tools.................................... 80
Using Soft Selection................................................... 85
Using the HSDS Modifier.......................................... 89
Using the Edit Normal Modifier ............................... 90
Modeling a Head with NURBS ............................... 92
Modeling a Head with NURBS ................................. 92
Creating Contours for the Head................................ 93
Previewing the Head ................................................. 97
Creating the Eye......................................................... 98
Creating the Ear....................................................... 101
Mirroring and Lofting the Head ............................. 102
Completing the Head .............................................. 105
Modeling an Apple ............................................... 106
Modeling an Apple .................................................. 106
Creating the Basic Apple Shape............................... 107
Improving the Shape of the Apple .......................... 108
Completing the Apple ............................................. 110
Adding a Stem to the Apple..................................... 112
Materials & Mapping ............................................ 114
Introduction to Materials & Mapping ................. 114
Introduction to Materials and Mapping ................. 114
Accessing Materials ................................................. 115
Assigning Materials to Objects ............................... 118
Creating Basic Materials.......................................... 119
Understanding Ambient Color and Light............... 122
Creating Transparency ............................................ 123
Understanding Shaders ........................................... 125
Mapping and Mapping Coordinates....................... 128
Creating Multi/Sub-Object Materials ..................... 136
Using Raytrace Materials and Maps ....................... 139
Texturing the Chessboard ....................................... 141
Using Displacement Mapping with Surface

Properties.............................................................. 144
Adding Stars to the Sky ........................................... 148

Contents



iv Contents

Creating a Skin Material.......................................... 151
Materials for Interior Scenes ............................... 155
Materials for Interior Scenes ................................... 155
Materials of One Color: Applying Standard

Materials ............................................................... 155
Adding Complexity: Applying Mapped Materials.. 159
Applying Multiple Materials to One Object............ 162
Creating 3D Materials: Another Approach to

Wood .................................................................... 166
Using an Architectural Material on the Wall .......... 169
Material Combinations: Using Blend to Create

a Floor Material .................................................... 174
Using the UVW Map Modifier to Adjust the

Floor Tiles ............................................................. 180
Using Map Scaler .................................................. 181
Using the MapScaler Modifiers............................... 181
Applying Uniform Textures to Different-Sized

Objects .................................................................. 181
Applying Uniform Textures to Complex Objects ... 186
Using the Object-Space MapScaler Modifier.......... 189
Managing Texture Coordinates........................... 192
Managing Texture Coordinates............................... 192
Using Unwrap UVW, Part 1 .................................... 193
Using Unwrap UVW, Part 2 .................................... 195
Using Unwrap UVW, Part 3 .................................... 199
Using the Relax Tool on Texture Coordinates......... 202
Using the Channel Info Utility ................................ 204
Ink & Paint ............................................................. 215
Ink ’n Paint Material................................................ 215
Translucent Shading ............................................ 221
Translucent Shading ................................................ 221
Animation ............................................................. 223
Animating with Auto Key..................................... 223
Bouncing a Ball........................................................ 223
Creating Animation Using Auto Key ...................... 224
Controlling In-Betweens......................................... 227
Adding Parameter Curve Out-of-Range Types ...... 229
Animating with Dummy Objects............................ 230
Using the Dope Sheet Editor ................................... 236
Using Weighted List Controllers ............................. 237
Adding Squash and Stretch with Modifiers ............ 240
Flying a Spacefighter ........................................... 241
Flying a Spacefighter ............................................... 241
Adding and Adjusting Flight Paths ......................... 242
Animating the Spacefighter with Constraints

and Controllers..................................................... 246
Taking Control of Mars, Its Moons, and the

Space Station......................................................... 255
Animating the Spaceship Using XRefs.................... 259

Animating a Pen ................................................... 262
Animating a Pen ...................................................... 262
Drawing the Path on the Paper ............................... 262
Animating the Pen on the Path ............................... 265
Creating the Line Using PathDeform...................... 267
Working with Animation Tracks .......................... 270
Working with Animation Tracks ............................ 270
Animating a Walkthrough ................................... 276
Animating a Walkthrough ...................................... 276
Creating a Walkthrough .......................................... 276
Biped Animation................................................... 281
Biped Quickstart ................................................... 281
Quick Start .............................................................. 281
Creating a Biped ...................................................... 282
Posing a Biped ......................................................... 283
Applying Physique .................................................. 288
Animating the Biped with Freeform Animation .... 291
Animating the Biped with Footsteps ...................... 294
Combining Motions with the Motion Mixer .......... 299
Animating with Footsteps ................................... 302
Animating with Footsteps....................................... 302
Creating a Distinctive Walk .................................... 303
Modifying Footsteps ............................................... 312
Making a Biped Stop and Start Walking ................. 317
Animating a Gymnastic Flip ................................... 319
Animating a Pratfall ................................................ 332
Changing Footsteps Using IK Keys......................... 341
Animating with Freeform .................................... 343
Animating with Freeform ....................................... 343
Creating a Simple Freeform Animation.................. 344
Animating a Freeform Walk Cycle ......................... 359
Using Controllers with Biped.................................. 375
Creating Animated Bones with Biped..................... 380
Adjusting the Biped to the Model ....................... 382
Getting Started with Physique ................................ 382
Working with Biped Parts ....................................... 383
Aligning the Biped to the Model ............................. 386
Applying the Physique Modifier ............................. 396
Adjusting Envelopes................................................ 400
Fixing Shoulders and Hips ...................................... 404
Rendering.............................................................. 409
Introduction to Lighting ...................................... 409
Introduction to Lighting ......................................... 409
Lighting an Interior Space....................................... 410
Lighting a Close-Up of a Head ................................ 415
Managing Multiple Lights ....................................... 419
Choosing a Shadow Type ........................................ 422
Introduction to Rendering................................... 424
Introduction to Rendering...................................... 424



Contents v

Rendering Still Images ............................................ 425
Rendering an Animation ........................................ 432
Creating an Animated Shadow Study ..................... 434
Advanced Lighting and Global Illumination ...... 437
Advanced Lighting and Global Illumination.......... 437
Creating a Radiosity Solution ................................. 438
Speeding Up Rendering .......................................... 441
Adjusting the Quality of Radiosity ......................... 443
Changing How Objects Behave Under Global

Illumination.......................................................... 446
Rendering a Daylight Scene .................................... 448
Using Radiosity with Standard Lights .................... 452
Rendering a Panorama......................................... 455
Rendering a Panorama............................................ 455
F/X .......................................................................... 457
Particles ................................................................. 457
Creating Cigarette Smoke........................................ 457
Creating an Explosion with Fragments and

Bubbles.................................................................. 464
Modeling Whipped Cream ................................... 473
Modeling Whipped Cream ..................................... 473
Lens Effects ........................................................... 474
Creating the Sun with a Lens Flare.......................... 474
Adding a Camera View ........................................... 475
Adding Lights .......................................................... 476
Adding a Glow to the Sun Using Lens Effects ......... 477
Adding a Ring Effect ............................................... 479
Adding a Star Effect................................................. 480
Adding Another Glow ............................................. 481

Index ......................................................... 483



vi Contents



Welcome to the World of 3ds Max

Welcome, and congratulations! You’ve just bought
a ticket to the world of Autodesk® 3ds Max® 8.
Hang on and get ready for the ride of a lifetime!
With 3ds Max, you can create 3D places and
characters, objects and subjects of any type. You
can arrange them in settings and environments
to build the scenes for your movie or game or
visualization. You can animate the characters,
set them in motion, make them speak, sing and
dance, or kick and fight. Then, shoot movies of
the whole virtual thing.

You can use 3ds Max to visualize designs of
real things that will actually be built, such as
buildings and machines. The File Link feature of
3ds Max lets you base visualizations on designs
created in AutoCAD or Autodesk Architectural
Desktop: when the design changes in these other
applications, the revisions can be automatically
updated in your 3ds Max scene. Add lighting
and materials, then render to still image or movie
formats.

These tutorials teach 3ds Max through a series
of hands-on exercises. Prepare to be entertained
and fascinated by the awesome power at your
fingertips.

Who the Tutorials Are for and How to
Use Them

Here is a strategy guide to point you directly to the
right tutorials for your needs.

If You’ve Never Used a 3D Program Before

Maybe you are new to the whole idea of creating 3D
models and animation on the computer. If so, read
the Getting Started with 3ds Max chapter of the
3ds Max 8 User Reference. This chapter contains
fairly brief conceptual sections that introduce the
ideas and terminology you need to understand to
use 3ds Max. You can read this chapter online, by
choosing User Reference from the Help menu.

Once you have familiarized yourself with the
concepts of 3D modeling and animation, move on
to the first of these tutorials, which will introduce
your hands and mind to the basic concepts of
working in 3D and using the program.

Once you have familiarized yourself with the
concepts of 3D modeling and animation, move
on to the online tutorials that are appropriate to
your interests. You access the online tutorials by
choosing Tutorials from the Help menu.

It might also help to read the 3ds Max 8 New
Features Guide, the printed booklet that comes
with the program.

Introduction

3dsmax.chm::/getting_started_with_3ds_max.html


2 Chapter 1: Introduction

If You Are Skilled in A Different 3D Program

Read the 3ds Max 8 New Features Guide, the
printed booklet that comes with the software.
Then read the Getting Started with 3ds Max
chapter of the 3ds Max 8 User Reference. This
chapter contains fairly brief conceptual sections
that introduce the ideas and terminology you need
to understand to use 3ds Max. You can read this
chapter online, by choosing User Reference from
the Help menu. Then look at reference topics and
tutorials related to the work you plan to do, so that
you can get a feel for the 3ds Max user interface
and workflow.

If You Are Upgrading from an Earlier Version of
3ds Max

Read the 3ds Max 8 New Features Guide, the
printed booklet that comes with the software.
Then read What’s New in 3ds Max 8 in the User
Reference. Finally, try your hand at some of the
new feature tutorials. See What’s New in 3ds Max
8 in the online Tutorials.

For another list of new features, in either the
Reference or the Tutorials, go to the Index panel of
the Help Browser and enter new feature in v8.

Printed and Online Tutorials

The tutorials are provided in two forms, as an
online help file, and as a printed manual. Due to
space limitations, not all of the tutorials are printed
in the book.

Links between the online tutorials and the
User Reference appear in the printed manual as
underlined text. Illustrations are printed in black
and white in the manual, and are full color in the
online system.

To do the online tutorials, from the 3ds Max
Help menu, choose Tutorials to display the online
collection.
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• Jeff Patton, along with other users on the Web,
for good tips on how to use the mental ray
(lume) Ocean shader.

• Miroslaw Piekutowski, for the model
demonstrating the mental ray Dielectric
Material shader.

• Retired Captain Irv Styer, fighter pilot, for
expertise and assistance in modeling for the
P-38 tutorial.

• Fred Ruff and Mike O’Rourke for the games
and skin-deformers tutorials.

Where to Find Tutorial Files

Most of the tutorials in this volume require you
to load sample files to start and complete the
lessons. These files do not install automatically
on your local drive when you install 3ds Max 8.
All the files for these exercises can be found on
the product disk. In order to do the tutorials, you
must manually copy the sample files from that disk
to your local hard drive using My Computer or
Windows Explorer.

To install the tutorial files:

1. Locate your 3ds Max product disk.

2. Open My Computer or Windows Explorer, and
navigate to the disk.

3. Copy the \tutorials folder.

4. Navigate to your installation of 3ds Max 8 and
paste the folder.

Now you have a \3dsmax8\tutorials folder on
your local drive.

Tip: If you have limited hard drive space, you
can copy individual directories from the disk.

How to Learn 3ds Max

Besides the tutorials found in this 3ds Max 8
Tutorials collection, there a number of other
resources to help you learn 3ds Max.

Autodesk Learning Resources

• Autodesk Authorized Training Centers for
Media and Entertainment: Autodesk has
authorized more than 100 training centers in
over 30 countries worldwide. You can take
intensive courses with flexible schedules to
meet your needs. To find a center near you,
visit: www.autodesk.com/me_training.

• Autodesk Learning and Training Materials:
Check out Autodesk’s latest learning and
training materials: go to www.autodesk.com,
click Store, and then click Learning and
Training. Here, you can get training manuals
designed for the instructor-led training
environment, purchase books, and download
individual E-courses to view off line. Training
DVDs are also available for our most popular
products.

• Autodesk Online Support World-Wide:
The Autodesk Support web site
www.autodesk.com/3dsmax-support
provides access to a wide range of product
information and support resources: searchable
Knowledgebase, FAQs, technical bulletins,
tested hardware information, and product
downloads.

• Discussion Forums: Information and
assistance are also available on the
peer-to-peer online discussion forum.
To visit the discussion forums, go to
www.autodesk.com/3dsmax-discussion, or
from the 3ds Max Help menu, choose 3ds Max
on the Web > Online Support.

• 3ds Max 8 User Reference: The online
reference covers fundamental concepts and

http://www.autodesk.com/me_training
http://www.autodesk.com
http://www.autodesk.com/3dsmax-support
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strategies for using the product, as well as
details about the features of 3ds Max. Access
the User Reference online by choosing Help >
User Reference.

• Additional Resources: A number of additional
Help files are installed with the software. For
details, see the topic ”3ds Max Documentation
Set” in the User Reference.

• Other Resources: There is a wealth of
information written about using 3ds Max.
There are third-party books that specialize in
teaching the software for various industries.
There are magazines devoted to 3D design and
animation, as well as user groups and mail lists.
Communities of users trade secrets daily, and if
you ask a question, you’re likely to get answers
from experts all around the world.

Working with the Tutorials Online

You can run the online tutorials by going to the
Help menu on the 3ds Max menu bar and choose
Tutorials. This runs 3dsmax_t.chm, a file found
in the \3dsmax8\help folder. The tutorials appear
in a window which floats on top of the 3ds Max
user interface. You can position this window like a
Schematic View or Track View horizontally across
a row of viewports. Or you may prefer to resize the
window so it is a column covering two viewports
on the left or right.

This window has the behavior that it will always
stay on top of the other displayed program
windows. If it is blocking your view of a viewport,
you can pick it up and move it all the way left or
right, leaving only a small slice or corner of the
window in view.

You can also run this file directly from My
Computer or Windows Explorer, and then use
ALT+TAB to switch between the view of the
tutorial and the program.

If you have a dual monitor system, you can see
both the tutorials and the user interface in a large
window at the same time by moving the tutorials
window to the second display.

If you are running on a small monitor, it can be a
challenge to find the real estate needed to see the
tutorial and the viewports. One trick you can use
is to change the viewport configuration to adapt
for this.

Suggested Viewport Layouts

You can also change your viewport layout to
accommodate the online tutorial window. Do the
following:

Configure your viewport layout:

1. Start 3ds Max 8.

Press the Min/Max toggle if you don’t see
4 viewports.

2. Activate the Perspective viewport, if it isn’t
already active.

3. Right-click the Perspective viewport label, and
choose Configure.

The Viewport Configuration dialog appears.
Click the Layout tab.

4. Choose the viewport configuration that has
three viewports on the right and one on the left.

5. Open the Tutorials window and resize it so it
covers half the large viewport.

You now have effectively five windows.
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6. If you prefer, you can also choose a viewport
configuration with three viewports above and
one viewport below.

Displaying the Tutorials in a Viewport

Another alternative is to display the Help directly
in a viewport. This is not a regular feature of
3ds Max, but since this is a customizable program,
there is a script that can do this.

Note: We have provided this script as a convenience;
it is not a supported feature.

To display the tutorials in a viewport:

1. Using Windows Explorer or My
Computer copy helpinvp.ms from the
\tutorials\tutorial scripts\ folder on the CD to
\3dsmax8\scripts\maxscripttools folder.

2. Start 3ds Max.

3. On the menu bar choose MAXScript > Run
Script

4. Navigate to the \3dsmax8\scripts\
maxscripttools folder. Highlight helpinvp.ms,
then click Open to run the script.

Running this script adds the Help in a Viewport
functionality to the session.

5. On the menu bar choose Customize>
Customize User Interface.

The Customize User Interface dialog appears.

6. On the Keyboard Shortcuts tab click the
drop-down arrow next to Category. Scroll to
the bottom and find Web Tools. Click it, and
choose Help in Viewport.

7. Click in the Hot Key field then assign a hotkey.
Any keystroke combination you press will
appear. We suggest ALT+H.

8. Once the hotkey has been assigned, close the
dialog using the X button at the upper right
corner of the dialog.

9. Activate the left viewport, and press ALT+H.

A Floating tutorial window appears.

10. Right-click the Left viewport label and choose
Views > Extended > Help in Viewport.

The Welcome tutorials display in the viewport.
Scroll down to the tutorials you wish to see and
click the link. That tutorial will display in the
viewport.

Note: The Navigation pane is not available when
you display tutorials in the viewport. Use the
Welcome topic links to navigate to the tutorial
you wish to do. Right-click and choose Back to
return to previous topics.
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Printing the Tutorials

The 8 tutorials are provided in a printed volume
that accompanies the software program. Not every
tutorial in the online set is included in this book,
however.

If your computer is connected to a printer, you can
print single Help topics or entire chapters.

To print a topic or chapter:

1. Open the online tutorials.

2. To print a topic or chapter, highlight the topic
or chapter title and click the Print button at the
top of the Help display.

A dialog appears.

3. Choose to print only the selected topic, or to
print all topics in that chapter. After you make
your selection, another dialog appears where
you can choose your printer and other options.

The tabs available at the top of the dialog
depend on the selected printer.

4. Choose options for the print job, and click Print
to begin printing.

User Showcase

In the 3ds Max 8 tutorials we teach you the tools
to use the software. Put those tools in the hands of
talented artists and magic happens.

Here is a gallery of images by creative individuals
from around the world using this software. We
hope you find these images inspiring before you
set out on your journey of learning 3ds Max 8.
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Chinese Opera

James Ku

www.3dartisan.net/~kuman/

The Ancient Indian Crown

Kameswaran Ramachandran Iyer, India

www.kameswaran.com

Unpleasant Company

Metin Seven

A Living Room

Frances Gainer Davey
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Guardian of the Enchanted Forest

Marc Tan, Insane Polygons

Old Courtyard

Pradipta Seth

by Tommy Hjalmarsson

http://hem.bredband.net/tomhja

by Tommy Hjalmarsson

http://hem.bredband.net/tomhja

Student Breakfast

Jean-Yves Arboit, Belgium

www.discreetcenter.com
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Electric Water

Johannes Schlörb

by reiv: Ponsonnet Olivier

http://reiv.fr.st/

Ripples of Spring

Casey McGovern

molerocket@hotmail.com

Indian Beauty

Jaykar Arudra, AMM Studio, India
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by Ben Paine

Old Sunflowers

Joana Garrido (Caixa D’Imagens), Portugal

Pistol Pete

Martin Coven

Sommar Torp: "Summer House"

Sören Larrson, Sweden

www.3dbetong.se

Anibal

Daniel Martínez Lara (Pepeland)

All images are copyright. Reproduction and
distribution is not permitted without the owner’s
permission.



New to 3D

If you are new to the whole idea of creating 3D
models and animation on the computer, start by
reading the Getting Started with 3ds Max chapter
of the 3ds Max 8 User Reference. This chapter
contains fairly brief conceptual sections that
introduce the ideas and terminology you need to
understand how to use 3ds Max. You can read this
chapter online, by choosing User Reference from
the Help menu.

Once you have familiarized yourself with the
concepts of 3D modeling and animation, move on
to the Getting Started lessons. These will introduce
your hands and mind to the basic concepts of
working in 3D and to using the program in its
various aspects.

Here are links to some of the Getting Started
tutorials:

Modeling Tutorials:

• Modeling a Chess Set (page 1–21)

In this tutorial, you will create four pieces of
a chess set using various modeling tools and
techniques.

Material & Mapping Tutorials:

• Ink ‘n Paint Material (page 1–215)

The Ink ’n Paint material lets you create
comics-style images without ever touching a
pen or brush. This short lesson will show you
a few of the options that are available with this
versatile material.

Welcome to 3ds Max 8

3dsmax.chm::/getting_started_with_3ds_max.html
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Animation Tutorials:

• Bouncing a Ball (page 1–223)

A bouncing ball is a common first project for
new animators. This classic example is an
excellent tool for explaining basic animation
processes in 3ds Max.

Character Animation Tutorials:

• Biped Quickstart (page 1–281)

This tutorial introduces you to the elements
of the built-in character animation features in
3ds Max and the workflow for some of its most
important features.

Rendering Tutorials:

• Lighting a Close-up of a Head (page 1–415)

To light a subject, such as a talking head or a still
life, it helps to think in terms of how you would
light the same subject if you were working on a
stage set or in a photo studio. There are some
widely used guidelines to lighting this way, and
this section introduces them.

Special Effects Tutorials:

• Modeling Whipped Cream (page 1–473)

BlobMesh is a compound object in 3ds Max
that creates a set of spheres from geometry,
shapes, or particles, and connects the resulting
mesh together as if the spheres were made of
a soft substance.

Things to try:

There are many more tutorials in the Getting
Started (page 1–46) section. When you are done
with the ones listed above, try your hand at some
of the others.

You can also experiment with the tutorials found
in the Basic Projects (page 3–1) section. These
tutorials cover different aspects of 3ds Max such as
Modeling, Rendering, and Animation in single,
project-oriented tutorials.
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What’s New in 3ds Max 8

To learn about the new features, first read the 3ds
Max 8 New Features Guide, the printed booklet
that comes with 3ds Max. If you want to read this
online, you can open the PDF file by going to the
Help menu, and choosing New Features Guide.

Or you can read the topic What’s New in 3ds Max
8 in the User Reference.

There are many additions to 3ds Max 8, some of
which are outlined in the following tutorials:

Modeling Tutorials:

• Modeling a Low-Poly Character (page 2–199)

Use new polygon modeling tools including Poly
Bridge and grow/shrink selections along rings
and loops.

• Using the Sweep Modifier (page 3–62)

Create simple lofts with this quick and
easy-to-use modifier.

Materials & Mapping Tutorials:

• Mapping a Character (page 2–236)

New Unwrap UVW workflow and Pelt
Mapping, which allows you to stretch out UVW
coordinates to create a flat unified map for
texturing objects.

• Creating Real-World Materials and Mapping
(page 3–65)

Specify real-world sizes for bitmaps.

Rendering Tutorials:

• Using Radiosity Adaptive Subdivision (page
3–68)

Use adaptive sub-division to add detail where
you need it in the Radiosity simulation.

• Saving Scene States (page 3–70)

Save camera and lighting setups, material
definitions, environment controls and other
values for quick and easy recall.

• Using Batch Render (page 3–72)

Automate the rendering of scenes using this tool
that works in perfect sync with Scene States.

Animation Tutorials:

• Working with Animation Tracks (page
1–270)

Create Tracks Sets for easier animation track
management and experiment with new Curve
Editor improvements.

• Using the Limit Controller (page 2–187)

Use this controller to limit the range of other
types of controllers.

Character Animation Tutorials:

• Using the Skin and Flex Modifiers (page
2–426)

Use new Skin defaults and Better Skin Controls
using the new Weight Tool.

• Using Biped Euler Rotations and Function
Curves (page 2–502)

Control Biped Limbs Using Function Curves in
the Curve Editor.

• Biped Retargeting (page 2–493)

Retarget one biped to another and fine-tune the
motion using Layers.

• Using Twist Links (page 2–499)

Use Twist Links to add twisty bones to the
biped figure.

• Character Rigging Tools (page 2–456)

3dsmax.chm::/whats_new_in_3ds_max_7.html
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Save Animation files to the new XML-based
animation format and reload them onto the
same rig or onto another one. Remap bones
from one skeleton to the next to retarget one
character to another.

AEC Tutorials:

• Publishing to DWF (page 2–78)

Post your 3D Scenes on the Internet with the
new 3D DWF support.

• Inventor Interoperability (page 2–125)

Experiment with the connectivity between
Inventor and 3ds Max.

• Revit Interoperability (page 2–132)

Use the File Link Manager to link 3ds Max to
your Revit Designs.

Dynamics Tutorials:

• Using Hair (page 2–743)

Simulate hair and fur in a variety of ways.

• Using Cloth (page 2–766)

Simulate the motion of fabric and other soft
bodies using this tool.

Project Management Tutorials:

• Using Asset Tracking (page 2–937)

Use this tool to get direct access to Asset
Tracking Systems (ATS) such as Autodesk
Vault.

Game Design

If you are new to the world of 3D, start with the
New to 3D (page 1–11) page to get a good grasp
of how to operate the software. If you are a current
user but want to learn about special techniques
pertaining to game design, you can learn about
them in the Specialized section of the tutorials.

Listed below are links to some games-related
tutorials:

Modeling Tutorials:

• Modeling Tutorials (page 2–199)

This tutorial explains how to model a character
by making extensive use of the Editable Poly
object and Edit Poly modifier.

Materials & Mapping Tutorials:

• Mapping a Character (page 2–236)

This tutorial explains how to map a character
working with the Unwrap UVW Modifier.
This modifier provides tools that go beyond
traditional mapping techniques.

Rendering Tutorials:

• Painting Vertex Colors (page 2–283)

In this exercise, you take the lighting
information from a file and add it to the vertex
color information.



Game Design 15

Character Animation Tutorials:

• Basic Rigging (page 2–299)

A Character Rig is a setup designed to facilitate
control of a character. You can think of a
character rig as the 3D equivalent of strings
that control a marionette. If the strings are well
placed and properly set up, the puppet is very
easy to control. The same is true for a character
rig.

Biped Tutorials:

• Biped Retargeting (page 2–493)

This tutorial explains how you can retarget one
character onto another and ensure that some
of the limbs accurately match the position and
rotation in space of the original character.

Dynamics Tutorials:

• Using Hair (page 2–743)

The tutorials included in this section walk you
through a variety of methods for using Hair.

Special Effects Tutorials:

• Creating Guided Missiles (page 2–904)

In this tutorial, a biplane tries to shoot down
some rebel teapots. This biplane has been
modified with missile pods on each wing that
will emit particles. Each missile pod will emit
one particle. Each particle will use instanced
geometry of a missile and seek a teapot at
random, trailing smoke particles along the way.
When a missile particle reaches its target, it will
trigger an explosion event.
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Things to try:

Other tutorials are suitable for game design. When
you are done with the ones listed above, try your
hand at some of the other tutorials listed in the
Contents under Getting Started, Specialized, and
Projects.

Sometimes Game Design and Film overlap in
workflow and/or their pipelines. if you wish, try
your hand at the tutorials found in the Film & TV
Effects (page 1–17) page.

Design & Visualization

If you are new to the world of 3D, start with the
New to 3D (page 1–11) page to get a good grasp
of how to operate the software. If you have some
working knowledge of 3ds Max and are already
familiar with other 3D products such as AutoCAD,
Inventor or Revit, then you can follow the lessons
in the AEC (page 2–1) section of the tutorials.

Listed below are links to some of the Design &
Visualization tutorials:

AutoCAD-related Tutorials:

• Working with AutoCAD Files (page 2–82)

The integration of drawings created with
AutoCAD and 3ds Max scenes has never
been tighter than it is with 3ds Max 8. DWG
files convert cleanly and maintain their layer
identities, and you have control over import
smoothing, normal unification, and several

other geometry specifications. You have the
capability to import entire drawings, merge
specific layers or components, and even create a
live link between 3ds Max and AutoCAD.

Revit-related Tutorials:

• Revit Interoperability (page 2–132)

In this tutorial, you learn how to use 3ds Max
in conjunction with Autodesk Revit 7.
Autodesk Revit is a building system that lets
you conceptualize your architectural designs
quickly and efficiently. Once you have created
your design in Revit, you can export it and link
it to 3ds Max to create high quality renderings
and animation.

Publish to Web Tutorials:

• 3D DWF Support (page 2–78)

In this tutorial, you learn how to publish
(export) to a 3D DWF format. The DWF
format allows people to view your designs
without having 3ds Max installed on their
system. With the free DWF viewer available for
download, you can email your 3D concepts or
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simply post them on the Internet to painlessly
reach a wider audience.

Global Illumination Tutorials:

• Changing how objects behave under Global
Illumination (page 1–446)

The global illumination options, radiosity
and light tracing, use object colors when they
calculate the color and energy of bounced light.
In this example, you set up some objects to emit
light that affects radiosity. The way to adjust a
material’s behavior under global illumination
is to give it an Advanced Lighting Override
material.

Scene Management Tutorials:

• Scene Management (page 3–61)

This tutorial touches on a number of the new
features you will find in 3ds Max. The scene
you work on shows a covered porch or balcony
that needs some detailing by means of the
Sweep modifier and real-world materials. You’ll
become familiar with scene states and how

they can help you store various conditions that
can be recalled at a later time for visualization
and rendering purposes. Radiosity adaptive
subdivision will be used for preliminary
rendering so you can create more accurate and
realistic images. Finally, you’ll get to experience
the batch rendering tool and how it can help
you increase efficiency when you’re ready to
generate renderings for clients.

Things to try:

Other tutorials are suitable for Design and
Visualization (page 2–1). When you are done
with the ones listed above, try your hand at some
of the others.

Film & TV Effects

If you are new to 3ds Max, start with the Getting
Started (page 1–46) tutorials to get a good grasp
of how to operate the software. If you already have
some working knowledge of 3ds Max, you can
follow the lessons in the Specialized and Advanced
Projects sections of the tutorials.

Here are the links to some of the Film & TV Effects
tutorials:

Materials & Mapping Tutorials:

• Introducing Normal Bump Mapping (page
2–251)



18 Chapter 2: Welcome to 3ds Max 8

Normal Bump Mapping refers to a new
technique for simulating high-resolution
surface detail on low-resolution polygonal
models. Normal Bump Mapping is similar
in some respects to regular bump mapping,
but it conveys more complex surface detail
than is possible in regular bump mapping.
Normal bump maps store information on the
direction normal of the surface in addition to
the simple depth information used in regular
bump mapping.

Character Animation Tutorials:

• Character Rigging Tools (page 2–456)

With the new rigging tools in 3ds Max 8, you
can load and save animation clips, share them
between characters, and have full control as to
how motion is transferred. You can use the new
retargeting tools to go from any kind of rig to
another, and you can use the Motion Mixer,
once compatible with biped objects only, to
layout and create transitions between motion
clips effortlessly.

• Lip-Sync Animation (page 2–475)

In this tutorial, you will learn two methods
for producing lip sync animation. In the first
lesson, you will use modifiers to animate the
mouth for speech. In the second lesson, you
will create a morph target of your own and
animate it with the Morpher modifier.

Animation Tutorials:

Animating Crowds (page 2–638)

This tutorial covers a range of techniques used with
the 3ds Max crowd-animation features for creating
and animating crowds. Crowd animation starts
out with behaviors applied to delegates, which
serve as stand-ins for crowd members. Next, that
motion is applied to mesh objects or bipeds. These
objects might carry their own animation, which
can be combined with the delegate animation in a
variety of ways. In the final part of this tutorial,
you’ll learn how to use motion synthesis to apply
different parts of a mesh object’s animation to each
crowd member, based on its current behavior.
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Dynamics Tutorials:

• Using Hair (page 2–743)

The tutorials included in this section walk you
through a variety of methods for using Hair.

• Using Cloth (page 2–766)

The tutorials included in this section walk you
through a variety of methods for using Cloth.

Rendering Tutorials:

• Mental Ray (page 2–805)

The mental ray renderer is an alternative to the
3ds Max default scanline renderer. Created
by mental images®, it is a general-purpose
renderer that can generate physically correct
simulations of lighting effects, including
ray-traced reflections and refractions, caustics,
and global illumination.

Special Effects Tutorials:

• Crashing an Asteroid into a Planet Surface
(page 2–885)

In this tutorial, you’ll start with a relatively large
asteroid crashing into a planet surface. The
collision creates massive after effects, including
a shock wave with more rocks jumping up from
the leading edge, all trailing fiery particles.

Camera Tutorials:

• Using Camera Match (page 3–114)

Using the Camera Map modifier and other
techniques, you will mix video and computer
generated graphics using the Camera Match
utility. You will then add some special effects to
the camera-matched scene. You will animate a
cue ball and synchronize it with the movement
of actors in the pool hall video. Finally, you’ll
create a matte object so the cue ball can move
behind the bitmap of the player’s hand, and
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you’ll use the Camera Map modifier to create a
wave in the table.

Things to try:

Sometimes Film and Game Design overlap in
workflow and/or their pipelines. When you are
done with the tutorials listed above, try your hand
at the ones found on the Game Design (page
1–14) page.



Modeling

Modeling a Chess Set
In this tutorial, you will create four pieces of a chess
set using various modeling tools and techniques.

Skill Level: Beginner

Time to complete: 1 hour

Features Covered in This Tutorial

You will make a pawn, a bishop, a rook and a
knight in these lessons. In the course of making
these objects you will learn:

• Creating and editing spline objects.

• Using Lathe modifier to create a 3D object.

• Using Face extrusion to create geometry.

• Using Boolean compound objects.

• Using viewport background images.

• Using the Surface modifier.

Tutorial Files

All the necessary files for this tutorial are provided
with the software and can be found in the
\tutorials\intro_to_modeling directory. Before
starting the tutorials, copy the \tutorials folder to
your local \3dsmax8 installation.

Modeling a Pawn

In this lesson, you will model a pawn for a set
of chessmen. In a wooden chess set of standard
design, pawns are turned on a lathe. You will use
3ds Max to do something similar: draw the pawn’s
outline, and then use a Lathe modifier to fill out its
geometry. The Lathe modifier revolves the outline

Getting Started
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around a central point to create a shape, not unlike
the way wood is turned on a machine lathe.

Features and techniques covered in this lesson:

• Using spline shapes to draw the outline of an
object.

This lesson also briefly introduces you to spline
editing.

A spline is a type of curve that is interpolated
between two endpoints and two or more
tangent vectors. The term dates from 1756, and
derives from a thin wood or metal strip used for
drafting curves in architecture and ship design.

• Editing the shape vertices and edges to better
control spline drawing.

• Using the Lathe modifier to turn a 2D outline
into a 3D model.

Tutorial Files:

Tutorial files for this lesson can be found in the
\tutorials\intro_to_modeling folder.

Skill Level: Beginner

Time to complete: 15 minutes

Set up the lesson:

• Start 3ds Max or choose File > Reset if the
program is already running.

No startup file is necessary for this tutorial.

Set up the viewport background:

To create the profile of the pawn (and other chess
pieces), you need to load a reference image into
the viewport so you can trace over it.

1. Right-click the Front viewport to make it
current.

2. From the Views menu, select Viewport
Background. The Viewport Background dialog
appears.

3. Click the Files button. Open the
\tutorials\intro_to_modeling folder, and
then double-click ref-chess.jpg to load it.

4. In the Aspect Ratio group, choose Match
Bitmap. This ensures the image in the viewport
does not get distorted.
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5. To the right of the dialog, turn on Lock
Zoom/Pan. This ensures the background image
reacts to zooms and pans you may use for
viewport navigation.

6. Click OK to exit the dialog. A bitmap now
appears in the Front view. Press the G key to
disable the grid, as you won’t need it for this
exercise.

Now you are ready to begin drawing.

Start the pawn’s outline:

You will draw the pawn’s outline beginning with
the “knob” on top.

1. Zoom in on the pawn reference in the Front
view.

2. On the Create panel, click Shapes, and then
click Line.

3. On the Creation Method rollout, set both Initial
Type and Drag Type to Corner. This ensures all
line segments will be linear.

4. In the Front viewport, click a point near the top
center. Hold the SHIFT key to constrain the
line to the vertical axis and then click a second
point at the base of the pawn.

5. With the Shift key still pressed, click a point in
the bottom-right edge of the base.

6. From this position, click a few points on the
right contour of the reference image to create a
rough profile, going up the side of the image.
You do not need to be very precise at this time
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as you will be able to edit the profile later. To
close the spline and end the command, click
on the first point.

7. When prompted, click Yes to close the spline.

Edit the pawn’s outline:

1. With the spline still selected, go to the
Modify panel.

2. On the Selection rollout, click the Vertex
button.

3. In the Front viewport, zoom in on the bottom
part of the profile you created.

4. Use the Select And Move tool to adjust the
vertices as shown in the following illustration.

5. Select the two rightmost vertices and then
activate the Fillet button on the Modify panel.

6. With the Fillet command active, place the
cursor on one of the selected vertices and then
click and drag to round off the two corners, as
shown below.

7. Pan up to work on the middle section of the
profile.
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8. Select the vertex above the rounded corner you
just created. If necessary, move it to a better
position, based on the reference image.

9. With the vertex selected, right-click in the
viewport and from the quad menu that appears,
choose Smooth.

10.Adjust the vertex position to match the
reference image.

11.Pan up to the next set of vertices.

In some situations, you might need to add a
vertex.

12.On the Modify panel > Geometry rollout,
choose Refine.

13.Click the line where you need to insert the
vertex.

A new vertex is added to the spline.

14.Using the Move tool, adjust the position of
vertices as shown in the following illustration.
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15.Select the vertex sticking out to the right and
fillet it to create a curve, as you did earlier.

16.Pan up the profile. Select the two vertices
shown in the following illustration.

17.Using the quad menu, convert the two selected
vertices to Smooth vertices, as you did earlier.
Move them to fine-tune their positions.

18.Pan up to the top part of the profile. Select the
two vertices to the right of the knob and make
them Smooth vertices. Again, use the Select
And Move tool to fine-tune their positions.
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19.Zoom in to the base of the knob.

20.If you have only one vertex at the base of the
knob, use the Refine tool as you did earlier to
add another vertex.

21.Select both vertices and right-click to access the
quad menu.

22.Use the quad menu to convert both vertices to
Bezier Corner.

23.Use Select And Move to adjust the positions of
the vertices and their handles to get the proper
curvatures around the base of the knob.

24.Select the first vertex you created, at the very
top of the profile. Use the quad menu to convert
it to Bezier Corner.

25.Adjust the handles to match the curvature on
the reference image.

26.Continue refining your profile, adjusting vertex
positions and types to match the reference
image.

27. When you are done, click the vertex
button in the Selection rollout of the Modify
panel to exit the sub-object level.
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Lathe the outline:

At this point, you can continue with the file you
created in the previous steps, or you can open the
file pawn_outline_edited.max, and continue from
there.

1. Select the pawn and click Modifier List above
the modifier stack display.

This is a drop-down list of various modifiers.

2. From the list, choose Lathe.

The pawn is now a 3D object.

The pawn model might not look as you
expected, but that’s only because the axis of
revolution, by default, is based on the spline’s
pivot point rather than the left side of the
profile. You will fix that in the next step.

3. On the Parameters rollout of the Lathe modifier,
find the Align group and click Min.

The pawn now looks better, albeit a bit
“choppy.”

4. On the Parameters rollout of the Lathe modifier,
increase the Segments value to 32.

The pawn is now smoother, as you can see if
you render the Perspective viewport, but the
center seems a bit pinched.

5. On the Parameters rollout of the Lathe modifier,
turn on Weld Core. This combines all the
vertices at the center of the model into one.

In the Introduction to Materials and Mapping
tutorials, you’ll provide the chess pieces with
more-convincing color and texture and create a
shiny, reflective wood-grain chessboard.
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Summary

In this lesson you learned spline creation and
editing. You also learned to create 3D geometry
using the Lathe modifier.

Modeling a Bishop

In this lesson you will model a bishop for the chess
set. For the most part, the bishop is modeled the
same way as the pawn, based on a profile shape
and a lathe modifier. The difference is the gap that
shows on the bishop’s head. You will use a Boolean
object to achieve that result.

Features and techniques covered in this lesson:

• Using spline shapes to draw an outline of an
object.

• Using the Lathe modifier to turn a 2D outline
into a 3D model.

• Using Boolean to subtract geometry.

Skill Level: Beginner

Time to complete: 15 minutes

Set up the lesson:

• The basic shape for the bishop is built
exactly the same way as the pawn in the
last lesson. Follow the procedures in the
“Modeling a Pawn” exercise or open the
bishop_outline_edited.max file to work with
a finished shape.

This file contains the profile of the bishop and a
reference background image. If you cannot see
the reference image, do the following steps.

1. Make sure the Front viewport is selected
and then press ALT+B to open the Viewport
Background dialog.

2. On the dialog, click the Files button.

3. Locate the ref-chess.jpg image in the
\intro_to_modeling folder and double-click it.

Lathing the Bishop

1. On the main toolbar, click the Select
tool. Select the spline representing the bishop’s
profile in any viewport.

2. With the Spline selected, go to the Modify
panel. From the Modifier list, choose Lathe.

3. On the Parameters rollout, click the Min button
in the Align group.

4. Set Segments to 32 and turn on the Weld Core
option.



30 Chapter 3: Getting Started

Create and position the box:

To create the gap in the bishop’s head, you’ll create
a simple box and then subtract from the bishop
model.

1. Zoom the Front viewport in, near the bishop’s
head.

2. From the Create menu, choose Standard
Primitives > Box.

3. In the Front viewport, click and drag to define
the base of the box. Do not worry about specific
dimensions; you will change those in a moment.

4. Once you have defined the base, move the
mouse and then click to define the height.

5. Go to the Modify panel and set the
dimensions of the box as follows:

• Length=15.0

• Width=2.0

• Height=50.0

6. On the main toolbar, click the Select
And Rotate button. Rotate the box in the Front
viewport so that it is aligned with the gap on
the bishop’s head (in the reference image).

7. Use Select And Move to position the box
on top of the gap.

8. In the Top view, move the box on the Y axis
(green axis) until you can see it on both sides
of the bishop.

Create the slice with a Boolean operation:

1. Select the bishop in any viewport.

2. On the Create menu, choose Compound
> Boolean. The bishop is now a Boolean
object and the command panel automatically
switches to the Create panel, showing you the
parameters of the newly converted object.

3. On the Pick Boolean rollout, click Pick Operand
B and then click the box in any viewport.

When you perform a Boolean operation, the
first object selected (in this case the bishop) is
recognized as Operand A and the second object
selected (in this case the box) as Operand B.
You can then choose the type of operation
to perform, whether it’s union, intersection,
or subtraction, and, in the latter case, which
operand to subtract from which.
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Summary

In this lesson, you learned to remove geometry
by cutting a hole in an object using Boolean
operations.

Modeling a Rook

In this lesson, you will model a rook for the chess
set. You’ll build the rook the same way as in the
previous lessons, where you created a pawn and a
bishop, except for the top part with the battlement.
If you were making a wooden chess set, you
wouldn’t be able to use a lathe for this part of the
piece, and so it is with the 3D model: Although
the basic structure of the rook is a lathed spline,
like the pawn and the bishop, its top requires a
different modeling technique.

Features and techniques covered in this lesson:

• Using face extrusion to change geometry.

• Adjusting smoothing groups for better results.

Time to complete: 15 minutes

Set up the lesson:

• Open the rook_outline_edited.max file.

This file contains the basic shape of the rook.
If you prefer to build the rook from scratch,
delete the yellow profile and recreate it as you
did in the previous lessons with the pawn and
the bishop. Make sure, however, that you do
not take into account the battlement at the top
of the rook, as you will create those later using
polygon extrusions.

The Front viewport should contain a reference
image. If you cannot see the image, perform
the following steps:

1. Make sure the Front viewport is active and
then press ALT+B to open the Viewport
Background dialog.

2. On the dialog, click the Files button.
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3. Locate the ref-chess.jpg image in the
\intro_to_modeling folder and double-click it.

Lathe the basic shape:

1. On the main toolbar, choose the Select
tool. Select the spline representing the rook’s
profile in any viewport.

2. With the spline selected, go to the Modify
panel. From the Modifier list, choose Lathe.

3. On the Parameters rollout, click the Min button
in the Align group.

4. Set Segments to 36 and turn on Weld Core.

Prepare the top for the battlement:

1. With the rook still selected, make sure you are
still in the Modify panel. From the Modifier
list, choose Edit Poly.

2. On the Selection rollout, click the Polygon
button.

3. Try selecting the top of the rook.

You can only select a fraction of the area; 1/36th
of the top area, to be exact.

4. On the Selection rollout, click the Vertex
button.

5. Select the vertex in the top center area of the
rook.

6. Hold the CTRL key down and click the Polygon
button again on the Selection rollout. All
polygons connected to the selected vertex are
automatically selected.

7. Press F4 to turn on Edged Faces display, if
necessary. This allows you to see the shaded
object and its underlying geometry.

8. On the Edit Polygons rollout, click the Settings
button next to Inset.

9. In the dialog that appears, set Inset Amount to
4.0.

10.Click OK to close the dialog and save the inset.
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Create the battlement:

1. Open the Modify panel, if necessary.

2. On the Selection rollout, make sure you’re
at the Polygon sub-object level.

3. Use the Select tool to select four adjacent
polygons in the outer ring.

4. Skip the next two polys and then select the four
after those. Repeat the procedure around the
circumference until the selection resembles the
following illustration:

5. On the Edit Polygons rollout, click the Settings
button next to Extrude. On the dialog that
appears, set the Extrusion Height value to 4.5
to match the height of the battlement in the
reference image in the Front viewport (change
the value if necessary). When you are finished,

click OK to save the extrusion and exit the
dialog.

6. On the Selection rollout, click the Polygon
button to exit this level.

7. Press F4 to exit Edged Faces display.

Note the faceted effect on the battlement. You
will fix that in a moment.

Adjust smoothing groups:

1. Make sure the rook object is still selected and
that you are still at the Modify panel.

2. From the Modifier list, choose Smooth. The
entire rook now appears faceted.

3. In the Parameters rollout, turn Auto Smooth
on and leave Threshold at the default value of
30.0. Any two adjoining faces that meet at an
angle less than that value will be made part of
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the same smoothing group and no edge will
appear between them.

The rook appears smoother now.

Summary

In this lesson you learned to create new geometry
using face extrusion. You also learned how to use
smoothing groups to give your objects a smoother
look.
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Modeling a Knight

In this lesson, you will create a knight for a chess
set using custom splines and the Surface modifier.
The Surface modifier makes a 3D surface from an
arrangement of intersecting splines.

Modeling a knight presents a special set of
challenges: its unique contours demand that it be
sculpted carefully. The Surface modifier is ideal
for this type of modeling.

Features and techniques covered in this lesson:

• Building a spline cage.

• Refining and Connecting spline vertices with
new segments.

• Applying and adjusting the Surface modifier.

• Using the Symmetry modifier.

• Extruding patches using the Edit Patch
modifier.

Skill Level: Intermediate

Time to complete: 1 hour

Set up the lesson:

• Load the file knight_start.max from the
\intro_to_modeling folder.

The scene is empty except for a background
picture that you will use as reference as you
model the knight. If you cannot see the
reference picture, follow these steps.

1. Make sure the Front viewport is selected and
then press ALT+B.

2. On the dialog that appears, click the Files
button.

3. Locate the ref-chess.jpg image in the
\intro_to_modeling folder and double-click it.

Draw the knight outline:

1. Maximize the Front view by pressing ALT+W.

2. On the Create panel, click Shapes,
and then click Line.

3. On the Creation panel > Creation Method
rollout, set both Initial Type and Drag Type
to Smooth. This will help set the base profile,
given the curved nature of the chess piece.

4. Click to create a contour for the knight. Do
not take into account the horse’s mane or the
base for now. Keep in mind that this kind of
modeling does not require a lot of detail, so try
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to keep the number of vertices to a minimum.
You will adjust them later.

5. Make sure you close the spline by clicking the
starting point.

6. Go to the Modify panel. On the Selection
rollout, click Vertex.

7. Adjust the positions of the vertices around
the shape of the knight. Select the following
vertices.

8. Right-click and choose Bezier Corner from the
quad menu.

9. Use the Select And Move tool to adjust the
vertex handles so that the profile fits the
reference image better.
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Create the inner spline cage:

1. You will start adding detail where the head
intersects the neck. On the Modify panel >
Geometry rollout, turn on Connect and then
click Refine.

Note: Refine adds vertices to a spline. If the
Connect option is on, all inserted vertices will
be connected by segments in the order they
were created.

2. Click the Bezier Corner vertex at the
intersection of the head and the front of the
neck.

A dialog opens:

This dialog points out that there is already a
vertex where you clicked. You still have the
option to refine the spline, adding yet another
vertex very close to the existing one, or you can
simply use the existing vertex and connect it
to others you will be inserting. Typically, use
the Connect Only method when this warning
appears.

3. Turn on the “Do not show this message again
option” and click Connect Only.

4. Click a point to the right at the back of the neck.

5. Right-click to finish the command. You now
have an additional segment going from the
front to the back of the neck.

6. Add two more “levels” to the neck as shown in
the illustration below.

7. Use Refine/Connect to add a vertical line of
detail going from the neck to the head.
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8. Continue adding detail until the spline cage
looks similar to the following illustration.

Delete unwanted vertices:

The next step is to ensure that there are no loose
vertices on the spline cage. In this method of
modeling, it is essential that the spline cage is made
of three- or four-sided areas only.

1. Make sure the spline is still selected and that
you are still at the Vertex sub-object level.

2. Look for any loose vertices and select them.

3. Press Delete to remove the unwanted vertices.
Make sure that a quad area has no more than
four vertices, where segments intersect.

Fine-tune the spline cage:

The next step is to adjust the spline cage to
get a nice flow of segments. When you refined
the spline cage, you introduced a number of
intersecting segments and subsequently a number
of intersecting vertices. It is very important that
these vertices which share the same position in
space be moved together.

1. Make sure the spline is still selected and that
you are still at the Vertex sub-object level.

2. In the Selection rollout, turn on Area Selection
and leave the value at 0.1. This ensures that
when you select a vertex by clicking it, all
vertices that are within the distance specified in
the threshold value get selected as well.
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3. Use the Select And Move tool to relocate
vertices to get a nice flow of segments in the
spline cage.

Give the spline cage volume:

So far, you’ve built everything in the Front
viewport. The collection of segments lies therefore
in the same plane. In this step, you will adjust
the spline cage so that it starts shaping into a 3D
volume.

1. If the Front viewport is still maximized, press
ALT+W to return to the four-way viewport
layout.

2. Click Zoom Extents All to see the spline
cage in all four viewports.

3. Using the Select tool and the CTRL key, select
all the internal vertices plus the two center ones
on the bottom segment.

4. In the Top viewport, move the selected vertices
down on the Y axis (green axis).
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5. Keep adjusting the position of these inner
vertices to give the volume a more interesting
shape (narrower snout, thicker bottom neck,
and so on). Feel free to experiment but do not
move the other vertices around the perimeter;
you’ll need them to mirror the object later.

Adjust the tangents on the perimeter:

1. Select all the vertices that run along the back of
the neck, except for the top one.

2. Right-click in the viewport and convert the
selected vertices to Bezier Corner.

3. Move the angled tangents so they are in a more
vertical position. This will give the segments a
stronger angle of attack as they meet the mirror
line.
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Tip: If you try to move the tangents and find the
direction locked in one axis or another, press
F8 to constrain motion to the XY plane.

4. Repeat this procedure on the two vertices near
the mouth, and those running up the front of
the neck.

5. Repeat the procedure on the vertices running
along the top of the head, but then use the Front
viewport to make the tangents horizontal.

Test the Surface Modifier

You will eventually mirror this spline arrangement
to make the other side of the knight, but before
doing so, you need to check the current setup to
see if the Surface modifier works on it.

The Surface modifier places a 3D surface over each
set of three- and four-sided polygons formed by
the splines.

The polygons must be completely closed in order
for the Surface modifier to make the 3D surface.
By trying out the Surface modifier now, you can

correct any “holes” in the surface before you
mirror the splines.

1. With Line01 selected, exit the Vertex sub-object
level.

2. From the Modifier List, choose Surface from the
Object-Space Modifiers section. Depending on
how you built your spline cage, the appearance
of the knight in the Perspective viewport might
look solid or hollow.

3. In the Parameters rollout, try turning the Flip
Normals option on or off until the knight
appears as shown on the right side of the
illustration above.

4. Expand the Line entry in the modifier stack and
then click Vertex. Turn on Show End Result so
you can work on the spline cage and see the
effect of the Surface modifier simultaneously.

5. In the Front viewport, select the vertex on the
neck where you see a dip in the muscle tones.
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Right-click and convert that vertex to Bezier
Corner.

6. In the Top viewport, adjust the handles into a
sharp inverted V. This will help simulate the
muscle tones on the neck. Keep an eye on the
Perspective viewport for reference.

7. Experiment with this vertex and others to
mold a better-looking neck. You can use this
technique on other parts like the snout or the
head as well.

Refine the mane line:

1. Adjust the Perspective viewport so that you are
looking at the back of the neck.

2. Using Connect/Refine, start from the vertex at
the very top of the head and work your way
down to refine a mane line as shown in the
following illustration.
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As you refine the segments, surface patches
temporarily disappear from view but reappear
once you finish the command. This is because
you are introducing additional vertices and this
creates patch areas that have more than four
vertices. Once you are done refining the spline
cage, however, the end result is made up of
quads again and therefore displays correctly.

3. Exit the Vertex sub-object level and then click
the Surface modifier to go to the top of the
stack.

Mirror the spline arrangement:

1. If you haven’t done so already, highlight the
Surface modifier on the modifier stack.

2. From the Modifier list choose Symmetry.

3. On the Parameters rollout, set Mirror Axis to Z.

4. Orbit around the object in the Perspective
viewport to see the full 3D object.

Extrude and adjust the mane:

1. Highlight the Surface modifier on the modifier
stack. From the Modifier list, choose Edit
Patch. This inserts an Edit Patch Modifier
above the Surface modifier and below the
Symmetry Modifier.

2. If necessary, turn off Show End Result.

You should be able to see only one half of the
knight in all viewports.

3. On the Selection rollout of the Patch
modifier, choose the Patch button.

4. In the Perspective viewport, select the patches
that make up the horse’s mane.
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5. In the Geometry rollout > Extrude & Bevel
group, click the Extrude button.

6. Bring the cursor close to the selected patches in
the perspective view and then click and drag to
extrude the patches. Keep an eye on the Front
viewport for reference.

7. On the Selection rollout, switch from Patch
to Vertex and turn on Show End Results.

Because of the direction of the extrusion, you
need to adjust the vertex position to give the
Symmetry modifier a little help.

8. In the Front viewport, use region selection to
select all vertices on the outer edge of the mane.
Use the CTRL key if necessary.

9. In the Top viewport, move the selected vertices
up until they intersect along the mirror line.
Keep an eye on the other viewport to see if the
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Symmetry modifier worked nicely to weld the
seams.

Note: This was a rather simplistic way of
adjusting the mirror line. Ideally, you want to
move the vertices individually or in groups,
while at the same time adjusting tangents for
better effects.

10.Adjust the positions of the vertices and tangents
in the Front viewport to follow the reference
image and create a nicely flowing mane.

Create the base:

Even though you could have created the base as
part of the same spline cage, it is easier to build it
as a separate object and then attach the two objects
together as a single mesh. The base is a simple
lathed object, much like the ones you created in
the previous lessons.

1. From the Create menu, choose Shapes > Line.

2. On the Creation Method rollout, set both the
Initial Type and Drag Type to Corner.

3. In the Front viewport, click a point in the top
center of the base, just below the knight.

4. Hold down the SHIFT key to constrain the line
to the vertical direction, and then click a point
at the bottom center of the base.

5. Move to the right and click a point at the
bottom-right corner of the base.

6. Release the SHIFT key and go up the right side
to create a rough profile of the base. Make sure
you close the spline when you are done.

7. Go to the Modify panel. On the Selection
rollout, choose Vertex.

8. On the Geometry rollout, choose Fillet.

9. Use the Fillet tool to round off the vertices that
need it.

10.Exit the Vertex sub-object level.

11.From the Modifier list, choose Lathe.
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12.Set the Segments to 32 and turn Weld Core. In
the Align group, click Min.

Note: If you need further detail on how to create
a lathed object, refer to the first lesson in this
tutorial: Modeling a Pawn.

Turn the two objects into a single mesh:

1. Make sure the base is still selected. Right-click
it and from the quad menu, choose Convert to
> Convert to Editable Mesh.

2. On the Edit Geometry rollout, click Attach and
then click on the knight in any viewport.

3. Change the object’s name to Knight.

The knight is now complete.

Summary

In these lessons, you created four chess pieces,
learning different tools and methods in each case.
Creating a pawn taught you about working with
splines and the lathe modifier. Creating a bishop
and a rook taught you about editing geometry
and using Boolean compound objects to add or
subtract components. Finally, you learned to
model using a spline cage approach using the
Surface modifier with spline objects.

Modeling an Airplane

Lockheed P-38 Lightning model

In this tutorial you will create the exterior
of a classic, WWII airplane, the Lockheed
P-38 Lightning. You’ll use primitive objects
and modifiers to create the parts. Viewport
background bitmaps will act as guides to help you
shape your plane.

Note: This tutorial is a basic tutorial, but we suggest
that you do this after completing the Animated
Still Life (page 3–16) lesson found in the “Getting
Started with 3ds Max” tutorial. You’ll need to
know how to select objects and vertices and
navigate around the viewports.

Skill Level: Beginner to Intermediate

Time to complete: 1 hour 30 minutes

Features Covered in This Tutorial

Upon completion of this tutorial, you will be able
to:

• Set up the viewports with background images
to help in building the model.

• Use primitive objects as the basis for each part
of the airplane.

• Edit the model at sub-object levels.
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• Adjust the pivot point and hierarchy of the
model in preparation for use with a game
engine.

Tutorial Files

All the necessary files to do the tutorials can
be found on the Tutorial Files CD, in the
\tutorials\p38_lightning folder. Before starting
any tutorials, copy the \tutorials folder from the
CD to your \3dsmax8 local installation.

Setting Up the Airplane Scene

The first task is to set the modeling units to meters
and create a calibration box. Aircraft designers
have always used the metric system for specifying
dimensions. As a default, 3ds Max is set to generic
units, so you’ll need to change this.

Set up units of measurement:

1. From the Customize menu, choose Units Setup.

The Units Setup dialog appears.

2. Choose Metric, then click OK.

Now when you create anything, the dimensions
will be displayed in meters.

3. In the Create panel, on the Object Type
rollout, click Box.

Look at the Parameters rollout; the size values
are now displayed in meters.

The next step is to set up the viewport
backgrounds.

Build the calibration box:

An actual P-38 has a wingspan of 15.85 meters,
and a length of 11.532 meters. With the wheels
extended, it has a height of 3 meters. You’ll use
this information to make a box of that size so you
can get an idea of how much space the model will
take up.

1. Activate the Top viewport.

2. In the Create panel, on the Object Type
rollout, click Box.

The Box button turns gold to show it’s active
and ready to create.

3. Open the Keyboard Entry rollout, and enter
the following values (you needn’t type the "m";
3ds Max adds it automatically when you press
ENTER or TAB):

• Length: 11.532m

• Width: 15.85m

• Height 3m

Tip: You can use the TAB key to move from
one field to the next.

4. Once these values are entered, click Create.

A box appears in the viewports.

5. In the command panel, name the object
calibration box.

6. In the viewport navigation controls at
the bottom-right corner of the interface, click
Zoom Extents All.

The box is now visible and centered over the
three background bitmaps. It doesn’t matter
if your box is a different color than the one in
the illustration.
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The calibration box.

Setting Up Viewport Backgrounds

You can load images or drawings in viewport
backgrounds to use as patterns for building
your airplane. Each viewport can have its own
background, so you can load a corresponding
image in the Front, Side, and Top viewports to
guide you as you build your model.

In general, when modeling something you’ve
previously visualized or seen, it’s best to start with
sketches from several different viewpoints, such
as top, side, and front. Also, the drawings should
all be to the same scale, if possible. In this lesson,
you’ll use three drawings of an P-38 Lightning
taken from WWII plane-spotting cards.

Three views of the P-38 Lightning from a set of
plane-spotting cards

Set up viewport backgrounds:

1. Move your cursor to the Top viewport and
right-click to make it active.

2. On the menu bar, choose Views > Viewport
Background.

Tip: You can also use the keyboard shortcut,
ALT+B.

3. In the Viewport Background dialog’s
Background group, click Files.

4. Navigate to the \tutorials\p38_lightning folder
and choose p38topview.jpg. Click Open.

5. In the Aspect Ratio group, choose Match
Bitmap. Click OK.

A sketch of the top view of the fighter is
visible in the Top viewport and the Viewport
Background dialog closes.
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Top viewport displays the Top view background image.

6. Turn off the grid display by pressing the G key.

7. Choose Views > Viewport Background to again
open the Viewport Background dialog.

8. At the lower left, click the arrow by the
Viewport field, and choose Left.

The Left viewport becomes active.

9. Click Files and choose p38leftview.jpg for the
Left viewport. Again, choose Match Bitmap.
Click OK. Turn off the grid display again.

Left viewport with its corresponding background image.

10.Right-click in the Front viewport and press
ALT+B to open the Viewport Background
dialog again. Click Files again and choose
p38frontview.jpg for the Front viewport.

Choose Match Bitmap, then click OK. Turn off
the grid display.

The three images are displayed in their appropriate
viewports.

Next you will zoom and pan each view to more
closely match the background images to the
calibration box to make sure the three viewports
are in the same scale. Each image is currently
centered within the calibration box.

Calibrate the viewports:

1. Activate the Top viewport.

2. In the viewport navigation controls, at
the lower right, click Zoom. Zoom the Top
viewport until the width of the box matches
the width of the wings. Match the wingspan
as closely as you can.

3. Click Pan in the viewport controls, and
then pan the viewport to center the box over
the bitmap vertically. It won’t be perfect, the
two rudders will extend slightly beyond the
calibration box.
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Top viewport aligned with calibration box

4. Zoom the Front viewport. Again match the
wingspan first using zoom, then pan to adjust
the vertical height. Since the landing gear is not
shown in the plane-spotting card, align the top
of the box with the tops of the rudders.

Front viewport aligned with the calibration box.

5. Now repeat zooming and panning in the Left
viewport.

Left viewport aligned with calibration box

All three viewports are now calibrated so
the picture in the viewport represents the
approximate dimensions of the P-38.

You can zoom and pan the background images in
the viewport if you want to center or enlarge them.
To zoom or pan the background images do the
following:

Zoom the background images and calibration box:

1. Activate the Top viewport, then choose Views
> Viewport Background.

2. Turn on Lock Zoom/Pan.

Turning on Lock Zoom/Pan locks the
background image and objects together, so
if you use the zoom or pan buttons from the
viewport navigation controls, you can zoom in
on the background image and objects or shift
them horizontally or vertically.

This is very handy if you have a detailed
background sketch and know you will be
zooming in to work on objects.

3. Repeat this for the Left and Front viewports.

You will notice the background image shifts
when you close the Viewport Background
dialog.
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Tip: Sometimes the background image can shift
out of alignment with your geometry. This is
inconvenient, but there is a workaround.

If you open up a saved file or notice the background
image has shifted, do one of the following:

• Use the viewport navigation Zoom
and Pan buttons to make the background
images the correct size and position in the
viewports. Turn off Lock Zoom/Pan, and
then use the same navigation tools to align
the geometry with the bitmaps. You can use
CTRL+ALT+B to toggle Lock Zoom Pan.

• You can also move the objects in the
scene to match the background image. Then
if you use Zoom Extents, the image will be
centered with the geometry.

Hide the calibration box:

1. You don’t need the calibration box now, so
you can hide it. To do so, select the box in any
viewport, right-click, and then choose Hide
Selection from the quad menu.

You can always unhide the calibration box and
repeat the above procedure to re-calibrate. To
unhide the box, go to the Display panel and
choose Unhide By Name, then in the dialog,
select the box.

2. Save your work as myp38_backgrounds.max.

Creating the Wings

There are many different modeling approaches
you could take to building the wings. Here, you’ll
use a Box primitive with a Taper modifier.

You’ll be continuing from the previous section,
Setting Up Viewport Backgrounds (page 1–48)
or open p38_calibrated_start.max from the
\tutorials\p38_lightning folder.

Create the wing using a box:

1. In the Create panel, on the Object Type
rollout, click Box.

2. In the Top viewport, do the following to
draw a box from upper left to lower right,
approximately around the front wingspan:

• Click once at the upper left, then drag to the
lower right with the mouse button down. As
you move the mouse, the values for length
and width change in the parameter fields.

• When you release the mouse button, you
have set the length and width of the box, and
now are setting the height, which you can
see increasing in the Perspective viewport.
Moving the mouse up creates a positive
height, moving down creates a negative
height. As you move the cursor the values
change in the parameter fields.

• Click again to set the height.

3. In the Create panel, you can immediately adjust
the values in the Parameters rollout. Enter the
following values:

• Length=3.048m

• Width=15.85m

• Height=0.305m

• Length Segs=3

• Width Segs=12

• Height Segs=3
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The Box with 12 width and 3 length segments.

You need to increase the number of segments
so the modifiers for tapering and bending the
wings will work correctly.

4. In the Name and Color rollout, type wing.

The object is now named wing.

Next you’ll change the shape of the wing’s
profile so it looks like an airfoil.

Shape the wing into an airfoil:

1. Activate the Left viewport, and make sure the
wing is selected.

2. From the viewport navigation controls,
click Zoom Extents.

You’ll zoom in on the wing object.

3. From the menu bar, choose Modifiers > Mesh
Editing > Edit Mesh.

You’ll need this to perform some sub-object
editing to the vertices that make up the wing.

4. In the Selection rollout, click the Vertex
button.

Look at the box in the Left viewport with vertex
selection on. Each tick you see is actually
twelve vertices lined up on top of one another.
When you want to select and move them, you
need to drag a selection window around them.

Otherwise you will only select one vertex,
rather than all of them.

The vertices appear as blue ticks at every intersection of
the model.

5. Draw a selection window around the upper
right set of vertices.

The X,Y,Z tripod jumps to the selection set and
the selected ticks turn red.

Selected vertices display in red.

6. Hold down the CTRL key and drag a selection
window around the vertices at the lower right.

The CTRL key allows you to add to an existing
selection set. The X,Y,Z tripod jumps to the
center of the selection set.
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On the main toolbar, click the Select and
Move button and move the cursor over the X
axis of the tripod. Click and drag the cursor to
the left so the leading edge of the wing looks
beveled.

7. Click Select And Non-Uniform Scale.
Then scale the vertices along the Y axis to 75%.

Tip: Watch the Y field of the coordinate read out
at the bottom below the time slider.

Scale the vertices to start rounding off the leading edge
of the airfoil.

8. Drag a selection window around all the vertices
in two center columns of vertices.

9. Move this set of vertices along the X axis
to the right about 0.5m.

Again, watch the coordinate readout at the
bottom.
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10.Drag another selection window around the
vertices at the upper left corner. Then hold the
CTRL key and drag a selection window around
the vertices at the lower left corner.

11. Move this set of vertices along the X axis
to the right about 0.8m.

The airfoil is beginning to take shape.

12. Click Select And Non-Uniform Scale,
hold down the CTRL key and drag a selection
window around all the leftmost set of vertices.

13.Scale this selection set along the Y axis to 75%

Now you’ve got a pretty good approximation of an
airfoil.

Now that you have your airfoil, you’ll make
further changes to the shape of the wing using
a Taper modifier.

Add a taper modifier:

1. Activate the Top viewport, and make sure
to turn off Vertex mode.

2. From the menu bar, choose Modifiers >
Parametric Deformers > Taper.

An orange taper gizmo appears in the viewport
over the box.
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3. On the command panel, in the Taper Axis
group, change the Primary value to X.

4. In the same group, turn on Symmetry.

5. Set the amount of the taper to -1.3.

The box is starting to resemble the P-38’s wing shape.

Next you’ll move the Taper Center to refine the
wing’s shape.

6. In the modifier stack display, expand the
Taper hierarchy by clicking the box marked
with a plus sign. When the Taper expands, click
Center.

At the Center sub-object level, you can adjust
the location of the center of the Taper. Moving
a modifier’s center will alter its results.

7. In the Top viewport, move the center of the
taper forward along the Y axis toward the nose
of the plane, until the wings’ shape more closely
matches the background image.

8. When you’ve finished moving the center, click
Taper in the modifier stack to turn off the
Center sub-object selection.

9. The Taper has affected the height of the wings.
In the modifier stack, click Box, then increase
the wing height to 0.4318m.

Note: Since you’re making a change that affects a
topology dependant modifier, Edit Mesh, you’ll
see a warning. Click Yes to make the height
change. If you’re not sure, click Hold/Yes.
Hold/Yes creates something like a clipboard
copy of the entire scene. If the change you
make is undesirable, use Edit menu > Fetch to
restore the scene to its state before you made
the change.

10. Activate the Front viewport and move
the wing along the Y axis so it is centered over
the background bitmap.

Move the wings up in the Front viewport.

Next you’ll convert the box to an editable
polygon object, and then move some vertices to
round off the wing tips.

Convert the box:

1. Save your file as myp38_wing.max.
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Tip: Get in the habit of saving your scene
frequently at key points. Saving before
converting the box is a good time, because the
conversion removes the stack parameters. If,
at a later time, you find that you have to make
further adjustments to the Box geometry or
Taper modifier, you can reload the saved model.

2. In any viewport, select the box, if it’s not
already selected.

3. Right-click and choose Convert to: > Convert
to Editable Poly.

The box is now an editable poly object.

Round off the wing tips:

1. In the Selection rollout on the command
panel, click Vertex.

Some vertices from previous operations are
already selected.

2. In the Top viewport, draw a selection window
to select the vertices in the upper-left corner
of the wing. While holding down the CTRL
key, drag another selection window around the
same set of vertices at the opposite wing tip.

Select the vertices at each end of the wing.

3. On the main toolbar, click Select And
Non-Uniform Scale. Then use the Transform
gizmo to scale the vertices in the top view so the
ends of the wing tips are rounded.

Scale the vertices to round off the wing tips.

4. Repeat the vertex selection and scaling until the
wing tips are rounded.

The wing tips are rounded.

In the top viewport you need to select all the
vertices on the outside edges of the wings. You can
accomplish this by using the selection rectangle
with the CTRL key.

Add a Bend modifier:

1. In the Selection rollout, click Vertex to turn it
off.

2. Click the arrow to the right of the Modifier List.
In the drop-down list, find the Object-Space
Modifiers group, and choose Bend.

3. Set the Bend Axis to X.

4. Change the Bend Angle to -20.

Bend the wings up.

5. Just for fun, spin the Direction spinner. Watch
the wings stroke in the air. Right-click or press
CTRL+Z to undo when you’re done having fun.

6. Save your work as myp38_wing2.max.
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Next, you’ll add the stabilizers and rudders.
These are easy to do.

Adding the Stabilizer and Rudders

Continue from the previous lesson, Creating the
Wings (page 1–51) or open p38_wing.max from
the \tutorials\p38_lightning folder.

In this lesson, you’ll add the horizontal stabilizer
and the twin rudders. You’ll use cylinders and
editable poly techniques to build these pieces.

Add the horizontal stabilizer:

1. Click the Top viewport to activate it.

2. From the Create panel, click Cylinder.

3. In the Top viewport, drag out the radius of
the cylinder in the center of the horizontal
stabilizer. When you release the mouse button,
you then drag to set the height of the cylinder.
Moving the mouse upward gives a positive
height; moving it downward gives a negative
height. Give it a positive height.

Create a cylinder to make the stabilizer.

4. Edit the Parameters, as follows:

• Radius=0.66m

• Height=0.051m

• Height Segments=1

• Sides=14

5. In the Name and Color rollout, type stabilizer.

Naming your objects proves useful later.

6. Right-click the cylinder and choose Convert to:
> Convert to Editable Poly.

7. In the Modify panel, on the Selection
rollout, click Vertex.

Now the vertices are visible in the cylinder.

8. Select half the vertices, and move them
to the right. Select the other half of the vertices
and move them to the left.

Move the vertices to match the top view of the stabilizer
in the background image.

9. Click Vertex selection again to turn it off.

10. In the Front viewport, move the stabilizer
up along the Y axis so it lines up with the
background image.

Align the stabilizer with the background image.
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Wingspan and stabilizer in Perspective viewport

Next, you will construct the twin rudders.

Just like the stabilizer, you’ll use a cylinder,
converted to an editable poly object, to create
one of the rudders. In this case, you’ll use the
soft-selection feature when you select and move
vertices. After the rudder is properly shaped, you’ll
use the Symmetry modifier to create the second
rudder.

Create the twin rudders:

1. Click the Left viewport to active it and
click Zoom Extents if necessary.

2. On the Create panel, turn on Cylinder.

3. In the Left viewport, draw a cylinder over the
rudder.

Start with a cylinder to make the rudder.

4. Set the following parameters:

• Radius=0.72m

• Height=0.051m

• Height Segments=1

• Sides=15

5. In the Name And Color rollout, enter the name
rudder.

6. Click the Modify panel tab, and then
right-click the Cylinder in the modifier stack.
Choose Convert To: Editable Poly.

The modifier stack no longer shows the
cylinder; it now shows Editable Poly instead.

7. In the Selection rollout, click Vertex.

8. In the Left viewport, drag a selection window
around the top vertices.

Remember that there are vertices at the top
and bottom of the cylinder, so even though a
single red dot appears in the viewport, you are
actually selecting two vertices.
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Select the top vertex.

9. Open the Soft Selection rollout, and turn on
Use Soft Selection.

Now the red dot is flanked by yellow-green dots.

Soft Selection display

10.In the Soft Selection rollout, increase the Falloff
value to 1.524m.

The selection expands in the viewport.

11.Using the Transform gizmo, move the selection
upward to shape the rudder.
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The rudder begins taking shape.

12.Select the bottommost vertex, and move it
down to finish the shape.

13.In the modifier stack, click Editable Poly to
turn off sub-object selection.

14.In the Top viewport, select and move the
rudder to the left into position.

Use Symmetry to create the second rudder:

There are several ways that you could create
the second rudder but you’ll use the Symmetry
modifier for this part of the lesson.

1. Make sure port rudder is selected and
open the Modify panel.

2. Open the Modifier List and select Symmetry.

3. In the Parameters rollout, change the Mirror
Axis to Z.

4. In the modifier stack display, expand
the Symmetry hierarchy by clicking the box
marked with a plus sign. When Symmetry
expands, click Mirror.

At the Mirror sub-object level, you can adjust
the location of the mirror axis.

5. In the Top viewport, drag the Mirror gizmo
to the center of the stabilizer. When the new
rudder lines up with the background image,
release the mouse button.
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The new rudder

6. Click Mirror again to turn it off.

7. Rename the object to rudders.

The Symmetry modifier adds geometry to an
existing object. It does not make a clone of the
original so both rudders are treated as a single
object.

The completed tail section and wings.

8. Save your work as myp38_wing_and_tail.max.

In the next lesson, Creating the Sponsons (page
1–61), you’ll create the sponsons that support
the tail section and house the engines.

(Optional) Separate the rudders:

It’s not really necessary, but if you want to separate
the rudders, you can do so by adding an Edit Mesh
modifier.

1. Open the Modifier List and apply an Edit Mesh
modifier to the rudders.

2. From the Selection rollout, choose
Element.

3. In the Top viewport, select the right-hand
rudder.

4. From the Edit Geometry rollout, click Detach.

The Detach dialog appears.

5. In the Detach As field, enter the name
starboard rudder and click OK.

6. Turn off the Element button and rename the
selected object as port rudder.

Creating the Sponsons

The P-38 was a rugged aircraft because it had
twin sponsons that supported the tail, housed
the engines and superchargers and contained
self-sealing fuel tanks. The airplane could sustain
damage to either side, and still fly, thus presenting
a formidable challenge to any opponent in a
dogfight.

In this lesson, you’ll model the sponsons using
the same techniques you’ve already practiced on
the wing and tail section. You’ll also use the Bevel
tools to create the engine exhaust gates.

Create the starboard sponson:

1. Continue from the previous lesson, Adding
the Stabilizer and Rudders (page 1–57) or
open p38_wing_and_tail.max from the
\tutorials\p38_lightning folder.

2. On the Create panel, click Cylinder.

The Cylinder button turns gold, showing it is
active and ready to use.

3. In the Front viewport, drag a cylinder out over
the left sponson so the radius approximates that
in the background image.
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Don’t worry about the height, you’ll adjust that
in a moment. Drag the height to any value. It
doesn’t matter.

4. Edit the Cylinder parameters, as follows:

• Radius=0.558m

• Height=10.0m

• Height Segments=6

• Cap Segments=1

• Sides=12

5. In the Name and Color rollout, enter the name
of the object as starboard sponson.

6. In the Top viewport, move the cylinder
so it is over the left sponson of the background
image. Position it so the propeller spinner is
visible.

7. Go to the Modify panel. From the
Modifier List, find the Object-Space Modifiers
group, and choose Taper.

8. In the modifier stack, expand the Taper
hierarchy so the Center and Gizmo are visible,
then click the Center to select it.

9. In the Top viewport, move the center so it is at
the front of the cylinder.

10.In the stack, click Taper to turn off sub-object
selection.

11.Now adjust the taper Amount to 0.8.
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Tapered sponson aligned with the background image.

(The front of the sponson is just behind the rounded
propeller spinner.)

12. In the Front viewport, rotate the sponson
about 15 degrees about its Y axis so the left and
right sides are vertical.

Tip: You can also enter 15 into the Y coordinate
read out at the bottom to be precise.

To further shape the sponson, you’ll repeat the
same technique as before. Convert to Editable

Poly, then select rows of vertices and move
them into position over the background image.

The propeller cap is called the “spinner”, and
you’ll create this component at the forward end of
the cylinder using a hemisphere and AutoGrid.

Add the propeller spinner:

1. Zoom into the Perspective viewport so
you have a close view of the front end of the
cylinder. Right-click the viewport label, and
set the shading mode to Smooth + Highlights
and Edged Faces.

2. Open the Create panel. In the Object
Type rollout, click to turn on Sphere.

3. Turn on AutoGrid, the check box below Object
Type. Now move your cursor over the surface
of the end of the cylinder.

An axis tripod follows your cursor, showing
you where the sphere will be drawn.
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4. In the Parameters rollout, turn on Base To
Pivot.

This lets you draw a sphere off the end of the
cylinder.

5. Move your cursor over the end of the cylinder,
and draw a sphere.

It doesn’t matter what size; you will adjust the
parameters after you draw it.

6. Edit the Parameters, as follows:

• Radius=0.558m

• Segments=12

• Hemisphere=0.5

Now instead of a sphere, there is a
hemisphere.

7. Rotate the hemisphere so the 12 segments
of the cylinder and the hemisphere are at the
same angle. Fifteen degrees about the Y axis.

8. On the toolbar, click the Align button,
then click the cylinder. In the Align Position
(World) group, turn on X Position and Z
Position. This properly aligns the hemisphere
and the cylinder. Click OK

The spinner is aligned to the end of the sponson.

9. Rename this object starboard spinner.

10.Save your scene as myp38_sponson.max.

You’ll be converting the sponson cylinder to an
editable poly so it’s a good time to save your
scene.

Finish shaping the sponson:

1. Select the sponson cylinder object and
right-click. Choose Convert To: > Convert To
Editable Poly from the quad menu.

2. In the Selection rollout, click Vertex.

3. In the Left viewport, select a column
of vertices and then on the toolbar, choose
Non-Uniform Scale from the scale flyout.
Non-uniform scale them closer together,
watching the bitmap as a guide. Then
right-click, choose Move from the quad menu,
and position the row.

4. Repeat this process for all seven columns of
vertices in the Left viewport, so the outline of
the sponson matches the background more
closely.
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Select one column at a time, scale, then move.

5. Click the Vertex selection button to turn
it off, then select the spinner hemisphere in the
viewport.

6. Move the propeller spinner away so you can
see the end of the sponson in the Perspective
viewport.

7. Select the cylinder again and turn on
Vertex selection.

8. Select the vertices in the forward end of the
cylinder and non-uniform scale them about
the X axis only. Use the Transform gizmo X
arrowhead, and watch the coordinate display in
the status bar. Scale down to 60 percent along
the X axis.

This returns the end of the cylinder to a more
circular shape.

9. Turn off sub-object selection by clicking Vertex
again in the Selection rollout, then move the

hemisphere back into place. Change its radius
so it fits over the end of the sponson again.

Finish the propeller spinner:

1. Collapse the hemisphere to an editable poly
by right-clicking, and choosing Convert to:
Convert to Editable Poly.

2. In the Perspective viewport, select the vertex in
the center of the hemisphere.

3. In the Soft Selection rollout, turn on Use Soft
Selection and adjust the Falloff so the second
ring of vertices turns yellow, but the last rows
do not. Move the selection forward along the
Y axis.

4. Lower the soft selection so only the vertex at
the tip is selected, and move the tip forward to
form the bullet shape.
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5. Click the Vertex selection button to turn
it off.

The sponson is almost finished. There is a
blister on either side of the sponson that serves
as the exhaust waste gate outlet. You’ll create
this next, using the Bevel features.

6. Save your scene as myp38_sponson2.max.

Create the exhaust gate outlet:

1. Select the sponson.

2. Turn on Vertex selection for the sponson.

3. In the Top viewport, select the third row of
vertices from the top and move them down so
they are at the end of the exhaust gate.

Select and move these red vertices down.

4. Select the fourth row and move them up, so
they are positioned at the start of the exhaust
gate.

Select and move these red vertices up.

The vertices now line up in the top view, but
need adjustment in the left view.

5. In the Left viewport, scale the selected vertices
smaller along the Y axis, as necessary against
the profile of the background image.

6. In the Selection rollout, choose Polygon.

This lets you select polygons instead of vertices.

7. Make sure the Select Object button
is turned on. In the Left viewport, drag a
selection window over the polygons shown in
the illustration below.

The selected polygon displays in red. If
you don’t see a fully shaded polygon, only
surrounding edges, right-click the Left
viewport label and choose Configure. In the
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Rendering Options group, turn on Shade
Selected Faces.

Dragging the selection window over these three
polygons in the Left viewport also selects the three
polygons on the opposite side of the sponson.

Note: It’s important to have Select Object active
here. If Select and Move were turned on,
after making the first corner of your selection
window, you’d start dragging the polygon
around giving you undesired results.

8. In the Edit Polygons rollout, click the Bevel
Settings to open the Bevel Polygons dialog.

9. Set the Height setting to 0.152m. Set the
Outline Amount to -0.095m. Click OK.

10. Region Zoom around the exhaust gate in
the Left viewport.

Because you have Lock Zoom/Pan turned on
for the background image, you might see a
dialog warning that some amount of memory
is necessary to redisplay the background. Click
Yes.

11.Once again, use a selection window to select
the newly created polygons at the front of the
exhaust gate, and then hold down the CTRL
key and drag another selection window across
the polygons at the rear.

This will also select the polygons on the
opposite side of the sponson.

12. Click the Bevel Settings button and set the
Height to -0.1m and the Outline Amount to
-0.025m. Click OK.
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13.In the modifier stack, click Editable Poly to
turn off sub-object selection.

14.Save your scene as myp38_sponson3.max.

Next, you’ll clone the starboard sponson and
spinner to make the port sponson and spinner.

Clone the sponson:

1. Select the sponson, if it isn’t selected already.

2. Hold down the CTRL key and click the
propeller spinner.

Now both objects are selected.

3. In the Top viewport, hold down the
SHIFT key and move the selected objects to
the right.

The Clone Options dialog appears.

4. Name the clone port sponson and click OK.

5. Select the new propeller spinner on the port
side and rename it to port spinner.

Tip: Feel free to change the colors of all the
objects so the plane looks more realistic.

The P-38’s wing, sponsons, and tail.

6. Save your work as myp38_nogondola.max.

All that remains is the central gondola and
canopy detail.

Creating the Gondola

The plane is starting to look like a P-38, but it’s
missing the central gondola, the pilot cockpit. You
will create the gondola using the same techniques
you learned when you shaped the sponson. To
ensure that the gondola is symmetrical, you’ll use
the Symmetry modifier.

Load a start file:

• Continue from the previous lesson, Creating
the Sponsons (page 1–61), or you can
load p38_build_gondola.max found in the
\tutorials\p38_lightning folder.

Create the gondola:

1. Go to the Create panel, and on the
Object Type rollout, click to turn on Cylinder.

If you’re continuing from the previous lesson,
make sure AutoGrid is turned off.

2. In the Front viewport, drag out a cylinder over
the gondola, until the radius approximately
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matches the height of the gondola in the
background image.

Watch in the Top viewport as you drag the
height of the cylinder, since the Front viewport
will not show any difference.

3. Edit the cylinder’s parameters, as follows:

• Height Segments=9

• Cap Segments=2

• Sides=10

4. In the Name And Color rollout, name the
object gondola.

5. If necessary, move the gondola object in
the Top viewport so the top lines up with the
trailing edge of the wing.

Line up the cylinder with the trailing edge of the wing.

6. On the Modify panel, adjust the height
of the cylinder so it is even with the end of the
sponsons, as illustrated below.

Start with a cylinder.

Shape the gondola:

1. Go to the Display panel, and hide
everything but the gondola by clicking Hide
Unselected in the Hide rollout.

2. Go to the Modify panel. In the modifier
stack, right-click Cylinder and choose Convert
To: Editable Poly.
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Now you can reposition the vertices over the
background images.

3. On the Selection rollout, click Vertex.

4. Starting at the rear of the gondola, in the Left
viewport and do the following:

• Select the leftmost column of vertices.

• On the toolbar, choose Non-Uniform Scale
from the Scale flyout.

• Scale them to the approximate size to match
the background image.

• Move them down to match the background
image as well. Alternate between scaling and
moving as you work your way forward.

Scale and move the vertices to match the
background.

Placement of vertices from Left viewport.

5. With all that work done, save your scene as
myp38_gondola.max.

6. Activate the Top viewport and repeat the
previous process. Select one row of vertices at
a time and position them over the background
image using Scale and Move tools. Using the
Transform gizmo, scale each row only along the
X axis.

Vertex scaling and placement from the Top viewport.

7. In preparation of building the canopy, move
and scale columns of vertices to match the
outline of the cockpit in the Left viewport.
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The 4th, 5th and 6th columns of vertices are moved
and scaled.

8. Activate the Perspective viewport and start
creating the nose by selecting the single vertex
at the center of the cylinder cap. Then turn on
Soft Selection and adjust the Falloff so the next
ring of vertices turns yellow.

9. While watching the Left and Top viewports,
move the soft selection forward to form the
nose. Turn off Soft Selection, and move the
single end vertex to create the point.

10.The nose might be a little too pointy, so from
the Left and Top viewports, scale an move the
second column of vertices to round the nose.

11.To unhide the rest of the airplane, on the
Display panel, choose Unhide By Name.
Select all the components you have created
(everything except the calibration box).

12.Change the color of the gondola to match the
rest of the plane.

13.Make adjustments as needed. Select the row
of vertices at the rear of the gondola and
move them along the Z axis in the Perspective
viewport, so the rear taper is hidden in the
wing.

You might also have to select the gondola and
wing and move them up.
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P-38 with gondola

14.Save your scene as myp38_gondola2.max.

You can create the canopy using a couple of
editable poly tools. You’ll cut and chamfer to create
this detail of the cockpit.

Add the canopy:

1. In the Perspective viewport, select the gondola,
if it’s not already selected, and zoom in so you
can see a close view of the cockpit area.

2. On the Selection rollout, click Edge, then
turn on Ignore Backfacing.

3. On the Edit Geometry rollout, turn on Cut.

4. Cut new edges into the cockpit. Click to set the
beginning of an edge, then move the mouse to
draw the new edge. Click again to set the end
of the edge.

Cut these new red edges to form one side of the cockpit.

5. Arc Rotate the view and make the same
cuts on the other side of the cockpit.

All these edges should be cut.

6. Click Cut again, to turn it off.

Now, you can chamfer edges to create the metal
frame of the canopy.

7. In the Selection rollout, turn on Ignore
Backfacing and select the edges around the
cockpit, as illustrated below.
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Select these red edges.

8. In the Edit Edges rollout, turn on Chamfer.
Move your cursor over one of the selected
edges, click and drag up until it looks like the
illustration below, and then release the mouse
button.

Chamfer edges to create the metal canopy frame.

9. You can apply a transparent material to the
canopy faces for extra detail. If you don’t
know how to create materials and apply them
to polygons, see Creating Multi/Sub-Object
Materials (page 1–136).

P-38 gondola with completed canopy.

10.Save your work as myp38.max. Or you can
open the completed file p38_lightning.max
found in the \tutorials\p38_lightning folder.

Make sure the gondola is symmetrical:

The Symmetry modifier has been added to
3ds Max specifically for the purpose of building
symmetrical models such as airplanes, boats and
characters.

In the previous section, you cut a lot of edges to
make up the canopy frame and glass. Some of
those new edges may not be the same on either
side of the gondola. Using the Symmetry modifier
will ensure that the gondola is symmetrical.

You can continue from the previous section of
open p38_lightning.max.

1. Select the gondola object.

2. In the Perspective viewport, right-click the
gondola to open the quad menu and choose
Isolate Selection.

3. Open the Modify panel and turn on
Element mode and select the gondola.
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The selected element in red.

4. From the Edit Geometry rollout, click Slice
Plane.

The gizmo appears, but it’s not in the right
orientation.

5. Click the Select and Rotate button from
the toolbar and enter 90 in the Z coordinate
field below the time bar.

The slice gizmo is rotated correctly.

6. If necessary, move the gizmo left or right
so it’s centered on the gondola.

Tip: Zoom in the Top viewport to better adjust
the gizmo position.

7. When the gizmo is positioned correctly, click
the Slice button. Turn off Slice Plane.

8. Turn on Polygon mode and in the Top
viewport drag a selection window around the
right side of the gondola.

Tip: In the Selection rollout, make sure
Ignore Backfacing is turned off and maximize
the Top viewport when dragging the selection
window.
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Half the gondola is selected.

9. Press the DELETE key and Yes when asked if
you want to delete isolated vertices.

Note: You might have to zoom in on the rear
end of the gondola to select some very small
polygons and delete them as well.

10. Turn off Polygon mode and choose
Symmetry from the Modifier List.

The Mirror gizmo appears at the gondola’s
pivot point.

11.In the Parameters rollout out, turn off Slice
Along Mirror.

The new half is created and it is automatically
welded.

The whole gondola

12.Turn off Isolation Mode to view the rest of the
model.

13.If you’re working on your own P-38, there
are many more details you could add, such
as propellers, machine guns, and landing
gear. Feel free to continue on your own. The
p38_lightning.max has some detail added.
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Propellers and machine guns added

Finishing the Plane

One major step remains: to link the plane into a
single hierarchy. Before it’s airworthy, however,
you’ll also need to rotate it into the proper
orientation and adjust a pivot.

Load a start file

• Continue from the previous lesson, Creating
the Gondola (page 1–68), or you can
load p38_lightning.max found in the
/tutorials/p38_lightning folder.

To work properly with Microsoft Flight Simulator
(FS), the pivot point of an aircraft used by FS as its
center, should be midway between the propellers,
and a quarter of the way back from the front of
the wings. In this procedure, you’ll make that
adjustment in the Top viewport.

Adjust the gondola pivot

1. Activate the Top viewport and press ALT+W to
maximize it.

2. Select the gondola object.

3. In the Command panel, click the
Hierarchy tab. In the Adjust Pivot rollout, click
Affect Pivot Only.

The gondola’s pivot becomes visible, near its rear.

The gondola’s pivot resembles the transform gizmo.

4. Use Select And Move to move the pivot
downward along its Y axis so that the pivot is
about a quarter of the way back from the front
of the wings.
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The gondola’s pivot properly positioned.

5. In the Adjust Pivot rollout, click Affect Pivot
Only again to turn it off.

Currently the plane looks like a single object, but
it’s really just a collection of unconnected parts.
You can demonstrate this, if you like, by moving
one of the parts, such as the gondola (if you do
move it, be sure to undo before continuing). In
this section, you’ll connect all the parts into a
hierarchy, so that moving the gondola moves the
entire plane.

Build a hierarchy for the plane

1. Using the Select And Link tool,
link the wing object to the gondola object.
Click on the wing and drag the cursor over to
the gondola, then release.

2. Next, link the two sponson objects to the wing
object.

3. Continue linking until all objects belong to the
same hierarchy, with the gondola as the topmost
node. You can start in the Top viewport, but

you’ll probably need to use the others as you
go along.

How you link objects is up to you; the only firm
rule is that the gondola must be above all the
other objects in the hierarchy. As a rough guide,
link small objects to larger nearby objects. For
example, you might link the propeller objects to
their related spinners, and then the spinners to
their sponsons. This would create a three-level
hierarchy, with the sponson at the top, the
spinner as its child, and the propeller blades
as the spinner’s children and the sponson’s
grandchildren.

As you work, keep switching to Select And
Move and move the gondola to see which
objects come along with it. When you’re
finished, no objects should be left behind when
you move the gondola.

You can also check the hierarchy by
clicking the Select By Name button on the
toolbar (or press the H key), and in the Select
Objects dialog, turn on Display Sub-tree. This
displays the hierarchy as an tiered list, with the
parent object at the top.

The final step is to rotate the plane so that it’s
pointing upward in the Top viewport. Otherwise
you’ll start out flying backward.
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Turn the plane around

1. In the Top viewport, select the gondola.

2. On the toolbar, click the Select And
Rotate button.

3. On the status bar at the bottom of the screen, in
the Coordinate Display area, enter 180 in the
Z field.

When you press ENTER, the displayed value
changes to -180.0, which is the same thing,
rotation-wise.

Also, the plane reverses its orientation in the
Top viewport, facing upward.

4. Save your work as myp38.max. Or
you can open the completed file
p38_lightning_final.max.

Summary

In this tutorial, you learned more about low-poly
modeling using primitive objects like boxes,
spheres and cylinders. You also made use of a
background image to help in the modeling process.

Refining the Airplane
3ds Max has modeling features that can help
you build models more efficiently. These lessons
describe each feature and show you practical ways
you can use them when constructing models.

Skill level: Beginner to Intermediate

Time to complete: 2 hours (15 to 20 minutes per
lesson)

Features Covered in This Tutorial

In these tutorials you will learn:

• Welding vertices with the Vertex Weld modifier.

• Features in Editable Poly.

• Ways to use soft selection.

• Features in the HSDS modifier.

• How to use the Edit Normal modifier.

Tutorial Files

All the necessary files to do the tutorials can be
found on the Tutorial Files CD, the third CD that
ships with 3ds Max. Before starting any tutorials,
copy the \tutorials folder from the CD to your
\3dsmax8 local installation.

The files for the lessons in this tutorial are in the
\tutorials\p38_lightning folder.
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Using the Vertex Weld Modifier

In this lesson, you’ll work on a model that was built
with an older version of 3ds Max. It’s a low-poly
model of an airplane that was created using the
Mirror tool.

Low-poly airplane

Set up the lesson:

Files for this lesson are in the tutorials\p38_
lightning folder.

• Load the low_poly_p38.max file. This scene
includes an airplane named Lightning.

Weld the seam between the two halves:

Since this model was built prior to 3ds Max 8
using the Mirror tool, there is a seam of unwelded
vertices where the two halves of the plane meet.

1. In the Front viewport, select the airplane,
Lightning.

2. Use Region Zoom to center the view on
the cockpit section of the airplane.

3. Choose Modifiers menu > Mesh Editing >
Vertex Weld.

You can also apply the Vertex Weld modifier
from the Modify panel > modifier list >
Object-Space Modifiers > Vertex Weld.

4. In the Parameters rollout, set the Threshold to
.75”.

This is one way to clean up the model.

Note: Be careful not to set the Threshold too
high. If you do, the model will begin to degrade
as more vertices get welded together.

5. Experiment a little by setting the Threshold to
1’, 6”, and 3”.

While the Vertex Weld can be used to reduce
the number of faces a model has, greater values
distort the model drastically.

6. Set the Threshold back to .75” and save the
scene as welded_lightning.max.
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Using the Editable Poly Tools

3ds Max has a set of handy editable poly tools that
improve the way you can clean up and add detail
to your models.

This set of lessons focuses on several tools.

Set up the lesson:

• Open low_poly_p38_02.max from the
tutorials\p38_lightning folder.

Detail the air intakes:

The first detail you’ll add are the air intakes on
the sponsons of your Lightning. The sponson is
the long extension between the wings and the tail
section of the airplane.

1. In the Right viewport, Zoom Region
around the sponson between the wing and tail.

2. Select the object, Lightning.

3. Go to the Modify panel and click the
Editable Poly entry in the modifier stack.

Note: Half of the airplane disappears because
you’ve chosen to work at a lower level in the
modifier stack.

4. Click the Show End Result On/Off Toggle
button that is located along the bottom of the
modifier stack.

Turning on this toggle lets you see the results of
additional modifiers all way up the modifier
stack. You now see the other half of the airplane
generated by the Symmetry modifier that was
used in the sample file you opened for this
lesson.

5. From the Selection rollout, click the
Polygon button and make sure Ignore
Backfacing is turned off.

6. Turn on Select Object and drag a window
across the three polygons in the center of the
sponson. Make sure the polygons at the top and
bottom are not selected.
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Tip: Press F2 on the keyboard to see selected
polygons displayed in red.

7. In the Edit Polygons rollout, click the
Settings button next to the Bevel tool.

The Bevel Polygon dialog appears.

8. Set the Height to 7” and the Outline Amount to
–3.5”. Click OK.

The air intake starts to take form.

Because the Symmetry modifier was used,
any change you make to the original half of
the airplane is automatically reflected in the
mirrored half.

9. Make sure Select Object is active, and
then click the Grow button in the Selection
rollout.

Grow increases the polygon selection to include
polygons that share a common edge.
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10.While holding down the ALT key, drag a
window across the middle set of polygons to
deselect them. Select only the polygons on the
left and right, as viewed in the Left viewport.

11. Click the Settings button next to the Inset
tool in the Edit Polygons rollout.

The Inset Polygon dialog appears.

12.Set the Inset Amount to 1.5” and click OK.

Inset creates new polygons from the current
selection by offsetting their edges toward the
inside.

13. Click the Settings button next to the Extrude
tool in the Edit Polygons rollout.

The Extrude Polygon dialog appears.

14.Set the Extrusion Height to –5” and click OK.

The air intakes are now complete. Next, you’ll
build some engine exhaust ports.

15.Save your scene as mylightning02.
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Add engine exhaust ports:

Next, you’ll add exhaust ports to either side of the
forward section of the sponson near the propellers.
Continue with the model you saved during the
previous exercise, or open low_poly_p38_03.max.
If you load this file, select the airplane, go to the
Modify panel, and access the Polygon sub-object
level of Editable Poly.

1. In the Top viewport, use Region Zoom
to zoom into the right-side engine/propeller
section.

2. Make sure the Show End Result On/Off
Toggle button at the bottom of the modifier
stack is turned on.

3. Turn on Select Object and select the
polygons at the left and right sides of the engine
housing. If selected polygons do not appear in
red, press the F2 key on the keyboard.

4. Activate the Right viewport and use
Region Zoom to center the view around the
engine section. If necessary, deselect polygons
until only the topmost polygons on the engine
housing are selected. Press F2 to display
selected polygons in red.

5. Click the Settings button next to the Inset
tool in the Edit Polygons rollout.

The Inset Polygon dialog appears.
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6. Set the Inset Amount to 3.5” and click OK.

7. In the Top viewport, select only the inside
polygon.

8. Click the Settings button next to the Hinge
From Edge tool in the Edit Polygons rollout.

9. Click the Pick Hinge button. In the Top
viewport, select the left edge of the selected
polygon.

The button text will change to Edge 1051. This
will cause a hinged face to be created at this
edge.

10.Set the Angle value to 45 and click OK. The
hinged face is created.

11.Select the outside polygon.

12.Repeat the Hinge procedure using the right
edge, Edge 1057, as the hinge.

13.Save your scene as mylightning03.max.
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View of the engine exhaust ports you’ve added

Using Soft Selection

The original propellers on this model are a little
too clunky-looking. In this lesson, you’ll remove
the existing propeller blades and replace them with
new blades.

Set up the lesson:

• Open low_poly_p38_04.max.

Change the propellers:

1. In the Front viewport, use Zoom Region
to center the view around the port engine of
the airplane.

2. Select the Lightning.

3. Go to the Modify panel and pick the
Editable Poly entry in the modifier stack.

4. Click the Show End Result On/Off Toggle
button that is located along the bottom of the
modifier stack.

5. From the Selection rollout, turn on
the Element button and make sure Ignore
Backfacing is turned on.

6. While holding down the CTRL key, select each
of the propeller blades.

7. Click the Detach button from the Edit
Geometry rollout and click OK at the Detach
dialog.
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Note: When you detach the propellers, notice
that they disappear from the opposite side of
the airplane. This is because they are no longer
part of the editable poly that has a Symmetry
modifier applied to it.

8. Click the Editable Poly entry in the modifier
stack to turn off the sub-object mode and pick
the propellers.

9. Press the DELETE key to remove the propellers
you just detached.

The Lightning has no propellers now.

Add the new propeller blades:

You’ll use the Merge command to add a new
propeller blade to your model.

1. Choose File menu > Merge.

The Merge File dialog appears.

2. Browse to the \tutorials\p38_lightning folder
and double-click the file newprops.max.

The Merge – newprops.max dialog appears.

3. Select the Blade01 object and click OK.

The new propeller blade appears in your scene.

4. Activate the Front viewport and turn on
the Select And Rotate button.

5. While holding down the SHIFT key, rotate
around the Z-axis to approximately 120
degrees.

The Clone Options dialog appears when you
release the mouse button.

6. Set the Number Of Copies to 2 and turn on
Instance in the Object group. Click OK.

Note: Turning on Instance is very important,
as you’ll soon see.
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Add a final touch for realistic propeller
blades

Now that the new blades are in the scene, you’ll
want to twist the blades to make them look
realistic. You’ll use a Soft Selection to accomplish
this.

Twist the blades:

1. Turn on Select Object. In the Front
viewport, select the top propeller blade .

2. On the Modify panel, click the Vertex
button in the Selection rollout.

3. Drag a window around the top set of vertices at
the tip of the propeller blade.

4. Open the Soft Selection rollout and turn on Use
Soft Selection.

5. Drag or set the Falloff setting to 6’3”.

Notice what happens to the adjacent vertices as
you increase the falloff. Vertices closest to the
top will be affected more than the vertices that
are further away.

6. Turn on the Select And Rotate button
and rotate the selected vertices around the
Y-axis to –35 degrees.

Because the second and third blade are
instances of the first, any change you make to
the first blade affects the other two.
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7. Click the Vertex button in the Selection rollout
to turn off the Vertex sub-object mode.

8. Turn on Select Object and select the
Lightning.

9. Select the Editable Poly entry in the
modifier stack and click the Attach List button,
next to the Attach tool, in the Edit Geometry
rollout.

The Attach List dialog opens showing you the
three propeller blades.

10.Click the All button at the lower left and then
the Attach button.

The blades are now attached to the rest of the
airplane, and they are automatically added to
the opposite half due to the Symmetry modifier.

11.Save your scene as mylightning04.max.
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Using the HSDS Modifier

The HSDS (Hierarchical SubDivision Surface)
modifier is a finishing tool rather than a modeling
tool. It gives you the best result when working on
low-polygon models, like the P-38 Lightning.

This lesson will give you a better understanding of
HSDS modifier’s use. You’ll use the modifier on
the tail of the airplane to give it a couple of levels
of detail.

Set up the lesson:

• Continue with the model you saved
during the previous exercise, or
open low_poly_p38_05.max in the
\tutorials\p38_lightning folder.

Refine the rudder:

1. In the Right viewport, use Zoom Region
to center the view around the rudder of the
airplane.

2. Select the Lightning.

3. Go to the Modify panel and pick the
Editable Poly entry in the Modifier stack.

4. Click the Show End Result On/Off Toggle
button that is located along the bottom of the
modifier stack.

5. From the Modifiers menu, choose Subdivision
Surfaces > HSDS Modifier

6. From the HSDS Parameters rollout, turn
on the Element button.

You’ll see half of the airplane displayed in a
yellow mesh.

7. Select the rudder element.

8. Click the Subdivide button under the
level-of-detail display.

The rudder becomes more refined and the
edges are much smoother. A level of detail,
Level 1 is added to the level of detail list.
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HSDS allows you increase the mesh resolution of specific
parts of the model instead of the entire model

9. On the HSDS Parameters rollout, turn
on the Polygon button, then drag a selection
window over the rear polygons on the rudder.

10.Click the Subdivide button again.

A second level of detail is added to the level of
detail list and the rear part of the rudder is even
more refined.

11.Click the display button next to the Base Level.

Level 1 and 2 are turned off and you see the
original polygons you started with.

Using the Edit Normal Modifier

The Edit Normal modifier in 3ds Max was
developed with game developers in mind. Now
that many game engines and graphics hardware
use pixel and vertex shaders, demand has increased
to give modelers the ability to adjust normals
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interactively when looking at the result of a pixel
vertex shader.

Note: In order to see the results of using the Edit
Normal modifier, 3ds Max should be configured
for DirectX.

Set up the lesson:

• Continue with the model you saved
during the previous exercise or
open low_poly_p38_06.max in the
\tutorials\p38_lightning folder.

If you use the sample scene, some of the plane’s
components have been hidden for better
performance. It’s also been maximized to the
Perspective viewport.

Adjust the normals on the wing:

1. Select the Lightning.

2. Open the Modify panel and unroll the
Modifier List.

3. Click Edit Normals.

The normals are indicated by the blue lines that
suddenly sprout from the model. The dark blue
color tells you the normals are Unspecified and
are calculated based on the smoothing groups
of surrounding faces.

4. Select Normal 194.

This normal is in the middle of the wing
between the cockpit and sponson.

You can also see which normal you’ve picked
by looking at the display at the bottom of the
Parameters rollout.

5. Rotate the normal. Notice the effect
different rotations have on the surface of the
airplane.

The surrounding surfaces get lighter or darker
depending on how you rotate the normal.

Note: Once you make a manual change to the
original orientation of the normal, the normal
changes to a green color, signifying that it’s now
an Explicit normal.

6. Experiment by selecting some of the other
normals, or try working with groups of normals
to see how they respond.
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Summary

You have learned about several powerful features
that will improve your modeling skills. The
Editable Poly object is very versatile, and works
with many modifiers to help you shape an object
exactly as you like.

Modeling a Head with
NURBS
In this tutorial, you use NURBS to create the
head of a 3D cartoon character. NURBS can be
especially suited for modeling organic, free-form
surfaces such as this character.

Note: NURBS are good for modeling free-form
surfaces, but they are computationally expensive.
If you want to do character animation, an editable
mesh or editable patch model is the better choice.
Meshes and patches require less computation, and
animate more quickly and reliably.

The concept for our cartoon character began with
an artist’s pencil sketch.

Another artist then used this sketch to create the
rounded, animatable figure known as Goco the
Monkey Boy.

This tutorial doesn’t guide you through creating
the entire figure, or animating it. It concentrates
on creating the character’s head. Creating the head
demonstrates a variety of techniques for NURBS
modeling in 3ds Max.

Skill Level: Intermediate

Time to complete: 60 minutes

Features Covered in this Tutorial

• Using a background image to trace NURBS
curves

• Drawing CV Curves

• Creating a loft surface from CV Curves

• Using CV Curve on Surface to add details to a
lofted NURBS surface

• Mirroring and welding a lofted NURBS surface

• Attaching lofted surfaces to one another

Tutorial Files

All the necessary files to do the tutorials can
be found on the Tutorial Files CD, in the
\tutorials\nurbs_modeling folder. Before starting
any tutorials, copy the \tutorials folder from the
CD to your \3dsmax8 local installation.
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Creating Contours for the Head

The head is the most complicated part of the
model, and the most critical for showing the
character’s personality. The overall technique is to
use contour curves to model half the head. This
preserves symmetry and also saves computation
time. The contour curves become the basis for a
U loft surface. When half the head is finished, you
mirror the half and make the head complete.

In this lesson, you use scans of the artist’s sketch
as viewport backgrounds to help you make the
contour curves.

Set up the scene:

1. Start 3ds Max.

2. Choose Customize > Units Setup.

3. In the Units Setup dialog, choose US Standard.
Make sure Feet w/Decimal Inches is active, and
then click OK.

It’s easiest when you work to scale. Goco will
be about six feet tall, and the head will be about
18 inches from front to back.

Set up the background:

1. Right-click the label of the Left viewport, and
under Views choose Right.

2. Make the Right viewport active, and then
choose Views menu > Viewport Background.

Note: You can also press ALT+B.

3. In the Viewport Background dialog, click Files
and choose head_side.png as the background
source.

Note: Files for this tutorial are in the
\tutorials\nurbs_modeling directory.

4. Turn on Match Bitmap and Lock Zoom/Pan,
then click OK.

Tip: Whenever you need to adjust the position
of the background relative to the model, use

CTRL+ALT+B to toggle Lock Zoom/Pan.
When Lock Zoom/Pan is off, the model zooms
and pans independently of the background.
When Lock Zoom/Pan is on, zoom and pan
affect both the model and the background.

Tip: Another way to view reference images while
you model in 3ds Max is to display them using
the Asset Manager.

5. Right-click the Right viewport label and turn
off Show Grid.

Tip: You can also press G to toggle the grid
display in viewports.

Now you’re ready to begin creating the model.

Initialize the first contour curve:

1. In the Front viewport, create a Circle shape
with a radius of 6 inches.

The circle is a general starting-point for creating
contours.

2. Right-click the circle. In the Transform
(lower-right) quadrant of the quad menu,
choose Convert To: > Convert to NURBS.
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Now you can use NURBS features to adjust
the contours. As you will see, a NURBS model
consists of one or more sub-objects. NURBS
sub-objects include curves and surfaces.

To make sure the head is symmetrical, at first
you model only half of it. The first step for the
first contour is to make it a semicircle.

3. Go to the Modify panel.

4. On the modifier stack display area at the
top of the Modify panel, click the plus icon to
the left of NURBS Surface. This expands the
hierarchy of the NURBS object. Choose Curve
as the sub-object level.

5. Click Curve to select it.

6. On the Curve Common rollout, turn on Break,
then click the circle at the top and bottom (12
o’clock and 6 o’clock).

Now you have two semicircular curves.

7. Right-click in the viewport to turn off Break.
Click the left-hand curve to select it, and then
on the Curve Common rollout, click Delete.

8. Click the remaining, right-hand curve to select
it, and then click Convert Curve.

9. In the Convert Curve dialog’s CV Curve tab,
choose Number and reduce the number of CVs
on the curve to 10.

CVs are "control vertices." They control the
shape of a NURBS CV curve. Reducing the
number of CVs makes the curve more efficient
and easier to handle. In general, when you
work with NURBS try to use the minimum
detail necessary.

10.Click OK to close the Convert Curve dialog.

11.In the Modify panel > Modifier Stack, click the
top level to exit sub-object mode.

Start forming the contour curves:

You start by creating contours for the profile. Later
you will load a scan of Goco’s full face, and adjust
the contours to match.

1. Right-click in the Right viewport to
activate it, then click Min/Max Toggle to see
only the right view.

2. Rotate, move, and
uniformly scale the contour so it sits at the
base of Goco’s snout, as seen in the following
illustration.

Note: Avoid using non-uniform scale with
NURBS models and their sub-objects.

3. On the modifier stack display, change the
sub-object selection level to Curve CV.

4. Move CVs in the curve so the curve more
closely follows the contour of the snout, from
the right view.
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Tip: Often it is easiest to move the CVs in order,
from top to bottom or bottom to top. Also,
when CVs are close together, the transform
gizmo can get in the way of selecting a new
one, so you might have to click and move a CV,
click to deselect it, click to select the new one,
and so on. (On the other hand, the transform
gizmo can be useful when you adjust overlaying
curves; for example, when you adjust contours
to match the full-face sketch of Goco.)

5. Right-click the NURBS model. In the Tools
1 (upper-left) quadrant of the quad menu,
choose Sub-objects > Curve.

When you modify NURBS models, the quad
menu has shortcuts for changing the sub-object
level, and performing some other Modify panel
commands.

From this point, the steps will say simply "go to
a sub-object level." You can use either the quad
menu or the stack display to do so.

6. SHIFT-move the curve to create a copy of it
toward the back of the head. In the Sub-Object
Clone Options dialog, leave Independent Copy
chosen as the method, and then click OK.

7. Return to the Curve CV sub-object level, and
again adjust the CVs so the curve follows the
head.

Contour the back of the head and the neck:

The contour curves are closer together at the base
of the neck, farther apart at the top of the head.

• Continue to clone a contour at the Curve level,
then adjust its CVs at the Curve CV level, until
in addition to the original contour you have
five contours for the top and back of the head,
going to the base of the neck, as in the following
illustration.

Tip: When you get to the neck, it can be helpful
to zoom in because the CVs are closer together.

Contour the snout and the mouth:

The important thing about modeling the snout
is that contours should surround the mouth but
never cross it. This way, you will be able to animate
the mouth later.

1. SHIFT-clone the original contour curve, this
time in the direction of the nose.

2. Adjust the new contour’s CVs, being careful
not to cross over the mouth. "Pinch" the curve
somewhat at the corner of the mouth, placing
two or three CVs near each other there.
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When two or three CVs are near each other, a
CV curve grows sharper.

3. Create another contour curve. Don’t move it
much, but move its CVs to project farther along
the snout.

Tip: When two CV curves are close to
each other, it can be hard to tell which curve a
CV belongs to. Turn on the Keyboard Shortcut
Override Toggle button, and then select a CV
on the curve you want. Now you can hold down
CTRL while you use the arrow keys. This moves
among the CVs on the active curve, with no
danger of selecting one from a different curve.

Another tip: Lock Selection is also useful
when you are moving CVs. CTRL+arrow
works even while Lock Selection is on, so you
can move multiple CVs without worrying

about changing the selection by clicking the
wrong CV.

Tip: SPACEBAR toggles the Lock Selection Set
button on and off.

4. Create two more contours, creating four in all
for the snout, not counting the original contour.
The last contour follows the shape of the mouth
itself.

5. Save your work as goco_right.max.

If you change the view to a Front view, you can
see that while the contours of the head match
the profile, they don’t yet match the face of the
character. The next step is to adjust CVs to
match the scanned drawing, head_front.png.
You can work on this if you want to, but we’ve
prepared a file to take you farther along the way
to completing the character’s head. In the next
topic, you load that file.

Tip: If you do work on completing contours for
the Front view, work in a Perspective view as
well as Front. This helps you distinguish one
curve from another. Also, the Soft Selection
feature for moving CVs (on the Soft Selection
rollout below the Curve CV rollout) lets
multiple CVs follow a single one as you move it.
This can be useful when you adjust the curves.
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Previewing the Head

In this lesson, you use an existing file to preview
the shape of the head.

Open a scene with completed contours:

• Open the file tut_goco_00.max.

Files for this tutorial are in the
\tutorials\nurbs_modeling directory.

Set up the viewport backgrounds:

1. Make sure the Right viewport is active. Choose
Views menu > Viewport Background.

2. In the Viewport Background dialog, click Files
and choose head_side.png as the background
source.

Files for this tutorial are in the
\tutorials\nurbs_modeling directory.

3. Make sure Match Bitmap and Lock Zoom/Pan
are turned on, then click OK.

You might have to adjust the position of the
NURBS model to align it with the bitmap.

Tip: Whenever you need to adjust the position
of the background relative to the model, use
CTRL+ALT+B to toggle Lock Zoom/Pan.
When Lock Zoom/Pan is off, the model zooms
and pans independently of the background.
When Lock Zoom/Pan is on, zoom and pan
affect both the model and the background.

Tip: Another way to view reference images while
you model in 3ds Max is to display them using
the Asset Browser.

4. Make the Front viewport active, and then
choose Views > Viewport Background.

5. In the Viewport Background dialog, click Files
and choose head_front.png as the background
source.

6. Make sure Match Bitmap and Lock Zoom/Pan
are turned on, then click OK.

Again, you might have to adjust the position of
the NURBS model to align it with the bitmap.

7. Select the NURBS model so it shows up
better against the backgrounds.

The Right viewport shows the profile, and the
Front viewport shows the face. You can see that
the two drawings don’t completely match up. This
is often the case when you build a model from
drawings created in 2D. A 3D model can’t exactly
match both elevations, so you have to choose
a compromise that is truest to the spirit of the
character. In the case of Goco, the profile of the
snout has been made shorter to better match the
wideness of the full face.

Preview the head:

1. Go to the Modify panel, and then select
the NURBS model.

2. On the General rollout, turn on NURBS
Creation toolbox to display the toolbox.

Tip: Whenever a NURBS model is selected
and the Modify panel is active, you can toggle
display of this toolbox by pressing CTRL+T
(make sure the Keyboard Shortcut Override
Toggle is turned on).

3. In the toolbox, click Create U Loft Surface.

The U Loft Surface rollout is displayed on the
Modify panel. A U Loft is a NURBS surface
sub-object that stretches across contour curves.

Most NURBS sub-object types have an
associated rollout. Usually this rollout is
displayed at the bottom of the Modify panel.
For example, the rollout for CV curves such as
the contours you are working with is displayed
below the long Curve Common rollout.
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One advantage of using the NURBS Creation
toolbox to create NURBS sub-objects is that
during creation, while a toolbox button is on,
the rollout for that type of sub-object appears
near the top of the Modify panel, just below the
Modifier Stack rollout.

4. Turning on U loft creation displays the U Loft
Surface rollout. On this rollout, make sure
Display While Creating is turned on.

Turning on this option can slow down 3ds Max,
but for the purposes of this tutorial, you want
to see what’s happening.

5. Click each contour curve once, in spatial order,
beginning with the mouth and proceeding to
the base of the neck.

As you move the mouse, curves turn blue to
indicate that you can pick them for use by the U
loft.

After you have clicked the third contour,
3ds Max begins to display a surface that
stretches across the contours. However, the
surface appears to be incomplete. In fact, it is
simply facing the wrong direction.

Tip: While you’re creating the U loft, pressing
BACKSPACE undoes the last section that you
created (between one contour and the next).

Tip: If your mouse has a middle mouse button,
you can use ALT+middle mouse button to
arc-rotate the viewport while you create the
loft. This can help you see the contour curves.

6. Right-click to end loft creation.

7. Turn on Flip Normals.

Now the surface appears correctly convex, and
shows one-half of Goco’s head.

8. Save your work as goco_loft.max.

At this stage, you might notice things about
the model you want to correct. You can go into
Surface sub-object level, select the U loft, and
then on the U Loft Surface rollout turn on the
Edit Curves button. Edit Curves is a shortcut
that lets you edit contours without having to
switch back and forth between the Curve and
Surface sub-object levels. It lets you move the
CVs of curves in the U loft. Select the curve’s
name in the U Curves list, and then move its
CVs.

While Edit Curves is turned on and a curve is
selected in the U Curves list, other curve and
CV editing rollouts are displayed below the U
Loft Sub-Object rollout. You can edit the curve
using the available controls in these rollouts,
as well.

The U loft you created in this lesson is not the
final surface for the head. First, you are going
to add a bit more detail, and then mirror the
contour curves.

Creating the Eye

In this lesson, you create an eye. The eye begins
with a curve on surface, which you then use as the
basis for the bulge of the eyeball.
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Create the first contour curve for the eye:

1. Open the file tut_goco_01.max.

This file shows the temporary U loft of half the
head.

Note: (If you want, you can open the work you
saved in the last topic, goco_loft.max, instead.
Maximize the Perspective viewport and adjust
it until it looks like the illustration.)

2. Go to the Modify panel and select the
NURBS model.

3. In the NURBS toolbox, click Create CV
Curve on Surface.

As its name indicates, a CV curve on surface is
like the CV curve sub-objects you have been
working with already, but it is constrained to lie
on a NURBS surface sub-object such as the U
loft that shows half of Goco’s head.

A curve on surface is an example of a dependent
NURBS sub-object. NURBS sub-objects are
described as dependent if they are constrained
by other NURBS geometry. A U loft is also a
dependent sub-object, because it depends on
the contour curves, which are independent.
While you edit a NURBS model, 3ds Max
displays independent sub-objects in white, and
dependent sub-objects in green.

(You can use Customize > Customize User
Interface > Colors tab to choose a custom
color for dependent NURBS sub-objects. For
example, choose Geometry as the Elements
type, choose NURBS Dependent Object, and
then assign your own color to this element.)

4. In the Perspective viewport, use the CV curve
on surface to draw a clockwise oval that is the
base of the eye. Use seven or eight CVs in this
curve. Click to position the first CV, then click
to position the other CVs in an oval shape.
Finally, click above the first CV, and answer Yes
in the Close Curve dialog that appears.

Tip: Zoom in a bit so it’s easier to see the eye
region of the head.

If the curve you create isn’t shaped quite right,
you can move CVs at the Curve CV sub-object
level.

Note: As the illustration shows, the curve on
surface doesn’t display well.

5. Go to the Curve sub-object level.

6. Select the CV curve on surface that you just
created.

7. On the Curve Common rollout, click Convert
Curve. In the CV Curve tab of the Convert
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Curve dialog, choose Number and enter 10 as
the number of CVs in the curve. Click OK.

The eye contour curve is now an independent
CV curve. It is no longer constrained to be on
the U loft surface, although it still retains the
shape it obtained from the surface.

Create the other contour curves for the eye:

1. Right-click the Perspective viewport label, and
under Views, choose Right.

2. SHIFT-clone the eye’s contour curve,
moving the clone so the new curve stands out
from the face about 0.4 inch. In the Sub-Object
Clone Options dialog, leave Independent Copy
chosen, and click OK.

3. Right-click the Right viewport label, and under
Views, choose Perspective.

4. Click the second contour curve.

5. On the toolbar, choose Select and
Uniform Scale. Also on the toolbar, choose
Screen as the Reference Coordinate System
(in the drop-down list to the right of the Scale
flyout).

6. SHIFT-clone the second eye contour,
scaling down to about 80%. In the Sub-Object

Clone Options dialog, leave Independent Copy
chosen, and click OK.

7. SHIFT-clone the third eye contour to
create a fourth. Scale this contour down to 2%.
In the Sub-Object Clone Options dialog, leave
Independent Copy chosen, and click OK.

Making the center contour very small ensures
that when you loft the eye, the center of the loft
will be smooth and fairly flat.

Warning: Don’t scale down to 1% or 0%. This can cause

problems.

Loft the eye:

1. Zoom in on the region of the eye.

2. In the NURBS toolbox, turn on Create U
Loft Surface.

3. Click the eye contour curves in the order you
created them, beginning with the curve that
originally lay on the head, and ending with the
point-sized curve in the center of the eye.

4. Right-click to end creation of the U loft.
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At this point, you might want to use Edit Curves
(described at the end of Previewing the Head
(page 1–97)) to adjust the eye some more.

5. Save your work as goco_eye.max.

Creating the Ear

The ear is the last detail of the head to create before
you mirror the half-head to create the whole.
While you don’t actually create the ear in this
lesson, you use a good technique for connecting
one surface to another.

Loft the ear:

1. Open the file tut_goco_02.max.

This file contains a nearly completed version of
half Goco’s head. The contours for the ear were
created in much the same way you created the

contours for the head itself. The Soft Selection
feature (on the Soft Selection Rollout for CV
sub-objects) was used to create the dimple in
the center of the ears.

Note: The eyes are white because a
Multi/Sub-Object material has been applied
to the head, as you can see if you open the
Material Editor. The head and ear surfaces have
material ID 1, which corresponds to the blue
sub-material, and the eyes have material ID 2,
which corresponds to the white sub-material.
The white sub-material uses a Gradient map
to create a dot in the middle for Goco’s pupils.
(You can see this map only when you render
the model of Goco.) You assign material IDs to
NURBS surface sub-objects using the surface
sub-object’s Material Properties rollout.

Go to the Modify panel and select the
NURBS model.

2. Zoom in on the region of the ear.

3. In the NURBS toolbox, turn on Create U
Loft Surface.

4. Click curves for the U loft from the top of the
ear toward the head. Start at the very small
curve at the tip of the ear, and end at the curve
on surface that lies on top of the head.

5. Right-click to end U loft creation.

6. On the U Loft Surface rollout, click to highlight
Curve on Surf 01 in the U Curves list, and then
in the Curve Properties group box, turn on Use
COS Tangents.

Use COS Tangents (Curve on Surface tangents)
makes the loft tangent to the surface that is the
parent of last curve (Curve on Surf 01) in the
loft. This is a good technique for connecting
one surface to another. Although you don’t
model the entire figure in this tutorial, Use COS
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Tangents is also used to connect the arms and
legs to the torso of Goco.

Note: You might have to turn on Flip Tangents
to get the correct appearance of the ear.

7. Save your work as goco_ear.max.

Mirroring and Lofting the Head

In this lesson, you create a complete head surface.
First you mirror the half-head, then you use Join
to connect the contour curves. Finally, you loft the
connected curves.

Mirror the head:

1. Open the file tut_goco_03.max.

2. Select the NURBS model.

3. Choose Tools menu > Mirror. In the
Mirror: World Coordinates dialog, leave X
chosen as the mirror axis. Set the Offset to -0.5"
(inches), choose Copy, and then click OK.

Make sure the offset is negative, or you will get
a weird overlap between the two halves.

The head is now mirrored, with a slight gap
between the two halves. The newly copied half
is selected.
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4. Go to the Modify panel.

5. On the General rollout, turn on the Attach
button, and then click the original half of the
head.

Attach makes both halves part of the same
NURBS model.

Remove the temporary U lofts:

1. Right-click in a viewport, and then go to the
Surface sub-object level in the modifier stack.

2. Click to select one of the surface halves, and
then hold down CTRL while you click the other.

Both halves of the head should be selected.
(You can leave the eyes and ears as they are.)

3. On the Surface Common rollout, click Delete.

Now the head consists of just the eyes, the ears,
and the contour curves.

Connect the contour curves:

1. Use Zoom and Arc Rotate to move
the model so you can easily see the gap between
the contour curves of the two halves.

2. Go to the Curve sub-object level.

3. On the Curve Common rollout, turn on Join.
Click the end of one curve near the gap. The
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curve is highlighted in blue, and a blue square is
displayed, showing the end that will be joined.
Drag to the corresponding curve. The second
curve is also highlighted in blue, with a square
to show the end that will be joined. When
you have matched the curves you want to join,
release the mouse button.

4. In the Join Curves dialog that appears, click OK
or press ENTER to use the defaults (the ZIP tab
is active by default, and this is the best way to
join two curves).

Steps 3 and 4 can be tricky, because it can be
difficult to see where the curves are, and which
ends should match. Follow these guidelines:

• For consistency’s sake, move from top to
bottom and left to right.

• Before you join, make sure the joined curve
(highlighted in blue) appears symmetrical.
Do not join mismatched curves.

• Join only the final ends of curves. Do not
join if a small green circle appears in the blue
highlight box. This indicates the start of a
curve. (After joining the final ends, you will
close the curves all at once.)

• Zooming in and panning to get a
closer view can help you locate the ends to
join.

• Save your work frequently so you don’t have
to backtrack too far if you make a mistake.

(If you run into trouble during this step,
you can skip ahead to the next group of
steps, "Loft the head," where you can load
a prepared file.)

5. When you’ve joined all the contour curves, use
CTRL to select all of the contours.

6. On the CV Curve rollout, click Close.

Close will be unavailable if you didn’t connect
all of the paired curves.

Now all the contours of the two halves of the
head are joined together, and you’re ready to
complete the head.

7. Save your work as goco_closecurve.max.

Loft the head:

1. Either continue to use goco_closecurve.max, or
open the file tut_goco_04.max.

2. In the NURBS toolbox, turn on Create U
Loft Surface.

3. Create the final loft of the head. Begin creating
the loft at the base of the neck, and proceed
forward to the mouth.

Tip: If you aren’t sure you’ve picked curves in
the right order, highlight each curve using the
U Curves list on the U Loft Surface rollout. If
a curve is out of order, highlight its name in
the U Curves list, then change its position by
clicking the buttons with up and down arrows
just above the U Curves list.

4. Examine the end result in the viewport. Notice
that there is a fair amount of creasing and
unwanted bulging on the nurbs surface over
the upper jaw and around the eyes. This is due
to a large number of unnecessary CV points
that were automatically inserted when you
joined/closed the curves earlier.
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5. On the Modify panel, go to Curve CV
sub-object mode. Zoom in and adjust your
view so you can have a better look at the center
line of the head.

6. Select and delete the CV points along the
mirror axis of the head. Try not to have more
than one or two CV points on each curve along
the mirror plane. When you are done, you
should have a much smoother surface for the
head of the character.

Completing the Head

In this lesson, you complete the head by restoring
the connections between the main head surface
and the eyes and ears. The eyes and ears are based
on curves that reside on the surface of the head,

but when you deleted the temporary U lofts, these
curves were converted back to independent CV
curves. You need to attach them again, to avoid
seeing gaps when you render Goco’s head.

Tip: After completion, you can experiment
by converting the head to an Editable Patch
surface and trying some of the new smoothing
improvements.

Attach the left ear again:

1. Open the file tut_goco_05.max, and select the
head.

2. Go to the Curve sub-object level.

3. In the NURBS toolbox, turn on Create
Normal Projected Curve. Drag from the last
curve in the left ear, the one that originally
resided on the temporary surface, to the new
head surface.

A new normal projected curve is created. It is
displayed in green rather than white, because it
is a dependent curve. The old curve and the
new curve occupy nearly the same location.

4. Still at the Curve sub-object level,
select the old curve, the white one, and press
DELETE.

DELETE is a shortcut for clicking Delete on the
Curve Common rollout.
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The last section of the U loft that forms the ear
disappears.

5. Go to the Surface sub-object level.

6. Select the ear.

7. On the U Loft Surface rollout, at the bottom of
the Modify panel, highlight the ------ End ------
marker in the U Curves list, and then turn on
Insert.

When you insert a curve into a U loft, it
always appears above the highlighted entry.
Highlighting the ------ End ------ marker
makes the new curve the last one in the loft.

8. When you move the mouse over the new
normal projected curve, it is highlighted in blue
to show you can add it to the U loft. Click the
new curve while it is highlighted.

Now the ear is connected to the head again.

9. On the U Loft Surface rollout, highlight Normal
Projected Curve in the U loft list, and then turn
on Use COS Tangents.

As with the temporary surface, this makes the
loft of the ear blend smoothly into the head.

You might have to turn on Flip Tangents to get
the correct appearance of the ear.

10.Change the Tension to 0.5.

The Tension spinner is another way to adjust
the effect of a curve on a loft. Decreasing
tension pulls the surface toward the curve.
Increasing tension (use large values) pulls the
surface toward the neighboring curves.

Attach the other ear and the eyes:

• Repeat the previous steps, 1 through 9, for the
right ear and the two eye surfaces.

Now the eyes and ears are fully and smoothly
connected.

Render your work and save it:

1. Render the head. It should look similar
to the illustrations.

2. Save your work as goco_fullhead.bmp.

This completes the tutorial for creating Goco’s
head.

Summary

The NURBS modeling tools are ideal for modeling
organic objects. When modeling characters, be
sure to use a reference picture to help you create
the object correctly.

Modeling an Apple
In this tutorial, you create an apple. You will add
Taper and Displace modifiers to reshape a sphere
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to look like an apple, then use additional tools to
improve its shape and add a stem.

Skill Level: Beginner

Time to complete: 25 minutes

Features Covered in This Tutorial

• Taper modifier

• Creating sub-object selection sets

• Using soft selections to blend changes to a mesh

• Using a Displacement modifier to shape your
mesh

• Using a Bend modifier to shape a stem

Tutorial Files

All the necessary files for this tutorial can
be found on the Tutorial Files CD in the
\tutorials\intro_to_modeling directory. Before
starting the tutorials, copy the \tutorials folder to
your local\3dsmax8installation.

Creating the Basic Apple Shape

First you will create the basic apple shape from a
sphere and modifiers.

Create the apple:

1. Choose File > Open and open the
file tut_apple_start.max from the
\tutorials\intro_to_modeling folder.
Highlight the file and click Open.

There is no geometry in this file; however, it
does contain a material you will need.

2. On the Create panel, under Standard Primitives
> Object Type, click Sphere.

The button turns yellow, indicated the Sphere
command is ready for you to make a sphere.

3. In the Top viewport, drag to create a sphere that
has a Radius of 10.

4. In the Name and Color rollout, name the sphere
apple.

5. Click Zoom Extents All to zoom all the
viewports.

Change the rendering background color:

You’ll be able to see the apple better if you render it
against a white background.

1. From the Main menu, choose Rendering >
Environment to display the Environment and
Effects dialog.

2. In the Common Parameters rollout >
Background group, click the black Color box
to display the Color Selector dialog. Set Value
to 255 and click Close to accept the value and
close the dialog.

3. Close the Environment and Effects dialog.

Apply an apple material:

1. Press M on the keyboard to open the Material
Editor.

2. From the Material Editor, drag the material
shiny apple to the apple sphere in any viewport.

3. Close the Material Editor.
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4. Right-click in the Perspective viewport
to activate it. On the Render toolbar, click
Quick Render. Or press F9 on the keyboard to
render the viewport without clicking a button.

Rendered apple against White background

Taper the apple:

Selecting what you want to work on is the first
step in modeling. Until you make a selection, all
modifier choices are unavailable. In this case,
the apple should be selected; when selected, its
wireframe mesh is displayed in white.

Modifiers can be selected from the Modifier List
on the Modify Panel, or from the Modifiers Menu.
Here you’ll use the menu option at the top of the
interface.

1. On the 3ds Max menu bar, on the Modifiers
menu, choose Parametric Deformers > Taper
to apply this modifier to the sphere of the apple.

2. In the Parameters rollout > Taper group, adjust
the Amount parameter and watch the effect in
the viewports. You only need a small amount of
taper. Adjust the parameter to about 0.85.

3. On the Parameters rollout > Taper Axis group,
set Primary to Z and Effect to XY.

Improving the Shape of the Apple

The Taper modifier produced a rough reshaping
of the apple’s original sphere. To achieve more
realism, you will collapse the sphere into an
editable mesh and use Soft Selection to adjust the
transition between selected and unselected areas.

Shape the lower half of the apple:

What you see in the viewports is a tapered
wireframe of the whole apple. For more detailed
modeling, you need to select only part of the apple,
such as the lower half. By collapsing the sphere to
an editable mesh, you can make a soft sub-object
selection.

1. With the apple selected, go to the Modify panel
> modifier stack display (below the Modifier
List), right-click the object name, and then
choose Collapse All. Click Yes in the Warning
dialog.

Tip: If you are unsure about collapsing the stack,
click Hold/Yes instead. You can revert the scene
to the current state by selecting Edit > Fetch
from the menu bar.

The tapered sphere becomes an editable mesh.

Tip: You can also convert a selected object to
an editable mesh in the active viewport by
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right-clicking the object and in the quad menu
> Transform quadrant > Convert To > Convert
To Editable Mesh.

2. In the stack display, click the plus sign (+) next
to Editable Mesh to expand its sub-object levels.

3. Choose Vertex from the level list.

In the viewports, the vertices appear,
highlighted in blue.

4. Activate the Left viewport.

5. Click Zoom Extents All in the viewport
navigation controls.

The apple is enlarged in three viewports.

6. In the Front or Left viewport, drag from outside
the sphere to make a dotted box around the
bottom two or three rows of vertices of the
apple. As you release to complete the box, the
selection is made, and the vertices turn red.

This technique is called region-select. It’s the
most common method for making sub-object
selections.

Name the sub-object selection:

With hundreds of vertices or faces, sub-object
selections are often hard to recreate exactly. So
it’s a good idea to give these selections a name
you can recognize later. Any selection (object
or sub-object) can be named and retrieved in
3ds Max. As your modeling skills develop, you’ll
begin to recognize the advantages of named
selection sets.

• On the Selection Sets toolbar, toward the right
side of the interface, you’ll find a blank list.
This is where you name the current selection.
In this case, type in bottom of apple and press
ENTER.

This selection name is stored with the file.

You might have many named selections on a
single object, but you will only see bottom
of apple in the list when you return to the
Vertex level of the editable mesh. At this level,
you could make multiple selections and give
them each a different name. You could then
experiment with which selection works best for
the modeling effect you want.

Use Soft Selection to blend changes to your mesh:

The Soft Selection setting helps the selected region
blend with the rest of the object.

1. In the Modify panel, scroll to and open the Soft
Selection rollout.

You can scroll any command panel by dragging
the hand cursor that appears in blank areas of
the panel. Click to open the rollout.

2. Turn on Use Soft Selection.

The vertices are now displayed in a graduated
color ramp.
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3. Adjust the Soft Selection Falloff setting
watching the viewport shading change until the
lower half of the apple is affected.

Completing the Apple

This lesson continues from the previous one. You
are working at Vertex level with Soft Selection
active. The bottom half of the apple is selected.

Apply a displacement modifier to your apple:

Here you apply a Displace modifier to move only
the currently selected vertices on the bottom of the
apple. You use a bitmap to control this movement,
or displacement.

1. Make sure the Vertex sub-object selection is
active (yellow) in the modifier stack and the
vertices are visible in the viewport. Then, click
the Modifier List drop-down arrow. From the
Object-Space category in the drop-down list,
choose Displace.

This applies the Displace modifier. You
won’t see much change until you adjust its
parameters.

2. Adjust the Strength spinner in the Displacement
group. You should see the effect happening
only on the lower half of the apple.

3. On the Parameters rollout > Image group, click
the Bitmap button labeled None.

4. In the Select Displacement Image dialog,
choose appledis.jpg.

The preview window at the bottom of the dialog
shows the bitmap you’re applying.

The bitmap is a black square with four fuzzy
white blobs. The white areas will displace more
than the black, producing the characteristic
four bumps on the bottom of the apple. The
fuzziness of the bitmap image creates a smooth
transition.

5. Click Open to apply the bitmap.

6. In the Parameters rollout > Displacement
group, drag the Strength spinners (the small
arrows next to parameter fields) to increase and
decrease the Strength parameter a little. Again
watch the effect in the viewport.

Negative values push the bitmap image into
the mesh. Positive values draw the image out,
producing bumps. Try a value of -5.0. You can
change this later if you need to.
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Complete the top of the apple:

To complete the apple shape, you’ll add an Edit
Mesh modifier to create a second soft selection,
and then copy the Displace modifier to the top half
of the apple.

1. On the Modify panel, choose Modifier List >
Object-Space Modifiers > Edit Mesh.

2. In the Selection rollout, choose Vertex.

Warning: You want the Vertex sub-object level of

the new (top) Edit Mesh modifier. Not the Vertex

level of the (bottom) Editable Mesh.

You are now working at the Vertex sub-object
level.

3. Region-select the vertices on the top two or
three rows of the sphere. Name the selection
top of apple.

Tip: You might notice that the original Soft
Selection vertices are still displayed. Once you
have selected the vertices at the top of the apple
and turn on Soft Selection, the newly selected
vertices should display correctly.

4. Open the Soft Selection rollout. Turn on Use
Soft Selection, and adjust Falloff to about 8.0.

The modifier stack display shows you all the
changes you’ve made to your object. The sphere
is now shown at the bottom as an editable mesh.
The successive modifiers that you applied to
this sphere are above it.

5. In the stack display, right-click Displace and
choose Copy.

6. At the top of the stack display, right-click over
Edit Mesh and choose Paste to add the duplicate
Displace modifier to the stack.

Warning: Do not highlight the Edit Mesh in the stack

display. This will turn off the sub-object selection.

Instead, just right-click over the Edit Mesh entry.

A copy of the Displace modifier appears above
the Edit Mesh modifier in the stack, and its
effect has been applied to the top of the apple
selection.

7. In the Parameters rollout > Displacement
group, set Strength to 2.0.

8. Right-click in a viewport and choose
Sub-Objects > Gizmo from the Tools1 quadrant
of the quad menu.

In the stack display, the Displace entry turns
yellow to show that you’re working at its
sub-object level.



112 Chapter 3: Getting Started

The gizmo is a control for the modifier and
defines where and how the effect will take place.
By placing the gizmo just above the apple, you
can get the effect you want.

9. Move the gizmo so that it’s floating above the
top of the apple.

10.On the Parameters rollout for Displace, set the
Decay parameter 1.5 to model the top surface
into a characteristic apple shape. Again adjust
the Strength parameter to fine–tune your effect.

11.In the stack display, click the Displace entry to
exit the sub-object level and turn off the yellow
highlighting.

Adding a Stem to the Apple

In this lesson, you add some more visual interest
to the apple. To create the stem of the apple, you
make a cylinder using the AutoGrid feature to
build the stem on the surface of the apple. You
then add a Bend modifier to finish the stem.

Create the stem:

When you build an object in a viewport, the object
is constructed on a grid. Up until now, you have
been using the home grid to build the apple. Now
you’ll try using the AutoGrid feature. This uses

a roving grid that is automatically created off a
surface using face normals.

1. On the Create Menu, choose Standard
Primitives > Cylinder.

The Cylinder button highlights on the Create
panel.

2. On the Create panel > Object Type rollout, turn
on AutoGrid. This is a small check box directly
under the Object Type rollout.

3. In the Top viewport, move the cursor over the
apple.

A tripod follows the cursor showing where the
cylinder will be created. Try to locate the center
of the top of the apple.

AutoGrid lets you create the stem on top of the apple.

4. Add a cylinder on top of the apple. First drag
and release to draw the base of the cylinder, and
then move the mouse to set its height. Click to
finish.
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5. In the Name And Color rollout, change the
color of the cylinder to green and name it stem.

6. On the Parameters rollout for the stem, set the
following:

• Radius=0.5

• Height=4.0

• Height Segments=12

7. On the Object Type rollout, turn off AutoGrid.

8. On the Modifiers list, choose Object-Space
Modifiers > Bend.

This applies a zero-degree Bend to the cylinder.

9. On the Parameters rollout for the Bend
modifier, adjust the Angle setting to bend
the stem. Plus or minus 60 is about right.
Experiment with the Direction parameter,
although you can leave it at 0 if you want.

10.Right click in the Perspective viewport to active
it, and press F9 to render last.

Rendered apple

If you want your stem to be similar to the one
in the bottom illustration, apply a very slight
Taper modifier below the Bend.

11.Highlight the Cylinder in the stack display.

12.Add the Taper modifier at this point, it will then
taper the cylinder before it is bent.

Warning: Applying the Taper modifier after the Bend

will produce entirely different results.
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After Adjusting the Taper modifier, highlight
Bend to reactivate it.

The cylinder is first tapered, then bent.

Save your work:

• Choose File > Save As. Save your work as
my_apple01.max in your appropriate local
folder.

Note: A completed file, tut_apple_complete.max
is also available in the tutorials\intro_to_
modeling directory.

Summary

In this tutorial, you learned how to start with a
primitive and shape the object using the Editable
Mesh tools. You also learned how you can use
displacement mapping to make an object appear
more organic.

Materials & Mapping

Introduction to Materials &
Mapping

Materials are like paint. With materials, you make
apples red and oranges orange. You put the shine
in chrome and the polish on glass. By applying
maps, you can add images, patterns, and even
surface texture to objects. Materials are what make
your scenes look real.

Mapping is a method of projecting pictorial
information (materials) onto surfaces. It is a lot
like wrapping a present with wrapping paper,
except the pattern is projected mathematically,
with modifiers, rather than being taped to the
surface.

This tutorial introduces the Material Editor, the
master design studio for materials and maps. In
the following lessons, you will learn how to assign
materials to objects, how to create basic materials,
and how to create several kinds of advanced
materials.

Skill level: Basic to intermediate
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Time to complete: 90 minutes

Features Covered in This Tutorial

In these lessons you will learn:

• Accessing materials from material libraries,
scene objects, and other MAX files.

• Assigning materials to scene objects.

• Creating basic materials, including wireframe,
2–sided and self-illuminated.

• Using ambient color and light with materials.

• Creating additive and subtractive transparency.

• Using shaders.

• Using texture, opacity and bump mapping.

• Creating and adjusting mapping coordinates.

• Creating multi/sub-object materials using drag
and drop.

• Creating a raytrace material.

• Using displacement mapping.

• Creating stars using noise.

• Using Shellac material to create realistic human
skin.

Tutorial Files

Files for this tutorial are in the \tutorials\intro_to_
materials folder.

Note: All the necessary files to do the tutorials can
be found on the Tutorial Files CD that ships with
3ds Max . Before doing the tutorials, copy the
\tutorials directory from the CD to your \3dsmax8
local installation.

Accessing Materials

Examples of different materials

When you work with 3ds Max, you access materials
from three different places: from the Material
Editor, from scenes, or from an external collection
of predesigned materials called a material library.
The next exercise shows you how to load materials
from a material library into the Material Editor.

The files for this lesson can be found in the
\tutorials\intro_to_materials folder.

Load a material library:

1. Start or reset 3ds Max.

If you receive the dialog asking if you really
want to reset the program, answer Yes.

2. Open intro_materials.max.

Note: If you see the File Load: Units Mismatch
dialog, choose the option Rescale The File
Objects To The System Unit Scale.

3. Press the M key on your keyboard to open the
Material Editor.

The sample slot in the upper-left corner has
a white border around it, indicating that it is
active.

3dsmax.chm::/file_load_units_mismatch_dialog.html
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4. Right-click the active sample slot. From
the right-click menu, choose 5 x 3 Sample
Windows. The sample palette redraws to
display 15 slots.

5. On the Material Editor toolbar, click Get
Material.

The Material/Map Browser appears.

6. In the Material/Map Browser > Browse From
group, choose Mtl Library (Mtl stand for
“Material.”)

7. In the File group, click Open.

The default Material Library, 3dsmax.mat, is
displayed. A number of others might be listed
as well.

8. In the Open Material Library dialog, navigate
to the \tutorials\intro_to_materials directory
and choose stilllife.mat.

The names of the materials appear in a list.

9. On the Material/Map Browser toolbar,
click View List+Icons.

A thumbnail of each material appears next to
its name.
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Transfer materials to the Material Editor:

1. On the Material/Map Browser, click the
material named orange.

A larger thumbnail of the Orange material
appears in the preview window.

2. Drag the thumbnail from the Browser to the
active sample slot in the Material Editor. You
can drag it from either the preview window or
the list of materials.

The material appears in the sample slot. The
name orange appears in the drop-down list just
below the palette.

3. Click the next sample slot to the right. The slot
becomes active.

4. On the Material/Map Browser, double-click
shiny apple. The shiny apple material appears
in the second sample slot.

5. Scroll the Material/Map Browser to the bottom
of the list, if necessary.

6. Drag the wood countertop material from the
list to the third sample slot.

The third sample slot activates, displaying the
wood countertop material.

Get materials from a MAX file:

You can just as easily get materials from MAX
scene files as from material libraries. The
procedure is nearly the same.

1. Activate the sample slot to the right of the wood
countertop material.

2. On the Material/Map Browser, check that
Browse From is still set to Material Library.

3. Choose Open from the File group.

4. Pull down the Files Of Type list and choose 3ds
Max (.max,.chr) instead of .mat.

5. Navigate to the \tutorials\still_life folder, and
then open Still_life_animated.max.

6. Double-click the material named leaf.
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The leaf material is transferred from the MAX
file to the Material Editor.

Get materials from objects in the scene:

There is a material already at work in this scene,
but it is not in the Material Editor. It is applied to
all the objects in the scene, so that they look like
they are all made of the same substance. You can
transfer the material from the scene to the Material
Editor using the eyedropper cursor to sample the
material.

1. Activate the fifth sample slot in the top row of
materials.

2. In the Material Editor, click Pick Material
From Object. The button is located next to
the material name, below the top row of icons
(under the sample slots).

3. Use the eyedropper to click any object in the
viewport.

The material, beige putty, appears in the sample
slot. Because the material is currently assigned
to objects in the scene and in the Material
Editor, the corners of the sample slot display
triangles. In 3ds Max parlance, this is called a
"hot" material.

Note: If the triangular corners are hollow, this
indicates the material is assigned to the scene. If
the corners are solid, it means an object that has
been assigned the material is currently selected.

For practice:

1. Transfer the rest of the materials from the
material library into the Material Editor.
Arrange them in a way that makes sense to you.

2. To copy and move a material, drag the sample
to a new slot.

3. To remove a material from a sample, press
Reset Map/Mtl to Default Settings.

4. To view more sample slots, use the scroll bars at
the right and bottom of the sample palette, or
change the right-click settings to 6 X 4 Sample
Windows.

Note: While the sample palette can show you 24
samples at any one time, there is no limit to the
number of materials you can assign to a scene.
Once a material is assigned to an object, that
sample in the palette can be reset and a new
material created.

5. Pan the sample palette by dragging in
between the slots.

6. To examine a material up close, double-click
the sample slot, or right-click the slot and
choose Magnify.

7. Save your file as mymaterials1.max.

Assigning Materials to Objects

In this lesson, you will learn two ways to assign
materials to objects.

• The files for this lesson can be found in the
tutorials/intro_to_materials folder.

Set up the lesson:

• Open intro_materials2.max.

Note: If you see the File Load: Units Mismatch
dialog, choose the option Rescale The File
Objects To The System Unit Scale.

Assign a material to a selected object:

Making your selection before assigning a material
to it ensures that the material goes exactly where
you want it to go. Use this approach for mapping
complex scenes, or when you want to assign
materials to sub-object selections.

3dsmax.chm::/file_load_units_mismatch_dialog.html
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1. On the keyboard, press H to display the Select
Objects dialog. Highlight Orange and click
Select.

2. Press M to open the Material Editor.

3. Click the sample slot that contains the orange
material.

4. Click Assign Material to Selection. The
object turns orange in the Camera01 viewport.

Assign a material using drag and drop:

Drag and drop is the most direct way to assign
materials to objects. Use this approach when the
objects you want to map are clearly visible in the
scene.

1. In the Material Editor, find the sample slot that
contains the shiny apple material.

2. Drag the sample onto the apple; a tooltip lets
you know when the cursor is over the right
object. The apple turns red.

See the results:

1. Activate the Camera01 viewport by
right-clicking in it.

2. From the toolbar, click Quick Render.
The view from the camera renders line by line
in a separate window.

For practice:

• Assign materials to the rest of the objects in
the scene. Use the tooltips to see the name of
each object, or choose objects by name from
the Select Object dialog. When you are done,
render the scene to see how it looks.

Creating Basic Materials

In this lesson, you create variations on the Standard
material type by changing basic parameters such
as color, glossiness, transparency, and shader type.

• The files for this lesson can be found in the
tutorials/intro_to_materials folder.

Set the diffuse and specular color:

The Blinn shader has basic settings for color,
glossiness, self-illumination and transparency.

1. Open intro_materials2.max.
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Note: If you see the File Units: Mismatch dialog,
choose the option Rescale The File Objects To
The System Unit Scale.

2. Press M to open the Material Editor. If
necessary, set the display to 5 x 3 Sample
Windows.

3. Select the fifth sample sphere in the third row;
the material is named try me.

4. Rename this material using the editable name
field above the rollouts. Call it myorange
material.

5. From the Material Editor, drag myorange
material onto the Orange object in the viewport.
The orange in the viewport turns gray.

6. On the Blinn Basic Parameters rollout, click
the Diffuse color swatch to display the Color
Selector. Change the Diffuse color to dark
orange. Then close the Color Selector.

Both the Diffuse color and Ambient color
change to dark orange, because the colors are

locked together. In the viewport, the Orange
object’s color changes to dark orange.

7. In the Specular Highlight group, experiment
with the Specular Level parameter by dragging
the spinner up and down while observing the
sample sphere. Then set the Specular Level to
100.

A highlight appears on the orange. The
highlight gets stronger as you increase the
Specular Level.

8. Experiment with the Glossiness parameter
by dragging its spinner up and down while
observing the sample sphere. Then set the
Glossiness to 40.

As Glossiness increases, the highlight gets
smaller and more focused. This is how you
control the shininess of an object.
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9. Click the Specular color swatch and change the
Specular color to a bright lemon yellow.

The highlight takes on a yellow tinge.

Use wire and 2-sided:

You can use the Wire material option to make an
object render in wireframe.

1. On the Shader Basic Parameters rollout, turn
on Wire.

The surface of the orange displays in wireframe,
rather than as shaded faces.

2. Open the Extended Parameters rollout. In the
Wire group, change the Size to 2.5.

3. Render the scene. The orange renders
with a thicker wire.

Tip: To depict an object turning to wireframe,
animate the wire thickness.

4. In the Shader Basic Parameters rollout, turn on
2-Sided. Now you can see the object’s back side
through the front wires.
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5. Turn off 2-Sided and Wire. The object turns
solid again.

Add self-illumination:

Self-illumination makes an object look as though
it’s lit from within. Use Self-Illumination to save
rendering overhead when you want to create lights
that do not need to illuminate surfaces, such as
running lights along the perimeter of a spaceship.

1. On the Blinn Basic Parameters rollout, set
Self-Illumination of myorange material
material to 100 percent.

The dark areas of the orange brighten, making
the orange look incandescent.

Note: If you see a black color swatch instead of
the spinner, turn off Color.

2. Right-click the Self-Illumination spinner to
reset the value to 0.

3. Save your file as myorange.max.

Understanding Ambient Color and
Light

Ambient light is used to simulate indirect light,
such as the atmospheric light that permeates
outdoor scenes. It may also be used to simulate
radiosity, which is the color that bounces off
brightly colored objects.

Ambient color controls the color of objects in areas
of shadow, whenever ambient light is present.
Generally, you do not see any effect when you
change the ambient color of a material, because
ambient lighting is turned off by default.

To see the effect of ambient color in a scene, you
must create an ambient light source. You can either
create lights that are set to Ambient Only in order
to create a localized effect, or use the Environment
dialog to affect an entire scene.

Set up the lesson:

• Continue from the previous lesson.

Adjust the ambient light and color:

1. In the Material Editor, choose the beige putty
material in the upper-right material sample.

2. Change the Ambient color of the beige putty
material to a bright shade of purple.

The color of the scene does not change.

3. Choose Rendering > Environment. The
Environment dialog appears.

4. Click the Ambient color swatch. In the Color
Selector, change the Ambient color to a medium
shade of gray. Then close the Color Selector
and the Environment dialog.

The materials brighten in direct proportion to
the brightness of the Ambient color. The beige
putty objects in the scene turn purple.
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5. Activate the slot containing myorange material.

6. Click the lock button to the left of the Ambient
and Diffuse colors to unlock them. Then
change the Ambient color from orange to a
bright green.

Watch the viewport and notice the orange turns bright
green.

Creating Transparency

The Opacity parameter controls the transparency
of a material. The default setting is 100 percent
opaque. An Opacity value of 0 creates total
transparency.

Set transparency:

1. Choose File > Reset.

Do not save your changes.

2. Press M to open the Material Editor.

3. Click the Background button to the right
of the sample spheres. A multicolored checker
pattern appears in the active sample slot behind
the sample sphere.

4. Double-click the sample material to open it in a
separate window. Resize the window if you like.

5. In the Blinn Basic Parameters rollout change
the Diffuse color to green. The Ambient color
changes as well.
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6. Set the Opacity value of the material to 50.

The sample sphere becomes semi-transparent.

Opacity controls transparency.

7. Set the Specular Level to 100 and the Glossiness
to 80. Two small highlights appear on opposite
sides of the sample sphere.

8. On the Shader Basic Parameters rollout, turn
on 2-Sided. Two more highlights appear on
the sample sphere. These represent highlights
inside the sphere.

9. Open the Extended Parameters rollout.

10.Change the Falloff setting from In to Out.

11.In the Advanced Transparency group, set the
Falloff Amt to 100.

The sphere becomes more transparent towards
the edges.

12.Change the Falloff setting from Out to In.
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The opacity falls off towards the center of the
sphere, revealing a nearly transparent center.

13.Change the Filter color to bright yellow.

The sample sphere takes on a ghostly look.

14.Change the Type to Subtractive, then Additive.

The areas of opacity turn dark like smoke, then
light like clouds.

Understanding Shaders

For standard materials, a shader is an algorithm
that tells 3ds Max how to calculate surface
rendering. Each shader has a unique set of
characteristics in order to serve a particular
purpose. Some are named for what they do well,
such as the Metal shader. Others are named for the
person who developed them, such as the Blinn and
Strauss shaders. The default shader in 3ds Max is
the Blinn Shader.

Note: In addition to the shaders listed below,
3ds Max supports plug-in shader types.

The following list describes the shaders supplied
with the software:

• Anisotropic: Used for brushed metal or hair.
Creates a highlight that is stretched and angled,
rather than the standard circular highlight.

• Blinn: Has the same features as the Phong
shader, but its mathematics are more accurate.
This is the default shader for Standard materials.
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• Metal: Used for making metals.

• MultiLayer: Two anisotropic shaders in one.
Used to make two different highlights with
independent controls. Simulates materials such
as a metal that is covered with a shiny coat of
wax.

• Oren-Nayar-Blinn: An adaptation of the Blinn
shader. It gives objects a porous, non-plastic
appearance, and is suitable for surfaces like
skin.

• Phong: A classic shading method that was the
first to enable specular highlights. Suitable for
plastic surfaces.

• Strauss: Suitable for metals. Allows you to
control the degree of metallic characteristics of
the material.

• Translucent Shader: Translucent shading
is similar to Blinn shading, but it also lets
you specify translucency. A translucent
object allows light to pass through, and also
scatters light within the object. You can use
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translucency to simulate frosted and etched
glass.

Comparing Shader Parameters

A shader is an algorithm that tells the program
how to calculate surface rendering. Each shader
has a unique set of characteristics in order to serve
a particular purpose.

Compare the parameters of different shader types:

1. Open the Material Editor and click an available
sample slot.

2. In the list on the Shader Basic Parameters
rollout, change Blinn to Anisotropic.

The Blinn Basic Parameters rollout changes
to the Anisotropic Basic Parameters rollout.
Observe the differences in the available basic
parameters.

3. Select each shader type from the list and
compare its parameters with the others. Some
parameters are shared in common, but each
shader has its own unique combination of
settings.
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For more information on shader types, see the
User Reference, including this topic: Shader Basic
Parameters Rollout.

Mapping and Mapping
Coordinates

Adding images and textures to a material is one
of the most important techniques for creating
realistic effects. In this lesson, you learn how to
add texture maps and bump maps to a material.
You also learn how to position a map on the
surface of an object by adjusting the mapping
coordinates of the material.

• The files for this lesson can be found in the
tutorials/intro_to_materials folder.

Make a texture map:

Suppose you want to make a realistic orange in
your scene. The most direct way is to use a realistic
image as the texture map in the diffuse component
of a material. In other words, you replace the
overall color with an overall texture. Here are the
basic steps:

1. Buy an orange and photograph it.

2. Crop a portion of the photograph.

3. Digitize the cropped portion with a scanner or
digital camera.

4. Load this image into your computer.

5. Apply the image as a diffuse map.

A cropped photograph of a real orange peel

Add a texture map to a material:

The digitized bitmap you are going to use is
already being used by the orange material in the
first sample slot. You can therefore browse for the
bitmap from the Material Editor.

1. Open intro_materials3.max.

Note: If you see the File Load: Units Mismatch
dialog, choose the option Rescale The File
Objects To The System Unit Scale.

2. Press M to open the Material Editor. Set the
display to 5 x 3 Sample Windows, if it isn’t
already.

3. Click myorangematerial. It’s the material in the
lower-right corner of the Material Editor.

4. On the Blinn Basic Parameters rollout, click the
map selector button to the right of the Diffuse
color swatch to display the Material/Map
Browser.

5. In the Browse From group, choose Material
(Mtl) Editor.

6. Click View Small Icons.

All the images that are currently loaded appear
as small thumbnails.

7. Click View Large Icons.

The thumbnails appear larger.

8. Click the image labeled Diffuse Color: Orange
(orangetex.jpg) and click OK. On the Instance
Or Copy dialog, choose Copy and click OK
again.
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The Material/Map Browser closes and the
orange texture map appears in the material
sample, but not in the viewport.

9. To display the texture map in the viewport,
click the Show Map In Viewport on the Material
Editor toolbar.

The orange texture map appears in the
viewport.

Note on Mapping Coordinates and Viewport
Visibility

The orange map shows in the viewport because the
orange object has mapping coordinates applied to
it. Like other parametric objects in 3ds Max, the
sphere of the orange generated its own mapping
coordinates when created. This is not necessarily
the case with editable meshes and many other
types of geometry.

If the object in the scene didn’t have mapping
coordinates, the map wouldn’t appear in the
viewport, even if Show Map In Viewport is on. In
that case, you can add a UVW Map modifier to the
object to make the texture display.

If the texture map still doesn’t display, you can
move the gizmo of the UVW Map modifier, and
experiment with the Offset, Tiling, and Angle
parameters in the Coordinates rollout. This will be
covered later in the tutorial.

Add a bump map:

The texture on the orange looks all right, but a real
orange peel has a pitted surface. You can simulate
this and add realism by using bump mapping.
This won’t show up in the viewport, but is visible
when you render.

1. Select the orange in the viewport.

2. Click myorangematerial in the lower-right
corner of the Material Editor.

3. Click Go To Parent to access the material
level.

4. Scroll down and open the Maps rollout.

5. Drag the orangetex.jpg map from Diffuse Color
to Bump. Choose Copy and click OK.

6. Set the Bump Amount to 100.

There is no change in the viewport.

To really see the effect, you’ll need to render the
scene. It would also be a good idea to zoom in
and see what’s happening to the orange.

7. Activate the Front viewport. Select the orange,
if it isn’t already selected.

8. In the viewport navigation controls, use Arc
Rotate Selected to rotate around the orange and
get a good view (the viewport will switch to
User type). Zoom so the orange fills up most
of the viewport.

9. Render the Front viewport.

10.Drag the orange material in the first sample slot
from the Material Editor to the Orange object
in the viewport.

Nothing will change in the viewport, but this
will let you use the experimental material for
other purposes later in this exercise.

11.Press F so the viewport returns to Front view.
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Use mapping coordinates and tiling:

In this procedure, you use the concrete wall behind
the objects to learn about mapping and tiling.

1. From the Material Editor, drag the concrete
material (second row, fourth sphere) onto the
wall object (named L-Ext01).

The concrete shows up in the camera viewport
because the parametric object has generated
its own mapping coordinates. But the concrete
doesn’t look quite right on the wall.

2. Select the wall object (L-Ext01), and then
from the Modifiers menu > UV Coordinates
submenu choose UVW Map.

The concrete changes appearance in the
viewport.

3. Right-click in the Camera01 viewport to
activate it.

4. In the Modify panel, scroll down to the
Alignment group.

5. Change the Alignment from Z to Y to X.

Choose the one that looks correct; probably Y.

6. In the Modifier Stack, expand the UVW
Mapping entry to see the Gizmo. Click the
Gizmo entry to highlight it.

7. On the Main toolbar, turn on Select And
Move. In the viewport, and drag the gizmo for
the mapping modifier to move the map.

The concrete bitmap shifts behind the objects.

To control placement of texture maps:

• Move the UVW Mapping gizmo.
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• Change the map’s Offset values.

To control tiling of texture maps:

• Change the map’s Tiling values.

• Change the UVW Mapping modifier’s Tile
values.

Create wallpaper with a tile pattern:

1. On the Modify panel, click Gizmo again to turn
off sub-object selection.

2. In the Material Editor, choose the concrete
material.

3. Change the name of the material to
background.

4. On the Maps rollout, click the concgren.jpg
map.

The rollouts change to the level of this map.

5. On the Bitmap Parameters rollout, select the
Bitmap button, which contains the path to the
concgren.jpg map. You’ll replace this map with
a tile pattern to create some wallpaper.

6. On the Select Bitmap Image File dialog, change
the Files of Type to Targa Image File and choose
pat0039.tga.

7. Turn on Show Map in Viewport.

A diamond pattern appears on the wall.

8. On the Coordinates rollout, set U Tiling and
V Tiling to 4.

9. Change the U tiling by clicking the spinner
until the tiling value is approximately 5.7.

This makes the pattern proportions more even.

On some systems, the diamond pattern might
be skewed in the Camera viewport. To correct
this, right-click the Camera01 viewport label
and choose Texture Correction.

10.See what happens when you add blurring
and then render. Also try working with Blur
Offset. Try setting the Coordinate rollout Blur
parameter to 1.5 and Blur Offset to 0.1. When
you’re finished experimenting with Blur, return
the Blur setting to 1.0.
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Use opacity mapping to make a leaf:

You can use the leaf objects in the scene to
experience a unique type of mapping. The leaf is
created with a simple box mapped with a texture
map and an opacity map.

The texture is a photo of a leaf.

The opacity map is a mask of white and black. The
black becomes transparent when rendered.

1. On the toolbar,
open the Named Selection Sets list and choose
the set named leavesandbase.

2. Right-click in the active viewport and choose
Hide Unselected.

The leaves and the base are now the only objects
visible.

3. Hold down CTRL and select the base.

This deselects the plank base.

The objects are really just thin boxes that have
Bend and Twist modifiers applied to them.
They don’t look anything like leaves right now.

4. Drag the leaf material from the Material Editor
onto the leaves in the scene.

5. When the Assign Material dialog appears,
choose Assign to Selection and click OK.

The leaf material is applied to all four leaves.

View the rendered leaves:

In this procedure, you zoom in without affecting
your existing camera view.

• Render the Camera01 viewport.

The boxes seem to have been replaced by
realistic leaves, and the opacity map and the
shadow-casting spotlights combine to cast
reasonable-looking shadows.
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Use mapping coordinates:

Besides letting you see maps in the viewport,
mapping coordinates give you control of how a
texture is applied to the object. In this procedure,
you’ll add a UVW Map modifier to the bottle label.
In the next procedure, you crop the texture.

Simple mapping is often solved by adding planar
mapping coordinates and then working with the
gizmo for adjustment. Let’s see how this works on
the label of the bottle.

1. Right-click in the active viewport, and choose
Unhide All. All the objects in the scene
reappear.

2. Select the orange, right-click, and choose Hide
Selection in the Display quadrant.

3. Press H and select label01.

4. Right-click in the Front viewport to activate
it, without affecting the selection of the label.
Then press G to turn off the grid.

5. Open the Modify panel and add a UVW
Map modifier to the label.

6. Region Zoom into the Front viewport so
you have a better view of label01.

7. Change the Front viewport display to Smooth
+ Highlights.

8. In the Parameters rollout > Alignment group,
turn on Region Fit and draw a box slightly
smaller than the label.

Region Fit lets you draw the gizmo to the size
you want.

9. In the Material Editor, click the label material.

10. Use Assign Material To Selection to apply
the material onto the label.
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11.Save the scene as mymaterials3.max.

Crop the texture:

The Gluggo texture map doesn’t really fit the label
properly, so you’ll fix it by using the cropping
features of the Material Editor.

1. In the Material Editor > Maps rollout, click the
Diffuse map button labeled gluggo.jpg.

2. In the Bitmap Parameters > Cropping/
Placement group, be sure Crop is chosen. Click
View Image.

A Specify Cropping/Placement window is
displayed showing the label bitmap.

3. Crop the Gluggo label by dragging the handles
on the corners and sides of the selection region.
Crop so the dark edge at the top is outside the
selection region. Close the window.

4. Turn on Apply, if it isn’t on already.

The dark edge no longer appears on the label in
the viewport. Adjust the length and width of
the modifier so that the map fits the label better.

Add a sticker on the label:

• Assume a scenario in which the Gluggo brand
has been purchased by Gulpco. It’s your job to
redo the image with the new Gluggo-Gulpco
label. In the following procedures, you’ll put a
Gulpco sticker onto the label to add the new
company name. As you do this, you’ll learn
about multiple channels and UVW coordinates.
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Set up the mapping modifier:

1. Press H and select label01, if it’s not already
selected.

2. Right-click in the active viewport and choose
Hide Unselected.

Everything disappears except for the label.

3. In the Front viewport, zoom in on the label.

4. Go to the Modify Panel and check the modifier
stack.

The label already has a UVW Mapping modifier
applied to it.

5. Right-click the UVW Mapping modifier and
choose Rename.

6. Rename the UVW Mapping modifier to
Gluggo label.

7. Scroll down to the Channel group and change
the map channel to 3.

The label changes orientation in the viewport.

Set up the label material:

1. In the Material Editor, click the label material if
it’s not already active.

2. Click the map button next to the Diffuse color
swatch to open the Bitmap map rollouts, if
necessary.

3. In the Coordinates rollout, change the Map
Channel for the label map to 3.

Now the label map will use the mapping from
the Gluggo label modifier, because they both
use the same map channel.

Select faces:

Here, you’ll select the faces where the Gulpco
sticker will go.

1. In the Front viewport, change the display to
Edged Faces (press F4).

2. In the modifier stack, click Editable Mesh.

3. Turn on Polygon selection.

4. Select the three rows of faces in the middle of
the label.

The label middle faces selected

5. Scroll down to the Surface Properties rollout >
Material group and change Set ID to 2 for these
faces.

6. Exit the Polygon sub-object level.

This is an important step. If you don’t turn off
Polygon selection, what follows will not work
as expected.

7. With the Editable Mesh still selected, add a
second UVW Map modifier.

The new UVW Mapping modifier is inserted
in the stack between the Gluggo label modifier
and the Editable Mesh . It will supply the
mapping coordinates for the Gulpco sticker.

8. Right-click the new UVW Mapping modifier
and rename it Sticker.

9. Scroll down to the Channel group and set Map
Channel to 2.
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Convert to a multi/sub-object material:

You’ll use the original label as a base for the new
label.

1. On the Material Editor toolbar, click Go
To Parent.

2. Choose the material label and click the
Standard button.

3. In the Material/Map browser, make sure the
Browse From group is set to New.

4. Double-click the Multi/Sub-Object entry. In
the Replace Material dialog, make sure Keep
Old Material As Sub-material is chosen, and
then click OK.

5. In the Multi/Sub-Object Basic Parameters
rollout, click Set Number. Change Number Of
Materials to 2 and click OK.

6. In the Name field next to the label material,
type Gluggo.

7. In the Name field next to the second material,
type Gulpco.

Add a map to the second sub-material:

1. Click the second material.

2. Click the map button to the right of the Diffuse
color swatch.

3. On the Material/Map Browser dialog, make
sure Browse From is set to New, and then
double-click the Bitmap list entry. The Select
Bitmap Image File dialog opens.

4. Navigate to the tutorials\intro_to_materials
directory and choose gulpco.jpg.

5. On the Coordinates rollout, set the Map
Channel to 2.

6. Click Show Map In Viewport. The second
map appears in the viewport, layered on top
of the first.

7. Adjust the Offset and Tiling settings for the
Gulpco map until it’s centered on the bottle.

8. Repeat the process for the Gluggo material so
that the map is centered behind the Gulpco
label.

9. Save your work again as mymaterials3.max.

Creating Multi/Sub-Object
Materials

When you want to apply two or more materials
to an object, you use a Multi/Sub-object material.
This is a material type can contain up to 1,000
different materials, each identified by a unique
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number called a material ID. By assigning different
material IDs to discrete selections of faces, you
control where each material will appear when the
parent Multi/Sub-Object material is applied to the
object.

• The files for this lesson can be found in the
tutorials/intro_to_materials folder.

In this exercise, you’ll create the material
automatically by dragging and dropping onto
sub-object selections.

Create Multi/Sub-object materials using drag and
drop:

1. Open intro_materials4.max.

Note: If you see the File Load: Units Mismatch
dialog, choose the option Rescale The File
Objects To The System Unit Scale.

2. Right-click the Camera viewport label
and change the viewport display mode to
Wireframe.

The viewport now displays all the geometry in
wireframe.

3. On the menu bar, choose Views > Shade
Selected.

4. Select the bottle in the viewport.

The bottle alone is shaded. At the top of the
Modify panel, the object name bottle with label

is displayed in boldface to indicate that this is a
group.

5. On the menu bar, choose Group > Open.

The grouping is temporarily suspended so
you can manipulate the members of the group
individually.

6. Press H and select the label01 by name from
the selection list.

The label becomes shaded.

7. Right-click in the viewport and choose Hide
Selection.

The label is hidden from view. Now you can
work just with the bottle.

8. Select the bottle again.

The name of the object is bottlewithcork.

3dsmax.chm::/file_load_units_mismatch_dialog.html
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Assign material IDs:

In order to assign material ID numbers to different
parts of an object you must first make a sub-object
selection of faces or polygons. Since the bottle
is already an Editable Poly object, sub-object
selection tools are available in the Modify panel.

1. On the Modify panel, access the Polygon
sub-object level by clicking the Polygon
selection icon.

2. Right-click the Camera viewport label, and
turn on Edged Faces (or press F4).

3. In the Camera viewport, select the polygons
used for the cork by dragging a region around
the top of the cork and down to (but not
including) the top of the glass.

The selected polygons turn red in the viewport.

If the selected polygons don’t turn red,
right-click the Camera viewport label
and choose Configure. In the Viewport
Configuration dialog > Rendering Method tab
> Rendering Options group, turn on Shade
Selected Faces.

4. In the Material Editor, click an unused material
and name it cork.

5. From the Material Editor, drag cork to the cork
on the bottle.

6. On the menu bar, choose Edit > Select Invert.

Everything except the cork is now selected for
the glass.

7. Drag the green bottle material from the
Material editor to the selection set of faces.

The bottle turns bright green.

8. Turn off Polygon selection.

Add the new material to the Material Editor:

3ds Max has automatically created a new
Multi/Sub-Object material in the scene. However,
if you want to work on the material, you will need
to load it into the Material Editor.

1. In the Material Editor, click an unused sample
slot.

2. Click Pick Material From Object.

3. Click the cork with the eyedropper cursor.

The multi/sub-object material is transferred
to the Material Editor. Both materials are
displayed on the same sphere.
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4. Name this material mybottle.

5. On the Multi/Sub-Object Material Parameter
rollout, click the material cork.

The Material Editor moves to the level of that
material and displays its parameters. The
sample sphere displays only the single material
now.

6. Expand the Maps rollout and click the None
label next to the Bump map component.

7. Change Browse From to New, if it isn’t already
set.

8. On the Materials/Map Browser, pick Dent.

9. Name the bump component of this material
bumpy dents.

10.On the Dent Parameters rollout, set Size to 22
and Strength to 5.

11.Set Color #1 to a pale brown and Color #2 to a
medium brown.

12. Click the Go To Parent button.

13.Drag the bumpy dents map from the Bump
component to the Diffuse Color component
and choose Copy.

14.Click the new Dent map to go to the Dent
Parameters level of the Diffuse Color and name
this map cork dents.

15.Set one of the viewports to Front and zoom in
on the cork.

16.Render to see what the dents look like on the
cork.

17.If you like, change the colors in the cork dents
map in the Diffuse component and render
again.

18.Save your file as mybottlematerials.max.

Using Raytrace Materials and
Maps

Raytrace materials are perfect for reflective
materials like shiny metal and glass.

• The files for this lesson can be found in the
tutorials/intro_to_materials folder.

Set up the lesson:

1. Continue from the previous exercise or load
bottlematerials.max.
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2. Change the Camera viewport back to Smooth
+ Highlights.

3. Turn off Views > Shade Selected, if it’s currently
turned on.

Make green glass using a raytrace material:

1. Open the Material Editor and access the green
bottle material within the multi/sub-object
material.

2. Change the material type from Standard to
Raytrace.

The bottle changes to a gray color in the
viewport.

3. In the Material Editor, make the Diffuse color a
rich forest green.

The bottle changes to a green color in the
viewport.

4. Click the Transparency color swatch. Change
the color to light gray by setting Value to 119.

5. Set the Reflect color swatch to a darker gray:
Value=100. Close the Color Selector dialog.

6. Drag the wood countertop material to the
counter (base) object.

7. Render the Camera01 viewport.

The bottle shows the reflections of adjacent
objects.

Raytrace reflections in the scene:

There are several ways to make objects appear
reflective. You choose a method of creating
reflection based on the main source of an object’s
color and the quality you want to achieve. For
objects that derive their color primarily by
reflection, such as polished metal or glass, you will
probably want to use a raytrace material. If an
object has a strong local color or texture as part of
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its material, you might add a reflection map to the
Reflection map component instead.

1. Press H and choose [knife]. The knife and its
handle are grouped together.

2. Choose Group > Open.

3. Select the knife blade in the viewport.

4. From the Material Editor, drag the knife blade
material to the knife blade (Line02).

This is another Raytrace material. It’s a lot like
the Raytrace green glass material except that it’s
not transparent.

5. Drag the knife handle material to the knife
handle.

6. Click the wood countertop material. On the
Maps rollout, click the None button of the
Reflection map component.

7. In the Material\Map Browser, double-click the
Raytrace map type. In this case you’re adding a
raytrace only to the Reflection component.

8. Name the Reflection component counter
reflection.

9. Click Go to Parent. On the Maps rollout,
set the Reflection amount to 44 and the
Diffuse Color amount to 90. This will keep the
reflection from overpowering the wood texture.

10.Render the Camera01 viewport, and examine
the reflections in the knife blade and
countertop.

11.Save your file as mymaterials4.max.

Texturing the Chessboard

In Modeling a Chess Set (page 1–21), you learned
how to create the pieces for a chess set. Chess
pieces want to live on a chessboard. In this
tutorial, you’ll construct a chessboard that has a
wood-grained, checkerboard pattern. You’ll also
add shininess and reflection to the chessboard.

• The files for this lesson can be found in the
tutorials/intro_to_materials folder.

Set up the lesson:

• Load the file tut_knight.max.

Create the chessboard:

1. On the Create panel, click the
Geometry button. Make sure Standard
Primitives is chosen in the drop-down list.
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2. Click the Box button.

3. If 2D Snap is on, turn it off.

4. In the Top viewport, drag to set the initial
length and width of the box, then release the
mouse and drag downward to set an initial
height. Click to finish.

Don’t worry about the initial dimensions: you
will change them soon.

5. Rename the box chessboard.

6. In the box’s Parameters rollout, set the Length
and Width to both equal 32cm, and set Height
equal to –1cm.

Tip: Because the board is bigger than the chess
pieces, you might need to zoom viewports and
move either object before you can comfortably
see both of them together.

7. Use the Move tool to position the box at the
world origin: 0,0,0.

Create the squares:

1. Activate the Perspective viewport and
click the Zoom Extents button.

2. Click the Field Of View button and zoom
in so the chessboard fills the viewport.

3. On the toolbar, open the Material Editor
by clicking the Material Editor button or use
the M keyboard shortcut.

4. Click the first sample sphere and click the map
button just to the right of the Diffuse color
swatch.

The Material/Map Browser appears.

5. In the Material/Map Browser, double-click
Checker.

3ds Max has a built-in checker pattern, which
makes your work easier. The active sample slot
now shows a sphere with the checker pattern.

6. In the Material Editor, click Assign
Material To Selection, and then click Show Map
In Viewport.

This lets you see the map in shaded viewports.
(The viewport display of maps is only an
approximate.)

The default checker pattern is two by two,
but a chessboard needs eight squares in each
direction.

Note: If the checker pattern looks slightly
skewed, right-click the Perspective viewport
label and turn on Texture Correction.

7. On the Coordinates rollout, set both the U and
V Tiling values to 4.0.

Now the board has the right number of squares.
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If you render the Perspective viewport, you see
that the checker pattern is more refined than
the shaded viewport shows.

Note: Because the chessboard is made out of
a box, the checker pattern is also applied to
the sides. Since the chessboard is so thin, the
pattern on the sides isn’t obvious.

Give the checker pattern a wood texture:

1. Open the Utilities panel and click Asset
Browser.

The Asset Browser appears. Click OK to the
copyright advisory it displays.

2. The Asset Browser is a large dialog. Move and
resize it so you can see both it and the Material
Editor.

3. Use the navigation tree at the left of
the Asset Browser window to locate the
tutorials/intro_to_materials folder.

4. In the Material Editor, make sure the Checker
map’s Checker Parameters rollout is visible.

5. In the Asset Browser, locate the file Oak1.tga.
Drag the Oak1.tga thumbnail to the Color #1
map button on the Checker Parameters rollout.
Then drag the Walnut3.tga thumbnail to the
Color #2 map button.

6. Close the Asset Browser.

Now if you render the chessboard, it has a
contrasting wood pattern.

7. Save the scene as mychessboard.max.

Add polish to the chessboard:

1. In the Material Editor, click the Go To
Parent button.

2. Open the Maps rollout.

3. Click the map button for the Reflection map
component.

The Material/Map Browser opens.

4. Double-click the Flat Mirror map.

5. Render the scene.

The pieces are reflected in the chessboard, but
the wood grain is washed out.

6. Click the Go To Parent button and, on the
Maps rollout, change the Reflection Amount
to 30.

The wood grain is not as washed out as before
but still looks faded.
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7. On the Maps rollout, click the Checker map in
the Diffuse Color component.

8. In the Checker Parameters rollout, click the
Color #1 map and open the Output rollout.

9. Set the Output Amount to 1.5.

10. Click the Go Forward To Sibling button
and make the same change to the Output
Amount of the Color #2 map.

11. Render the scene.

The wood grain looks much warmer and more
realistic.

12. Save the scene as mychessboard01.max.

Using Displacement Mapping with
Surface Properties

In this lesson, you make a moon with a detailed
surface using displacement mapping combined
with Surface properties.

• Bitmaps for this lesson can be found in the
tutorials/intro_to_materials folder.

Create a moon:

1. Reset 3ds Max.

2. In the Perspective viewport, create a sphere that
fills the viewport.

3. On the Create panel, set the Radius to 100.
Name the sphere Earth’s Moon.

4. Click Zoom Extents All to zoom out in all
four viewports.

Set up lights and cameras:

1. On the Create panel, open the Camera
sub-panel and click Target.

2. In the Perspective viewport, create a target
camera by dragging anywhere in the scene.

3. Press CTRL+C to match the camera to the
Perspective viewport. Then press C to change
the viewport to the camera view.
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4. Click Zoom Extents All. In the Top
viewport, you see the camera is facing the
moon at about a 45 degree angle.

Note: Your sphere might be a different color
than the one shown here.

5. On the Create panel, open the Lights
sub-panel and click Omni.

6. In the Top viewport, create an omni light by
clicking at the bottom of the viewport. Name
this light main light.

7. On the Modify panel, turn on Shadows and set
Multiplier to 1.2.

8. In the Top viewport, create another omni light
by clicking near the top left of the viewport.
Name this light fill light.

9. On the Modify panel, turn on Shadows and set
Multiplier to 1.5. Then change the color of the
fill light to orange. This adds some warmth to
the image.

10.Right-click in the Camera viewport to activate
it. Then press F9 to render the scene.

In the rendered image, the highlights on the
moon appear very bright, and the edges of
the moon need more detail. You will fix both
problems using mapping.

Map the moon:

1. Press M to open the Material Editor.

2. Click a material sample slot. Name the material
Earth’s Moon.

3. Choose the Oren-Nayar-Blinn shader from the
drop-down list on the Shader Basic Parameters



146 Chapter 3: Getting Started

rollout. The highlights of the material darken,
giving the sample sphere a softer look.

Comparing the Blinn (l) and Oren-Nayar-Blinn (r) shaders

4. Click the Diffuse map button; it’s the blank gray
button to the right of the Diffuse color swatch.
In the Material/Map Browser, choose Bitmap
and click OK.

5. Use the Select Bitmap Image File dialog to open
moon.jpg. The moon map appears on the
sample sphere.

6. Click Show Map In Viewport, and then
drag the material onto the sphere.

7. Press F9 to do a test render.

8. In the Material Editor, click Go To Parent.

9. Drag from the Diffuse map button to the
Diffuse Level map button, in the Advanced
Diffuse group. Choose Instance and click OK.

10.Press F9 to see the result.

The dark areas of the map look even darker.

Displace the surface with a map:

Displacement mapping uses an image or algorithm
to alter the geometry of an object. Unlike bump
mapping, it actually changes the mesh, so you
can see the texture on the edges of an object.
Ordinarily this isn’t visible until you render,
although you can see it in the viewports with
the Disp Approx modifier. This modifier is not
covered in this tutorial.

1. Open the Maps rollout. Pull down the bottom
edge of the Material Editor so that you can see
the entire rollout, if necessary.

2. Drag the moon.jpg map from the Diffuse Level
map component to the Displacement map
component. Choose Copy and click OK.

The button next to Displacement is now labeled
"Map#2 (Moon.jpg)."

3. Set Displacement amount to -20.

4. Select the sphere. Right-click the sphere and
choose Convert To Editable Poly.

5. On the Modify panel, scroll down to the
Subdivision Displacement rollout and open it.

6. In the Subdivision Displacement rollout, turn
on Subdivision Displacement and click Low.
This prevents the surface mesh from becoming
too complex.
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7. Press F9 to render. The surface of the moon
appears bumpy.

8. On Material Editor > Maps rollout, increase the
Displacement amount to –50.

9. Press F9 to render. The surface of the moon
appears even bumpier.

Displacing the surface of the moon

Control the areas of displacement:

This procedure shows you how to control the
surface displacement so that it accentuates the
areas of moderate displacement.

1. On the Maps rollout of the Material Editor,
click the Displacement map button labeled
"Map#2 (moon.jpg)."

2. On the Bitmap Parameters rollout, click View
Image. The close grayscale values that you
see in the map limit the amount of surface
variation.

3. Close the viewer window and scroll down to
the Output rollout.

4. Open the Output rollout and turn on Enable
Color Map. Scroll to the bottom so you can see
both the graph and the gradient bar.

5. Drag the point on the right downward so the
line is horizontal.

The gradient bar and the sample slot turn black.

6. Click Add Point. Then click to add two
points to the curve at about one-third intervals
along its length.

7. Click Move. Select the two points that you
just created and move them upward to form a
trapezoidal graph.
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8. Press F9. The bumpiness increases across the
middle values of the map.

The moon with mountains

9. Click Go to Parent. Change the
Displacement to 20 and press F9. You now have
a moon with craters.

Craters on the moon

10.Save your file as mymoon.max.

Adding Stars to the Sky

Vincent van Gogh is not the only one who gets
to have fun painting the night sky. In this lesson
you’ll create your own starry night using a Noise
map in the environment background.

• The files for this lesson can be found in the
tutorials/intro_to_materials folder.

Apply a Noise material:

1. Open moon.max.

2. Press 8 on the keyboard to open the
Environment dialog.

3. Click the Environment Map button.

4. In the Material/Map Browser, choose Noise
and then OK. The Noise map appears in the
Environment map component.

5. Open the Material Editor.

6. Drag the Noise map from the Environment
dialog to an unused sample sphere. Choose
Instance and click OK.

The sample sphere disappears and is replaced
with the Noise map. The map is displayed as a
square, since this is a map, not a material.
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7. Scroll down to the Noise Parameters rollout
and set the Noise Size to 0.2.

8. In the Noise Threshold settings, set the low
threshold to 0.6 and the high threshold to 0.7.
This narrows the range between white and black
so the noise will display as dots or pinpoints.

9. Activate the Camera viewport and press F9
render the scene. Hundreds of stars appear in
the sky.

Stars created with Noise material

10.Reduce the number of stars by increasing the
low threshold to 0.65. Then tone down the
brightness of the stars by changing the white
Noise color to pale gray.

11.Render the scene again. The stars fade into the
background.

After adjusting the Noise material

Create a nebula field:

To add drama, create a nebula field by mapping the
black areas of the Noise material with a Gradient
Ramp.

1. On the Noise Parameters rollout, click the
Color #1 map button.

2. Choose Gradient Ramp from the Material Map
Browser and then OK.

3. The Material Editor moves down a level in the
material tree. The sample sphere is replaced
by a grayscale gradient. Scroll to the Gradient
Ramp Parameters rollout. The Gradient ramp
has three flags: one on the right, one in the
middle, and one on the left.

4. Double-click the flag on the right to display the
color selector. Change the color to black.

5. Without closing the color selector, click the
middle flag and change it to blue. Then close
the color selector.

6. In the Noise group, set Amount to 1.0. Choose
the Fractal option and set Size to 9.0.
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7. Render the scene. A diffuse blue nebula appears
in the sky.

Add a streak to the nebula field:

1. Click twice near the center of the gradient, on
either side of the middle flag. Two more flags
appear. (If you make too many flags, right-click
a flag and choose Delete.)

2. Double-click the middle flag and change its
color to a lighter blue.

3. Set the Noise Levels parameter to 6 to add more
details to the streak.

4. Render the scene.

Nebula background with a streak

5. Experiment with the gradient color, type and
noise parameters until you master the effect.

6. Save your work as mymoonandstars.max.

Create a starry sky with a large sphere:

Another way to make stars is to create a large
sphere, invert its normals, and then apply a
starfield bitmap to it.

1. Using the keyboard entry method, create a
very large sphere with a radius of about 1200.
(If you’re not familiar with this method, open
the Create panel and click Sphere. Open the
Keyboard Entry rollout and set Radius to 1200.
Then click Create.)

2. Name the sphere skydome.

3. Open the Modifier panel. From the Modifier
drop-down list, choose Object Space Modifiers
> Normal.

4. In the Parameters rollout, turn on Flip Normals,
if it is not already on.

5. Open the Material Editor and click an unused
sample slot. Name the material starry sky.
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6. Click the Diffuse map button. In the
Material/Map Browser, choose Bitmap and
click OK.

7. In the Select Bitmap Image File dialog, choose
stars10.jpg and click OK. This is a large and
detailed map, so it may take a moment to load.

Note: You’ll find this bitmap in the
tutorials/space folder.

8. Turn on Show Map In Viewport.

9. Click Go to Parent. On the Blinn Basic
Parameters rollout, set Self-Illumination to 100.

10.Drag the material onto the skydome object
and press F9 to render the scene. The stars
from the map appear in the sky, replacing the
environment background map.

Brighten the stars:

1. Open the Maps rollout and click the Diffuse
Color map.

2. Open the Output rollout and set RGB Level
to 2.0. To filter out the dimmer stars, set the
Output Amount to 1.2.

3. Press F9 to render the scene.

Save your work:

• Save your work as mymoonandstars2.max.

Creating a Skin Material

Human skin is difficult to simulate in computer
graphics because it reflects light from a short
distance beneath the surface, rather than directly
at the surface. In this lesson, you’ll learn how to
use the Shellac material to create a material that
closely resembles skin.

The files for this lesson can be found in the
tutorials/intro_to_materials folder.

Set up the lesson:

• Open the scene file skin_material_start.max.

Create the skin material:

1. Open the Material Editor, and then click
the third sample slot on the top row.

This material is already applied to the head.

2. Click the Standard button, just above the
rollouts, and then in the Material/Map Browser,
double-click Shellac.
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Shellac is a special material that superimposes
one material over another so that you can see
through the upper material to the lower one.
This capability is well suited to simulating
human skin.

3. On the Replace Material dialog that displays,
click OK to keep the old material as a
sub-material.

4. Name the material Skin.

Choose a map for the base skin material:

1. On the Shellac Basic Parameters rollout, click
the Base Material button.

2. Click the Show Map In Viewport button
to turn it on.

3. On the Blinn Basic Parameters rollout, click
the map button to the right of the Diffuse color
swatch.

4. In the Material/Map Browser, double-click
Bitmap.

5. In the file selector dialog, choose the file
skin_tile.jpg.

6. Click Open.

Adjust the shading for the base skin material:

1. Click Go To Parent, and change the
Material’s shading type to Oren-Nayar-Blinn.

2. In the Oren-Nayar-Blinn Basic Parameters
rollout > Specular Highlights group, set
Specular Level to 27 and the Glossiness to 11.

Apply bump mapping for the skin texture:

1. Expand the Maps rollout, and then drag the
Diffuse Color map button (labeled with the
map number and the file name skin_tile.jpg) to
the Bump map button.
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On the Copy (Instance) Map dialog, choose
Copy (if necessary), and then click OK.

2. Click the Bump map button to open the
parameters for the copied bitmap.

Set the tiling for bump mapping:

At the default tiling setting, the bump map is a
bit coarse; increasing the Tiling values gives the
bumpiness a finer grain.

• In the Coordinates rollout, enter 4.0 for both
U and V Tiling values.

Adjust the amount of bump mapping:

1. Expand the Output rollout, and set the Bump
Amount to 1.86.

2. Click Go to Parent.

3. In the Maps rollout, change the Bump Amount
setting to 70.

Set up the Shellac material:

1. Click Go To Parent again, and in the
Shellac Basic Parameters rollout, click the
Shellac Material button.

2. Change the shading type to Anisotropic.

3. Click the map button to the right of the Diffuse
color swatch.

4. In the Material/Map Browser, double-click
Bitmap.

5. Use the Select Bitmap Image File dialog to open
the file skin_tile.jpg.

Set the tiling for the Shellac material map:

• On the Coordinates rollout, enter 4.0 for both
U and V Tiling values.

Adjust the specular highlights for the Shellac
material:

1. Click Go To Parent, and then click the
Specular color swatch.
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2. In the Color Selector, change the color to a light
skin tone: Red: 250, Green: 224, Blue: 195, and
click Close.

3. In the Specular Highlight group, set Specular
Level to 131, Glossiness to 34, and Anisotropy
to 40.

4. Click Go To Parent, and set Shellac Color
Blend to 24.

This gives the Shellac Material component a
small but significant role in the look of the
composite material.

5. Save the scene as skin_material.max

6. Render the Camera01 viewport to see the result.

You’ve created a realistic-looking skin material.
Try changing the parameters and components and
re-rendering to see how they affect the material. In
particular, try changing the Shellac Color Blend
setting to blend different amounts of the Shellac
Material component into the overall material.

Summary

3ds Max offers a wealth of options for applying
textures to objects. You use the Material Editor for
creating and modifying materials, applying maps,
and even adjusting mapping. Once a material is
ready, you can apply it to an object by dragging and
dropping it from the Material Editor to the object
in the viewport. The Material Editor provides a
number of different shaders for achieving such
effects as metal and translucency. The UVW Map
modifier lets you determine how materials and
maps wrap around an object. One of the most
useful material types is Multi/Sub-Object, which
lets you easily combine different materials on a
single object. Another way is to use a map such
as Checker, which gives you the option to apply
two different maps in place of the black and white
checks. You can add modeling detail to your
objects with displacement mapping. The Shellac
material is useful for simulating human skin, as
well as other materials.

This tutorial provided a starting point for learning
about materials, but the ultimate possibilities



Materials for Interior Scenes 155

with 3ds Max materials are limited only by your
imagination. The time you spend practicing and
experimenting with the procedures you learned
here will be rewarded by a greater proficiency with
the available tools, and the ability to get the effects
you seek with ease and speed.

Materials for Interior Scenes
One of the most useful 3ds Max features for
architectural models is its ability to fashion
complex and subtle materials. The 3ds Max
Material Editor provides you with ultimate control
over the materials you create.

This tutorial focuses on material techniques that
lend themselves to interior scenes. Outdoor scenes
can use similar materials.

Skill Level: Beginner to Intermediate

Time to complete: 45 minutes

Features Covered in This Tutorial

After completing this tutorial, you should be able
to:

• Use the Material Editor to create and assign
materials.

• Create a simple “one-color” material.

• Use a map in a material.

• Create a multi/sub-object material for assigning
multiple materials to a single object.

• Create a Blend material that includes a
procedural map.

• Create and apply an Architectural material.

• Use the Asset Browser to find textures.

• Use the UVW Map modifier.

Files for This Tutorial

All the necessary files to do the tutorials can be
found on the Tutorial Files CD that ships with
3ds Max 8. Before doing the tutorials, copy the
\tutorials directory from the CD to your \3dsmax8
local installation.

Materials of One Color: Applying
Standard Materials

In this lesson, you create simple, “one-color”
materials and apply them to objects in the scene.
Specifically, you create the materials for a pair of
chairs and an end table.

Material Components: Colors and Other
Controls

In general, we think of simple standard materials
(with no maps) as being of “one color”. In
fact, an 3ds Max material consists of a number
of component controls, and among these are a
number of color components. The default Blinn
shader, for example, uses three color components:
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ambient, diffuse, and specular. Ambient is the
color of the material in shadow, and specular is the
color of highlights if the material is shiny. Diffuse,
the color of the material under diffuse light, is what
we usually think of as “the” color of a material.
In the lessons of this tutorial, you work with the
diffuse color component exclusively.

Materials have other non-color components, such
as highlight and opacity controls. In these lessons,
you adjust some highlights and map amounts,
but don’t otherwise work with numeric material
components.

Set up the scene:

• On the menu bar, choose File > Open. Locate
chairs.max in the \tutorials\designviz folder,
and click Open.

If you see the File Load: Units Mismatch dialog,
choose the option Adopt The File’s Unit Scale.
This will change your system unit, so be sure
to reset your system unit after completing this
tutorial.

To reset your system unit, go to the Customize
menu and choose Units Setup > System Unit
Setup > System Unit Scale > Inches.

If the geometry is not visible in the
viewport, click the Zoom Extents All button
twice to correct the display.

This scene contains only the chairs and the end
table. At present, they are simply a dull gray.

You will make the seats and the table top a glossy
black leather, and the wood a flat brown.

Create a black leather material:

1. On the toolbar, click Material Editor.

The Material Editor is displayed. This is a large
dialog for designing and applying materials.
At the top of the dialog are sample slots that
display material previews.

Sample slots show previews of materials on small
sample objects such as spheres.

Below and to the right of the sample slots are
various buttons and other controls. Below these
tools are rollouts that are specific to a particular
material type.

2. Make sure the first sample slot is active. If
active, it has a heavy white border.

3. In the Material Editor, go to the Blinn Basic
Parameters rollout.

4. Click the gray color swatch labeled Diffuse.

A Color Selector appears.
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5. In the Color Selector, change the diffuse color
to black. The easiest way to do this is to drag
the Whiteness slider all the way to the top. The
RGB and HSV fields should both show 0,0,0.

6. In the Color Selector, click Close.

By default, the diffuse component is locked to
the ambient component, so both the Diffuse
and Ambient color swatches now appear black.

The material is very dark, as you can see in its
sample slot. To look like leather, it needs to be
shiny, too. To do this, you increase the intensity
and size of the highlight.

7. In the Blinn Basic Parameters rollout > Specular
Highlights group, set the Specular Level to 79.

As the highlight graph shows, there is now a
large highlight. Increasing the value of Specular
Level increases the height of the highlight curve.

The effect is also apparent in the sample slot.

8. In the Specular Highlights group, set the
Glossiness to 54.

The highlight graph shows that the highlight
curve has become much narrower.

Increasing the value of Glossiness narrows the
highlight curve. In general, small but intense
highlights give the effect of shiny materials, as
you can see in the sample slot.

This is the effect intended for the leather
upholstery, so give this material a name.

9. In the material name field, below the sample
slots, highlight the default name of 1 Default
(the number can vary), and enter Black
Leather.

Apply the black leather material to the upholstered
parts of the chairs:

1. In a viewport, click to select the
upholstered parts of the chairs and table.
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In the wireframe viewports, these parts are
blue.

The name Leather Parts should
appear in the Name And Color rollout on the
Create panel. If you go to the Modify panel, it
should also appear in the object name field at
the top of the panel.

2. In the Material Editor, make sure the Black
Leather material’s sample slot is still active, and
then click Assign Material To Selection.

In viewports, the upholstered areas now appear
dark and the Black Leather sample slot has
solid, white triangles at each corner indicating
that the material is applied to the selected
object(s) in the scene.

Create a simple wood material:

For this model, which is a small part of a much
larger scene, the wood can be a simple brown
color. Future exercises will show how to create
more realistic wood textures.

1. In the Material Editor, click the second sample
slot to make it active.

2. In the Blinn Basic Parameters rollout, click the
Diffuse color swatch.

3. In the Color Selector, assign the hue, saturation,
value (HSV) fields these values, respectively:
25, 129, 146.

The red, green, blue (RGB) spinners update to
show 146, 116, 72.

4. Close the Color Selector.

The Diffuse and Ambient color swatches now
show a medium brown.

5. In the Specular Highlights group, set the
Specular Level to 15. Leave the Glossiness at
the default value of 10.

Broad, shallow highlights give a material a
matte appearance, as intended for the wood
parts.

6. In the material name field, enter Wood 1.

Apply the wood material to the wooden parts of the
chairs, and the table:

1. In a viewport, click to select the leg of a
chair or table.

In the wireframe viewports, this is the orange
part of the model.

If you go to the Modify panel, the name
Wood Parts should appear in the object name
field at the top of the panel.

2. In the Material Editor, make sure the
Wood 1 material’s sample slot is still active, and
then click Assign Material To Selection.

In viewports, the wooden areas now appear
brown.

Render the scene to see more of the effect:

1. Right-click the Perspective viewport to make
sure it’s active.

2. On the toolbar, click Quick Render.

The materials appear in the rendering. They
are simple, but adequate as details of an
architectural scene.
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One problem with this rendering is that certain
faces don’t appear; specifically, the front of the
end table and one side of the chair on the right.
One way to fix this would be to go into the scene
and flip the face normals of the nonrendering
geometry, but there is a fix available in the
Material Editor itself.

3. For the Wood 1 material, go to the Shader Basic
Parameter rollout and turn on 2-Sided. Then
click the Black Leather sample slot to activate
it, and turn on 2-Sided for the leather material
as well.

Turning on 2-sided is one way to make sure all
of an object’s geometry renders in a scene. Be
aware that this can increase rendering time,
especially in complex scenes.

4. Click Quick Render again.

This time, all of the furniture geometry renders.

Save your work:

• Save the scene as chairs_with_materials.max.

Adding Complexity: Applying
Mapped Materials

You can create more complex materials quite
easily, by assigning a map to the diffuse color. A
map applied to the diffuse color component is

often described as a texture map. For example, the
bookshelves used in the library model have two
textures: wood grain for the shelves, and books
for the shelves’ contents.

In this lesson, you create the mapped materials
and apply them to a bookshelf model.

Set up the scene:

• On the menu bar, choose File > Open. Locate
bookshelf.max in the \tutorials\designviz
folder, and click Open.

If you see the File Load: Units Mismatch dialog,
choose the option Adopt The File’s Unit Scale.
This will change your system unit, so be sure
to reset your system unit after completing this
tutorial.

To reset your system unit, go to the Customize
menu and choose Units Setup > System Unit
Setup > System Unit Scale > Inches.

If the geometry is not visible in the
viewport, click the Zoom Extents All button
twice to correct the display.

This scene contains the bookshelf model, but
with no textures applied.

Setting Texture Coordinates Preferences:

1. From the Customize menu, choose Preferences.
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2. In the General tab, under the Texture
Coordinates group, make sure the Use
Real-World Texture Coordinates option is
turned off.

3. Click OK to exit the Preferences dialog.

Create the wood material:

1. On the toolbar, click Material Editor.

2. In the Material Editor, click the first sample slot
to make it active (if it isn’t already).

3. On the Blinn Basic Parameters rollout, click the
blank map button to the right of the Diffuse
color swatch.

The Material/Map Browser dialog is displayed.

The map button is the gray square to the right of the
diffuse color swatch.

If a map has been assigned, it shows the letter ‘M.’

4. In the Material/Map Browser, locate Bitmap in
the list, and double-click it.

A Select Bitmap Image File dialog appears.
Most of the controls in this dialog are standard
Windows file controls.

5. In the same directory as the bookshelf.max file,
choose the bitmap file named wood02.jpg, and
then click Open.

In the Material Editor, the sample slot updates
to show that the diffuse color of the material
is now an image of the map file you chose.
Also, the rollouts area of the dialog now shows
controls for the map, rather than the parent
material.
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Mapped wood material in sample slot

6. Click the Go To Parent button to get back
to the top level of your new material.

7. In the material name field, enter Wood 2.

By default, the material name is a generic name,
01 – Default. Giving your materials more
descriptive names will help you manage them
more efficiently in the future.

Apply the wood to the bookshelves:

1. On the toolbar, click Select By Name. In
the Select By Name dialog that appears, choose
Shelves in the list, and then click Select.

2. In the Material Editor, make sure the
Wood 2 sample slot is still active, and then click
Assign Material To Selection.

The material is now applied to the shelves,
and would appear in a rendering. However, it
doesn’t yet appear in shaded viewports.

Incidentally, when you apply the material, the
sample slot shows solid, angled tabs at the
corners. This is an indication in the Material
Editor that the material in the slot is a material
used in the scene.

Solid corner tabs of a sample slot indicate that the
material is used in the scene.

3. In the Material Editor, click to turn on
Show Map In Viewport.

Now the shaded Perspective viewport shows
that the shelves have a wood grain.

Tip: If you turn on Show Map In Viewport, but
nothing changes in shaded viewports, this is
probably because objects with the material do
not have mapping coordinates. In this case,
you need to apply a UVW Map modifier. This
modifier is used in later lessons of this tutorial.

Create the book material:

1. In the Material Editor, click the second sample
slot to make it active.

2. On the Blinn Basic Parameters rollout, click the
blank map button to the right of the Diffuse
color swatch.

The map button is the gray square to the right of the
diffuse color swatch.
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3. In the Material/Map Browser, locate Bitmap in
the list, and double-click it. The Select Bitmap
Image File is displayed. In the same directory as
the bookshelf.max file, choose the bitmap file
named books1.jpg, and then click Open.

Although it is somewhat hard to see on the
sphere in the sample slot, the texture for this
material is a scanned image of books on a
bookshelf.

4. Click the Go To Parent button to get back
to the top level of the material.

5. In the material name field, enter Books.

Apply the book material to the shelves:

1. On the toolbar, click Select By Name. In
the Select By Name dialog that appears, choose
Books in the list, and then click Select.

2. In the Material Editor, make sure the
Books sample slot is still active, and then click
Assign Material To Selection.

3. In the Material Editor, click to turn on
Show Map In Viewport.

Now the shaded Perspective viewport shows
the shelves with books on them.

With just two image files, you have given the
model a convincing amount of detail, especially

if the model is meant, like the bookshelf, to be a
detail in a larger scene. Texture-mapped materials
are a convenient way to add textures and images
to your scene. (You can also use a map as a scene
background image.)

Save your work:

• Save the scene as bookshelf_with_maps.max.

Applying Multiple Materials to
One Object

The result of this lesson may appear to be similar to
that in Materials of One Color: Applying Standard
Materials (page 1–155). This lesson, however,
shows how to combine the leather and wood parts
of the chairs into a single mesh, while retaining the
material assignments.

Multi/Sub-Object Material

The trick to having multiple materials assigned
to a single object is to use a multi/sub-object
material. A multi/sub-object material is simply a
container for other materials. As its name implies,
it works at the sub-object level, assigning different
sub-materials to different sub-objects of the
model. (A variety of object types have sub-object
levels, especially the surface models: editable
mesh, editable poly, editable patch, and NURBS.)

Assigning sub-materials is a two-part process:

• Assign Face sub-objects a material ID value.

• Match materials contained in the
multi/sub-object material to the ID
values on the faces.

You can do these steps in either order.
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Figure mapped using a multi/sub-object material

Lower right: Different sub-objects have different material
IDs.

Upper right: Multi/sub-object rollout maps the IDs to
different sub-materials.

Set up the scene:

You can use a prepared file, or the file you worked
on before. Do one of the following:

•

• Choose File > Open. Locate
chairs_assigned.max in the
\tutorials\designviz folder, and click
Open.

If you see the File Load: Units Mismatch
dialog, choose the option Adopt The File’s
Unit Scale. This will change your system
unit, so be sure to reset your system unit after
completing this tutorial.

To reset your system unit, go to the
Customize menu and choose Units Setup
> System Unit Setup > System Unit Scale >
Inches.

If the geometry is not visible in the
viewport, click the Zoom Extents All button
twice to correct the display.

• Choose File > Open. Locate the file you
created (chairs_with_materials.max), and
click Open.

The chairs have materials assigned, but
Leather Parts and Wood Parts are still two
separate mesh objects.

Wireframe views show that the leather and wooden
parts of the chairs are two separate meshes.

Plan and assign material ID’s:

When you work with sub-object materials, the first
thing to do is to plan how to map the material ID
numbers. The values on the geometry must match
the values in the material, and vice versa. This is
not a task for the 3D software, but for a design
document, even if it’s only a scrap of paper.

For this model, the wood parts will retain the
default material ID of 1, and the leather parts will
have a new material ID of 2.

1. Select the Leather Parts mesh.

2. Go to the Modify panel. The
modifier stack display is the window below the
object name and the drop-down Modifier List.
This is where you choose a sub-object level.
Click the plus icon next to the name Editable
Mesh to see the mesh’s sub-object levels.
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Top: After clicking the plus icon, the stack shows
sub-object levels.

Bottom: The sub-object levels in the stack display.

3. Faces are the smallest renderable portions of a
mesh. Click Face in the hierarchy.

The stack with the Face sub-object level selected.

4. Choose Edit > Select All.

This selects all the faces in the Leather Parts
object. By default, sub-object selections display
in red.

5. On the Modify panel, go to the Surface
Properties rollout. (This is the last rollout on
the Modify panel.) In the Material group,
increase the Set ID value from 1 to 2.

6. In the modifier stack display, click Editable
Mesh again to return to the top, object level.

Combine the two meshes:

1. In a viewport, select the Wood Parts
mesh.

The wood parts have material ID 1, so it makes
sense to make them the basis of the combined
mesh.

2. Go to the Modify panel. On the Edit
Geometry rollout, click to turn on Attach.
Then, in a viewport, click the Leather Parts
mesh to attach it.

An Attach Options dialog is displayed.
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3. In the Attach Options dialog, choose Do Not
Modify Mat IDs Or Material, and then click
OK.

This option leaves the material IDs on faces
unchanged.

Tip: After attaching the parts of your model,
be sure to turn off the Attach button. If you
don’t do this and want to make other object
selections, you will inadvertently attach objects
you don’t want attached.

4. In the object name field at the top of the Modify
panel, type Chair Group.

Create the multi/sub-object material:

1. On the toolbar, click Material Editor.

2. In the Material Editor, click the third, unused
sample slot to make it active.

3. To the right of the material name field is the
Material Type button. At present, its label says
“Standard.” Click this button.

The Material/Map Browser is displayed.

4. In the Material/Map Browser list, double-click
Multi/Sub-Object.

A Replace Material dialog is displayed.

5. Choose Discard Old Material, and then click
OK.

The Multi/Sub-Object Basic Parameters rollout
is displayed in the Material Editor.

6. By default, the multi/sub-object material
contains 10 sub-materials. The chair group
model needs only two. On the rollout, click
Set Number. In the Set Number Of Materials
dialog that is displayed, reduce the Number Of
Materials value to 2, and then click OK.

7. Drag the sample slot that contains the Black
Leather material to the Multi/Sub-Object Basic
Parameters rollout, and release the mouse
when you are over the button for the second
sub-material. This button is in the column
labeled Sub-Material.

8. In the Instance (Copy) Material dialog that is
displayed, leave Instance chosen, and click OK.

The new sub-material corresponds to Material
ID 2.

Controls in the Multi/Sub-Object Basic Parameters
rollout after dragging the Black Leather material to the
second sub-material’s button.
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9. Drag the sample slot that contains the Wood
1 material to the Multi/Sub-Object Basic
Parameters rollout, and release the mouse
when you are over the button for the first
sub-material. As before, accept Instance and
click OK.

This sub-material corresponds to Material ID 1.

Tip: You can change material ID assignments
in the Material Editor, by editing the values in
the ID column of the Multi/Sub-Object Basic
Parameters rollout. You can also change them
on the geometry side by using the Material
group of the Surface Properties rollout.

Sample sphere for the multi/sub-object material

Assign the material to the mesh:

The multi/sub-object material is now complete.
The last step is to assign it to the model.

1. In a viewport, click to select the Chair
Group model.

2. In the Material Editor, click Assign
Material To Selection.

The appearance of the model is unchanged, but
it now consists of a single editable mesh, so you
can use it with the Substitute modifier.

Save your work:

• Save the scene as chair_group_single_
mesh.max.

Creating 3D Materials: Another
Approach to Wood

In an earlier lesson, you created a wood material
using a bitmap. In this lesson, you create a wood
effect using the built-in Wood material. This is
an example of a 3D material. 3D materials, also
known as procedural materials, are generated by
the software. This lets you adjust their settings
interactively.

Another advantage of 3D materials is the way they
exist in three dimensions. If you slice an object
with 3D Wood applied, you see the interior grain,
as you would if you sawed into a real piece of wood.

3D materials pervade an object. “Cutting” an object with
a 3D wood material (for example, by using a Boolean
operation) reveals interior grain.

Set up the scene:

• On the menu bar, choose File > Open. Locate
kitchen.max in the \tutorials\designviz folder,
and click Open.

If you see the File Load: Units Mismatch dialog,
choose the option Adopt The File’s Unit Scale.
This will change your system unit, so be sure
to reset your system unit after completing this
tutorial.

If you do not adopt the file’s unit scale, the
material you create will be out of proportion
and some of the settings you make will show
poor results.
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This scene is a model of a kitchen. At present, it
has a clean, industrial look.

You will add textures to make some surfaces wood,
giving the kitchen a warmer look. (In the exercises
that follow, you will also create a brick material for
the wall and add a tile material to the floor.)

Creating a wood material:

1. On the toolbar, click Material Editor.

Tip: You can also press the M keyboard shortcut
to open the Material Editor.

2. In the Material Editor, click an unused sample
slot to make it active.

Reminder: Unused sample slots have no angle
brackets in their corners. Used sample slots
have angled corners.

3. In the material name field, enter Wood 3.

4. On the Shader Basic Parameters rollout, change
the shader type from Blinn to Anisotropic.

5. On the Anisotropic Basic Parameters rollout,
click the blank map button to the right of the
Diffuse color swatch.

The map button is the gray square to the right of the
diffuse color swatch.

The Material/Map Browser dialog is displayed.

Note: Anisotropic is a variant of the default
Blinn shader.

6. In the Material/Map Browser, scroll to the
bottom of the list, then double-click the Wood
entry.

A wood-grain material appears in the sample
slot.

Adjusting the colors and settings:

The default colors for this material are darker
than you would probably want to use in a kitchen
design. You will change them to lighter shades of
the same hue.

1. In the Wood Parameters rollout, click the Color
#1 swatch.

2. In the Color Selector, assign the hue, saturation,
value (HSV) fields these values, respectively:
34, 119, 214. (Hue does not change.)

The red, green, blue (RGB) spinners update to
show 214, 194, 114.

3. In the Wood Parameters rollout, click the Color
#2 swatch.
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4. In the Color Selector, assign the hue, saturation,
value (HSV) fields these values, respectively:
25, 121, 169. (Hue does not change.)

The red, green, blue (RGB) spinners update to
show 169, 136, 89.

5. Close the Color Selector.

6. In the Wood Parameters rollout, change Radial
Noise to 2.0, and Axial Noise to 1.2.

This gives the grain a “noisier” or “busier”
appearance.

Applying the material to the scene:

1. On the toolbar, open the Named Selection Sets
drop-down list, and choose Wood Surfaces.

This selection set consists of the portions of the
kitchen that will have wood.

Tip: The Named Selection Sets list is between
the Named Selection Sets button and the Mirror
Selected Objects button.

2. In the Material Editor, click Assign
Material To Selection, and then click to turn on
Show Map In Viewport.

The wood grain appears on objects in the scene.

Rendering to view the wood effect:

Viewport display of 3D materials is usually only a
rough approximation. To see the full effect, you
need to render the scene.

• On the toolbar, click Quick Render.

In the rendering, you can see that the wood
grain is much too large. This wood has come
from a very big tree! To make the material more
realistic, you can adjust the material.

Adjusting the size of the wood grain:

1. Minimize the rendered frame window.

2. In the Material Editor > Wood Parameters
rollout, change the Grain Thickness to 0.7.

With the grain a tenth of its former size, the
preview in the viewport looks very busy.
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As a rule of thumb for scenes of this scale,
if the grain is too “busy” and indistinct in
viewports, it is probably about the right size for
the renderer.

3. Click Quick Render.

The rendered scene looks much more
convincing. However, the grain appears to be
end-on, which isn’t right.

Adjusting the direction of the wood grain:

1. Minimize the rendered frame window.

2. In the Material Editor > Coordinates rollout,
change the X Angle and Y Angle to 90 (degrees).

The Angle values for X, Y, and Z are the third
column of spinners.

3. Click Quick Render.

Changing the grain angle doesn’t have much
effect on the viewport preview, but it greatly
improves the rendered scene.

Saving your work:

• Save the scene as mykitchen_wood.max.

Next, you’ll learn about the Architectural
material.

Using an Architectural Material on
the Wall

The Architectural Material in 3ds Max provides
heightened realism when used with photometric
lights and radiosity, because its settings are based
on physical properties.

The Architectural material lets you choose from
a series of templates of preset parameters for
the material. These templates approximate the
general characteristics of the kind of materials
you’re creating, such as masonry, glass, or painted
surfaces, for example.

Note: The Architectural material is not meant to
be used with standard 3ds Max lights or with the
Light Tracer.

In this lesson, you’ll explore the Architectural
material and its application to a scene. You’ll be
using the material to create a texture for the wall
of the kitchen.
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Set up the scene:

1. Continue from the previous lesson, or
choose File menu > Open and browse
to the \tutorials\designviz folder. Open
kitchen_with_wood.max.

Note: If you see the File Load: Units Mismatch
dialog, choose the option Adopt The File’s Unit
Scale. This will change your system unit, so be
sure to reset your system unit after completing
this tutorial.

2. If the geometry is not visible in the
viewport, click the Zoom Extents All button
twice to correct the display.

The next material you’ll create for this kitchen is a
brick material for the wall.

Setting Texture Coordinates Preferences:

1. From the Customize menu, choose Preferences.

2. In the General tab, under the Texture
Coordinates group, make sure the Use
Real-World Texture Coordinates option is
turned off.

3. Click OK to exit the Preferences dialog.

Creating a brick material for the wall:

1. On the toolbar, click the Material Editor
button.

2. In the Material Editor, click an unused sample
slot to make it active.

3. Click the Standard button to open
the Material/Map Browser and choose
Architectural. Click OK.

4. In the Templates rollout, open the Templates
list and choose some of the different material
presets and watch the Physical Qualities
rollout. You’ll see how the material presets fill
in the physical characteristics for Shininess,
Luminance, and so forth.

5. Choose Masonry before you continue.

6. In the Physical Qualities rollout, click the
Diffuse Map button.

It currently says None.

7. Choose Tiles from the list of map types and
click OK.

8. From the Standard Controls rollout, open the
Preset Type list and choose Running Bond.
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A typical, staggered placement of bricks

9. Open the Advanced Controls rollout and click
the Texture map button in the Tiles Setup
group.

The Material/Map Browser reopens.

10.Choose Noise and click OK.

The Material Editor shows you the Noise
Parameters.

11.In the Noise Parameters rollout, set the Noise
Type to Fractal and the Size to 10.

12.Click the Color #1 swatch and set a deep red
color in the Color Selector. Some good settings
are Red: 112, Green: 5, and Blue: 0.

13.Click the Color #2 swatch and set a lighter red
color in the Color Selector: 180, Green: 106,
and Blue: 106. Close the Color Selector dialog.

14. Click the Go To Parent button.

15.In the Tiles Setup group of the Advanced
Controls rollout, set the Horiz. Count to 6.0,
Vert. Count to 14.0, and Color Variance to 0.63.

16.In the Grout Setup group, click the Texture
swatch to re-open the Color Selector.

17.Set the Value setting to 90, then close the dialog.

Tip: If you know a color needs to be black, white
or any shade of gray in between, the Red, Green
and Blue values must be the same. Adjusting
the Value setting automatically assigns the same
value to Red, Green and Blue.

18.Set the Rough value to 5.0 to give the mortar
joints a little irregularity.

19. Click the Go To Parent button.

This puts you at the top level of your material.
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The primary brick mapping is complete.

To make the material more realistic, you’re now
going to add a bump map.

Adding realism with a bump map:

1. Open the Special Effects rollout and make sure
the size of the Materials Editor dialog lets you
see both the Physical Qualities and Special
Effects rollouts.

2. In the Physical Qualities rollout, click the
Diffuse Map button and drag it down onto the
Bump map button.

The Instance (Copy) Map dialog is displayed.

3. Choose Copy and click OK.

You’re using Copy for this example because you
want to make unique settings for the bump
map. If you chose Instance, any change you
make to the bump map would propagate to the
diffuse map.

4. Click the Bump map button to begin working
on the bump map for the bricks.

5. Click the Noise map on the Tiles Setup group in
the Advanced Controls rollout.

6. In the Noise Parameters rollout, leave the Noise
Type set to Fractal and set the Size to 15.0.

7. Click the Color #1 swatch to open the Color
Selector, and drag the Whiteness slider all that
way to the bottom to give you a solid white.

8. Click the Color #2 swatch and set the Red value
to 126 and Green and Blue values to 0. Close
the Color Selector.

Tip: To quickly set spinner values to zero,
right-click the spinner arrows.

9. Click the Go To Parent button.

10.Click the Texture map button in the Grout
Setup group.

The Material/Map Browser is displayed.

11.Click the Tiles map and click OK.

12.In the Standard Controls rollout, set the Preset
Type to Running Bond.

You want to duplicate most of the Tiles map
settings you used for the Diffuse map. These
settings will ensure that the grout lines for the
Bump map align properly with the Diffuse map.

13.In the Advanced Controls rollout, in the Tiles
Setup group, set the Horiz. Count to 6.0 and
Vert. Count to 14.0.

14.Click the Texture swatch for the Tiles Setup and
set it to black.

Dark colors are embossed when used with a
Bump map.

15.In the Grout Setup group, click the Texture
swatch and set it to white.

Lighter colors, on a Bump map, are recessed.
These will form the depressions along the
mortar joints.

16.Close the Color Selector and enter a Rough
value of 5.0 for the Grout Setup.

17. Click the Go To Parent button twice to get
back to the top level of your material.
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18.In the Special Effects rollout, set the Bump
amount to 50.0, and then rename the material
MyRedBricks.

Now your material is done and ready to apply
to the wall.

Assigning texture coordinates:

1. Activate the Camera01 viewport and select the
wall object named VC Wall.

The wall is selected.

Before you can apply the brick material to the
wall, the wall needs texture coordinates.

Without texture coordinates, the texture map
will not show up and you will receive a Missing

Map Coordinates message when you render
the scene.

2. Open the Modify panel and click the
down arrow of the Modifier List.

3. Scroll down the list and choose MapScaler from
the Object Space Modifiers grouping.

Texture coordinates (UVWs) are assigned to the object
when the modifier is applied.

Applying the bricks to the wall:

1. In the Material Editor, click your brick material
and drag it onto the wall.

2. In the Material Editor, click the Show Map
In Viewport button.
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The scale of the texture is way too small. The
default scale of the MapScaler modifier is 1”.

3. In the Parameters rollout, set the Scale to 2’6”.

The bricks are more proportional now.

Note: If the bricks appear crooked, right-click
the Camera01 viewport label and turn on
Texture Correction if 3ds Max is configured to
use the Software display driver. Next you deal
with the brick size.

4. Save the scene as mykitchen_brick.max.

5. Click Quick Render.

The kitchen of your trendy loft.

Material Combinations: Using
Blend to Create a Floor Material

The Material Editor provides a number of ways
to combine materials. Bitmaps and procedural
(3D) materials will probably serve your needs for
most models, but this lesson is an example of the
versatility of the Material Editor.

In this lesson, you create a complex Blend material
for the tile floor in the kitchen.

Set up the scene:

• Continue from the previous lesson, or open
the file, kitchen_with_brick.max located in the
\tutorials\designviz folder.

Note: If you see the File Load: Units Mismatch
dialog, choose the option Adopt The File’s Unit
Scale. This will change your system unit, so be
sure to reset your system unit after completing
this tutorial.

Setting Texture Coordinates Preferences:

1. From the Customize menu, choose Preferences.

2. In the General tab, under the Texture
Coordinates group, make sure the Use
Real-World Texture Coordinates option is
turned off.

3. Click OK to exit the Preferences dialog.

Create the floor material:

1. In the Material Editor, select an unused
sample slot.

2. In the material name field, enter Floor Tile.
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3. Click the Material Type button to the right of
the material name field. (Initially, its label says
“Standard.”)

4. In the Material/Map Browser, double-click
Blend in the list.

A Replace Material dialog is displayed.

5. Choose Discard Old Material, and then click
OK.

Like the Multi/Sub-Object material, a Blend
material is a container for other materials.
The Multi/Sub-Object material apportions
sub-materials among different sub-objects. The
Blend material, on the other hand, blends the
colors and other attributes of its sub-materials.
You can also control the amount and the
method of blending.

Configure the sub-materials:

1. On the Material Editor toolbar, open the
Material/Map Navigator.

The Material/Map Navigator is a dialog that
shows the components of the material in the
active sample slot. For complex materials
such as Blend, it can help you to visualize and
navigate the material hierarchy.

Note: The Navigator is one way
to move about the hierarchy of a complex
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material. Another is to use the Go To Parent
and Go Forward To Sibling buttons on the
Material Editor toolbar.

2. In the Material/Map Navigator, click Material 1.

3. In the material name field of the Material
Editor, rename this material Grout.

4. In the Material/Map Navigator, click Material 2.

5. In the material name field of the Material
Editor, rename this material Tile Surface.

Sub-material names are automatically updated
in the Material/Map Navigator.

Set the texture and color of the grout:

1. In the Material/Map Navigator, choose the
Grout material.

2. In the Material Editor > Blinn Basic Parameters
rollout, click the blank map button to the right
of the Diffuse color swatch.

The map button is the gray square to the right of the
diffuse color swatch.

3. In the Material/Map Browser, double-click
Noise in list.

This applies a Noise map as a texture for the
Grout material.

4. In Noise Parameters rollout, change the Size to
3, and choose Turbulence as the Noise Type.

This gives the Grout material a grainy
texture, as you can see in the sample slot if you
turn off Show End Result in the Material Editor
toolbar.

• When the Show End Result button is
on, the final result of the top-level material is
shown on the sample sphere.

Show End Result turned on - Background turned on
for clarity.

• When Show End Result is off, you
are shown only the material level you are
working on. That way it is easier to view
your adjustments to a specific map.

Show End Result turned off.

5. In the Noise Parameters rollout, click the Color
#1 color swatch (black by default).

6. In the Color Selector, change Color#1 to
R=232, G=219, B=197.

7. In the Noise Parameters rollout, click the Color
#2 color swatch (white by default).

8. In the Color Selector, change Color#2 to
R=196, G=170, B=159.



Material Combinations: Using Blend to Create a Floor Material 177

9. Close the Color Selector.

Add a bump pattern to the grout:

1. In the Material/Map Navigator, choose the
Grout material.

Previously, the Noise map was active.

Note: You can also click the Go to Parent
button to move up one level to the Grout
material.

2. Go to the Utilities panel. Click Asset
Browser. Answer OK to the warning dialog,
and then resize the Asset Browser window so
you can see both the Browser controls and the
Material Editor.

3. In the Asset Browser, navigate to the
\tutorials\designviz folder.

4. In the Material Editor, open the Maps rollout
for the Grout material.

5. Drag the file glasblkb.gif (the image looks
like a tile pattern) from the Asset Browser to
the blank (“None”) Bump map button in the
Material Editor. Release the mouse.

The image in glasblkb.gif

The Maps rollout with glasblkb.gif assigned to the
Bump map button

Just as you can search for geometry models,
you can use the Asset Browser to find bitmap
files and use them in the scene. The Asset
Browser also gives you the freedom to search
for models and bitmaps anywhere on your local
hard drives or across the Internet.

6. Minimize the Asset Browser.

7. In the Material Editor > Maps rollout, change
the Bump map’s Amount to 50.

The Grout material now has a grid-like
bumpiness.

Set the texture and color of the tile surfaces:

1. In the Material/Map Navigator, choose the Tile
Surface material.

2. On the Material Editor toolbar, click to
turn off Show End Result.
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3. In the Material Editor > Blinn Basic Parameters
rollout, click the blank map button to the right
of the Diffuse color swatch.

The map button is the gray square to the right of the
diffuse color swatch.

4. In the Material/Map Browser, double-click
Noise in list.

This applies a Noise map as a texture for the
Tile Surface material.

5. In the Noise Parameters rollout, change the Size
to 10.

6. In the Noise Parameters rollout, click the Color
#1 color swatch. (Black by default.)

7. In the Color Selector, change Color#1 to
R=220, G=197, B=181.

8. In the Noise Parameters rollout, click the Color
#2 color swatch. (White by default.)

9. In the Color Selector, change Color#2 to
R=162, G=132, B=111.

10.Close the Color Selector.

The tile surface is also “noisy” or rough, and
somewhat darker than the grout.

Change the shininess and bumpiness of the tile
surfaces:

1. In the Material/Map Navigator, choose the Tile
Surface material.

Previously, the Noise map was active.

2. In the Blinn Basic Parameters, go to the
Specular Highlights group. Change the
Specular Level to 15. Leave Glossiness set to 10.

3. In the Maps rollout, click the Bump map
button.

4. In the Material/Map Browser, double-click
Noise in the list.

5. In the Noise Parameters rollout, change the Size
to 1.

6. Click Go To Parent.

This takes you to the parent Tile Surface
material. The highlight in the Navigator
indicates the change.

7. In the Maps rollout, change the Amount for the
bump map to 15.

Combine the two materials by using a mask:

The Blend material now has two sub-materials,
Grout and Tile Surface. You will use a bitmap file
as a mask to combine them.

1. In the Material/Map Navigator, choose Floor
Tile (Blend).

This is the top level of the material. The
Blend Basic Parameters rollout shows the two
component sub-materials.

2. Restore the Asset Browser.

3. Drag the file glasblkb.gif from the Asset
Browser to the Mask button on the Blend Basic
Parameters rollout.

4. Minimize the Asset Browser.
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Rename the mask:

1. On the Blend Basic Parameters rollout, click
the Mask button.

2. In the material name field, rename the mask
map Grout Lines.

Adjust the blending:

1. In the Material/Map Navigator, select the Floor
Tile (Blend) material.

Floor Tile, the blend material, is the top material in the
tree.

The Navigator now shows all component materials and
maps of the Floor Tile material.

2. In the Blend Basic Parameters rollout > Mixing
Curve group, turn on Use Curve.

3. Change the Transition Zone Upper amount to
1.0 and the Lower amount to 0.0.

This gives a crisp appearance to the grooves.

Apply the material to the floor:

1. In the viewport, select the Floor object.

2. In the Material Editor, click Assign
Material To Selection.

Assign coordinates to the floor:

1. With the Floor still selected, go to the
Modify panel.

2. Open the drop-down Modifier List and choose
UVW Map.

This guarantees that the floor has mapping
coordinates the Floor Tile material can use, and
gives you a means to adjust them. You will need
to, as the following steps demonstrate.

Render the scene:

• On the toolbar, click Quick Render.

The floor has a tiled appearance, but the tiles
are far too large.

You will correct the tile size in the following
lesson.

Save your work:

• On the menu bar, choose File > Save As. Name
your design mykitchen_with_tile_floor.max.

You can use this file in the following lesson.
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Using the UVW Map Modifier to
Adjust the Floor Tiles

In the previous lesson, you tiled the floor, but
found that with default mapping, the tiles appeared
too large. The tiles should be 10” x 10”, with
roughly 1/4” grout lines between each tile. You can
use the UVW Map modifier to set these values.

Set up the scene:

1. Continue from the previous lesson, or open the
file, kitchen_with_tile_floor.max found in the
\tutorial\designviz folder.

Note: If you see the File Load: Units Mismatch
dialog, choose the option Adopt The File’s Unit
Scale. This will change your system unit, so be
sure to reset your system unit after completing
this tutorial.

2. Close the Material Editor and the Asset Browser.

Setting Texture Coordinates Preferences:

1. From the Customize menu, choose Preferences.

2. In the General tab, under the Texture
Coordinates group, make sure the Use
Real-World Texture Coordinates option is
turned off.

3. Click OK to exit the Preferences dialog.

Adjust the floor tile size:

1. Select the Floor object.

2. Go to the Modify panel.

3. With UVW Mapping selected in the modifier
stack display, go to the Parameters rollout and
change the Length and Width values to 3’5”.
(The Floor Tile material has four tiles in each
dimension, with grout lines around them.)

4. Click Quick Render.

The tile dimensions are now correct.

Save your work:

• On the menu bar, choose File menu >
Save As and name the finished model
mykitchen_final.max.

Summary

This completes the material design tutorial.
Features it has covered include:

• Using the Material Editor to create and assign
materials.

• Creating a simple “one-color” material.

• Using a map in a material.

• Creating a multi/sub-object material for
assigning multiple materials to a single object.

• Using the Architectural material to use the
material presets.

• Creating a Blend material that includes a
procedural map.

• Using the Asset Browser to find textures.
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• Using the UVW Map modifier.

Using Map Scaler
Among the more useful tools for design
visualization in 3ds Max are the MapScaler
modifiers. Available in both object-space and
world-space versions, their primary purpose is
to allow scaling bitmapped materials applied to
objects separately from the objects themselves.
Thus, you can instance a modifier to numerous,
different-size objects in a scene, and thereafter set
one parameter for a uniform map scale throughout
the scene. In this tutorial, you’ll learn how to
accomplish this, and also observe some of the
differences between the two MapScaler modifier
types.

The MapScaler modifier is useful in situations
where geometry has not been mapped. For
example, if you import or link a DWG file that
doesn’t have UV coordinates, the MapScaler
modifier is very useful for quickly mapping objects.
Also, the MapScaler modifier is particularly useful
for objects such as curved walls which don’t map
well with the UVW Map modifier.

Skill Level: Beginner

Time to complete: 30 minutes

Features Covered in This Tutorial

After completing this tutorial, you should be able
to:

• Use the MapScaler modifiers to apply uniform
texturing to different-sized objects in a scene.

• Use the MapScaler modifiers to apply uniform
texturing to complex geometry in a scene.

• Understand the differences between the two
MapScaler versions and use each appropriately.

Tutorial Files

All the necessary files to do the tutorials can be
found on the Tutorial And Sample Files CD, in the
\tutorials\new_materials\ folder, unless otherwise
specified. Before beginning the tutorials, copy the
\tutorials directory from the CD to your \3dsmax8
local installation.

Applying Uniform Textures to
Different-Sized Objects

By default, in 3ds Max, the size of an object
determines the size of a bitmapped texture that
you apply to it. However, the MapScaler modifier
lets you scale a texture independently of the sizes
of objects it’s applied to. Moreover, once it’s
applied to an object, you can change the object’s
size without affecting the scale of the texture. You’ll
explore these capabilities in this lesson.

The files for this tutorial are in the
\tutorials\new_materials\ folder.

Set Texture Coordinates preferences:

1. From the Customize menu, choose Preferences.

2. In the General tab, under the Texture
Coordinates group, make sure the Use
Real-World Texture Coordinates option is
turned off.

3. Click OK to exit the Preferences dialog.

Open the scene and apply a bricks texture:

1. Open the file \tutorials\new_materials\
plaza.max.
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The scene is of a small building plaza containing
objects of various sizes and shapes.

You’ll create a brick texture and apply it to all
the objects.

2. Press M to open the Material Editor.

The first material, represented by the upper-left
sample sphere, is active, and has been named
Brick and set to use a Standard material. You’ll
apply Diffuse map containing a brick image.

3. In the Material Editor, to the right of the Diffuse
color swatch, click the square button.

The Material/Map Browser dialog opens.

4. Double-click the Bitmap list entry.

The Select Bitmap Image File dialog opens.

5. If necessary, navigate to the directory from
which you opened the scene file, and then open
the brkrun.jpg file.

The brick image appears on the sample sphere.

6. Click the Show Map In Viewport button
on the Material Editor dialog.

This lets you see the brick image in shaded
viewports on objects to which the material is
applied.

7. Press CTRL+A to select all objects in the scene.

8. Click the Assign Material To Selection
button on the Material Editor dialog.

The brick texture appears on all the objects in
the viewport, but the brick sizes differ from
object to object. On the small pyramid objects
the bricks are tiny, while on the bigger objects
such as the hemisphere the bricks are too
large. Also, the bricks on the sides of the L-Ext
and C-Ext objects are stretched out, while
they maintain correct proportions on top. Of
course, in a real-world structure the bricks are
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usually all the same size. You’ll accomplish this
in the next step.

Use a modifier to make the bricks a uniform size:

1. With all the objects still selected, go to
the Modify panel, click the Modifier List, and
choose Object-Space Modifiers > MapScaler.
On the Modify panel, make sure the Scale value
is set to 100.0, the default setting.

This applies the modifier as an instance to
all the objects in the scene. Thus, changing
any parameter in one instance of the modifier
changes all instances identically.

The bricks are all now the same size, but they’re
a little too big. You’ll set them to be half the
current size.

2. Select the C-Ext01 object. This is the wall object
near the right side of the Perspective viewport;
it resembles a reversed, squared-off letter C.

3. On the Modify panel > Parameters rollout, set
Scale to 50.0.

The bricks image shrinks to half its previous
size on all objects. This is about right for the
scale of the project.

4. On the Modify panel, turn off Wrap Texture.
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The brick texture still looks okay on most of
the objects, but on the dome it looks irregular.
Zoom in for a better look, if you like, and then
zoom back out.

Wrap Texture attempts to apply the texture
along surface normals, and should generally be
left on for best results.

5. Turn Wrap Texture back on.

Next you’ll see even more dramatically how
MapScaler scales the texture uniformly.

6. In the modifier stack display, click the
light-bulb icon next to Map Scaler OSM to turn
off the modifier.

All instances of the modifier are turned off,
and the texture returns to its original, different
scales.

The C-Ext01 object should still be selected.

7. In the modifier stack display, click the C-Ext
item to highlight it.

Its parameters appear on the Modify panel.

8. Change the Height setting to 60.0.

The size of the brick texture on the sides
expands along with the wall’s height.

9. Turn the modifier back on by clicking the
light-bulb icon in the stack display.

The texture returns to its uniform size.
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10.Use the Height spinner to increase the C-Ext01
object’s height to 85.0.

The texture remains the same size as the object
expands.

Observe the modifier stack behavior of MapScaler
(WSM):

As the final part of this lesson, you’ll observe
one difference between the object-space and
world-space versions of the MapScaler modifier.
As you’ve seen, the instanced object-space version
is accessible with any number of objects selected.
An instanced world-space version, however, can
be accessed only with a single object selected.

1. Press CTRL+A to select all objects in the scene.

The modifier stack shows “Multiple Selected,”
and the only entry in the stack display is the
modifier.

2. Click the Remove Modifier From The
Stack button to delete the modifier from all
objects.

The texture returns to its original, varied sizes.

3. On the Modify panel, click Modifier List, and
from the list choose World-Space Modifiers >
MapScaler (WSM).

The software applies the modifier as an instance
to all objects, and the map size becomes
uniform. However, the modifier doesn’t appear
in the modifier stack display.

4. Click any object in the scene to select it and
deselect all the other objects.

Now the object’s name appears in the modifier
stack display, along with the modifier as a
binding.

The software always includes “Binding” as part
of the default name of world-space modifiers in
the modifier stack display, because of the way
world-space modifiers work.

5. Change the Scale setting to any value.

The size of the brick texture changes throughout
the scene, demonstrating that the modifier is
instanced on all objects.

6. Click the Remove Modifier From The Stack
button to delete the modifier from the selected
object.

The texture returns to its original size on the
object.

7. Select a different object.

The modifier again appears on the object’s
modifier stack. As you can see, there’s no
easy way to remove the modifier from the
scene; you’d have to select each object in turn
and remove the modifier. In this regard, the
world-space version isn’t as convenient to use
as the object-space modifier. On the plus side,
the world-space version allows the texture to
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survive changing object size with the Select
And Scale tool as well as by changing the object
creation parameters, whereas the object-space
version functions correctly only in the latter
case. We leave it to you to explore this capability
as an elective exercise.

Applying Uniform Textures to
Complex Objects

In addition to being useful when used on objects
of various sizes, the MapScaler modifier is also
useful for objects which do not map well with the
UVW Map modifier such as curved walls, or roofs
with multiple slopes. You will explore the latter
in this exercise.

The files for this tutorial are in the
\tutorials\new_materials\ folder.

Open the scene and create the roof:

1. Open the file \tutorials\new_materials\
roof.max.

The scene shows two splines, one representing
the 2D roof layout, the other is a simple line you
will need to build the roof in 3D.

2. Select the yellow spline named Roof and
go to the Modifier panel

3. In the Modifier list, choose Bevel Profile.

4. In the Parameters rollout, choose the Pick
Profile button and then click on the blue line
in any viewport.

The 3D roof takes shape but its edges are
intersecting in a strange way.

5. With the roof still selected, activate the option:
Keep Lines From Crossing in the Intersections
group.

The roof is now displayed correctly.
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Create and apply a shingles material to the roof:

1. Press M to open the Material Editor.

The first material in the upper-left sample
sphere is active. You will apply a Diffuse map
containing a shingles image.

2. In the Material Editor, to the right of the Diffuse
color swatch, click the square button.

The Material/Map Browser dialog opens.

3. Double-click the Bitmap list entry.

The Select Bitmap Image File dialog opens.

4. navigate to the directory from which you
opened the scene file, and then open the
shingles.jpg file.

The shingles appear on the sample sphere

5. Click the Show Map In Viewport button on
the Material Editor dialog.

This lets you see the shingles image in shaded
viewports on the roof to which the material is
applied.

6. Drag the newly created material from the
Material Editor and drop it on the 3D roof in
the viewport.

Close the Material Editor when done.

The shingles texture appears on the roof but it
is not following any logical pattern.

If you were to apply a UVW Map modifier at
this moment, you would notice that none of
the map types such as Planar, Cylindrical or
Spherical would help in this situation, that is
unless you used multiple UVW Map modifiers
to account for the different slopes on the roof. It
is much easier to achieve the same results using
a Map Scaler modifier.
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Apply a MapScaler (WSM) modifier to the roof:

1. With the roof selected, go to the Modify
panel.

2. From the Modifier list, choose World Space
Modifiers > MapScaler (WSM).

Note: A World-Space Modifier (WSM) modifier
is always evaluated last. This means that if you
decide to edit the geometry of the roof at a later
time, the mapping will remain unaltered

3. Try changing the scale value.

Notice how the orientation of the shingles flows
nicely on each slope of the roof.

Modify the geometry without altering the texture:

1. With the roof selected, go to the Modify
panel.

2. From the Modifier list, choose Edit Mesh.

Notice that even though you applied the
modifier to the top of the stack, it is still
listed below the MapScaler modifier and
will therefore be evaluated before the WSM
modifier.
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3. Activate the Show End Results toggle to
display the proper mapping in the viewport.

4. Expand the Edit Mesh modifier and choose
Vertex.

5. In the top view, select the vertices that protrude
in the Y-direction and move them back to
shorten the roof length.

Notice the end result in the perspective view.
The shingles scale remains the same as you edit
the mesh structure.

Using the Object-Space MapScaler
Modifier

One of the main differences between object-space
and world-space modifiers is that the latter always
reside at the top of the modifier stack, while
object-space modifiers can live anywhere in the
stack. Because the stack order is usually important,
this gives MapScaler OSM (object-space modifier)
version a distinct advantage in situations
where some modifiers must be applied after
the map-scaling operation. You’ll explore this
capability in this lesson.

The files for this tutorial are in the
\tutorials\new_materials\ folder.
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Open the scene and apply modifiers:

1. Open the file \tutorials\new_materials\
doors.max.

The scene is of two door objects, to each of
which is applied a Multi/Sub-Object material
containing a wood bitmap texture on the inner
panel.

The texture is too large, so you’ll use MapScaler
modifiers to reduce its size.

2. Select the left-hand door, WSM Door, and,
from the World-Space Modifiers category,
apply a MapScaler (WSM) modifier. Set Scale
to 50.0.

3. Select the right-hand door, OSM Door, and
apply an object-space MapScaler modifier. Set
Scale to 50.0, if necessary.

The textures on both doors are scaled to half
their original size, and look the same. Note that
the selection bounding box of WSM Door is
aligned with the world, while that of the OSM
Door object is aligned with the object.

Rotate the textures on the first door:

Say, for some reason, you want the wood texture
to be oriented horizontally instead of vertically. To
do this, you’ll select the polygons that contain the
texture, apply a UVW Xform modifier, and then
use the latter to rotate the texture.

1. Select the left-hand door, WSM Door, and
apply a Mesh Select modifier from the Selection
Modifiers category.

The Mesh Select modifier appears in the
modifier stack below the Map Scaler Binding
entry. World-space modifiers always stay at the
top of the stack.

2. On the Modify panel > Mesh Select
Parameters rollout, click the Polygon button.

3. In the Select By Material ID group, set ID to 3
and then click the Select button.

This selects the panel polygons on the front
and back sides of the door. If it’s not evident
that they’re selected, press F2 to turn on Shade
Selected Faces.
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4. Apply a UVW Xform modifier to the door.

This modifier lets you change the texture
orientation. Again, the MapScaler remains at
the top of the stack.

5. On the Parameters rollout, turn on Rotate
About Center, and then set Rotation to 90.0.

Nothing happens to the texture image on
the door. This is because the world-space
MapScaler modifier is applying its own texture
coordinates at the top of the stack, overriding
the texture coordinates applied by the UVW
Xform modifier. You can confirm this by
turning off the Map Scaler Binding item in the
stack (click its light-bulb icon). If you do, note
that the texture is now rotated but is back to the
too-large size, and then turn the Map Scaler
Binding back on.

Rotate the textures on the second door:

1. From the modifier stack display, drag the Mesh
Select modifier from the modifier stack onto the
OSM Door object in the Perspective viewport.

The second door is now selected, along with
its textured polygons, and the Mesh Select
modifier appears at the top of its stack, above
the Map Scaler OSM entry.
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2. In the modifier stack display, click the Mesh
Select modifier entry, currently highlighted in
yellow, to exit the sub-object level.

This is necessary in order to be able to select
a different object.

3. Select the WSM Door object again, and then
drag its UVW Xform modifier onto the OSM
Door object in the viewport.

The UVW Xform modifier appears at the top of
the OSM Door object’s stack. Because it takes
effect after the MapScaler modifier, you can see
its rotation of the texture.

The texture, still the correct size, is now
rotated 90 degrees, according to the Rotation
adjustment you made previously in the UVW
Xform modifier.

4. Try changing the UVW Xform modifier’s
Rotation setting using the spinner; the texture
orientation changes in real time. Also click
the Map Scaler OSM stack entry and use the

spinner to change the Scale value. Again, you’ll
see it change in real time.

Summary

In this tutorial, you learned about the useful ability
of both MapScaler modifiers to unify texture scale
throughout your scene with a single setting. You
also learned some of the differences between the
two versions, including the accessibility in the
stack of an instanced OSM version with multiple
objects selected, and its ability to live anywhere
in the stack.

Managing Texture
Coordinates

This tutorial looks at some of the 3ds Max features
related to materials, texturing, and rendering. The
first lesson, in three parts, covers functionality in
the Unwrap UVW modifier. Following this are
lessons on Render To Texture, the Ink ’n Paint
material, and the Translucent shader.

Skill level: Intermediate

Time to complete each lesson: 30–60 minutes

Features Covered in This Tutorial

In these lessons you will learn:
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• Using the Unwrap UVW modifier.

• Using Render To Texture to “bake” lighting,
shadows, and other scene features into a bitmap
texture for use in games and other real-time
applications.

• Using Ink ’n Paint to render comic-style images.

• Using the Translucent shader to simulate
translucent materials

Tutorial Files

All the necessary files to do the tutorials can
be found on the Tutorial Files CD, in the
\tutorials\materials_and_rendering folder. Before
doing the tutorials, copy the \tutorials directory
from the CD to your \3dsmax8 local installation.

Using Unwrap UVW, Part 1

In this three-part lesson, you’ll get an introduction
to the Unwrap UVW modifier, and use several of
its features.

Note: All the necessary files to do the tutorials can
be found on the Tutorial Files CD that ships with
3ds Max 8. Before doing the tutorials, copy the
\tutorials directory from the CD to your \3dsmax8
local installation.

Examine the final mapping:

You’ll start by looking at the final version of a fairly
detailed object mapped with the Unwrap UVW
modifier.

1. Open the file tut_unwrap_start.max.

2. Go to the Modify panel and select the
Fuselage object; just click a wing.

You can now see the object’s modifier stack,
with the Unwrap UVW modifier applied to the
Editable Poly object.

3. In the modifier stack display, click Face to
access this sub-object level. Also, in the
Selection Parameters rollout, turn on Select
By Element.
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This will let you select large sections of the
Fuselage, rather than single faces.

4. On the Parameters rollout, click Edit.

This opens the Edit UVWs dialog, also known
as the UVW editor.

5. In the drop-down menu at the top right of the
window, choose biplane_texture.jpg.

You can now see the UVW clusters laid out
against the texture map in the background.
Each cluster represents a section of the Fuselage
geometry that is planar-mapped with the
underlying area of the bitmap texture.

6. In the Perspective viewport, click the upper
wing.

The entire wing is selected, and in the editor
window, the UVW clusters assigned to it
become highlighted.
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7. Still in the viewport, click different parts
of the Fuselage to see which UVW clusters
correspond to them.

Highlighting a cluster makes it easier to see
how well its outline matches the shape of the
underlying section of the texture map. You
can also use the Options button to change the
wireframe color used by the clusters. Also, it
often helps to lower the bitmap brightness as
well.

Most of the Fuselage parts are combined into a
single element, which uses the clusters on the
left side of the editor window.

8. In the viewport, select the nose cone (it’s right
behind the propeller), and note the cluster that
highlights in the editor.

The nose cone is mapped as a single piece,
which is convenient to texture with a single area
of the bitmap. It’s not really flat, but the planar
mapping works with it because of the UVW
editor’s ability to closely match the geometry
with the bitmap on a per-vertex basis.

9. Next, click one of the landing gear housings,
and note how it’s mapped with four different
clusters.

10.Click an empty area of the editor window to
deselect the UVW clusters.

11.In the editor, turn on Selection Modes group
> Select Element, if necessary, and click each
of the previously highlighted clusters in turn
to see which part of the housing it maps. You
might need to rotate the viewport to see the
highlighted polygons. If you still can’t see
the selection, press F2 and/or F4 to enable
Shade Selected and Edged Faces, respectively.
Also, the outermost cluster corresponds to the
inside of the wheel housing, so it might be a bit
difficult to spot at first.

Because the housing structure is more complex
than that of the nose cone, it makes sense to
map it with four clusters instead of one.

Ultimately, it’s up to you how you map your
geometry; the UVW editor gives you the power
and flexibility to use the method that works
best for you.

Using Unwrap UVW, Part 2

In this section, you’ll examine Unwrap UVW’s
Flatten Mapping command for automatic
mapping.

Use Flatten Mapping:

1. Click an empty area of the editor window to
deselect any selected UVW clusters.

2. In the Edit UVWs dialog, open the Mapping
menu and choose Flatten Mapping.
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The Flatten Mapping dialog opens.

3. Click OK to accept the default settings and
remap the Fuselage using this automatic
mapping function.

The software applies planar mapping to each
section of the mesh based on the Flatten
Mapping dialog settings. The editor now
displays a very different set of UVW clusters.
Each cluster consists of a set of contiguous faces
in which the angle between neighboring faces is
less than or equal to the Face Angle Threshold
setting in the Flatten Mapping dialog.

The main difference is that there are many more
clusters, and most of them are smaller than in

the final. The wings are relatively flat, so their
clusters are easy to identify, but most of the
rest are not. You can remedy this somewhat by
increasing the angle threshold.

Of course, the underlying texture map remains
the same when you change the mapping. If you
look at the Perspective viewport, you can see
that the mapping is now much different than
before.

4. Again choose Mapping menu > Flatten
mapping, and for Face Angle Threshold, type
61 (this is the angle used by the artist as a first
step in creating the final mapping). Click OK to
perform the remapping.
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The result is fewer clusters than before, but
still many more than in the final. In the next
procedure, you’ll look at a couple of ways of
combining these clusters.

Combine the UVW clusters:

You can use the editor’s Stitch function to combine
clusters one at a time, and the modifier’s Planar
Map command lets you combine several clusters
simultaneously.

1. In the viewport, select the nose-cone element.

This causes all of the UVW clusters used by the
nose-cone geometry to highlight in the editor.

2. On the editor’s lower toolbar, click the Filter
Selected Faces button to turn it on.

Now only the highlighted clusters appear.

3. Click outside the bounding box to deselect
everything, and then click a vertex on one of
the smaller clusters to select the cluster.

Highlighted edges and vertices appear on one
or more other clusters to show the sub-objects
shared with the selected cluster.
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4. In the Tools menu, choose Stitch Selected.

The Stitch Tool dialog appears, and one of
the other clusters moves next to the selected
clusters, with the shared sub-objects “stitched”
together. The software automatically stitches
the cluster with the most shared sub-objects;
if two or more share the same number of
sub-objects, it picks the one with the lowest
vertex ID numbers. In this case, it picked the
rightmost cluster near the top of the editor
window.

5. In the dialog, click the Align Clusters check box
to turn it off, note what happens, and then click
it again to turn it back on.

When you turn off Align Clusters, the attached
cluster moves back to its original position. Use
this when the automatic alignment positions
the attached cluster in an undesirable way, such
as overlapping the first cluster.

6. Click OK to close the dialog.

Next, you’ll use Planar Map to combine all of
the nose cone clusters at once.

7. In the viewport, select the nose cone element.

8. In the Modify panel > Map Parameters rollout,
click Planar.

The Planar button turns yellow and the clusters
combine into a single cluster that’s roughly
the shape of the nose-cone texture in the
upper-right section of the bitmap. But the
cluster is oriented differently than the texture,
and is much bigger.

9. In the Map Parameters rollout, click on Align
X. This will reorient the mapping gizmo so that
it is perpendicular to the nose cone element.

10.Near the bottom-right corner of the Edit UVWs
dialog, click the Rotate -90 button to match the
orientation.
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11.In the Modify panel > Map Parameters rollout,
click Planar again to exit Planar Mapping mode.

12. Use the Freeform Mode transform tools
to fit the cluster to the nose-cone texture. Drag
the corners of the bounding box to scale the
cluster, and drag within the bounding box to
move it. Check your work in the viewport, and
render if you like.

To get an exact match, you’d have to move the
vertices as well. You can improve the match
somewhat using the Sketch Vertices command,
which we’ll cover in the next lesson.

Tip: You can use the Edit UVWs dialog to make a
template for creating your own texture maps. Once
you’ve got the clusters set up the way you want
them, go to the Tools menu and choose Render
UVW Template, and then use the Render UV
Template button to generate a flattened 2D image
of the mapping coordinates. You can then save and
open the bitmap image into your Paint application
(such as Adobe Photoshop). Use the cluster
outlines as a guide for painting the texture map.

Using Unwrap UVW, Part 3
Add a menu item:

To use Sketch Vertices, you need a selection of
vertices. The UVW editor gives you a variety of
ways of making the selection, including several
built into the Sketch Vertices tool. You’ll try one of
the easiest, but it will require a bit of setup. In this
procedure, you’ll add a menu item to the editor
that will let you choose an entire cluster outline
with one click.

1. From the 3ds Max menu bar, choose Customize
> Customize User Interface

2. Click the Menus tab, and then, from the Group
drop-down list, choose Unwrap UVW.

3. From the drop-down list above the right-hand
column, choose UVW Unwrap - UVW Select.

This is the Select menu in the Edit UVWs
dialog.

4. In the left-hand list, scroll down until you
see Open Edge Mode. Drag this item to the
right-hand list, just above the End Of Menu
item.

Tip: While you’re at it, you might also want
to add Open Edge Select. This works on an
existing selection, selecting all outer edges of
any clusters that have any outer edges selected.

5. Close the Customize dialog by clicking the X
box in the upper-right corner.
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6. Close the editor window the same way, and then
reopen it by clicking Parameters rollout > Edit.

This refreshes the editor interface,
implementing the change you made.

Select the outer UVW vertices:

You’ll use the newly added command to select the
cluster outline, and then convert the edge selection
to a vertex selection.

1. Use Zoom Region to zoom in on the nose-cone
section of the editor window.

2. On the Options panel (docked to the bottom of
the Edit UVWs dialog), in the Selection Modes
group, choose Edge Sub-object Mode and turn
off Select Element.

3. Click a point inside the dialog to deselect all
edges.

4. From the Select menu, choose Open Edge
Mode.

With this turned on, selecting an outer edge (or
one adjacent to an outer edge) selects the entire
outline.

5. Click one of the cluster’s outer edges.

The entire outline highlights to indicate all
outer edges are selected.

6. From the Select menu, choose Convert Edge
To Vertex.

All outer vertices of the cluster are selected.

Sketch the vertices:

1. From the Tools menu, choose Sketch Vertices.

2. In the Sketch Tool dialog, from the Select By
drop-down list, choose Use Current Selection.

3. Make sure Align To is set to Free Form, and
that Show Vertex Order is turned on. Also, if
Interactive Mode isn’t turned on, turn it on.

4. Click OK to exit the dialog.
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You’re now in Sketch mode. The selected
vertices are numbered in the order that they’ll
be drawn.

5. Examine the vertices closely, starting with the
first one (number 0).

There’s a problem: They’re not numbered in
order, so the shortcut won’t work in this case.
But at least you added a useful command to the
Select menu.

When using Sketch Vertices, always make sure
the selected vertices are numbered in the exact
order you intend to draw them, otherwise you
can end up with a mess.

6. Right-click in the editor window to exit Sketch
Vertices mode.

7. Zoom in as far as possible, so the nose cone
fills the editor window, and then choose Sketch
Vertices again from the Tools menu.

In this case, you want to pick only vertices on
the outside edge of the cluster; zooming in
helps ensure that you don’t inadvertently pick
internal vertices.

8. This time, in the Sketch Tool dialog, choose
Select By > Drag Selection. Leave the other
settings as they are, and click OK.

The mouse cursor turns into a circle, indicating
that you’re in Drag Selection mode. Don’t
worry if the vertex numbers show; they’ll go
away as soon as you start dragging.

9. Position the cursor over the top-center vertex.
While pressing the mouse button, drag around
the entire outline.

The vertices highlight as you drag over them,
and this time they’re numbered in the correct
order.

When you release the mouse button, the cursor
turns into a pencil, indicating that you’re ready
to start sketching.

10.Position the mouse over the top-center of the
nose-cone texture, at the bottom of the V, and
press and hold the mouse button.

11.Drag around the entire outline of the nose-cone
texture, following the edges as closely as you
can.
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As you drag, the vertices spread out along the
outline you draw.

As you can see, Sketch Vertices/Free Form is
best used for matching vertices to bitmaps with
curved outlines. With the other Align To options,
you can also match straight-line, circular/oval,
and rectangular outlines. The purpose here was
primarily to introduce you to the tool; in this
situation, you’d probably get a better match after
doing the planar mapping simply by moving
vertices one at a time.

Check the original again:

• To finish, load the tut_unwrap_start.max file
and examine its mapping again. Try flattening
its mapping again, and see how closely you can
match the texture map with your own mapping
methods.

Summary

The Unwrap UVW modifier is a powerful tool
for applying complex mapping to your objects.
This tutorial covered a variety of methods for
using the modifier, including how to coordinate
selection of UVW coordinates and parts of the

object, usage of the automatic mapping tools such
as Flatten Mapping, combining mapping clusters,
and sketching vertices.

Using the Relax Tool on Texture
Coordinates

An important tool in the Unwrap UVW modifier
editor is Relax, which algorithmically spreads out
texture coordinates to give more even coverage
of the underlying texture. This makes it easier to
assign specific texture coordinates to the desired
areas of the texture. This tutorial gives you a brief
look at how to use Relax in a specific texturing
application.

Skill Level: Intermediate

Time to complete: 20 minutes

Features Covered in This Tutorial

In this tutorial you learn:

• Applying a Unwrap UVW modifier.

• Using the Relax tool to affect texture
coordinates.

Tutorial Files

All the necessary files to do the tutorials can
be found on the Tutorial Files CD, in the
\tutorials\materials_and_rendering folder. Before
doing the tutorials, copy the \tutorials directory
from the CD to your \3dsmax8 local installation.

Procedures

Set up the tutorial:

• From the tutorials\materials_and_rendering
directory, load the scene file clown_head.max.

3dsmax.chm::/Unwrap_UVW_Modifier.html
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The scene contains a model of a head, with a
UVW Map modifier set to Planar applied to the
face. Also applied to the face is a material with
a Checker map. The map helps show where the
texture vertices might need to be adjusted.

Apply the Unwrap UVW modifier:

1. Select the head object and go to the Modify
panel.

2. Apply an Unwrap UVW modifier.

The Unwrap UVW modifier appears at the top
of the stack, but doesn’t provide a sub-object
mode because you’re applying it to an existing
sub-object selection.

Edit the UVW mapping:

1. On the Parameters rollout, click the Edit button.

The Edit UVWs dialog opens.

Only the selected parts of the mesh appear, and
all texture vertices are selected.

Note that the texture vertices are most dense
around the detailed parts of the face: the eyes,
nose, and mouth. This is where you can use
Relax to spread out the vertices for easier
manual editing.

2. Drag a selection region around the eyes.

3. From the Edit UVWs dialog menu bar, choose
Tools > Relax dialog.

The Relax Tool dialog appears.
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The Relax Tool dialog is modeless. It offers
different algorithms to relax the mapping. The
default mode, Relax By Edge Angles is often
recommended as it minimizes the overlapping
of edges.

4. Click the Apply button twice.

The selected vertices move apart slightly.

5. Similarly, use Relax on the vertices around the
nose and mouth.

Summary

The Relax tool in Unwrap UVW can save you time
and effort by automatically spreading out mapping
vertices. In some cases, you’ll need to follow up by
moving vertices to the desired final locations.

Using the Channel Info Utility

This tutorial shows a number of different methods
for using the Channel Info utility. This is an
intermediate-level tutorial; you should be familiar

with standard 3ds Max procedures such as creating
and applying materials.

Skill level: Intermediate

Time to complete: 90 minutes

The files for this tutorial are in the
\tutorials\materials_and_rendering folder.

Note: All the necessary files to do the tutorials can
be found on the Tutorial Files CD that ships with
3ds Max 8. Before doing the tutorials, copy the
\tutorials directory from the CD to your \3dsmax8
local installation.

Reduce a mesh object’s memory footprint:

When working as a 3D artist on a
game-development project, you might
receive models to work on that have already
been mapped, but it’s difficult to tell what the
mapping is. In addition, the mapping might
have been applied inefficiently, so that it takes
up more memory than necessary in the model’s
data structure. This lesson shows you how to use
Channel Info to adjust a model’s mapping, thus
recovering the unused memory, which can then be
used by other game assets.

1. Open the ostrich.max scene file.

2. Apply a UVW Map modifier to the ostrich
model. Set Map Channel to 4.

3. Collapse the ostrich object’s stack; this results
in an Editable Mesh object.

This simulates a situation you might encounter
as a 3D artist working for a commercial game
developer: You receive a mesh object to work
on that already has mapping applied, but you
don’t have direct access to the tool (modifier)
originally used for applying mapping, and

3dsmax.chm::/channel_info_utility.html
3dsmax.chm::/UVW_Map_Modifier.html
3dsmax.chm::/Collapse_Utility.html
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you need to minimize the object’s memory
footprint for embedding into the game.

4. Create a standard material with a Checker map
applied as a Diffuse map. For the Checker map,
set U and V Tiling both to 4.0, and set Map
Channel to 4.

5. Turn on Show Map In Viewport, and apply
the map to the ostrich model.

The map appears on the model, mapped in a
planar manner parallel to the world grid.

6. Go to the Utilities panel, click the More
button, and then double-click Channel Info to
open the utility. On the Utility panel, click the
Channel Info button.

The Map Channel Info dialog opens:

The dialog lists all pertinent channel
information for the object. This is described in
detail in the Interface section.

The last channel, whose ID is “4:map,”
represents the mapping you applied with the
UVW Map modifier. It’s preceded by three
empty map channels, each of which contributes
about 33 kilobytes to the object’s memory
footprint. These were created because the
software requires consecutive numbering of
map channels, but the memory isn’t being used
for anything.

You’ll use the Channel Info tools to remove the
empty channels, thus freeing up the unused
memory. But first you’ll copy the mapping to
the first available mapping channel, because
you can delete channels only starting with the
last one.

7. Right-click the last channel, and from the
right-click menu, choose Copy.

This places the texture mapping created by the
UVW Map modifier into the copy buffer. The

3dsmax.chm::/channel_info_utility.html##sublink_channel_info_interface
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status line on the dialog, beneath the row of
buttons, reads “Copy Buffer Info: Node: ostrich
Map Channel 4”.

8. Right-click the channel whose ID is “1:map”
(the first available texture map channel), and,
from the right-click menu, choose Paste.

The Channel Name dialog appears, giving you
the opportunity to name the pasted channel.

9. Type Planar Mapping and press ENTER or
click OK.

Map channel 1 now also contains the planar
mapping originally applied to channel 4. You
can now delete the remaining map channels,
but first you’ll demonstrate that the planar
mapping is indeed applied to channel 1.

Note: With an object that has default mapping,
such as a geometric primitive, you might
have pasted to channel 2 instead. This would

preserve the original, default mapping as well as
the planar mapping in two different channels.

10.Open the Material Editor, if necessary, and go
to the material’s diffuse map level. Use the Map
Channel spinner to decrement the value to 1 by
clicking the down arrow three times.

At map channels 3 and 2, no map appears
on the ostrich model, because those channels
don’t contain any mapping values. But at map
channel 1, the checker texture reappears on the
object.

11.Right-click the 3:map channel, and from the
right-click menu, choose Clear.

The channel remains, and still uses 33 kilobytes
of memory. This demonstrates that you can’t
delete intermediate channels.

12.Right-click the 4:map channel, and from the
right-click menu, choose Clear.

The channel disappears.

13.Clear the 3:map channel, and then the 2:map
channel.

Only map channel 1 remains. You’ve deleted the
others, thus reducing the object’s total memory
footprint by approximately 99 kilobytes (the
memory consumed by the three unused map
channels).
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14. On the Modify panel, look at the object’s
modifier stack. It contains a UVW Mapping
Paste and four UVW Mapping Clear modifiers;
the Channel Info utility uses these modifiers
to help do its work. To get rid of these, simply
collapse the stack.

Enable vertex sub-object selections to survive
topology changes and object type changes:

Because Channel Info provides access to the
channel that stores the current vertex selection,
and lets you copy that information to other
channels, you can store the vertex selection. Once
you’ve done so, the vertex selection will survive
topology changes, such as adding mesh resolution
and even changing the object type.

It’s important to remember, however, that the
vertex-selection channel has only one component,
while map channels have three. Thus, you
need to copy the vertex-selection channel to a
subcomponent of a map channel.

This lesson also demonstrates usage of the Select
By Channel modifier in conjunction with Channel
Info.

1. Open the octopus.max scene file.

This octopus is at an early stage of modeling.
You’ll use it to learn how to retain sub-object
selections after subdividing the mesh.

2. Select the octopus object, open the Channel
Info utility, click one of the tracks, and then
click Add to create a new map channel.

You can use the extra map channel to store
the vertex-selection data, thus retaining any
information already in the original map
channel.

3. On the Modify panel, go to the
Vertex sub-object level of the Editable Poly base
object.

4. From the Region Selection flyout on the
toolbar, choose Lasso Selection Region and, in

3dsmax.chm::/select_by_channel_modifier.html
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the Left viewport, select all the vertices in the
octopus head. Drag out an approximate region
selection; you needn’t be particularly careful
about not selecting non-head vertices for this
exercise.

Next, you’ll determine whether this selection
can survive a topology change on its own. You
can use a special feature of Editable Poly to
automatically convert the vertex selection to a
polygon selection.

5. On the Selection rollout, CTRL+click the
Polygon button to go to that sub-object level
while simultaneously selecting the polygons
used by the existing vertex selection.

6. On the Edit Geometry rollout, click the
Tessellate button, and then return to the Vertex
sub-object level.

The vertices you selected before are interspersed
with the new, unselected vertices that were
created by tessellating the mesh. The vertex
selection did not survive the topology change.
That is, not all of the head vertices are still
selected.

7. Press CTRL+Z to undo the tessellation.

The software restores the original vertex
selection.

8. In the Map Channel Info dialog, right-click the
vsel channel and choose Copy.

“vsel” is short for vertex selection. This channel
stores the current selection set of vertices.
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9. Right-click the 2:map channel you created in
step 2.

The Paste command is unavailable, because
map channels each have three components, but
the vertex-selection channel has only one. You
can’t copy and paste between a one-component
channel and a three-component channel.
Fortunately, Channel Info gives you
optional access to individual components of
three-component channels.

10.At the top of the Map Channel Info dialog, click
the SubComp (subcomponents) button.

All three-component channels expand
into their subcomponents. vsel is the only
one-component channel.

11.Right-click the 2:map:X channel and choose
Paste. When the Channel Name dialog opens,
type Head Vertices and press ENTER.

The software adds a UVW Mapping Paste
modifier to the object’s stack.

12.Return to the Editable Poly > Vertex sub-object
level, and select all of the octopus’s leg vertices.

13.Copy the vsel channel to the 2:map:Y channel,
and name it Leg Vertices.

14.In the modifier stack, right-click one of the
UVW Mapping Paste modifiers and choose
Collapse All.

All of the additional modifiers are deleted, and
the pasted data is “baked” into the object mesh.

15.Apply a Tessellate modifier to the model.

The mesh resolution increases significantly.



210 Chapter 3: Getting Started

16.Apply a Select By Channel modifier to the
octopus model.

This modifier lets you select channels that you
named in Channel Info.

17.In the Select By Channel modifier, open the
Selection Channel drop-down list.

The entries are the same as the vertex selections
you copied and pasted to the map channel
subcomponents.

18.Choose each of the items from the drop-down
list in turn.

The corresponding stored vertex selection
appears on the object, including all new vertices
created by the tessellation. Note that the
software automatically creates a soft selection
for any vertices that the tessellation created
between the original selected and unselected
vertices; that is, on the border of the selection.

You could get the same results by copying the
stored channels back to the vsel channel in
the Map Channel Info dialog, but Select By
Channel makes it easier to access the various

stored selections. You can pass the selection
in the active selection channel up the stack to
further modifiers.

Normally, if you change an object’s geometry
type, it’s possible to lose a sub-object selection.
But with Channel Info, stored selections remain
intact, as you’ll see in the final part of this
lesson.

19.Right-click the octopus and convert it to an
Editable Patch object. Reapply the Select By
Channel modifier and access the different
stored channels.

The channels are empty, because Channel Info
doesn’t support stored vertex selections in
patch objects. But, as you’ll see in a moment, the
stored mesh-vertex selections are still available.

20.Convert the octopus to an Editable Mesh object.
Apply another Select By Channel modifier and
access the different stored channels.

The vertex selections remain intact. If you
performed the same series of conversions,
starting with an editable mesh with a vertex
selection, the selection would be permanently
lost after the first conversion.

Tip: If you’re doing this sort of work and find
that you can’t paste a copied channel that you
think you should be able to, try clicking the
Update button on the Map Channel Info dialog.
This step is necessary, for example, after object
type conversions and topology changes.

The next procedure follows on from this one. If
you’d like to try it later, save this file first.

Apply texture blending with the Vertex Color map:

In 3ds Max, the Vertex Color map works in
conjunction with Channel Info to provide access
to the different named channels. This lesson shows
how to use the capabilities of the Vertex Color
map along with stored vertex selections to blend
textures on an object’s surface.
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This lesson follows on from the one above
(page 1–207). If you haven’t done the previous
procedure, please complete it before attempting
this one.

You’ll create a composite material and use opacity
to specify which sub-material should appear
where.

1. Continue from the previous procedure, or
open the file you saved at the end, or open the
included file octopus01.max.

2. Open the Material Editor and apply the first
material (1-Default) to the octopus.

3. In the Material Editor, click the Standard
button, and in the Material/Map browser,
double-click Composite. When the Replace
Material dialog appears, click OK to continue.

4. At the top of the Composite Basic Parameters
rollout, click the Base Material button.

5. Click the Diffuse color swatch and set it to a
bright green color.

6. Click the Go To Parent button, and then click
the Mat. 1 button. Choose a Standard material
for material 1.

The Composite material uses opacity to
determine how the different materials overlay
the base mesh, so that’s where you apply a
Vertex Color map. You’ll use Vertex Color
because it provides access to the named, stored
channels.

7. On the Blinn Basic Parameters rollout, click the
Opacity map button to the right of the spinner,
and choose the Vertex Color map.

8. On the Vertex Parameters rollout, find the
Channel Name field and click the arrow button
to its right.

The drop-down list shows the vertex-selection
channels you pasted and named.

9. Choose the Head Vertices channel.

10.Click the Go To Parent button, and set the
Diffuse color to a bright red.

11.Apply a UVW Map modifier to the object.

This is just so the renderer doesn’t complain
about missing map coordinates when you
render.

12.Render the Perspective viewport.

A slight amount of blending between the colored areas
is the result of the soft-selected vertices created by the
tessellation.

13.Click the Go To Parent button, and set Mat.
2 to a blue, Standard material, with Opacity
mapped with a Vertex Color map set to the Leg
Vertices channel.

14.Render again.
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You now have an RGB octopus.

You can find the completed scene file in
octopus_final.max.

15.Also try setting the different sub-materials to
different maps such as Checker and Cellular.

This is a very powerful method of using
any mapping channel to combine different
materials on an object’s surface.

Enable a morph object to survive a topology change:

Sometimes, after you set up a morphing animation
with the Morpher modifier, you need to change
the object geometry. For example, the client or
technical director might request that you add a
facial feature such as wart, which requires you to
increase mesh resolution.

Normally, if you change the topology of the
base morph object, the morphing animation is
completely lost because the base object’s topology

then differs from that of the targets. To recover,
you must re-create the morph targets using the
new topology, which can be a lot of work.

Instead, you can reuse the original morphing
animation via the Channel Info’s Copy and Paste
functions, thus saving a great deal of time and
effort.

1. Create a base object, convert it to Editable
Mesh or Editable Poly, make several copies, and
modify the copies to create morph targets. Use
the Morpher modifier to set up a morphing
animation on the base object.

You can use your own scene, or load the
included scene file octopus_morph.max. The
remainder of the lesson assumes you’re using
this scene, which contains a low-polygon
octopus moving its head and legs using three
morph targets.

2. Play the animation.

The leftmost object, the one animated with the
Morpher modifier, moves its head and legs.
This is also referred to as the base object. The
remaining objects are morph targets; the base
object uses these poses for the different phases
of its animation. All four objects have the same
geometry; this is a requirement for morphing
animation.
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Before starting, you’ll demonstrate how
changing the object geometry loses the
morphing animation.

3. Select the base object, octopus base, and, on the
Modify panel > modifier stack, click Editable
Poly twice to go to the Vertex sub-object level.

4. On the Edit Vertices rollout, click the Extrude
button, and then, in the Perspective viewport,
drag one of the neck vertices upward to extrude
it outward.

5. In the modifier stack, click Editable Poly again
to exit the Vertex sub-object level.

6. Play the animation again.

The animation is lost. This happened because
the base object’s geometric structure, or
topology, is now different from that of the
morph targets.

7. Press CTRL+Z several times until the octopus is
no longer selected, and then play the animation.

The morphing animation is restored.

To begin, you’ll use Channel Info to copy each
of the morph targets’ mesh channels to different
channels in the base object.

8. Select the base object, octopus base, and then
open the Channel Info utility.

9. On the Map Channel Info dialog, click any
channel, and then click the Add button three
times to add three new map channels.

You can store the mesh data in existing channels
such as Alpha, Illum, and vc, or add new
channels to hold it. In this lesson, you’ll do the
latter.

10.Select the first morph target, octopus head
forward. On the Map Channel Info dialog,
right-click the first channel, poly, and choose
Copy from the menu.

The poly channel contains the object’s mesh
data.

11.Select octopus base again and use the Map
Channel Info dialog to paste to the 2:map
channel, which is the first new channel you
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created earlier with the Add button. Name the
channel octopus head forward.

12.Similarly, copy the poly channels from the
octopus legs 1 and octopus legs 2 objects (the
second and third morph targets) to the octopus
base object’s 3:map and 4:map channels,
respectively, naming the channels octopus legs
1 and octopus legs 2, respectively.

Tip: If you select multiple objects, they all
appear in the Map Channel Info dialog, so you
can copy and paste channels without having to
change your selection.

13.Select the base object and, in its modifier stack,
move the Morpher modifier above any UVW
Mapping Paste/Add modifiers (drag it to the
top of the stack).

14.Right-click the uppermost UVW Mapping
Paste modifier and from the context menu
choose Collapse To.

The added/pasted channels are combined
into the base object; only it and the Morpher
modifier remain.

15.At the Editable Mesh/Poly level, refine the
mesh. For example, you might use Slice, Cut,
or Tessellate to add resolution. Try this: Select
a few polygons on the front of the neck, click
the QuickSlice button, click once on either side
of the polygon selection, and exit the Polygon
sub-object level.

16.Play the animation.

Because of its modified topology, the base
object no longer morphs into the target shapes.

17.Delete all the morph targets (not the base
object).
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18.Make three copies of the edited base object.

Each of these copies has the same topology as
the modified base object, and contains all of the
original morph targets’ shapes in its mapping
channels.

19.Select the first copy, open the Map Channel
Info dialog if necessary, and copy the octopus
head forward channel to the poly channel. It’s
not necessary to rename the poly channel when
you paste.

The first morph target regains its head-forward
pose.

20.Similarly, copy the octopus legs 1 and octopus
legs 2 channels on the second and third copies,
respectively, to the poly channels .

21.Optional: Recover extra memory used by
the morph targets by deleting the mesh data
stored in their mapping channels with the Clear
function.

Lastly, you’ll set the Morpher modifier to use
the new targets.

22.Select the base object, go to the Modify panel,
and click the Morpher modifier in the stack,
if necessary.

23.On the Channel List rollout, right-click the first
target name button (octopus head forward),
choose Pick From Scene, and click the first
morph target object in the viewport (octopus
base01).

The new target name replaces the old one on
the button.

24.Similarly, use the Channel List buttons to set
octopus base02 and octopus base03 as the
second and third morph targets.

25.Play the animation.

The morphing animation is restored intact with
the modified topology.

You can find the end result of this lesson in the
file octopus_morph_final.max.

Summary

With its ability to store different kinds of
information in mapping channels for later
retrieval, the Channel Info utility can play a role in
helping you master a variety of tasks in 3ds Max.
You can use it to:

• Eliminate unused mapping channels in an
object, thus minimizing memory usage.

• Enable vertex sub-object selections to survive
topology changes and object type changes.

• Blend texture edges on an object’s surface, in
conjunction with the Vertex Color map.

• Name map channels and sub-channels for
access by the Select By Channel modifier.

• Restore morphing animation to an object after
changing its topology.

Ink & Paint

Ink ’n Paint Material

The Ink ’n Paint material lets you create
comics-style images without ever touching a pen
or brush. This short lesson will show you a few of
the options available with this versatile material.

Note: All the necessary files to do the tutorials can
be found on the Tutorial Files CD that ships with
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3ds Max 8. Before doing the tutorials, copy the
\tutorials directory from the CD to your \3dsmax8
local installation.

Set up the lesson:

1. Load the file tut_inknpaint_spitfire.max. This
is located in the \tutorials\materials_and_
rendering folder.

This simple scene contains a World-War II
airplane to which a standard material with a
bitmap in the diffuse channel is applied.

2. Make sure the Perspective (lower-right)
viewport is active, and then, from the
Rendering menu, choose ActiveShade Floater.

This opens a floating window that re-renders
the scene whenever you change a parameter.

Note that the background color is set to white;
this makes it easier to see the ink effects.

3. Click a viewport, and then press M to open the
Material Editor. If necessary, reposition the
editor dialog or the ActiveShade window so you
can see both at the same time.

The first sample sphere shows the Standard
material applied to the plane. You’ll create an
Ink ’n Paint material, and then apply it to the
fighter plane.

4. In the Material Editor, click the second sample
sphere to activate its slot, and then click the
Standard button.

The Material/Map Browser window opens.

5. In the browser list, double-click the Ink ’n Paint
item.

The browser closes, and the second slot now
contains an Ink ’n Paint material.

6. Drag this material to the plane in the Perspective
viewport or the ActiveShade window.

After a brief pause, the ActiveShade window
re-renders the plane with the Ink ’n Paint
material, giving it a much flatter look. Instead
of black shadow, the bottom portion of the
plane’s fuselage is now colored with a darker
shade of the blue paint color. Reapply the
original material, observe the differences, and
then apply the Ink ’n Paint material again.

With the default settings, the Ink ’n Paint
look is a bit drab. You’ll explore some of the
alternatives, using first the paint controls and
then the ink controls.
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Modify the paint controls:

The Paint Controls rollout contains three basic
settings: Lighted, Shaded, and Highlight. You’ll
look at each of these briefly, in turn.

1. The Lighted check box is on by default. Click it
to turn it off.

This removes all traces of paint from the object
surface as rendered in the ActiveShade window,
although the inked outlines remain. It doesn’t
affect the paint highlight, although that’s not on
right now so you cannot see it anyway.

2. Turn Lighted back on, and then, over on the
right side of the rollout, click the upper half of
the Paint Levels spinner once to set it to 3.

The plane now shows three levels of shading,
with a new level between the two original levels.

By default, the Ink ’n Paint material uses
two levels of shading to match the shading
often found in color comics. However,
you can increase this up to 255 for a more
three-dimensional look, or to as low as 1 for
a completely flat look.

3. Try increasing the number of levels a few more
times, and then set it back to 3.

As you increase the number of levels, the area
of pure paint color becomes smaller, while the
darkest shaded area remains the same size.

Tip: To increase the size of the fully lit area,
make the light source brighter by increasing its
Multiplier setting. With this material, the light
color has no effect, and changing the lighting
intensity affects only the size ratio between lit
and shaded areas.

Next, you’ll look at the Shaded setting.

4. Currently, Shaded is turned on, and is set to 70.
Change this to 35, and then 0.

Left: Shaded=35; Right: Shaded=0

As you lower the Shaded value, the shaded
areas of the surface get progressively darker, but
the lit portion does not. Among other things,
this lets you change the apparent lighting setup
without touching the light source(s).

5. Turn off Shaded.
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The spinner changes to a color swatch, currently
showing a dark blue-green color. The shaded
areas now blend between the Lighted color and
the Shaded color.

6. Click the color swatch and change the Shaded
color to a markedly different one; say, a dark
red.

After a brief pause, the ActiveShade window
displays the change.

7. Try a few other colors, and also try increasing
the Paint Levels setting for a smoother
transition.

Next, you’ll look at the Highlight setting.

8. Turn on Highlight.

Bright, hard-edged highlights appear in the
same places as the specular highlights in the
original material.

9. Set the Glossiness value to 20.

This works just like the Glossiness setting
in the Blinn shader: Reducing it enlarges
the highlight, while increasing it makes the
highlight smaller.

Modify the ink controls:

1. Create a new Ink ’n Paint material and apply it
to the plane.
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This lets you start over so you can isolate the
ink settings.

2. Close the Paint Controls rollout so the Ink
Controls rollout is completely visible.

3. First, turn off Ink.

Now only the painted surface is visible. As you
can see, the ink effect is very important for the
comics look. In most cases, you’ll want to keep
Ink turned on when using this material.

4. Turn Ink back on, and then turn on Variable
Width.

A slight difference is visible. You’ll increase the
maximum width to make it more apparent.

5. Set Max to 10.

Now it’s easier to see that the ink is thinnest
where the light intensity is high, and thickest in
the most deeply shaded areas. This replicates
the look of drawn comics, where the artists ink
the outlines of shadowed areas the thickest.

To conclude this lesson, you’ll look at some of
the available ink types.

6. Move down to the Outline setting, and turn off
its check box.

The outline vanishes, but the inner line of ink
remains. The software creates outline ink only
where the object’s edges meet the background.

7. Turn Outline back on, and turn off SmGroup.
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Now the lines acting like borders between
faces assigned to different smoothing groups
disappear.

8. Turn off Overlap.

Now the inner line of ink is gone. Overlap ink
is generated on the near surfaces when parts of
an object’s geometry overlap other parts.

9. Turn Overlap back on, and then turn on
Underlap.

The inner line of ink appears to have thickened.
Try toggling Underlap a few times. If you look
closely, you’ll see the thickness is added above
the Overlap line. That’s because Underlap
ink is generated on the far surfaces adjacent
to overlapping geometry (from the current
viewpoint). Try turning off Overlap to see the
difference.

Working with Maps

Lastly, you’ll look at how you can use a map to
give the rendering the look of a pencil/charcoal
drawing.

1. Create a new Ink ’n Paint material and apply it
to the plane.

2. Click the blue Lighted color swatch and set it
to white.

3. Set the Paint Levels to 5.

4. Turn off Shaded in the Paint Controls rollout.

5. Click the map button in the Shaded channel
(currently reads “None”), and then, in the
Material/Map Browser, double-click Noise.

6. On the Coordinates rollout, set the X tiling to
25, the Y-Angle to -45 and the Z-Angle to 45.
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7. On the Noise Parameters rollout, set Noise
Type=Fractal, Size to 100, High threshold to
0.6 and Low threshold to 0.4.

The paint now has a pencil stroke pattern
applied to the shaded areas.

The effect can be strengthened by playing with
the light sources in the scene.

8. Go to the Display panel and turn off Lights in
the Hide by Category rollout.

9. Zoom out in the Front view and select the omni
light above the plane.

10.Go to the Modify panel. In the
Intensity/Color/Attenuation rollout, set
the Multiplier value to 0.75.

Summary

You’ve scratched the surface of the Ink ’n Paint
material with this lesson, but there’s much more to
it than described here. For instance, you can use
any 3ds Max map to specify almost any material
component, and you can set each map’s intensity
to any percent between 0 and 100. You can use
ink to outline smoothing groups as seen on the
fighter plane in this exercise, but also on areas with
different material IDs, and set different colors for
each ink type. All of these settings let you achieve
a wide range of effects with Ink ’n Paint.

Translucent Shading

Translucent Shading

The Translucent shader in 3ds Max lets you
simulate substances that allow light but not clear
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images to pass through. An example of this is
the type of screen on which slides and movies
are projected. In this short lesson, you’ll use the
Translucent shader to set up a projection screen
where on its back surface you can see the image
being projected as well as the shadow of an object
between the projector and the screen.

Note: All the necessary files to do the tutorials can
be found on the Tutorial Files CD that ships with
3ds Max 8. Before doing the tutorials, copy the
\tutorials directory from the CD to your \3dsmax8
local installation.

Load and render:

1. Load the file tut_translucent_shader_start.max.
This is located in the \tutorials\materials_and_
rendering folder.

2. Activate the Camera02 viewport and render
the scene.

In the rendered image, you can see an image
being projected onto a screen, with a cutout of a
person walking in front of the projector casting
a shadow onto the screen.

3. Activate the Camera01 viewport and render the
scene again.

From this perspective, you can see the rear of
the screen, but no image or shadow appear on
it. You’ll make the scene look more realistic by
applying the translucent shader.

Change the shader:

1. In the Camera01 viewport, select the Screen
object, and press the M key to open the Material
Editor.

2. In the Material Editor, look at the fourth sample
sphere, at the left end of the second row.

The material is selected. Its name is Screen,
and you can tell that it’s applied to the selected
Screen object because of the solid white
triangles in the corners.

Currently, the Screen material uses the Blinn
shader, which is the default shader used by the
Standard material.

3. On the Shader Basic Parameters rollout, click
the drop-down list (where “Blinn” appears)
and choose Translucent Shader.
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The name of the second rollout changes
to Translucent Basic Parameters and a new
Translucency group box appears at the bottom
of the rollout.

You control the degree and color of translucency
with the Translucent Clr (Color) setting. By
default, this color is black, which effectively
turns off translucency.

4. Click the Translucent Clr color swatch, and use
the Color Selector dialog to set the Value to 174.

By using a shade of gray, you change the
translucency amount while maintaining a
neutral tone for the translucent material.

5. Close the Color Selector dialog, and then
render the Camera01 viewport again.

Now you can see the projected image and the
shadow from the rear.

You can load this version of the scene from the
file tut_translucent_shader_finish.max.

6. Try setting different colors and values for
Translucent Clr, and render each time to see
the difference. Also try setting different colors
for the material’s Diffuse and Translucent
components, and rendering from the front and
back.

The translucent color has no effect on the
diffuse color, and vice-versa. For realistic
results, use the same colors for both.

Summary

You learned how to work with the Translucent
shader and use it to simulate the effect of an image
shining through a projection screen. Other types
of objects exhibit translucency as well, such as
plastic and frosted glass. See if you can model
such an object and give it a realistic look with the
Translucent shader.

Animation

Animating with Auto Key
A bouncing ball is a common first project for new
animators. This classic example is an excellent
tool for explaining basic animation processes in
3ds Max.
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Skill Level: Beginner

Time to complete: 1 hour 45 minutes

Features Covered in This Tutorial

In these lessons you will learn:

• Creating animation using transforms.

• Copying keys in the track bar.

• Using ghosting to visualize in-betweens.

• Using tangent handles in the Function Curve
Editor to control in-betweens.

• Creating looping animation using Parameter
Out-of-Range Types.

• Animating using dummy objects.

• Using Layout mode.

• Applying Multiplier curves.

• Working with the Dope Sheet Editor to speed
up animation and reverse time.

• Using Weighted List controllers.

• Creating squash and stretch effects with the
Flex modifier.

• Animating using Set Key mode.

Tutorial Files

Files for this tutorial are found on the Tutorial Files
CD in the \tutorials\intro_to_animation directory.

Before starting the tutorials, copy the \tutorials
folder to your \3dsmax8 directory.

Creating Animation Using Auto
Key

In this lesson you’ll start learning how to animate
in 3ds Max.

Animate the ball using the Move transform:

1. Choose File > Open to open bounce_start.max.

The file can be found in the\tutorials\intro_to_
animation directory.

Note: The following illustrations display the grid
differently than you will see in your viewports.
For ease of use, press G on the keyboard to hide
the display of your grid.

Perspective viewport: bounce_start.max

This file has the Perspective viewport on the
left. This is not the standard viewport layout;
the layout has been customized for this lesson.

2. Click Auto Key to turn on this feature.

The Auto Key button and the time
slider background turn red to indicate that
you are in animation mode. The viewport is
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outlined in red, as well. Now, when you move,
rotate, or scale an object, you create keyframes
automatically.

Time Slider background turns red

3. Click to select the ball in the Perspective
viewport.

It is displayed within white selection brackets,
indicating that it’s selected.

4. Right-click the sphere and choose Move from
the Transform quadrant of the quad menu.

The Transform gizmo appears in the viewport.
The Transform gizmo lets you easily perform
constrained movements. As you move your
cursor over the Transform gizmo, the different
axes and their labels turn yellow.

5. Position the mouse cursor over the Z axis, and
when it turns yellow, click and drag upward to
raise the ball up in the air.
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As you move the ball up in the air, notice the
Z value changing in the Coordinate Display
below the track bar.

The ball’s position at frame 0 is now fixed above
the box.

A Position key is created when you do this. The
key is displayed on the track bar.

The track bar displays the keys for whatever is
selected in the viewport. The track bar is found
directly beneath the time slider and above the
prompt area.

Keyframe created in Auto Key Mode

6. Move the time slider to frame 15.

To move the ball precisely down to the table
surface, put your cursor in the Coordinate
display Z field, and change the value to 0.

Coordinate Display type-in for precision animation.

The box is built off the world origin, so a Z
position value of 0 will set the ball directly in
contact with the box.

Note: The World Origin, (0,0,0) in XYZ
coordinates, is shown by the intersection of the
dark lines on the Home grid.

Frame 15: Ball is in contact with the box

You need to make the ball rise up to its original
position at frame 30. Instead of moving to
frame 30 and moving the ball back up in the air,
you’ll use an alternate method.

Tip: You can zero the Z coordinate (or any other
spinner) by right-clicking the spinner arrows.

7. Put your mouse over the time slider’s frame
indicator (the grey box that currently reads
15/100 and right-click.

The Create Key dialog appears.

8. In the Create Key dialog, change the Source to 0
and the Destination to 30, then click OK.

This copies the key from frame 0 to frame 30.

9. Click Play Animation to play the
animation, or drag the time slider back and
forth between frames 0 and 30.

The ball moves down and up between frames 0
and 30, and stays up in the air between frames
30 and 100.

10. If you clicked Play Animation, click Stop
(the same button) to end the playback.

Next, you’ll set the length of the active time
segment to 30 frames.
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11. In the time controls, click Time
Configuration.

12.In the Time Configuration dialog > Animation
group, set End Time to 30. Don’t click the
Re-Scale Time button. Click OK.

3ds Max lets you work in an active time segment
that’s a part of a larger animation. Here you are
making frames 0 through 30 the active time
segment. Notice that the time slider now shows
only these frames. The other frames still exist,
they just aren’t part of the active segment at the
moment.

13.Play the animation.

The ball goes up and down. Since the first and
last frames are the same, the animation appears
to cycle as it plays.

The ball moves, but it doesn’t have “bounce”
yet.

14.Stop the animation playback.

3ds Max made decisions on how the
in-betweens are being distributed. Right now
they are evenly distributed so the ball has no
acceleration. It doesn’t speed up or slow down;
it just floats along with no sense of weight.

You need to simulate the effect of gravity so that
the ball slows to a stop at the top of its bounce,
speeds up as it approaches the table, and then
bounces up again. To accomplish this, you’ll
use the key interpolation curves available on
the Curve Editor. You’ll also use the Ghosting
feature to help visualize what the interpolation
curves are doing.

Controlling In-Betweens

To make the ball bounce more convincingly, you’ll
change the interpolation on the key at frame 15.

You’ll use the tangency handles available in the
Curve Editor. The tangency of the curve will

determine the position in space of the in-between
frames. Ghosting will let you see where the
in-betweens are being positioned.

Using ghosting to visualize in-betweens:

1. Move the time slider to frame 15.

2. From the Views menu, click Show Ghosting to
turn on this feature.

The ghosting feature shows object positions
before the current keyframe in an aqua color.

3. Go to Customize menu > Preferences >
Viewports tab, and set Ghosting Frames to 4
and set Display Nth frame to 3. Click OK to
exit the dialog.

The viewport displays the ghosting.

Ghosting shows the object positions on previous
keyframes.

4. Play the animation, and then stop.

5. Now, to control the in-betweens, right-click the
ball in the viewport and choose Curve Editor.

The Function Curve Editor is displayed across
the top two viewports.

The Curve Editor is composed of two windows,
a Controller window on the left that shows the
names of tracks, and a Keys window on the
right that shows keys and curves.
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6. In the Controller window on the left, click to
select only the Z position track.

Note: If you don’t see the Z Position track, click
the plus icon to the left of the Sphere to expand
the Sphere’s tracks. If you don’t see a plus icon,
right-click and choose Manual Navigation, then
hold down ALT and right-click, then choose
Expand from the quad menu.

There are a lot of possible configurations in the
Curve Editor, so you may encounter variations
from the standard.

Now the only curve displayed in the Keys
window is the one you want to work on.

Function curve for bouncing ball Z position

7. Move the Track View time slider (the double
aqua line in the Key window).

As you move back and forth the animation
plays in the viewport.

If you look carefully you’ll see a dark dot on the
curve at frame 15.

8. Drag around the dark dot (the position key)
to select it.

The selected key turns white on the curve.

To manipulate the curve you need to change the
tangency type so you have access to tangency
handles.

9. On the Track View toolbar, click Set
Tangents To Custom.

If you look carefully you’ll see a pair of black
tangency handles have appeared on the curve.

10.Hold down the SHIFT key and drag the left
handle on the left upwards in the Key window.
The SHIFT key allows you to manipulate the
left handle independently from the right.

The curve now looks like this:

SHIFT key allows for manipulation of individual handles.

You’ll change one more setting to make this tool
more useful.

Using Interactive Update:

1. On the Track View Settings menu turn on
Interactive Update. Now move the time slider to
frame 15, then manipulate the tangency handle
while observing the effect in the ghosting. You
can clearly see the changes as you work.

2. Set the tangency handle so the in-betweens are
mostly drawn toward the raised position (see
the illustration that follows). With interactive
update on you can do this with very fine
control.

Interactive update and ghosting
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3. Move the time slider to frame 30, then adjust
the right tangency handle so it approximately
matches the left one.

By manipulating this handle you can get
different effects. The upward movement of the
ball as it bounces off the table will determine
the perception of the weight of the ball. The ball
will appear to be bouncy, like a tennis ball, if
the two handles are similar. The ball will appear
to hang in space if enough of the in-betweens
are drawn close to the topmost position.

4. Turn off Views > Show Ghosting and
then play the animation. Concentrate on the
movement of the ball. Adjust the curve handles
some more while the animation plays. Observe
the effect.

The ball leaves the table as quickly as it hit it,
then begins to slow down as it rises.

5. Play the animation, and then stop.

The ball has bounce now. It looks like there is
gravity at work here.

When you see something you like in the
viewport, it’s a reminder that you should save
your work. It’s easy to forget while you’re being
creative.

6. Save your work as mybounce.max.

You’ve made the ball bounce once. In the next
section you’ll learn to repeat the bouncing of the
ball using Out-of-Range types in Track View.

Adding Parameter Curve
Out-of-Range Types

You can repeat a series of keys over and over in a
variety of ways, without having to make copies of
them and position them along the time line. In this
lesson, you’ll add Parameter Curve Out-Of-Range
Types to the ball’s position keys. Out-Of-Range
Types let you choose how you want the animation
to repeat beyond the range of the current keys.
They have the advantage that when you make
changes to the one set of keys, the changes are
reflected throughout the animation

Most of the tools in Track View are available both
from menu choices and from toolbars. This feature
is also on the Controllers menu.

Repeat keyframed motion:

1. Continue from the previous lesson, or open
bounce_repeat.max. This is a 3ds Max scene
with the ball bouncing once.

2. If the Curve Editor isn’t displayed already, select
the ball in the viewport, right-click, and choose
Curve Editor from the quad menu.

3. In the Controller window, make sure that only
the Z Position track is selected.

Before you repeat the keyframes, you’ll extend
the length of the animation.

4. Click Time Configuration. This button is
beneath the Go To End button in the animation
playback controls at the bottom-right corner of
the interface (not Track View).

5. Change the Animation End Time to 120.

This adds 90 blank frames onto the existing
30 frames. It doesn’t stretch the 30 frames
over 120. The ball will still be bouncing once
between frames 0 and 30.



230 Chapter 3: Getting Started

6. Now, back in Track View, click the
Parameter Curve Out-Of-Range Types button
on the toolbar.

Parameter curve out-of-range type choices

7. Click both boxes under the Cycle graph to
choose Cycle for In and Out. Click OK.

8. Click Zoom Horizontal Extents on the
Navigation: Track View toolbar at the lower
right corner of the Track View window.

The Keys window zooms back so the entire
time segment is visible. The Parameter
Out-of-Range curves are displayed as dotted
lines.

Parameter Out-of-Range curve

There are no keys beyond frame 30. Any change
made to the original keys will be reflected in
the looping.

Tip: You can create keys for the out-of-range
curves by choosing Utilities > Track View
Utilities > Create Out of Range Keys.

9. Play the animation.

The ball bounces over and over.

10.Save your work as mybounce_repeat.max

Next, you will learn to link the ball to a dummy
object and then use the dummy to animate the
position of the ball. This allows you to keep the
bouncing independent from the position, and
makes it easier to control the animation.

Animating with Dummy Objects

In this lesson, you will link the bouncing ball to a
helper object. Then you can animate the helper so
that the ball bounces across the top of some text.
This animation technique is useful because you
can control the ball’s bouncing and its traveling
motion independently.

Set up the lesson:

1. On the File menu choose Open.

2. Navigate to the \tutorials\intro_to_animation
directory on your hard disk and open
bounce_dummy.max.

This file is similar to the bouncing ball created
in the last lesson. The only difference is that it
has a text object prepared for you in the scene
and it has a longer active time segment.

Tip: If you want to keep using your own
bouncing ball, you can merge the text object in
from the bounce_dummy.max file using File >
Merge. Or create your own.

3. If you didn’t open bounce_dummy.max.,
you’ll need to extend the active time segment
to 240 frames. Click the Time Configuration
button and then in the Animation group change
End Time to 240.
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Create a dummy object:

1. Go to frame 0, if you’re not there already.

2. Right-click the Top viewport to activate it, then
zoom in on the ball and the box.

3. On the Create panel, click the
helpers button, then on the Object Type rollout
click Dummy.

4. In the Top viewport, move the cursor over the
ball.

Tip: Move the Layers and Extras toolbars away
from the Top viewport

5. Press the mouse button and drag outwards to
create a dummy object.

Make the dummy in the Top viewport.

If you look in the Front viewport, you’ll see that
while the ball is up in the air, the dummy is
positioned at the same level as the box.

Dummy created below the ball

Next you will align the dummy so that it is
centered over the sphere when viewed from
the top.

6. On the toolbar, click Align. Then in the
Top viewport, click the Sphere.

The Align Selection dialog is displayed.

7. On the Align Selection dialog, turn on X
Position and Y Position, but leave Z turned off.
Click OK.

You’ll see the dummy shift position so it is
aligned to the sphere.

Next, you’ll align the dummy’s pivot point with
its base, and you will position the dummy so
that it sits on top of the box. The idea is to
set up the dummy so that its pivot point will
match where the ball bounces. Then placing
the dummy on any frame in time will ensure
the correct alignment.

8. Select the dummy object, and go to the
Hierarchy panel.

Instead of moving the pivot, you will move the
object using Affect Object Only. This moves the
object but leaves the pivot unmoved.
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9. On the Adjust Pivot rollout, click Affect Object
Only to turn it on.

The pivot icon is displayed in the viewport.

Pivot point tripod display

Now you can move the object to change its
relationship with the pivot point.

10. Turn on Select And Move, and raise
the dummy cube so its base is level with the
pivot tripod. Use the Transform gizmo so the
dummy only moves up.

You don’t want to move in any other axis, since
the dummy is already centered properly in the
other axes.

Tip: You can increase the size of the transform
gizmo by pressing = repeatedly on the keyboard
until the gizmo is the size you want.

Equals key used to grow the transform gizmo

11.Turn off Affect Object Only.

Now you will link the ball to the dummy. The
dummy will become the parent to the bouncing
ball.

Link the ball to the dummy:

1. In the Front viewport, zoom in so you can see
the dummy and the ball.

2. On the main toolbar, turn on Select And
Link.

3. Move the cursor over the ball, then press and
hold the mouse button.

The cursor changes to two interlinked boxes.

4. Move the mouse to the dummy. A rubber-band
line follows the cursor. When the cursor passes
over the dummy, it changes again. One box is
white, showing you this object (the dummy)
will be the parent of the first object (the ball).
When the cursor has changed, release the
mouse button.
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Link the ball to the dummy

You just linked the ball to the dummy.

You can also create linkages in Schematic View.
For something this simple, it’s easier to link
directly in the viewport.

When you’ve created a linkage, it’s a good idea
to test it out to make sure you did what you
think you did.

Verify that you’ve created the hierarchy:

1. On the toolbar, turn on Select Object.

2. Press H to select by object name.

3. On the Select Objects dialog, turn on Display
Subtree, it is isn’t already on.

The Sphere01 object should appear indented
below Dummy01 in the list.

4. Click Cancel to exit the Select Objects dialog.

5. You can also test a linkage by transforming
the parent object. Rotating the dummy in the
viewport will affect he ball as well. If you do
this, then undo the transform once you’ve
tested your linkage.

Testing the linkage

Now you’re ready to animate the dummy. You’ll
use simple Auto Key animation first, just so you
can understand the process.

Animate the dummy:

1. Grab the divider lines between the viewports
and drag them so the perspective viewport is
wide screen.

2. Turn on Auto Key

3. On the main toolbar, turn on
Select And Move.

4. At frame 0, move the dummy so it is to the left
of the box in the Perspective viewport.

Dummy at frame 0



234 Chapter 3: Getting Started

5. Use the time slider
to move to frame 15, or type 15 in the Go To
Frame field.

6. Move the dummy using the Transform gizmo
so the ball is touching the box.

Dummy at frame 15

You just set two keys for the dummy, one at the
start location at frame 0 and a second at frame
15.

7. Go to frame 30 and move the dummy again to
the right of the box, so the ball continues to
bounce away, rather than straight up in the air.

Dummy at frame 30

You’ve now set a third key at frame 30. If you
play the animation, you’ll see the ball bounce
off the box as if it had been tossed.

You can display the trajectory of the ball to help
visualize the animation. Here’s how.

8. On the main toolbar, turn on Select
Object.

You can use any transform tool for this,
but using Select Object ensures you don’t
accidentally transform the object.

9. Select the ball, and then right-click it.

10.Choose Properties from the quad menu.

11.In the Object Properties dialog, in the Display
Properties group, turn on Trajectory.

Trajectory display for the ball

12.Play the animation.

You see the ball bouncing onto the box and off,
following the trajectory.

Try Layout mode:

If you turn off Auto Key and move the dummy,
you will be moving the entire animation in space.
When both Auto Key and Set Key are off, you are
working in what is known as Layout mode. Here
you will use Layout mode, so that instead of the
ball bouncing on the block, the ball bounces off
the letter F.

1. Turn off Auto Key Mode.

The red disappears in the time slider
background and viewport outline.

2. Move the dummy object back toward the text.
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3. Watch the position of the trajectory and move
the dummy until the bounce point of the
trajectory intersects the top of the letter F.

Layout Mode lets you move the animation in space.

Bounce the ball on the letters:

Now you’ll repeat what you’ve learned to create the
ball bouncing on the letters.

The ball bounces 8 times, making contact with
the letters at frames 15, 45, 75, 105, 135, 165, 195,
and 220.

1. Turn on Auto Key.

2. In the track bar, select the key at frame 30 and
delete it.

3. Move the time slider to frame 45 (or enter 45 in
the Current Frame field).

4. Position the dummy so the ball bounces on the
double L’s in the word “Follow”.

5. Move the time slider, then the dummy so the
ball bounces on the following letters at these
frames.

• F at frame 15

• ll at frame 45

• w at frame 75

• th at frame 105

• b at frame 135

• u at frame 165

• c at frame 195

• ba at frame 225

6. At frame 240, move the dummy so the ball
move away from the letters.

7. Play the animation and observe the results.

8. Save your work as mybounce_text.max. If
you had any trouble, you can open the file
bounce_text.max to see the correct animation
so far.

Next you will learn to use a multiplier curve to
affect the height of the bouncing ball.

Add a multiplier curve:

1. Select the ball in the viewport, right-click and
choose Curve Editor.

The Curve Editor window is displayed, if it
wasn’t already visible.

2. In the Controller window, click the Z Position
track.

3. On the Curves menu, choose Apply Multiplier
Curve. In the Controller window, click the plus
icon. Click the Multiplier Curve to highlight
it, then hold down the CTRL and click the Z
Position track. This way you have only these
two curves displayed.

In the Controller window, the Multiplier curve
is added beneath the Z position track. It’s not
very noticeable in the Keys window on the right.

The scaling of the multiplier track is quite small,
so the slightest change to a key could result
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in a large change in the animation. You can
counteract this by zooming in on the multiplier
track.

4. On the Navigation: Track View toolbar
(at the lower right of the Keys window), click
the Zoom Region button. Drag a zoom region
window around the key at frame 240 on the
multiplier track.

5. On the Settings menu, turn on Interactive
Update.

6. On the Track View toolbar click Move
Keys to turn it on, then move the multiplier key
downward, while observing the effect on the
trajectory in the Perspective viewport.

Lowering the multiplier curve shows effect on Z position
curve in Keys window

Don’t move it below the horizontal zero value,
or you will get some strange effects.

Multiplier curve shown on trajectory

Tip: You can type in precision values on the Key
Stats: Track View toolbar.

While working with Multiplier curves, if you’re
not sure you like the results, you can just turn
them off. Select the Multiplier curve in the
Controller window, then on the Curves menu
choose On/Off.

7. Click Zoom Horizontal Extents on in the
Navigation toolbar to see the entire curve again.

Using the Dope Sheet Editor

Track View also has a mode called Dope Sheet,
which lets you work with keys and ranges. In this
lesson, you’ll use the range function to make your
animation go faster. You’ll also use the Time tools
to reverse your animation.

Speed up the animation:

The bouncing ball doesn’t have enough pep. To
speed up the animation, you’ll use Edit Ranges in
Dope Sheet mode.

1. Continue from before or open bounce_
multiplied.max.

2. Select the dummy object in the viewport. Then,
on the Graph Editors menu, choose Track View
— Dope Sheet.

3. On the Keys: Dope Sheet toolbar, click
Edit Ranges. By default, the Keys: Dope Sheet
toolbar is on the top left.

The Keys window now displays the ranges for
the animation.

4. In the Controller window, highlight the item
label Dummy01. This way you will adjust the
ranges of all the dummy’s tracks at the same
time.

Before making changes to the dummy, you
want to make sure you also are making changes
to the bouncing ball as well. Since the bouncing
ball is the child of the dummy, you’ll use the
Modify Child Keys button.
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5. On the Display: Dope Sheet toolbar,
click Modify Child Keys to turn it on.

Now the changes you make to the dummy range
will also be applied to the bouncing ball.

6. Click the end of the Dummy range and drag it
to the left to around frame 100.

Range bars used to speed up the animation

This compresses the animation for the dummy
and the bouncing ball so it happens within 100
frames.

Tip: You can raise the time ruler up from
the bottom of the Keys window for greater
precision.

7. Play the animation.

The animation plays faster. The ball continues
bouncing at the end of the animation. There
are several different ways you could correct this.
You could try to use an ease curve to stop the
animation, or create keys from the out-of-range
curve, and then delete the keys. Or you can set
the active time segment to 100 frames.

8. Click the Time Configuration button
beneath the animation playback controls.

9. Change the Animation End time to 100.

Reverse time:

You can reverse the animation by using the Time
tools available in Dope Sheet mode. It’s easy to do.

1. On the Keys Dope Sheet toolbar, click
Edit Keys.

The range bars are replaced with keys.

2. On the Time menu, choose Select.

When working with Time commands, you first
select the time, then make changes to it.

3. In the Keys window, on the Dummy track, drag
from frame 0 to frame 100 to select the time.

The time is displayed as a light yellow band in
the Dummy track.

Time displayed as light yellow band

4. On the Time menu, choose Reverse

The animation plays backwards. The ball
bounces from right to left instead of left to
right, and the last bounce now happens on the
letter F instead of the double L in ball.

Tip: You can easily reverse the playback of an
animation using controls found in the Time
Configuration menu. But if you need to actually
reverse the keys, this is the technique to use.

Using Weighted List Controllers

There are many different animation controllers
in 3ds Max. Each one has its own attributes,
strengths, and uses. Each one has techniques
associated with it. Controllers can be combined
using weighted list controllers. By changing or
animating the weights of controllers in a list, you
can adjust each controller’s effect, and animate in
a nonlinear way. Here, you’ll learn to animate the
weights and to see what they can do.

Use the Weighted List controller:

With the Position List controller, you can add
other controllers on top of the Bezier Position
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controller you already have. Here you will add
a Noise controller to layer the animation of a
Ping-Pong ball.

1. Choose File > Open to load pingpong_
volley.max.

A Ping-Pong ball and table are visible.

Tip: If the texture on the table looks wrong,
right-click the Perspective viewport label and
choose Texture Correction.

Ping-Pong volley

2. Play the animation.

The Ping-Pong ball bounces over the net in a
simulated volley. The last four bounces happen
in place. You can use weighted list controllers
to remove those last four bounces, and replace
them with a rolling motion. A Noise controller
can be added to get rid of the bouncing, and
instead you will have the ball wobble around
on the table, then stop.

3. Select the Ping-Pong ball.

4. Open the Motion panel and expand the Assign
Controller rollout.

Notice that the Assign Controller rollout
displays the Position controller as a Bezier
Position for the Ping-Pong ball. Use the pan
hand in the window to read the label.

There are at least three different places where
you can assign a controller to an object: in
Track View windows, on the Motion panel,

or from the Animation menu. You’ll use the
Animation menu to assign the controller, and
the Motion panel to edit the weights.

5. On the Animation menu (not on the Motion
panel), choose Position Controllers > Noise.

The viewport trajectory changes into a frenzied
red spline. Don’t worry, this is correct.

Noise controller: A frantic trajectory

Note: When you assign a controller from the
Animation menu, a weighted list controller is
automatically added to your object.

6. On the Motion panel, in the Assign Controllers
rollout, expand the position list, and then the
Noise Controller.

You can see that Noise Strength is indented
beneath the Noise Position. If you scroll down
a little, you can see that the Weight is listed as
well.
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The new Noise Position track appears below
the Bezier Position track. The old animation
has not been replaced; instead, the new Noise
controller has been added to it.

If you play the animation, the ball flies all over
the place. It is following the position controller
tracks and the noise controller tracks. This
probably isn’t what you want here. You will
need to adjust the noise parameters and the
weighting of the controllers.

Adjust the Noise Frequency and Strength:

1. In the Assign Controllers window, highlight
and then right-click the Noise Position entry
and choose Properties.

The Noise Controller properties dialog is
displayed

2. Change the Frequency to something very small,
like 0.009.

3. Change the Z Strength to 0.0.

Important: If you miss this step, the tutorial won’t

work. The Z strength counteracts the up-and-down

bouncing movement.

4. Change the X Strength and Y Strength to 1.0.

This creates the motion of the ball wobbling
around on the table surface.

Noise Controller Properties dialog

5. Play the animation

The Noise is now less jittery, in fact barely
visible. You need to weight the controllers so the
noise doesn’t affect the bouncing until frame
201, and to turn off the position controller after
frame 200.

Animate the weights:

1. Turn on Auto Key.

The Auto Key button turns red.

2. Move to frame 200.

You’ll set keys at frames 200 and 201 for the
Bezier Position. You’ll also set keys at frames
200, 201 and 0 for the Noise.

3. Open the Position List rollout, then in the
window select the Bezier Position layer.

4. Locate the Weight field, then SHIFT+right-click
the spinner arrows.

The spinner is outlined in red, showing a
keyframe has been placed there.

Tip: You can set keys this way in both Set Key
and Auto Key modes.

5. Select the Noise Position layer in the Position
List rollout.

6. Right-click the spinner.

The Weight value is reset to 0, and a key is set.

Tip: Right-click any spinner to reset the value to
0 and set a key. SHIFT+right-click any spinner
to add a key without changing the value.

7. Move to frame 201.

Tip: You can use the . key on the keyboard to
move ahead one frame at a time. You can also
click the arrows on either side of the frame
indicator on the time slider.

8. With Noise still selected, enter 100 in the
Weight field,



240 Chapter 3: Getting Started

9. In the Position List, select the Bezier Position
layer, then right-click the Weight spinner to set
the value to 0 and set a key.

This removes the bouncing from this point on.

10. In the animation playback controls, click
Go To Start .

11.Select the Noise Position in the Position list,
then set the Weight value to 0.

12.Play the animation.

Ball stops bouncing after frame 200, rolls around table

The Ping-Pong ball bounces across the table,
then stops bouncing, but still rolls around a bit.

13.If for some reason the ball is rolling around
in the air, instead of on the table, go to frame
201 and move the dummy object down until
the ball comes into contact with the table.
Use this technique to correct any other errant
movement.

14.To stop the ball’s movement altogether, go to
frame 250 and keyframe the Noise weight to
0. Play the animation. The ball stops moving
completely at frame 250.

15. Turn off Auto Key.

16.Save your work as mypingpong_layered_
animation.max.

You can open pingpong_layered_
animation.max to compare your work
with a completed tutorial file.

Adding Squash and Stretch with
Modifiers

To create the illusion of cartoon movement,
traditional animators rely on a technique called
squash and stretch. For example, if a cartoon
villain runs off a cliff, he will not descend to earth
until he notices that he is suspended in the air.
When he does descend, he will stretch on the way
down, and then squash when he hits the desert
floor.

In this topic, you’ll add a little squash and stretch
automatically to a Ping-Pong ball using the Flex
modifier.

Note: You could also use XForm modifiers to
manually achieve the same squash and stretch
created in this lesson. You would use non-uniform
scale transforms on the modifier gizmo to do this,
rather than directly scaling the object, which can
lead to unexpected results.
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Flex modifier creating squash and stretch

Use the Flex modifier to generate squash and stretch:

1. Open pingpong_layered_animation.max and
select the Ping-Pong ball.

Files for this tutorial are on the Tutorial Files CD
in the \tutorials\intro_to_animation directory.

2. On the Modify panel, open the Modifier List,
and then locate and click the Flex modifier.

3. Play the animation in the viewport.

There’s a little too much squash and stretch.

4. Reduce the Flex parameter to about 0.3and play
the animation again.

The ball is automatically stretched by the
movement along the path. You can adjust a
path value to improve this.

5. While the animation is playing, try entering
different values in the Flex field. Also
experiment with the Strength and Sway values.
A good combination is a high strength (say 11)
and a low sway (around 1). You can animate
the Flex parameters to vary the effect.

Still another approach is to set all the keys
yourself using a Stretch modifier to distort the
ball. As mentioned earlier, you could squash
the ball by putting an XForm modifier on it
and then using Non-uniform Scale to reshape
the gizmo. You could also squash the ball using
free-form deformation (FFD) modifiers. Or
you could use a Path Deform modifier. There
are many possibilities.

Summary

In these Animation tutorials you have been
introduced to the techniques of creating
animation. You have learned to animate a
bouncing ball using the Auto Key button
and transforms. You have learned to control
in-betweens using key interpolation and ghosting,
and how to loop animation using Track View
controls. You’ve learned about animating with
dummy objects, using the Dope Sheet editor and
weighted list controllers. Finally you’ve created
squash and stretch effects using the flex modifier.

Flying a Spacefighter
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In this tutorial, you’ll animate a spacefighter to
make it fly along a simple path by using the path
constraint. You’ll also learn how to blend paths.

Skill Level: Beginner to Intermediate

Time to complete: 1 hour

Features Covered in This Tutorial

In this tutorial you will learn:

• Animating with Path constraints.

• Using dummy objects for animation.

• Using weighted list controllers to add
turbulence.

• Setting keys using the Set Keys button.

• Controlling Euler controller rotations.

• Substituting high resolution objects for low
resolution objects by using XRefs.

Tutorial Files

All the necessary files for this tutorial can
be found on the Tutorial Files CD in the
tutorials\intro_to_animation directory. Before
starting the tutorials, copy the \tutorials folder to
your local\3dsmax8 installation.

Adding and Adjusting Flight Paths

In this first exercise, you’ll assign a path constraint
to the spacefighter and have it fly along a path.
You’ll also set a few path parameters to improve the
flight dynamics of the spacefighter.

Set up the lesson:

• Load the flyingspacefighter.max file.

Files for this lesson are in the
tutorials\intro_to_animation folder.

This scene includes the following:

• A spaceship named SpaceFighter.

• A path, Path01.

• A (hidden) camera named SpaceCam.

Assign a path constraint:

1. In the Top viewport, select SpaceFighter.

2. From the Animation menu, choose Constraints
> Path Constraint.

You’ll see a dotted line linking the spacefighter
and your cursor.

3. Click the green line, Path01.

Once you pick the path, the spacefighter jumps
to the start point of the path.
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Note: The Motion panel is automatically opened
on the command panel.

4. From the Motion panel, slide the rollouts
up until you can see all of the Path Parameters
rollout, if necessary.

You’ll see that Path01 has been added to the
path list.

5. Activate the SpaceCam viewport and play the
animation.

The spacefighter moves along the path, but it’s
not facing the right direction and it slows down
when it gets to the curves.

6. In the Path Options group of the Path
Parameters rollout, set the following:

• Turn on Follow: the spacefighter follows the
path and turns as the path curves, but it’s
perpendicular to the motion path.

• In the Axis group, change the axis to Y: the
spacefighter is reoriented and faces along
the path, but it’s flying backwards.

• Turn on Flip: the spacefighter now faces the
direction it will move on the path.

7. Play the animation again.

Now the spacefighter is moving along the path
properly, but its flight dynamics don’t look very
realistic.

Improving the Flight Characteristics

In this section, you’ll improve the flight
characteristics of the spacefighter. You’ll make it
look more realistic when it enters and exits turns.
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Make the flight more realistic:

1. Leave the SpaceCam viewport active and
confirm that Constant Velocity is turned on in
the Path Options group.

2. Play the animation.

Now the spacefighter doesn’t slow down as it
enters the curves. It has a fluid, continuous
motion now, but still doesn’t look very realistic.

3. Now turn on Bank and play the animation
again, if it isn’t still playing.

Now the spacefighter banks as it goes through
the turns. It’s subtle and needs to be made more
pronounced.

4. Use the Bank Amount and Smoothness settings
to make the spacefighter look like it’s really
banking into the curves of the path. Make the
following settings:

• Set Bank Amount to 7.0.

Bank Amount controls how far an object
rolls to either side of the path it travels along.

If you were sitting in the cockpit, positive
values roll the starfighter to the left and
negative values roll to the right. Be careful
how high you set Bank Amount. If too high,
the spacefighter will roll all the way over.
Experiment with different settings and put it
back to 7.0 before continuing.

• Set Smoothness to 1.0.

Smoothness controls how rapidly the roll
changes as the starfighter moves through
bends in the path. Smaller values make
the object more responsive to changes in
the curve while larger values smooth out
jerkiness.

The spacefighter has a smoother look as it
rights itself when coming out of the turns.
Try increasing the Smoothness and see what
happens.
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Note: You can change settings while the
animation is playing.

5. Save your scene as MySpaceFighter01.max.

Animating the Path of the Spacefighter

The parameters in the Path Parameters rollout can
be animated. In this section, you’ll make a few
animated setting changes and see what happens
to the spacefighter.

Animate path parameters:

1. Move the time slider to frame 60.

2. Turn on Auto Key and set Bank
Amount to 6.0.

You’ll see a new key added to the timeline at
frame 60.

3. Slide the time slider to 75 and set Bank Amount
to 12.0.

4. Turn off Auto Key and play the animation.

As the spacefighter enters the second curve,
it makes a drastic rolling turn, as if evading a
missile or dodging a laser.

5. Save your scene as MySpaceFighter02.max.

Blending Paths

So far, you’ve worked with a single path. 3ds Max
allows you to blend multiple paths, which can
result in some interesting motion effects.

Set up the lesson:

• Open the file flyingspacefighter02.max.

Files for this lesson are in the
\tutorials\intro_to_animation folder.

This scene includes the following:

• A spaceship named SpaceFighter.

• Two paths, Path01 (green) and Path02 (red).

• A camera (hidden) named SpaceCam.

Fly the spacefighter along blended paths:

1. Select SpaceFighter and open the Motion
panel.

Spacefighter is already constrained to Path01.

2. In the Path Parameters rollout, click the Add
Path button.

3. Select Path02, the red path.

Notice how the spacefighter is positioned
halfway between the two paths. This is because
each path is influencing the spacefighter equally.

4. Click the Add Path button to turn it off.
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5. Activate the SpaceCam viewport, if it’s not
already active, and play the animation.

The Weight setting controls how much the
spacefighter is affected by each path.

6. Select Path01 and set Weight to 25.

7. Play the animation again.

The spacefighter follows Path02 more closely
because it has a greater weight then Path01.
Experiment with different Weight settings for
each path and see what happens.

8. Save your scene as MySpaceFighter03.max.

Animating the Spacefighter with
Constraints and Controllers

In this lesson, you’ll use an assortment of
constraints and controllers with a flight of
spacefighter on a mission.

Set up the lesson:

• Open flyingspacefighter03.max.

Files for this lesson are in the
tutorials\intro_to_animation folder.

The scene already contains the following:

• A flight of three spacefighters, FlightLeader,
Wingman01 and Wingman02.

• A dummy object, SpaceshipControl.

• Two motion paths, flightpath (visible) &
wingmanpath (hidden).

• A camera (hidden), SpaceCam.

Using a Dummy Object to Control the
Flight

Dummy objects are very useful when setting up an
animation. By animating a dummy, you can focus
on getting your motion set up using a very simple
object that doesn’t slow down your system. Once
the dummy animation is complete you link objects
to the dummy. Now wherever the dummy moves,
the object goes with it.

Link the spacefighters to the dummy:

1. Activate the Top viewport, if it’s not
already active, and click the Select And Link
button from the Main toolbar.

2. Select FlightLeader and drag the cursor over the
dummy, SpaceshipControl. Release the mouse
button.

FlightLeader is now linked to the
SpaceshipControl. Wherever you move
SpaceshipControl, FlightLeader will follow.
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3. Link both Wingman01 and Wingman02 to
SpaceshipControl.

Add a path constraint to the dummy:

1. In the Top viewport, use Zoom Extents
to view the scene.

2. Select SpaceshipControl.

3. From the Animation menu, choose Constraints
> Path Constraint. Drag the cursor and click
the flightpath.

SpaceshipControl jumps to the beginning of
the path. The spacefighters follow along since
they’re linked to the dummy.

4. In the Path Parameters rollout, make the
following settings.

• Turn on Follow, Bank, and Constant
Velocity.

• In the Axis group, turn on Y and Flip.

• Set the Bank Amount to 7.0 and the
Smoothness to 1.0.

5. Activate the SpaceCam viewport and play the
animation.

All three spacefighters move along the
flightpath.

6. Save the scene as MyFlight01.max.

Making the Camera Follow the Action

In this exercise, you’ll use the Link Constraint
to make the camera follow the flight as it passes
by. Continue from the last lesson or load
flyingspacefighter04.max

Add link constraint to the camera:

1. Open the Display panel and turn off
Cameras in the Hide By Category rollout.

The camera, SpaceCam, will appear.
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2. In the Top viewport, use Zoom Extents to
view the scene. Select the camera target.

Also make sure the time slider is set to frame 0
(zero).

3. From the Main menu, choose Animation >
Constraints > Link Constraint. Click the
flightpath to set the first Link Parameter at
frame 0 (zero).

4. Move the time slider to frame 80 and click the
Add Link button in the Link Params rollout.
Click SpaceshipControl.

5. Click Add Link to turn it off.

6. Activate the SpaceCam viewport and play the
animation.

The camera target is linked to the flightpath
from frames 0 to 79. At frame 80, the
camera target begins to specifically track the
SpaceshipControl object.

7. Save the scene as MyFlight02.max.

Your Flight Leader Gets Cocky

Your flight leader has a pretty bold character. He
or she feels a victory roll is in order as the flight
passes by your vantage point from SpaceCam.
In this exercise, you’ll use the Orientation
Constraint to control the rotation of the flight
leader’s spacefighter as it performs a barrel
roll. Continue from the last lesson or load
flyingspacefighter05.max.

1. In the Top viewport, use Region Zoom to
view the three spacefighters.
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2. On the Create panel, click Helpers, then
Dummy. Create a new dummy object near the
FlightLeader and name it barrelroll.

3. Click Select And Link and link barrelroll
to SpaceshipControl.

4. From the Tools menu, choose Align, and click
SpaceshipControl.

The Align Selection (SpaceshipControl) dialog
appears.

5. In the Align Orientation (Local) group, turn on
the X, Y, and Z axis controls and click OK.

The barrelroll dummy aligns to the
SpaceshipControl.
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6. On the Motion panel, open the Assign
Controller rollout, if it’s not open, and select
the Rotation: Euler XYZ controller.

7. Click the Assign Controller button and
choose TCB Rotation from the Assign Rotation
Controller dialog.

Note: This will be very important later on, so
don’t miss this step.

Animate the victory roll:

1. Select the FlightLeader in the Top viewport.

2. Open the Animation menu and choose
Constraints > Orientation Constraint. Move
the cursor over the barrelroll dummy and select
it.

You’ll see barrelroll added to the Orientation
Constraint Target list on the Motion panel.

3. Select barrelroll and make sure the time slider
is at frame 0 (zero).

4. Turn on the Set Key toggle
and click the Set Key button.

5. Move the time slider to frame 110 and
click Set Key again.

You’ve added two keys that will keep the
FlightLeader flying normally from frames 0 to
110.

6. Activate the SpaceCam viewport and move the
time slider to frame 130.

7. Click Select And Rotate and change the
Reference Coordinate System to Local.
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8. Click the barrelroll dummy and rotate it around
the Y-axis to about 180 degrees and click the
Set Key button.

Note: If you’d like to be precise, you can enter
the rotation in the Y-axis type-in field on the
status bar.

9. Move the time slider to frame 150 and rotate the
barrelroll dummy around the Y-axis another
180 degrees and click the Set Key button. Turn
off the Set Key Toggle when you’ve finished.

10.Save the scene as MyFlight03.max and play the
animation.

A Wingman in Trouble

While the FlightLeader is performing stunts,
Wingman01 seems to be having some trouble. He
doesn’t seem to be flying as smoothly as the others.
In this exercise, you’ll use the Noise Controller
to add some turbulence to Wingman01 flight
dynamics. Continue from the last lesson or load
flyingspacefighter06.max.

Note: If you continue from the last lesson, make
sure the time slider is back on frame 0 (zero).

Add turbulence:

1. In the Top viewport, use Region Zoom to
view the three spacefighters, if you haven’t done
so already.

You might have to do a Zoom Extents first, then
a Region Zoom to see the three fighters.

2. Select Wingman01.

3. On the Animation menu, choose Position
Controllers > Noise.

Doing this automatically adds a List Controller
to the Wingman01. The Position List contains
the original Linear Position and the new Noise

Position controller with default Weight settings
of 1.0.

4. Play the animation and note the erratic flying
of Wingman01.

5. Stop the playback and change the Weight of the
Noise Position controller to 25.

Now the flight path of the Wingman01
spacefighter is affected by slight battle damage.

6. Save the scene as MyFlight04.max.

A Wingman is Called Away

Now it looks like Wingman02 has received a
transmission and is being ordered to peel off
and fly somewhere else. You’ll revisit the Link
Constraint to make Wingman02 follow the
FlightLeader for a little while then take off on
another path. Continue from the last lesson, or
load flyingspacefighter07.max.

Alter course for Wingman02:

1. Reset your time slider to frame 0 (zero) and
zoom to the trio of spacefighters in the Top
viewport.
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2. Create a new dummy near Wingman02 and call
it WingmanControl.

3. Right-click any viewport and choose Unhide
By Name from the quad menu. Select
wingmanpath and click Unhide.

A yellow path appears in front of Wingman02.

4. Make sure the new dummy, WingmanControl,
is still selected and choose Constraints > Path
Constraint from the Animation menu. Drag
the cursor over and pick wingmanpath.

The WingmanControl jumps to the beginning
of wingmanpath.

5. In the Path Parameters rollout duplicate the
previous settings.

• Turn on Follow, Bank, and Constant
Velocity.

• In the Axis group, turn on Y and Flip.

• Set the Bank Amount to 7.0 and the
Smoothness to 1.0.

If you play the animation, you’ll see
WingmanControl on its own path.

Make Wingman02 change paths:

1. In the Top viewport, select Wingman02
and click the Select And Unlink button.

Wingman02 is no longer linked to the
SpaceshipControl dummy object.

2. From the Animation menu, choose Constraint
> Link Constraint and select SpaceshipControl.

Wingman02 will work as it did before, but the
link constraint will give you the flexibility to
have it follow a different path.
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3. Move the time slider to frame 45 and click the
Add Link button in the Link Params rollout on
the Motion panel.

4. Click the WingmanControl dummy.

You will see WingmanControl is added to
the Target list, and when Wingman02 gets to
frame 45, the spacefighter begins to follow the
WingmanControl dummy on the other path.

5. Save the scene as MyFlight05.max and play the
animation.

Make Wingman02 roll out of formation:

To make Wingman02 roll out of formation, you’ll
use the Orientation Constraint again.

1. Move the time slider back to frame 0 (zero), if
it’s not there already.

2. Create another dummy object in the Top
viewport near Wingman02 and name it
wingmanroll.

3. Use Select And Move to position wingmanroll
next to Wingman02.

Watch the Front and Right viewports to help
you position it. This will help you keep the
objects in your scene organized.

4. Click Select And Link and link
wingmanroll to WingmanControl.

5. From the Tools menu, choose Align, and click
WingmanControl.

The Align Selection (WingmanControl) dialog
appears.

6. In the Align Orientation (Local) group, turn on
the X, Y, and Z axis controls and click OK.

The wingmanroll dummy aligns to
WingmanControl.

Note: This is important because you want
to make sure that rotation values you give
wingmanroll, later on, will be based on
the initial orientation of WingmanControl.
Otherwise, any rotation you give wingmanroll
will result in the spaceship tumbling out of
control.
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7. On the Motion panel, open the Assign
Controller rollout, if it’s not open, and select
the Rotation: Euler XYZ controller.

8. Click the Assign Controller button and choose
TCB Rotation from the Assign Rotation
Controller dialog.

Note: If you don’t assign the TCB Rotation
controller, you will not be able to rotate
wingmanroll about a local axis.

9. Select Wingman02 in the Top viewport.

10.Open the Animation menu and choose
Constraints > Orientation Constraint. Move
the cursor over wingmanroll and select it.

You’ll see wingmanroll added to the Orientation
Constraint target list in the Orientation
Constraint rollout on the Motion panel.

11.Select wingmanroll in the Top viewport.

12. Turn on the Set Key toggle
and click the Set Key button.

13. Move the time slider to frame 60 and
click Set Key again.

You’ve added two keys that will keep
Wingman02 flying normally from frames 0 to
60.

14.Activate the SpaceCam viewport and move the
time slider to frame 85.

15. Click Select And Rotate and change the
Reference Coordinate System to Local.

16.You’ll make two rotations during this step:

• Enter –15 in the X-axis Coordinate Display
Type-in field and click the Set Key button.

• Enter 90 in the Y-axis Coordinate Display
Type-in field and click the Set Key button.
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17.Move the time slider to frame 100 to make the
next two rotations:

• Rotate 5 degrees around the Z-axis and click
the Set Key button.

• Rotate 90 degrees around the Y-axis and
click the Set Key button again.

18.Move the time slider to frame 115 to make the
next two rotations:

• Rotate 10 degrees around the Z-axis and
click the Set Key button.

• Rotate 90 degrees around the Y-axis and
click the Set Key button again.

19.Turn off the Set Key toggle when you’ve
finished. Save the scene as MyFlight06.max
and play the animation.

Taking Control of Mars, Its Moons,
and the Space Station

So far, you’ve used dummy objects to help animate
the spacefighters. Another handy use of dummy
objects is as an alternate pivot point. Any object

could be used, but dummies are great because they
don’t render.

Set up the lesson:

• Load the spacestation.max file.

Files for this lesson are in the
tutorials\intro_to_animation folder.

This scene includes the following:

• Three heavenly bodies, Mars and its two
moons, Deimos and Phobos

• A space station named SpaceStation

• A camera (hidden) named SpaceCam

Take a few moments to familiarize yourself with
the names of the objects in the scene. This will
make it easier for you to select objects during this
lesson.

Rotate Mars and its moons:

The first part of this lesson focuses on the three
heavenly bodies you see in the scene. You will set
up a dummy object to control the rotation of Mars
and its moons, Deimos and Phobos.

1. In the Left viewport, create a Dummy object
around Mars. Name the dummy object
MarsControl.

Make the dummy a little larger than the planet
so it’s easier to pick.
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2. With the dummy object still selected, choose
Tools menu > Align, and click Mars.

3. In the Align Selection (Mars) dialog, do the
following:

• Turn on X, Y and Z Position in the Align
Position (Screen) group.

• Turn on X, Y and Z Axis in the Align
Orientation (Local) group.

• Click OK to accept the settings.

MarsControl is now aligned and oriented with the center
of Mars.

4. Select MarsControl.

5. Go to the Motion panel, and expand the Assign
Controller rollout. Select Rotation: Euler XYZ.

6. Click the Assign Controller button and
choose TCB Rotation then click OK.

TCB Rotation will allow you to rotate objects
on their Local axes as opposed to the World
axes. This is beneficial when you have an object
that is rotating on an axis that is tilted, such as
the rotational axis of a planet.

7. Select Mars, then click Select and Link.
Drag the rubber band to MarsControl. Release
the mouse button when the cursor changes.

8. Link each of the moons, Deimos and
Phobos, to MarsControl.

Mars and its two moons are now linked to
MarsControl. Any movement or rotation
you make to MarsControl will affect all the
planetary bodies.

9. Click Select And Rotate, and select
MarsControl.

10. Change the
Reference Coordinate System from View to
Local.

11. Turn on the Auto Key button and
move the time slider to frame 100.

12.In the Z axis field, below the time slider, enter
60.

This rotates MarsControl by 60 degrees around
its local Z axis. Because the planet and moons
are linked to MarsControl, they also rotate.
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13.Turn off the Auto Key and save your work as
MySpaceStation.

14.Activate the SpaceCam viewport and play the
animation.

You will see Mars rotating on its axis, then at
frame 60, Deimos swings into view and passes
by and Phobos remains off-camera. If you like,
you can zoom out to see both moons during
playback.

15.Return the time slider to frame 0 before
continuing.

Set the space station into orbit:

Now that Mars is spinning on its own axis and
Deimos and Phobos are orbiting Mars, you can
set the space station into a geosynchronous orbit
around Mars (an orbit that matches the planet’s
rotation). You’ll use the same technique for
controlling the space station.

1. Add a new dummy object to the Top viewport,
and name it StationControl.

It doesn’t matter where you place the dummy
object, because you’ll align it to Mars in a few
steps.

2. Open the Assign Controller rollout on the
Motion panel, and select Rotation : Euler XYZ.

3. Click the Assign Controller button, and
choose TCB Rotation. Click OK.

4. While StationControl is still selected, choose
Tools menu > Align, and click Mars.

5. In the Align Selection (Mars) dialog, do the
following:

• Turn on X, Y and Z Position in the Align
Position (Screen) group.

• Turn on X, Y and Z Axis in the Align
Orientation (Local) group.

• Click OK to accept the settings.

These are the same settings you made when
aligning MarsControl to Mars in the previous
section.

6. In the Left viewport, link SpaceStation
to StationControl.

7. Turn on Select And Rotate and select
StationControl. Change the Reference
Coordinate System from View to Local, if it’s
not already changed.

Tip: You must always choose the transform (in
this case, Select and Rotate) before choosing
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the Reference Coordinate System. Different
transforms can have different Reference
Coordinate Systems. If you choose the
coordinate system first, it might change when
you choose a different transform.

8. Turn on the Auto Key button and
move the time slider to frame 100.

9. In the Z axis field, below the time slider, enter
40.

10.Turn off the Auto Key and save your work as
MySpaceStation01.

To create an incrementally saved file, use the

Save As command click the button.

11.Play the animation.

Now the Space Station is orbiting around Mars
but it’s orbiting at a slower rate.

Add artificial gravity to the space station:

The space station need to rotate around its own
axis in order to generate some level of artificial
gravity for its personnel. This last section will
solve that problem.

1. In the SpaceCam viewport, select SpaceStation
and open the Motion panel.

2. Open the Assign Controller rollout and select
Rotation : Euler XYZ.

3. Click the Assign Controller button and
choose TCB Rotation then click OK.

4. Turn on Select And Rotate if it’s not
already active. Set the Reference Coordinate
System from View to Local.

5. Turn on the Auto Key button and
move the time slider to frame 100.

6. In the Z axis field, below the time slider, enter
90.
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7. Turn off the Auto Key.

8. Play the animation.

Now the Space Station rotates about its own
axis while it’s in geosynchronous orbit around
Mars. Maximize the SpaceCam viewport for
a better view.

9. Save your work as MySpaceStation02.

Animating the Spaceship Using
XRefs

3ds Max lets you quickly and easily animate
directly in the viewports. You can play your
animation and get feedback on timing and
movement without having to render.

This remains true until you start using really big
models, and then performance can start to slow

down. You can get around this by using XRefs,
which are externally referenced files. In this
tutorial, you’ll animate a low-polygon spaceship as
a proxy for a very detailed spaceship that will only
be used when rendering the final animation.

You won’t use the same spaceship that you just
made; instead you’ll use a highly detailed model
of a battleship.

XRef Hi-Poly object into scene:

1. Reset 3ds Max.

2. Open the file marsandsun.max.

Files for this tutorial are in the
tutorials\intro_to_animation folder.

Note: If you see the File Load: Units Mismatch
dialog, choose the option Rescale The File
Objects To The System Unit Scale.

3. Choose File menu > XRef Objects.

4. In the XRef Objects dialog, click Add.

5. In the Open File dialog, navigate to the
tutorials\intro_to_animation directory and
locate battleship.max. Highlight this file in the
list and click Open.

The XRef Merge dialog is displayed. This dialog
lists the objects in battleship.max. There are
two objects here. One is a highly detailed
battleship, the other is a low-poly proxy version
of the ship.

Note: The proxy object doesn’t have to be in the
same 3ds Max file as the high-resolution object.
This just happens to be the case in this lesson.

6. Choose Hi Poly BattleShip. Click OK.

The battleship.max file and its path are listed
in the upper window of the dialog; the Hi Poly
BattleShip object appears in the lower window.

7. Close the XRef Objects dialog.

3dsmax.chm::/file_load_units_mismatch_dialog.html
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You have just added the battleship as an XRef
object in the scene. This object has almost
100,000 faces.

Don’t worry. The battleship will be moved soon.

XRef Low-Poly object into scene:

1. Select the battleship.

2. Open the Modify panel. Look at the modifier
stack for the object.

Nothing is listed in the stack except XRef
Object. You can add modifiers to the object,
but you can’t make any changes to the XRef
object itself.

3. In the XRef Object rollout, in the XRef
Viewpoint Proxy group, click the File Name
browse button. (The button with three dots
located under the File Name field. Don’t
confuse this button with a similar one in the
XRef group.)

4. Choose battleship.max. Click Open.

The Merge dialog is displayed.

5. Highlight Low Poly BattleShip and click OK.

The low-resolution proxy is displayed in the
viewport. The battleship name is displayed
in the Object Name field. Use Proxy is
automatically toggled on.

The proxy battleship will also be moved soon.

Animate and render with xref objects:

1. Activate the Top viewport and zoom back a bit.

2. On the Display panel, in the Hide by Category
rollout, turn off Cameras.

The camera now appears in the viewports and
it’s pointing at Mars.

3. In the Top viewport, move the proxy battleship
object down and left so that it’s at the bottom
left of the viewport. Rotate the proxy battleship
so that it points toward Mars.

4. Move Camera01.Target so it’s pointing at the
proxy battleship.
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You should be able to see the battleship in the
Camera01 viewport.

5. Turn on Auto Key.

6. Move the time slider to frame 100.

7. Move the proxy battleship closer to Mars.

8. Move the camera target so the camera looks at
the battleship.

9. Turn off Auto Key.

10.Play the animation in the Camera01 viewport.

11.Go to frame 100. Render the Camera viewport.

Although the proxy battleship is visible in
the viewport, the high-resolution model is
rendered in the final output. The scene features
a lens flare behind the planet.

Note: If the texture maps seem to be missing on
the ship, go to the Modify panel > XRef Object
rollout > Options group. Turn on Update
Material and render again.

Rendered image of the hi-poly spaceship with a sun
flare in the background

For more information about the lens flare effect,
see Creating the Sun with a Lens Flare (page
1–474) tutorial.

Summary

Among the animation tools you can use is the
path constraint. With this feature, you can make
an object follow a path partially or fully. When
objects are complex and take up a lot of system
resources, you can use the Xref feature to bring a
low-resolution proxy into the scene.
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Animating a Pen
A client asks for an animation of a pen writing the
word “yes” onto a page. You already know how to
model the pen, but how do you animate it so that it
follows a path? And how do you make the writing
appear synchronized with the movement of the
pen? These questions and others will be answered
in this tutorial for a write-on animation.

Skill Level: Beginner

Time to Complete: 15 minutes

Features Covered in This Tutorial

In this tutorial you will learn:

• Drawing splines on objects using snaps

• Using path constraints

• Using path deform modifiers

Tutorial Files

Files for this tutorial can be found on the Tutorial
Files CD in the \tutorials\intro_to_animation
directory. Before starting the tutorials, copy the
\tutorials folder to your \3dsmax8 directory.

Drawing the Path on the Paper

We won’t take you through the entire process of
modeling a scene. Instead, you’ll open a file that is
already developed. The pieces are all ready, so you
can focus on animation.

Setup:

• On the menu bar, choose File > Open and
navigate to \3dsmax8\tutorials\intro_to_
animation\write_on_start.max. Highlight the
file name, then click Open.

Note: All the necessary files to do the tutorials
can be found on the Tutorial Files CD that ships
with 3ds Max 8. Before doing the tutorials copy
the \tutorials directory from the CD to your
\3dsmax8 local installation.

The sample file, write_on_start.max.

You see a piece of paper on a drawing board,
and a pen and a bottle of ink on either side.
The camera zooms back to frame a better view
of the paper.

Before you draw the path, you’ll change the
color of the paper to black. This will make it
much easier to see the line as you draw.
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Change the paper color:

1. On the toolbar, choose Select By Name.

2. In the Select Objects dialog, highlight paper in
the list on the left, then click Select.

The paper object is selected in the viewport,
and its parameters are visible in the Modify
panel on the right.

3. On the toolbar click the Material Editor
button to open the Material Editor.

The Material Editor displays the materials used
in the scene. The paper material sample sphere
is highlighted and should be visible.

4. Click the Black material on the second row. The
material name Black Paper appears next to the
eyedropper.

5. On the Material Editor toolbar, click
Assign Material To Selection. The paper is now
black.

Black paper makes it easier to see the lines you draw.

While you still have the paper selected, you’ll
make one more change.

Add segments to the paper:

1. Close the Material Editor, then right-click the
viewport label, and choose Edged Faces.

This shading mode displays shaded faces and
edges.

2. On the Modify panel, in the Parameters rollout,
increase the Length Segments and Width
Segments of the paper object to 8.

The black paper segments are now visible in
the viewport.

Increased box segments

You will snap to the faces on the black paper
when you draw the line.

Use snaps with lines:

1. On the Customize menu, choose Grid and Snap
Settings. On the Snaps panel, click Clear All
and turn on Face, then close the dialog using
the X at the upper right.

All the setting up is done; now it’s time to draw
the word yes.

2. On the toolbar, turn on 3D Snap.

Tip: You can also press S to turn snap on and off
during creation operations.
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3.

On the Create panel click the Shapes
button, then in the Object Type rollout, click
Line.

4. Move your cursor over the black paper. As you
move, you’ll see the snap-face cursor showing
you which face you are snapping to. Click to
set the first point, then move your cursor to the
right and up. You’ll see the snap cursor again.

Snap To Face cursor

5. Click and drag to create a rounded spline. Move
the cursor, and click and drag again to create
another rounded spline. Place points to create
the letter Y. (In the Illustrations that follow,
we’ve turned off the snap cursor so you can see
the point placement better.)

Tip: Pressing the BACKSPACE key while
drawing will delete the last-placed vertex in the
line. You can also adjust the vertices later.
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Click and drag to create rounded splines.

You can see the flat line segments that are used
to create the splines, particularly obvious in
the tail of the Y. Don’t worry about these, you
can increase the segmentation later to create
a smoother line.

Create sharp corners:

1. When you want to create a sharp corner, just
click, rather than clicking and dragging. For
example, when you come to the letter e, you’ll
need a sharp corner, as well as in the letter s. To
stop creating line segments, right-click.

For the corner of the letter e, make a sharp corner by
just clicking.

Right-click to finish.

2. Right-click the viewport to turn off the Line
Shape tool.

3. Save your work. On the menu bar, choose File
> Save. Name your file my_write_on.max.

Animating the Pen on the Path

Now that you’ve drawn the path on the paper, you
can animate the pen using a path constraint.
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Setup:

1. Continue from before or open write_on_
yes.max.

2. Move the time slider to Frame 0, if it isn’t there
already.

Change material and color:

1. Press M on the keyboard to open the Material
Editor, if it isn’t open already. Locate the
material named paper, and drag it onto the
paper object in the viewport.

2. Press the H key or choose Select By
Name from the toolbar.

3. In the Select Objects dialog, select the object
named Line01, then click Select.

4. On the Modify panel, in the Name And Color
field, click the color swatch, and then change
the color of the line from white to black.

5. Click in open space in the viewport to deselect
the Line01 object.

The line is visible in the viewport now.

Animate the pen with path constraints:

1. Press the H key again. In the Select Object
dialog, choose the object named nib from the
list. At the bottom of this dialog, click Display
Subtree. Click Select.

The components of the pen (the wood, the
cork, and the nib) are already linked into a
hierarchy for animation. This is indicated by
the indented list. The nib is the parent of the
hierarchy. When you animate the nib parent
object, the cork and the wood child objects will
follow.

The pen nib is now selected in the viewport.

2. On the menu bar, choose Animation >
Constraints > Path Constraint.

As you move your mouse over the viewport,
you’ll see a dotted line connecting your cursor
to the nib.

3. Move your cursor to the Line01 object, then
click to select that as the path.

The pen jumps to the start of the path. It is also
buried in the paper.

Pen jumps to the start of the path.

4. On the toolbar, turn on Rotate Mode.
Rotate the pen in the viewport, approximately
–30 degrees about X, and 17 degrees about Z,
so the pen is not buried in the paper.
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Rotate the pen so that it’s above the paper.

5. Play the animation. The pen follows the path.

Pen moves along the path.

The next order of business is to create a growing
line to follow the end of the pen. To do this, you
will use a PathDeform modifier.

Creating the Line Using
PathDeform

The PathDeform modifier takes an object and
stretches it along a path. By animating the amount
of stretch, you can use it to create the effect of a
line growing over time.

1. Continue from before, or choose File > Open,
then open \3dsmax8\tutorials\intro_to_
animation\write_on_growline.max.

2. Use Arc-rotate to navigate the perspective
viewport to give you a more frontal view of the
objects in the scene.

3. On the Create menu, choose Standard
Primitives > Cylinder.

4. On the Object Type rollout, turn on Auto Grid.

5. Drag out a cylinder over the start of Line01. It
doesn’t have to be very wide.

Create a cylinder over the start of the line.

6. In the Parameters rollout, set the following
values:

• Radius=0.03

• Height=2.5

• Height Segments=133

• Sides=4

These values will give the cylinder enough
segmentation to stretch over the path. Before
you create the path deform, you’ll hide the
paper, so it’ll be easier to see the new object.

7. Select the paper in the viewport, then
right-click and choose Hide Selection from the
quad menu.
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The paper disappears from view.

8. Select the Cylinder, and then on the menu bar
choose Modifiers > Animation Modifiers >
PathDeform.

The Path Deform rollout parameters appear in
the Modify panel.

9. On the Parameters rollout, click Pick Path, then
click the line in the viewport.

The cylinder deforms in the viewport into the
first few bends of the letter Y. However, it is
rotated along its Z axis. Later, you’ll rotate the
cylinder so that it lies on top of the line.

10.On the Modify panel, in the Parameters rollout,
increase the Stretch value to 3.62, or until the
deformed cylinder extends just to the end of the
line. Move the time slider to frame 0, right-click
and choose Move from the quad menu. Using
the Transform gizmo, raise the deformed
cylinder up in Z until you can see it clearly.

11.Navigate the Perspective viewport to see how
the path deform is positioned. Press SHIFT+Z
to undo the viewport changes.

Tip: Press Arc-rotate to arc-rotate the view.

Arc-rotate the Perspective viewport to see the cylinder’s
orientation.

12.Right-click and choose Rotate from the quad
menu, then rotate the deformed Cylinder about
the X axis –90 degrees.

13.In the Front viewport, check that the logo
appears parallel to the paper. If not rotate it as
necessary until it is.

14.Move the cylinder down in the Front viewport
so it’s visually aligned with the pen.

Use the Front viewport to adjust the cylinder’s position.

15.In the Top viewport, right-click and choose
Rotate from the quad menu. Then rotate again
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until the corners of the letters “e” and “s” line
up with Line01.

16.Activate the Perspective viewport, then move
the Cylinder down slightly to finish aligning the
object with the path.

Note: Depending on how you drew your line,
you may have to make adjustments to get the
object to line up with the path. You can make
adjustments visually until it is correct.

Aligned path-deformed cylinder

Next, you’ll keyframe the stretch so the line
grows.

Keyframe the stretch:

1. Turn on the Auto Keybutton. Set the Stretch
to 0.1.

2. Move to frame 100, then adjust the stretch so it
coincides with the end of the pen. Try a Stretch
value of about 4.4.

3. Move the time slider to frame 0, and play the
animation.

You’ll notice the line and the pen are not in
perfect synchronization.

4. Move to frame 10 and adjust the Stretch value
of the path so the line meets the end of the pen.

Tip: Use the spinner to adjust the Stretch value.

5. Repeat at 10 frame intervals until you get to
frame 100. Play the animation again.

6. To get it just perfect, go back to frame 0 and
then move forward in time using the > key.
Whenever you see the path out of sync, adjust
the Stretch value and set a key. The keys will be
visible on the track bar. You’ll probably need to
set keys every 5 or 10 frames.

Tip: There are more mathematical ways to
approach this process, such as applying a
Normalize Spline modifier to the line, but for
an artist this method gets the job done using
visual means.

7. Unhide the paper, and hide Line01, then play
the animation.
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Pen writes onto the paper.

8. Save your work as mywrite_on_yes_anim_
complete.max.

You can open write_on_yes_anim_
complete.max for comparison.

Summary

In this tutorial, you have learned to create
animation using path deform. You have learned to
draw a line on an object by snapping to faces, then
use that line as a path for the animation of the pen.
The same line was used as the path deform path
to create the illusion of the line being drawn on
the page. By animating the stretch parameter and
synchronizing it with the animation of the pen,
the illusion is complete.

Working with Animation
Tracks

Working with Animation Tracks

In this tutorial, you will animate the second,
minute and hour hands of a clock. You will learn
how to create keyframes in a variety of ways and
prepare a set of animation tracks for later recall.
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Features Covered in this Tutorial

• Creating a Track Set

• Using Auto Expand

• Trackview Quad Menu

• Hierarchy Right-Click Menu

• Default In/Out Tangents for new keys

• Zoom Key Extends

• Setting Parameter Curve Out of Range Type

• Copying Controllers

Skill Level: Intermediate

Time to Complete: 30 minutes

Form a Track Set

1. Open Watch1.max from the \tutorials\curve_
editor folder. If you get a Units Mismatch
warning, choose the option “Adopt the File’s
Unit Scale”.

2. Right-click in the viewport and from the Quad
menu, choose Curve Editor.

3. Open the hierarchy so that the rotation Z-axis
tracks for each of the hands can be seen.

4. Press Ctrl and select each of the three Z
Rotation tracks.

5. Create a Track Set by entering Hands in the
Track Sets field.
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This Track Set can be recalled to conveniently
display the included tracks within the Curve
Editor.

6. Close Curve Editor

Animate the Second Hand

The second hand will be animated so that it rotates
one second per frame.

1. Press H to open the Select by Name dialog.

2. Highlight the Second Hand in the list and click
Select to select it.

3. Right-click and choose Curve Editor from the
Quad menu.

4. Right-click in the pane displayed on the left to
open the Quad menu.

5. Within the Auto Expand sub menu, make sure
the following options are active.

These options display the X, Y, and Z
components of the transform tracks.

6. Highlight the Second Hand’s the Z Rotation
track.

7. Click Add Keys.

8. Click near frame 0 and again near frame 1 to
add some keys. Don’t worry about setting the
values exactly at this point. You’ll adjust them
in a moment.

9. Right-click and choose Move Keys from the
Quad menu. This cancels Add Keys mode.

10.Click the first key and set its time and value to
zero.

11.Click the second key and set its time to 1 and
value to –6.
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12.Close the Curve Editor.

Setting Key Tangent Type

1. Open Watch2.max or continue with your
current file.

2. Select the Second Hand and open Curve Editor.

3. Highlight the Z Rotation track.

4. Click Zoom Horizontal Extents Keys.

Note: It is contained within the Zoom
Horizontal Extents flyout.

5. Repeat the Procedure with the Zoom
Value Extents Range (vertical zoom).

The Curve editor zooms in to show only the
range with keys, which in this case is frame 0
and 1.

The curve uses the default Auto tangent type.
The tangent type should be set to Step.

6. Select both keys using a window selection.

7. Click Set Tangents to Step on the Curve
Editor’s toolbar. This retains a key’s value until
the next key frame.

Setting Parameter Curve Out-of-Range Type

To make the second hand repeat its motion the
Out-of-Range type should be set to Relative
Repeat.

1. Click Parameter Curve Out-of-Range
Type.

2. Click the Relative Repeat option.

3. Click OK to close the dialog.

4. Close the Curve Editor.

5. Play the animation.

The second hand repeats its motion throughout
the animation range.
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Animate the Minute Hand

The second hand moves in steps, jumping ahead
each second. The minute hand however should
move continuously. This can be accomplished
with the linear key tangents.

1. Set the default tangent type to linear.

2. Move the time slider to frame 60.

3. Open the Select by Name dialog and select the
minute hand.

4. Click Auto Key.

5. Click the Rotation tool.

6. Enter –6 in the Z transform field and press
enter.

7. Turn off Auto Key.

8. Open the Curve Editor

9. Select the Z Rotation track of the Minute Hand.

10. Click Parameter Curve Out-of-Range
Type.

11.Set the Parameter Curve out of Range type to
Relative Repeat.

12.Close the Curve Editor.

Play the animation.

The second and minute hands move correctly.
Next you’ll animate the hour hand.

Copying Controllers

In this sequence you’ll animate the hour hand by
copying and adjusting the controller from the
minute hand.

1. Open Watch3.max or continue with your
current file.

2. Right-click in the viewport and select Curve
Editor.

3. Choose Hands from the Track Set list.

4. Highlight the Z-Rotation track of the Minute
Hand.

5. Right-click and choose Copy from the Quad
Menu.
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6. Highlight the Z Rotation track of the Hour
Hand.

7. Right-click and choose Paste from the menu.

8. Choose Copy from the dialog.

9. Make sure the Z Rotation track of the Hour
Hand is the only highlighted track.

10.Select the second key of the Hour Hands Z
Rotation track.

11.Adjust the value at frame 60 from –6 to –0.5.

12.Close the Curve Editor.

Play the animation.

Although the hour hand is animated you
can’t see it move until the animation time is
extended.

Extending the Animation Time

1. Open the time configuration dialog.

2. Set the end time to 3600.
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3. Click OK to close the time configuration dialog.

4. Drag the time slider to view the animation. One
hour elapses over the course of the animation.

Summary

In this tutorial, you learned how to animate the
second, minute and hour hands of a clock. You
also learned how to create keyframes in a variety
of ways and prepare a set of animation tracks for
later recall.

Animating a Walkthrough

Animating a Walkthrough

When you create a camera in 3ds Max, you can
“fly” that camera through your scene, whether that
scene is an interior or an exterior design. You can
use the camera to explore your virtual conception,
and see if you actually end up with what you
thought you designed. You can also present your
walkthroughs to your clients and colleagues.

There are a variety of methods you can use to
create a walkthrough animation. In this chapter
we’ll teach you a simple method of placing a
camera on a path.

Skill level: Beginner

Time to complete: 1+ hours (includes rendering
time to create an animation)

Features Covered in This Tutorial

In this tutorial, you will learn how to:

• Create Free and Target cameras.

• Adjust the animation length for a suitable
camera motion.

• Apply a path constraint to a camera.

• Use Set Key to animate the camera target.

Tutorial Files

All the necessary files to do the tutorials can be
found on the Tutorial, Samples, And Partners
CD, in the \tutorials\walkthrough folder, unless
otherwise specified.

Creating a Walkthrough
Set up the lesson:

• Open the great_wall_head.max file from the
\tutorials\walkthrough folder.

Tip: If the Units Mismatch dialog displays,
choose Adopt The File’s Unit Scale and then
click OK.
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Calculate the Required Number of Frames:

1. Press H to open the Select Objects dialog, and
then double-click Camera Path.

2. From the Utility
panel, click the Measure tool. This tool
reports the length of the camera path, which is
approximately 900 feet.

Note: For a comfortable walking pace in
architectural walkthroughs you’ll need about a
second for every 3 feet of distance. For a jog
or a fast run, you can go as far as 9 feet for a
second. In NTSC format, that translates into 30
frames for every 9 feet of distance traveled, or
3000 frames for 900 feet.

3. Click the Time configuration button next
to the Current Frame Field.

4. In the Animation group in the Time
Configuration dialog, change End Time to
3000 to increase the number of frames in the
animation, and then click OK.

This will provide sufficient frames for your
walkthrough animation.

The time slider frame indicator now displays
3000 frames.

Creating a Free Camera:

1. From the Cameras category of the create Panel,
click the Free button.

2. Click to create the camera anywhere within the
Front viewport.

3. In the Name and Color rollout, rename the
camera FreeCam

Assigning a Path Constraint to the Camera:

1. Press H to open the Select by Name dialog.

2. Double-click on FreeCam, the camera you just
created.

3. From the Animation menu at the top of the
screen, choose Constraints > Path Constraint.
A rubber band appears.

4. Press H to access the Pick Object dialog, and
then double-click Camera Path to select it. This
places the camera on the path and gives the
Motion panel focus. The selected path appears
in the Target window of the Path Parameters
rollout.
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5. Enable the Follow option in the Path Parameters
rollout.

6. Set the Follow Axis to Y.

7. Right-click the Perspective viewport to activate
it, and then press C to view what the camera
is looking at.

8. Click Play to view the animation.

The Free Camera travels along the path but
the motion seems unnatural. At times it aims
too high and at other times too low. The Free
Camera direction is maintained tangential
to the path. While the Free Camera may be
suitable for a path constrained to a horizontal
plane it isn’t ideal for the undulating path in
this scene. In the next section you’ll try a Target
Camera.

Creating a Target Camera:

A Target camera follows a path in the same fashion
as a free camera. Instead of aiming tangential to
the path it remains directed towards its target,
which can be animated independently.

1. Stop the animation if it is still playing and go
to Frame 0.

2. Select the FreeCam you created in the previous
section if it is not already selected.

3. Right-click over the camera, and then, from
the quad menu, select Hide Selection.

4. From the Cameras category of the Create Panel,
click the Target button.

5. Click and drag to create the camera anywhere
within the Top viewport.
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6. In the Name and Color rollout, rename the
camera TargetCam.

7. Assign a Path Constraint, as you did earlier, to
constrain the new camera to the existing path.

8. Activate the FreeCam viewport.

9. Press C to view the selected Camera’s point of
view.

10. Click Play to view the animation. The
target remains stationary while the camera
moves along the path.

Animating the Camera Target:

To create a walkthrough with a target camera, you
have to animate the target moving ahead of the
camera and stop occasionally on points of interest.

1. Stop the animation if it is still playing and go
to Frame 0.

2. Press H to open the Select by Name dialog.

3. Double-click TargetCam.Target.

4. Click and then right-click the move tool.

5. At frame 0, position the target at –22, -200,147.

This gives an appropriate starting direction for
the camera.

6. Press Auto Key.

7. Move the time slider to frame 194.

8. Position the target at 80,-69,26.

Note: From the Top viewport that this position
corresponds to the first tower along the wall,
which is a suitable point of interest.

9. Press shift and drag the key you just created to
approximately frame 815. This holds the target
at the tower as the camera approaches it.

10.Move the time slider to frame 1050.

11.Position the Target at 44,11,42.

12.Move the time slider to frame 1272.

13.Position the Target at -141,112,92.
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This positions the target near the second tower.

14.Press Shift and drag the key you just created
to approximately frame 1820. This holds the
target at the second tower while the camera
approaches it.

15.Move the time slider to frame 1964.

16.Position the target at –235,250,82.

17.Move the time slider to frame 2135.

18.Position the target at –235,250, 29.

This lowers the target’s position along the Z
axis to accommodate the drop in the path just
after the second tower.

19.Move the time slider to frame 2534.

20.Position the target at –273,520,197.

21.Press shift and drag the key you just created to
approximately frame 2963.

22. Click Play to view the result in the
TargetCam viewport. Note how the target
moves ahead of the camera to the points of
interest along the way.

23.Turn off Auto Key mode.

24.Right-Click in the Top viewport to make it
active.

25. Click Play. Viewing the animation in the
top viewport further emphasizes how the target
is moving to the points of interest ahead of the
camera.

Summary

In this lesson, you have created a camera
walkthrough animation by calculating the number
of frames needed for the animation, and you have
learned to automate the creation of the camera
and how to constrain it to a path. Finally, you have
learned how to manually animate the head turn
and tilt of the camera by animating the camera
target to create realistic camera motion.
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Biped Animation

Biped Quickstart

Quick Start

This tutorial introduces you to the elements of the
built-in character animation features in 3ds Max
and the workflow for some of its most important
features.

Note: The components that are described in the
following topics were previously offered separately
in the character studio product, but are now
integrated within 3ds Max 8.

The purpose of this tutorial is to familiarize you
with:

• Creating and posing a biped

• Associating the biped with a mesh using the
Physique modifier

• Animating the biped using two different
methods, freeform and footstep animation

• Combining motions in the Motion Mixer

Skill level: Beginner

Time to complete: 1 hour

You can find the files for this tutorial in the
tutorials\character_animation\quick_start folder
on the Tutorial Files CD that ships with 3ds Max.
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Creating a Biped

In this lesson, you’ll create a default biped: a
simple skeleton consisting of bones connected
in a hierarchy. A default biped is different from
3ds Max Bone system objects because the biped
structure automatically has built-in joints like a
human being. You can bend your knee so your
foot touches the back of your thigh, but you can’t
bend it forward so that your toe touches the front
of your thigh. Biped creates skeletons in the same
fashion. They are ready to animate, and work
accurately without additional set up.

Set up the lesson:

• Reset 3ds Max.

Create a biped:

1. On the Create panel, click Systems.

2. On the Object Type rollout, click
Biped.

The Biped button turns gold.

3. If you can’t see the Height spinner in the Create
Biped rollout, scroll to the bottom of the
command panel.

4. In the Perspective viewport, place your cursor
over the center of the grid, press down on the
left mouse button, and drag upward.

A biped appears and grows with your cursor
movement.

5. Drag upward until the Height spinner on the
Create Biped rollout reads approximately 70
units, then release the mouse button.

A biped is created in the viewport.

The biped is a hierarchy of special objects.
Its parent object (Bip01) is its center of mass
(COM). The COM is displayed in the viewports
as a small, blue tetrahedron, initially centered
in the biped’s pelvis. After you create a biped,

only the center of mass object is selected (not
the entire biped).

Name the biped:

When you create your first biped, it has a root
name of Bip01. The root name of each additional
biped is incremented, so the next biped you create
has a root name of Bip02. The root name acts as a
prefix for each part of the biped, to make it unique
from any other bipeds in the scene.

1. In the Create Biped rollout, highlight the
current root name entry, Bip01, in the Root
Name field.

Note: You can also change the biped root name
from the Motion Panel if you expand the Biped
rollout.

2. Enter the new root name, MyBiped.

Renaming the biped’s root name to the name
of the character is common practice and helps
with scene organization.

3. Using File > Save As on the menu bar, save the
scene as MyBiped.max.
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To find more information about building bipeds,
see the tutorial Working with Biped Parts (page
1–383).

Posing a Biped

Once you’ve created a biped, you need to pose it
to match the character model that the biped will
control. This is done in Figure mode, which allows
you to bend, rotate, and scale parts of the biped to
conform to the character mesh. In this lesson, you
will adjust a biped to fit a character mesh.

Character meshes are usually built in one of two
stances. The most common is with the arms out
and the legs slightly spread, like da Vinci’s drawing
of the Vitruvian Man. Or, the character mesh is
built in a resting position with arms at its sides and
legs together.

For this lesson, you’ll be working with a character
named Dr. X.

Left: Dr. X exhibiting the Vitruvian Man stance; right: a
resting position.

Set up the lesson:

1. Reset 3ds Max.

2. Load the scene file cs4_qs_drX01.max from
the tutorials\character_animation\quick_start
folder.

This scene contains a character mesh named
DoctorX.

Build the biped:

Now that you know how to create a biped, you’re
going to use the character mesh as a template for
building the biped that will control Dr. X.

1. On the Create panel, click Systems.

2. Turn on Biped and make sure you
can see the Height spinner in the Create Biped
rollout.

3. In the Front viewport, click down at Dr. X’s
feet and drag up until the biped is about 1.0m
in height

This will place the center of mass (COM)
roughly at Dr. X’s pelvis.

The new biped and Dr. X.

4. In the Create Biped rollout, change the Root
Name to Dr.X.
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Position the biped:

Once the biped is added to the character mesh,
you need to adjust the biped to better match the
stance of the mesh. First, you’ll adjust the position
of the biped within the Dr. X model.

1. Click the Motion panel tab.

2. In the Biped rollout, turn on Figure
Mode.

All changes to the biped’s reference pose must
be done in Figure mode.

3. In the Left and Front viewports, click
Zoom Region and zoom in around the pelvis
of Dr. X.

The illustrations show the COM in white and
arrows pointing at the center line of the mesh.

Zoom into Left viewport

Zoom into Front viewport

4. In the Track Selection Rollout, make sure
the Body Horizontal button is active.

5. Move Dr.X, the COM, in both the Left
and Front viewports so that it lines up with the
vertical center line of the character mesh.

Bip01 moved in the Left viewport

Bip01 moved in the Front viewport

Adjust the legs:

Next, you’ll adjust the legs so they conform with
the character’s legs. When adjusting legs, you’ll
want to pay close attention to the key bend points
at the knees and ankles.

1. Activate the Front viewport. Enlarge the
viewport by pressing ALT+W on the keyboard
and click the Zoom Extents button.
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2. Select the biped’s left thigh, Dr.X L
Thigh. This is colored blue by default, and its
name appears in the name field at the top of the
Motion panel when selected.

Tip: If you select the mesh by mistake, deselect
by clicking outside the figures, and then try
again.

3. From the Track Selection rollout, click the
Symmetrical button.

The biped’s right thigh, Dr.X R Thigh is now
added to the selection set.

4. In this step, you rotate the biped’s legs to run
roughly along the legs of the mesh. To make
these rotations, you’ll have to switch between
the Front and Left viewports. Press F and L on
the keyboard to make these switches.

Click the Rotate button and make the
following rotations:

• In the Front viewport, rotate about 12.0
degrees about the Z-axis. A readout appears
in yellow as you rotate the selection.

• In the Left viewport, rotate about –8 degrees
about the Z-axis.
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• TIP: You can type in the rotation values
if you right-click and choose the Rotate
Settings button from the quad menu.

5. Right-click and from the Quad menu, choose
the Scale settings button. Scale the thighs along
the X-axis by 85%. Type in the value or use
the spinners while viewing the results in the
viewport.

6. Press the Page Down key on the keyboard.
Page Up and Page Down are quick shortcuts
for moving up and down the hierarchy. Since
both thighs were selected, now both calves are
selected once you’ve pressed Page Down.

7. Scale the calves by about 90% along the
X-axis as you did with the thighs earlier. This
aligns the biped’s ankles more closely with the
ankles of the character mesh.
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The Left view of the scaled thighs and calves.

8. Page Down again to select the biped foot
objects. Scale the feet from the Front and Left
views to more closely fit in the shoes.

9. On the Structure rollout, adjust the Ankle
attach value to slide the foot to better fit in the
mesh.

10.In the Front viewport, rotate the Bip Foot
objects so they match the mesh angle.

Rotate the feet to fit the mesh.
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11.Save the scene as my_drx01.max.

The procedures you’ve just completed give you an
idea of what it takes to align a biped to a mesh,
and that patience is the key to this process. This
character still needs work, such as the feet need to
be adjusted as well as the entire upper body. If you
want, read the following tips for biped alignment,
then use the same procedures to experiment with
aligning the rest of the biped. Otherwise, continue
to the next lesson.

Tips for Biped Alignment

Here are some tips that may help when adding a
biped to a character mesh.

• The most important tip is to make sure the
COM is always aligned with the mesh.

• When scaling and rotating biped parts, pay
attention to the model in multiple viewports. A
rotation, for instance, may look good in one
viewport, but another viewport may indicate a
problem.

• Examine the character mesh’s complexity.
If the character is wearing mittens or shoes,
you probably don’t need five fingers and toes.
Adjust the biped structure accordingly.

• Remember ponytails. If the character has a lot
of hair or a long nose, like an elephant trunk,
you can use a ponytail to control that part of
the mesh.

• If the character mesh has a short torso or long
neck, it may be best to reduce the number of
Spine Links or increase the number of Neck
Links. You can add up to 25 links in the neck,
tail or ponytails, and up to ten links in the spine.

• If the character is carrying something like a
weapon or tool, add a Prop to control that
object.

For a more detailed look at posing a biped, see
the lesson Aligning the Biped to the Model (page
1–386).

Applying Physique

After the biped is posed to match the character
mesh, you apply the Physique modifier to the
character mesh. The Physique modifier associates
the biped with the character mesh.

After Physique is applied and set up, any animation
on the biped is passed on to the mesh, making
it move as if there were bones and muscles
underneath.

Set up the lesson:

1. Load cs4_qs_drX02.max from the
tutorials\character_animation\quick_start
folder.

This scene contains Dr. X and a completely
posed biped.

2. In the Front viewport, zoom in on the biped’s
pelvis (orange triangle) and the center of mass,
or COM (blue tetrahedron).

Apply Physique:

1. Select the character mesh, DoctorX.

2. On the Modify panel, choose Physique
from the Modifier List.

The Physique rollouts appear in the command
panel.

3. In the Physique rollout, click Attach To
Node, then click the biped’s COM.

The Physique Initialization dialog displays.

4. Click Initialize.

The character mesh is now associated with the
biped. The orange deformation spline running
through the mesh indicates that the entire biped
structure has been associated with the mesh.
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Orange spline follows Dr. X mesh. (This view uses
See-Through display mode with the biped bones
hidden.)

Tip: To toggle the view to See–Through display
mode, select the DoctorX mesh and press
ALT-X.

Adjust the envelopes:

Physique associates the biped with the mesh via
the mesh’s vertices. Each biped part is surrounded
by an area called an envelope, and mesh vertices
that lie inside an envelope are effected by that biped
part. The default size of an envelope depends on
the size of the biped part, which you set when you
pose the biped.

Often, envelopes need to be manually adjusted
to make the biped work properly with the mesh.
If you notice irregular spikes poking out from
the mesh, it’s a good indication that one or
more vertices lie outside of an envelope’s area of
influence. You can see this effect by rotating the
arm.

1. Right-click in the Top viewport to activate
it and use Region Zoom to view Dr. X’s left arm.

2. Select DrX Biped L Forearm and rotate
it up and down. You’ll see some vertices don’t
move with the arm.

Vertices that are not influenced by the envelope pull
out of shape.

3. Press CTRL+Z to put the arm back to its
original position so you can adjust the envelope.

4. Select the DoctorX mesh again and in the
modifier stack, click the plus (+) symbol
next to Physique and highlight the Envelope
sub-object.
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Note that the orange splines running through
the biped have turned yellow. These are
deformation splines, which deform the mesh as
the spline moves.

5. Select the deformation spline running along the
biped’s left forearm to display the associated
envelopes.

Notice that each biped part has two envelopes,
an inner one (red) and an outer one (purple).
Some of the vertices near the opening of the
glove are outside the outer envelope boundary.
These vertices won’t be affected at all by the
biped’s lower arm unless the envelope is
enlarged.

6. In the Blending Envelopes rollout, in the
Envelope Parameters group, increase the Radial
Scale parameter to 2.0.

The vertices at the opening of Dr. X’s glove are
now within the envelope.

The dark outer envelope completely encompasses the
lower arm.

Many more small adjustments are needed to
make all the envelopes fit the mesh correctly. In
the next lesson, you’ll load a file that has a mesh
with envelopes that are properly adjusted.

Note: Keep in mind that the default envelopes
are based on the size of the biped bones.
Therefore, if you adjust the envelopes of a
character that uses the Classic biped body type,
and later change to the Skeleton body type, the
envelopes are going to be much smaller and will
require more editing.

When you have finished adjusting envelopes,
you can apply a MeshSmooth modifier to the
mesh above the Physique modifier to make the
mesh look smoother.

7. Apply the MeshSmooth modifier to the mesh
above the Physique modifier, and set Iterations
to 1.

When MeshSmooth is placed above Physique
on the stack, you only need to adjust envelopes
for the low-poly version of the model. The
Physique settings are passed up the stack to the
MeshSmooth modifier.

8. Save your work as my_drx02.max.

If you want to learn more about adjusting
envelopes and vertex assignments, see the
lesson Adjusting Envelopes (page 1–400).
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Animating the Biped with
Freeform Animation

There are two types of animation that a biped
can perform: Freeform animation and Footstep
animation. In this lesson, you’ll use Freeform
animation to make Dr. X do a series of deep knee
bends. Freeform animation does not use footsteps.
You manually set all the keys in a Freeform
animation.

To get an idea of how your animation should turn
out, view the preview file, drxkneebends.avi, in the
tutorials\character_animation\quick_start folder.

Dr. X doing his deep knee bend exercises

Set up for this lesson:

1. Open cs4_qs_drx03.max from the
tutorials\character_animation\quick_start
folder.

This scene contains Dr. X with properly
adjusted envelopes.

2. Press the H key and choose DrX Biped L Foot
from the Select Object list, then click the Select
button.

Plant the feet:

Since Dr. X is doing squats, his feet are not
required to move. You’ll plant his feet to keep them
from moving throughout the exercise.

1. Open the Motion panel.

2. Expand the Key Info rollout, and expand the
IK expansion bar.

The left foot is selected, so you can set a key for
it.

3. In the Key Info rollout, click Set Planted
Key.

4. In the Track Selection rollout, click the
Opposite button to select DrX Biped R Foot.

5. Click Set Planted Key to set a key for the
right foot.

Animate the first knee bend:

You’ll start by animating the knee-bending motion.
Dr. X will start the knee bend in his current stance
with arms outstretched, and perform a total of
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four squats. When completed, he’ll return to his
original stance.

When the feet are planted, you animate the knees
bending by moving the biped’s center of mass up
and down.

1. Make sure the time slider is at frame 0.

2. In the Track Selection rollout, click Body
Vertical.

This selects the center of mass’s body vertical
track.

3. Turn on Auto Key.

4. Move the center of mass (COM) downward
slightly to make the character’s knees bend a
little bit.

This places a key for the center of mass’s body
vertical track at frame 0.

5. Right-click in the Front viewport to activate it,
and move the time slider to frame 15.

6. Move the COM down about –0.25m on
the Z-axis.

Watch the Coordinate display Z-field until it
reaches about –0.25m and release the mouse

button. A key is automatically created at frame
15. This is Dr. X’s squatted pose.

7. Scrub (pull) the time slider to see Dr. X bend
his knees once.

Copy and paste the standing posture:

1. Move the time slider to frame 0.

2. Expand the Copy/Paste rollout.

The tools on this rollout enable you to quickly
copy and paste keys from one frame to
other frames. By default, the Posture option
is selected. This option pastes keys from
individual body parts.

3. In the Copy/Paste rollout, click Create
Collections. Name the Collection Dr X poses.

4. Click the Copy Posture button.

5. In the Copied Postures field, rename the
posture to the name Standing.

6. Move the time slider to frame 30.

7. Make sure Auto Key is still turned on.
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8. In the Copy/Paste rollout, paste options
group, click the Paste Vertical button.

9. Click Paste Posture.

Dr. X stands up again. When you paste a
posture with Auto Key turned on, a key is
created at the current frame with the new
posture. Here, a new key was created for the
COM’s Body Vertical track at frame 30.

Copy and paste the squatting posture:

1. Go to frame 15.

2. In the Copy/Paste rollout, click the
Copy Posture button. Rename the posture to
Squatting.

3. Go to frame 45, and click Paste Posture.

Paste the remaining postures:

Now that you’ve stored the two postures, you can
easily paste them to other frames.

1. Go to frame 60. Choose the Standing posture
from the Copied Postures list, and click Paste
Posture.

2. Go to frame 75. Choose the Squatting posture
from the Copied Postures list, and click Paste
Posture.

3. On frame 90, paste the Standing posture.

4. On frame 105, paste the Squatting posture.

5. On frame 120, paste the Standing posture.

You have now created all the knee-bend
motions for this animation. If you like, you can
play the animation to see the motion.

6. Save the scene as MyDrX02.max.

Animate the arms:

Now that the legs are set to bend, you’ll rotate
the arms and lock the upper body. As Dr. X dips

down, his arms are going to swing forward, then
back out to his sides as he rises. You’ll also set two
keys to lock the upper body to keep Dr. X facing
forward.

1. Press the H key and choose DrX Biped L
UpperArm, then click the Select button.

2. From the Track Selection rollout, click
the Symmetrical button to select the opposite
upper arm.

3. Move the time slider to frame 0.

4. On the Key Info rollout, click Set Key.

This sets a key for the arms in their outstretched
position.

Warning: Be sure to use the Set Key button on the

Key Info rollout, not the Set Key text button under

Auto Key.

5. On the Copy/Paste rollout, click Copy
Posture. Name the posture Arms Out.

6. Move the time slider to frame 15.

7. In the Top viewport, rotate the arms
about –75 degrees around the Z-axis.

Look at the Z-field in the Coordinate display
Z-field when rotating the arms. A key is added,
and Dr. X’s arms are in the forward position.
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8. On the Copy/Paste rollout, click Copy Posture,
and name the posture Arms Forward.

9. Paste the copied postures to set keys for the
arms on these frames:

• Frame 30: Arms Out

• Frame 45: Arms Forward

• Frame 60: Arms Out

• Frame 75: Arms Forward

• Frame 90: Arms Out

• Frame 105: Arms Forward

• Frame 120: Arms Out

Save a motion clip:

When you’re happy with the results of the
animation, you want to save it so the motion can
be reused in the future. When you save a motion,
it is saved in the .bip file format, the native format
for biped character movement.

1. Select any part of the biped. If you have hidden
the biped to render the scene, you must unhide
it before you can select it.

2. From the Biped rollout, choose Save File.

The Save File dialog displays.

3. Specify a folder where you are storing
your motion files such as a new
tutorials\character_animation\motions
folder.

4. Enter my_kneebends as the file name and click
Save.

The motion is saved as a BIP file.

To learn more about freeform animation, see
the tutorial Animating with Freeform (page
1–343).

Play the animation:

1. Select all the parts of the biped, and right-click
and choose Hide Selection.

2. Select the mesh. In the Modify panel, turn on
the MeshSmooth modifier by clicking the light
bulb to turn it on.

3. Play the animation.

4. Save the scene as my_drx03_freeform.max.

Animating the Biped with
Footsteps

Now that you’re familiar with freeform animation,
you’ll learn the basics of footstep animation.
Footstep animation only controls the placement
of the biped’s feet. In this lesson, you’ll create a
footstep animation where Dr. X walks for eight
steps.

You can see what your animation should look like
by viewing the preview file, drxwalk.avi, in the
tutorials\character_animation\quick_start folder.
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Set up the lesson:

1. Reload cs4_qs_drX03.max from the
tutorials\character_animation\quick_start
folder.

This scene contains Dr. X with Physique
applied to the mesh, and all envelopes adjusted.
The mesh is ready for animation.

2. Press the H key and choose DoctorX from the
Select Object list, then click the Select button.

3. In the Perspective viewport, right-click the
mesh and choose Hide Selection from the quad
menu.

Hiding the mesh makes it easier to select the
biped and test the animation. This is especially
true if you have a highly detailed mesh.

4. Press the H key again and choose DrX Biped,
the center of mass, from the Select Object list,
then click the Select button.

Create the footsteps:

Now you’ll make Dr. X walk forward in a straight
line.

1. Open the Motion panel.

2. In the Biped rollout, turn on Footstep
Mode.

Using the rollouts that now display, you’ll create
footsteps for Dr. X.
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3. In the Footstep Creation rollout, click the
Create Multiple Footsteps button.

The Create Multiple Footsteps: Walk dialog
displays.

4. In the General group, increase the Number Of
Footsteps to 8 and click OK.

5. In the Footstep Operations rollout, click
Create Keys For Inactive Footsteps.

When the footstep keys are created, Dr. X
changes his pose.

6. Right-click in the Perspective viewport,
and then click the Play Animation button. You
can also scrub the time slider to examine the
animation more closely.

By just watching the biped walk, you can tell
that Dr. X’s walk doesn’t look right. You can see
that the feet are too close together, and his arms
are straight down at his side. In addition, the
shoes and hands will collide or intersect with
other body parts when the mesh is displayed
again. Next, you’ll do some fine tuning to make
Dr. X’s walk look better.

Fine tune the animation:

In this part of the lesson, you’ll make a few
adjustments to clean up the animation.

1. If you don’t see footsteps outlined in front of
Dr. X, do the following:

• In the Biped rollout, click the gray expansion
bar below the buttons. Additional buttons
appear.
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• In the Display group, click the Show
Footsteps And Numbers button.

Note: If the footsteps still fail to display,
click the Show Footsteps And Numbers
button and hold until you see the button
flyout. Choose the Show Footsteps And
Numbers button from the flyout.

2. In the Perspective viewport, zoom out, if
necessary, to see all the footsteps. Drag a
selection window around all the footsteps. Be
sure to include the two footsteps under the
biped’s feet.

The footsteps turn white after they’re selected.

Note: Because you’re working in Footstep mode,
only the footsteps can be selected, so you can
drag over the biped without fear of selecting
other objects.

3. In the Footstep Operations rollout, turn off
Length and increase the Scale to 2.5.

The biped’s stance widens to more closely
match how it looked in Figure mode. However,
now that the stance is wider, the hands will
intersect the legs when the mesh is unhidden.
You’ll fix that next.

Rotate the arms:

With the wider stance, the hands intersect the legs
as they swing past. Now you’ll do a little freeform
animation to give the arms some clearance.

1. In the Biped rollout, turn off Footstep
mode.

Now you can rotate Dr. X’s arms.

2. Press the H key and select DrX Biped L
Upperarm.

3. In the Track Selection rollout, click the
Symmetrical button.

Notice the keys in the time line. At each of the
keys, you’ll rotate the arms.

4. Turn on Auto Key and Key
Mode Toggle, then click the right arrow on the
time slider.

The time slider jumps to frame 30.

5. On the Main toolbar, click the Rotate
button.

6. On the Coordinate display, in the Y-field, enter
12.

The arms are rotated out away from the body.
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7. Continue clicking the right arrow on the time
slider to jump to the next key and repeat the
same amount of rotation for each key on the
time line.

Don’t forget the key at frame 0.

8. Turn off Auto Key to end the
animation process.

9. Play the animation.

Save the motion in a BIP file:

You can save the footstep motion for later use in
other scenes.

1. From the Biped rollout, choose Save File.

The Save File dialog displays.

2. Specify a folder where you are
storing your motion files such as a
newtutorials\character_animation\motions
folder.

3. Enter my_DrXWalk as the file name, and click
Save.

The footstep motion is saved in the BIP file.

Prepare for playing or rendering:

1. Press the H key and click the All button, then
click Select.

2. Right-click the biped and choose Hide
Selection.

The biped is now hidden.

3. Open the Display panel. In the Hide rollout,
click Unhide By Name.

The Unhide Objects dialog displays.

4. Select DoctorX from the list and click Unhide.

Dr. X’s mesh is unhidden.

5. On the Modify panel, turn on the MeshSmooth
modifier by clicking the light bulb to turn it on.

6. Click in the Perspective viewport and
click the Play Animation button.
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7. Save the scene as my_drx03_footsteps.max.

You can find a finished version of this scene in
the file cs4_qs_drX03_footsteps.max.

Combining Motions with the
Motion Mixer

In this lesson, you’ll use the Motion Mixer with the
two motion files you’ve just created. The Motion
Mixer lets you create a smooth transition between
Dr. X doing his deep knee bends and walking.

Set up for this lesson:

• Open the file cs4_qs_drX03.max from the
tutorials\character_animation\quick_start
folder.

This scene contains Dr. X ready for animation.

Open the Motion Mixer:

The Motion Mixer is similar to a sound mixer,
except you’ll work with animation files instead of
audio files. You’ll add motion clips, which are .bip
files, to the Motion Mixer, and create transitions
between the clips to smoothly blend them together.

1. Select any part of the biped.

2. Open the Motion panel.

3. On the Biped rollout, turn off Figure
Mode.

4. In the Biped Apps rollout, click
the Mixer button.

The Motion Mixer window opens.

The biped is automatically displayed in the
Mixer. It has a default trackgroup labelled All,
where you will start laying out your tracks,
motion clips, and transitions. The label All
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indicates that motions placed on tracks will
apply to the entire biped, rather than specific
body parts.

Tip: The Motion Mixer window can be resized.
For better viewing of what’s added to the Mixer,
you can drag the edge of the window vertically
and horizontally.

Opening the Motion Mixer also
automatically turns on the Mixer Mode button
on the Biped rollout. When Mixer mode is on,
the biped performs the motions in the Motion
Mixer.

Add the clips to the Mixer:

Trackgroups are populated by tracks, in the form
of Layer tracks or Transition tracks. On each track,
you add clips and transitions. The final product of
your efforts is called a mix.

Here, you’ll add two clips to the trackgroup with a
transition between them.

1. Click in the topmost track on the All trackgroup
to select it. The track turns a lighter gray color
when selected.

By default, the topmost track is a layer track,
which is designed for consecutive clips with no
transitions between them. You want to create a
transition between two clips, so you’ll need a
transition track.

2. On the Mixer menu bar, open the Tracks menu
and choose Convert To Transition Track.

The track is changed to a transition track that
is taller than the original, with room for two
tracks and a transition.

Tip: You can right-click the track to access the
same menu options.

3. On the Tracks menu, choose New Clips > From
Files.

The Open dialog displays.

4. If you’ve done the two previous lessons
and want to use the motions you
created, browse to the folder where
you saved your motions, and choose
my_kneebends.bip. Otherwise, browse to the
tutorials\character_animation\quick_start
folder and choose kneebends.bip.

The clip holding the knee-bend motion is
added to the track.

The clip appears with hatchmarks, indicating
that it is not yet valid. A clip on a transition
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track has to have a transition to be valid. You’ll
take care of this in the next step.

Note: The color of the clip in your Motion Mixer
might differ from the color of the clip in the
image.

5. Right-click a blank area of the transition track,
and choose New Clips > From Files from the
pop-up menu. Choose the file my_drxwalk.bip
or drxwalk.bip.

The second clip is added to the track, and a
transition is automatically added between the
two clips. The transition is colored with a
darker version of the clip color, and spans the
transition time between the two clips.

6. On the Motion Mixer toolbar, click Zoom
Extents so you can see the entire mix in the
display.

7. On the Motion Mixer toolbar, click Set
Range.

This feature automatically sets the length of the
animation to the number of frames needed
for the mix. In this case, it sets the animation
length to 225 frames.

Play the mix:

You’ve just created a basic mix comprised of
two clips and a transition. Now you’ll play the
animation.

1. In the Biped rollout, turn on the Mixer
Mode button if it’s not already active.

2. Click the Play Animation button on the
3ds Max status bar. Watch the animation in the
viewport and its progress in the Mixer window.

Dr. X does his knee bends in the first clip.
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He smoothly transitions to walking in the
second clip.

The feet slide a little during the transition, but
this problem can be fixed with the Mixer. For
information on how to do this, and for a more
detailed look at other features in the Motion
Mixer, see the tutorial Mixing Animation (page
2–547).

3. Save the scene as my_drx03_mixer.max.

You can find a finished version of this scene in
the file cs4_qs_drX03_mixer.max.

Tip: If you want to render this animation, hide
the biped, select the mesh, and turn on the
MeshSmooth modifier on the Modify panel
before rendering.

Animating with Footsteps
Footstep mode uses a unique footstep gizmo to
control the contact of the foot with the ground.
When you move a footstep gizmo to a new

location, the animation updates to match the
move.

Footstep animation

In this tutorial, you’ll do the following:

• Animate a biped using footsteps.

• Make a biped walk, run, jump, and do flips.

• Make a biped take a pratfall.

• Add a freeform period to a footstep animation.

• Convert a footstep animation to freeform.

• Change the duration of a footstep animation
using IK keys.

Skill level: Beginner

Time to complete: 1+ hours

You can find the files for this tutorial in
the tutorials\character_animation\footstep_
animation folder on the Tutorial Files CD that
ships with 3ds Max. Before starting the tutorials,
copy the \tutorials folder from the CD to your
\3dsmax8 local installation.
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Creating a Distinctive Walk

In this lesson, using automatically created motion
as the basis, you’ll animate a biped walking with
a rolling, springy step.

The automatic footsteps generate a starting point
for you. You’ll then change the automatic walk
into something more expressive and distinctive.
This sophisticated yet simple approach results
in a natural-looking motion that you can create
quickly.

Set up for this lesson:

1. Reset 3ds Max.

2. From the tutorials\character_animation\
footstep_animation folder, open
walk_start.max.

In this file, a biped is standing near the origin.

Biped near origin of grid

3. Maximize the Perspective viewport by pressing
ALT+W.

4. Click any part of the biped to select it.

A white box outlines the selected body part.

5. Open the Motion panel.

The Biped controls are displayed. Figure mode
is active.

Next you’ll turn on Footstep mode. Figure
mode turns off automatically.

Create multiple footsteps:

1. On the Motion panel, in the Biped
rollout, turn on Footstep Mode.

The Footstep mode button turns
yellow, and the Footstep Creation and Footstep
Operations rollouts are displayed.

2. In the Footstep Creation rollout, click
Create Multiple Footsteps.

The Create Multiple Footsteps: Walk dialog is
displayed. Here you see many parameters for
creating multiple footsteps. You’ll only change
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the number of footsteps, leaving the other
defaults as they are.

3. In the General group of the Create Multiple
Footsteps: Walk dialog, change Number Of
Footsteps to 8, and then click OK.

Footprints are displayed in white in the
viewport. These are inactive footsteps. They do
not yet control any animation for the biped. If
you press the Play Animation button, the biped
won’t move.

Inactive footsteps

4. In the Footstep Operations rollout, click
Create Keys For Inactive Footsteps.

The footsteps are activated. Animation keys are
created for the biped.

5. Play the animation.

The biped walks.

The biped takes a step.

The biped takes another step.
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The biped keeps on walking.

6. On the Biped rollout, turn off the Footstep
Mode button.

Notice that the first footstep is numbered 0, and
the last footstep is numbered 7.

7. In the Track Selection Rollout, click the
Body Horizontal button. This selects the
horizontal position track for the center of mass
(COM) object.

The track bar displays keys for the length of the
animation.

Body Horizontal keys

8. In the Track Selection rollout, click the
Horizontal button to turn it off, and then click
the Body Vertical button.

The same keys are visible in the viewport.

Body Vertical keys

9. Play the animation.

The biped walks, but without much character.

In the following procedures, you’ll begin
individualizing the motion by adjusting the
keys for the Body Horizontal, Vertical, and
Rotation tracks. You’ll exaggerate the rotation
of the center of mass to create a more energetic
walk.

Adjust body rotation keys:

1. In the Perspective viewport, use Arc
Rotate to shift the view so that the biped is
walking toward you. Then move the time slider
to frame 0.

Be sure a part of the biped is still selected.
In the Track Selection rollout, click the Body
Rotation button.

The Transform gizmo displays for rotation. The
track bar displays the rotation keys.

2. On the 3ds Max status bar, click the Key
Mode button to turn on Key mode.

Key mode lets you use Previous and Next
Key buttons to jump between keyframes for
the selected object. You can also use the <
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and > keys on the keyboard to move between
keyframes without clicking the mouse.

3. Press > on the keyboard to move the time
slider to frame 24.

4. Use the Transform gizmo to adjust the body
rotation. Move your cursor over the gizmo;
when the circle turns yellow and the X in the
center turns red, press and drag to rotate. If
you can’t see the X, zoom into the viewport.
Rotate 5 to 10 degrees about the X-axis to move
the hips down toward the leg that is in motion.
When you rotate, one foot will cross the other.

Tip: The rotation is displayed in yellow text
above the Transform gizmo, and also in the
Coordinate fields on the status bar. You can use
the plus (+) and minus (–) keys to change the
size of the Transform gizmo.

Rotation of the center of mass object about the X-axis

5. On the Motion panel, open the Key Info
rollout and click the Set Key button.

When you set the key, the biped will shift
position slightly. In the viewport, you can see
that the blue foot is no longer crossing the
green.

Biped foot snaps away from the other foot.

What is happening is that the foot, calf, and
thigh bones are being controlled by the footstep
gizmos. The footsteps represent a pair of keys
with IK Blend set to 1 and the Join To Prev IK
key turned on. When you set the key, these
settings force the foot, calf, and leg bones back
into the correct path for walking.

6. Click Next Key three times to move to
frame 40.

7. Rotate the Transform gizmo –6 to –10 degrees
about the X-axis.
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Negative rotation with blue foot in contact with the
ground

8. Slowly go through the rest of the rotation keys,
repeating this process. At keys where the blue
foot comes in contact with the ground (frames
40, 69, and 99), rotate about the X-axis in a
negative direction, then set a key. At keys where
the green foot is down (frames 55, 84, 116),
rotate about the X-axis in a positive direction,
then set a key.

Positive rotation at frame 54

9. Repeat this pattern until you have finished
rotating the COM at the end of the animation.
Don’t make your adjustments too precise.
Slight variations from frame to frame make the
motion look more natural.

When you are done, play the animation and
notice the increased hip swings that result from
rotating the center of mass back and forth.

10. On the Biped rollout, click Save File and
save the file as mywalk.bip.

If you load the newly saved mywalk.bip file
into a scene containing a skinned character,
the character will swing its hips according to
the instructions you saved in this file. Play the
animation to determine if you need to adjust
it. For instance, Dr. X (from the quick start
tutorial) has huge feet, which may need to be
moved further apart so they don’t pass through
the legs accidentally.

Dr. X character with distinctive walk

Add spring to the step:

1. Continue from before, or load mywalk.bip that
you saved.
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To load a BIP file, create or select a biped. On
the Motion panel, in the Biped rollout, click File
Load and open the file. This transfers all the
movement information in the file to the biped.

2. In the Track Selection rollout, click the
Body Vertical button.

This selects the vertical position track for the
center of mass object.

3. Turn on Key Mode, if it isn’t already on.

4. Starting at frame 0, move through the
animation using the < and > keys. When you
come to a frame where either a green or blue
foot comes in contact with the ground, move
the COM down just a few units.

The knees will bend because the feet are
controlled by the footsteps.

5. In the Key Info rollout, press the Set Key
button after making a change at a frame.

This sets a key for the change you’ve made in the
viewport. Otherwise the change is discarded.

6. Play the animation.

The biped walks with newfound bounce.

7. On the Biped rollout, click Save File.
Name the file mywalk2.bip.

Add arm and hand motions:

Arm and hand motions are an integral part of an
individual’s gait. In the following sequence, you’ll
customize the arm motion by moving the hands
and rotating the arms.

You previously created keyframes using the Set
Key button; however, for this technique, you’ll use
Auto Key instead.

1. Continue from before, or load mywalk2.bip,
the file you saved earlier. If you prefer, you

can begin at the end of the last procedure by
opening springystep.max.

2. In the 3ds Max status bar, turn on the
Auto Key button.

3. Move the time slider to frame 0.

4. Dragging the time slider to the right, flip
through the frames of animation. Drag forward
and backward, and watch the how the arms and
legs swing. Study the motion carefully.

When the green foot is extended, the blue arm
swings forward. When the blue foot swings out,
the green arm swings forward. See if you can
find the frame at which the hand extends the
farthest forward.

5. In the viewport, select the green hand of the
biped (Bip01 RHand).

The track bar displays the keys for the hand.

6. Move the time slider to frame 30.

There is a key in track bar at that frame for the
hand object.

7. Right-click the hand, and choose Move from
the quad menu.

Using the Transform gizmo, move the hand
approximately 10 units upward on the Z-axis.

By moving the hand, you’ve also rotated the
two arm bones. The keys for the hand and arm
bones are stored on a single track.
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The hand moved upward

8. Select the Bip01 R UpperArm object, then
right-click and choose Rotate. Rotate the upper
arm approximately -30 degrees about the
Z-axis.

The upper arm rotated around the Z-axis

9. Rotate the upper arm approximately 20 degrees
about the Y-axis, so the elbows are flying out
and away from the body.

10.Select the forearm object (Bip01 R Forearm)
and rotate it so the hand moves closer to the
chest.

The hand rotated close to the chest

You can position the arm using forward
kinematics (the rotation of the parent objects)
or inverse kinematic (using position transform
on the end of the chain, in this case the position
of the wrist.) You can also rotate the hands.

11. Use Arc Rotate to revolve the viewport so
you can see the angle of the other arm behind
the biped.
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View of the arm behind the biped

12.Select the blue hand, and right-click to choose
Move. Move the hand further away from the
biped’s body. Then move the blue hand upward
on the Z-axis so the elbow bends slightly.

13.Move the time slider back and forth to observe
the animation so far.

14.Repeat the process at frames 60 and 90.

15.Repeat for the other side at frames 45 and 75.

Tip: If you want exact duplication of these
arm positions, you can use the tools in the
Copy/Paste rollout. Select both arm assemblies,
create a collection, then use Copy Posture
and Paste Opposite at the correct frames. See
Creating a Simple Freeform Animation (page
1–344)for information on using those features.

16.Play the animation.

Save it as mywalk3.bip.

17.To see your work on a skinned character,
open cs4_qs_DrX04.max from the
\tutorials\character_animation\quick_start
tutorial folder, and then load your mywalk3.bip
file. For comparison, you can also load
distinctive_walk_final.bip. Remember to select
part of the biped to access the Biped rollout.

Dr. X with spring in his step

Add head motions:

You can edit the head motion to make the biped’s
walk look more natural. In this procedure,
you’ll add head rotations to accentuate the COM
rotation.

1. Turn on Auto Key, if it isn’t on already.
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2. Turn on Key mode, if it isn’t on already.

3. Move the time slider to frame 0.

4. In the Perspective viewport, select the
biped’s head using Rotate on the 3ds Max Main
toolbar.

5. Rotate the head down as if the biped is asleep.

The head rotated downward

6. Move the time slider to the next keyframe by
pressing the > key on the keyboard.

7. Keyframe rotations for the head. You can rotate
the head to counterbalance the angle of the
shoulders. Or, you can rotate the head in the
opposite direction so it follows the rotation of
the COM. Each rotation will give a different
result. Extreme rotations should be avoided.
Also, be careful to put the rotations only on
existing keys.

Rotate the head to follow the movement, or rotate the
head to oppose the shoulders.

8. Continue to jump through the head’s keys,
setting rotations of your choice to animate the
head.

Natural head motion is smooth, so the
orientations should change gradually from one
key to the next.

9. Turn off Auto Key and Key Mode.

10.Play the animation, and notice how much the
biped’s head movements add to the animation.

You can now save your work as
mywalk4.bip. You can check your file
against head_rotate_with.bip and head
rotate_against.bip.
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Dr. X’s distinctive walk with head rotation

Modifying Footsteps

In this lesson, you’ll learn how to copy and paste
biped footsteps to extend an animation. You’ll also
learn how to adjust and bend the steps, and to
produce the effect of walking on uneven terrain.
You’ll also make the biped take a jump.

Set up for this lesson:

• Continue from the previous exercise, or open
paste_footsteps_start.max.

Extend the walk:

1. Select any part of the biped.

2. On the Motion panel, in the Biped
rollout, turn on Footstep Mode.

The Footsteps sub-object level is activated, and
only the footsteps can be selected.

3. Right-click to activate the Top viewport, then
press ALT+W to maximize the viewport.

4. Using Select And Move, region-select footsteps
3 through 7.

5. On the Footstep Operations rollout, click
Copy Footsteps to place the selected footsteps
into the footstep buffer.

6. Click Paste Footsteps to paste the selected
footsteps into the viewport.

The new footsteps appear next to the biped’s
current footsteps.

Pasted footsteps appear.

Tip: If you have Transform gizmo on, use the
minus key (-) to shrink the Transform gizmo,
so it doesn’t cover up the footsteps.

7. The new footsteps can be moved as a set. Move
them so the first footstep of the new set is over
footstep 7 of the original set. When footstep 7
of the original set turns red, release the mouse
button.

Footsteps from the original motion are
inserted. Now there are 11 footsteps visible.

8. Press ALT+W to display four viewports.

9. To display the entire animation in the
Perspective viewport, zoom out and use Arc
Rotate and Pan to adjust your view until the
biped and all 11 steps are visible.
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Pasted footsteps extend the motion.

10.With the Perspective viewport active, play the
animation.

Since you are still in Footstep mode, the Motion
panel is available. This is a good time to save
your mywalk_pasted.bip file, using Save File
on the Biped rollout.

Scale the walk:

1. Make sure Footstep mode is active.

2. In the Top viewport, region-select all the
footsteps.

3. On the Footstep Operations rollout, turn off
Length, and leave Width selected.

4. Set Scale to 2.0 to double the spacing between
the left and right footsteps.

5. Play the animation.

The biped walks with legs apart.

6. Set Scale to 0.25 or smaller to reduce the
spacing between the left and right footsteps to
half of the original scaling (one-quarter the
current setting).

If you hadn’t previously doubled this parameter,
a setting of 0.5 would have scaled the width by
50%.

Now the biped puts one foot in front of the next.

Tip: If your character has big feet, or if it’s
walking on a wire or a ledge, use Scale Width
and Length to adjust the footsteps.

Scale the width between the steps.

7. Play the animation.

The biped walks as if on a tightrope.

Bend the walk:

1. In the Top viewport, select all the footsteps
from 7 on.

2. On the Footstep Operations rollout, set Bend
to 20.0.

The footsteps bend to the left, beginning at
footstep 7.

3. Play the animation.

Walk on uneven terrain:

You can raise and rotate the footsteps to create the
illusion of walking on uneven terrain.

1. Make sure that Footstep mode is still on.

2. Maximize the Perspective viewport.

3. Use Select And Rotate to select all the footsteps
from 4 on.
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4. Use the Transform gizmo arrows to rotate the
selected footsteps approximately -15 degrees
about the X-axis so the footsteps go up a hill.

5. Select footsteps 8 through 11.

6. Rotate the selected footsteps about the X-axis
approximately 21 degrees, so that the footsteps
go back down the hill.

7. Select footstep 11. Rotate it so it’s parallel with
the grid.

8. Play the animation.

The biped’s feet follow the footstep placement.

Add a jump:

If there is a period of time during a footstep
animation when neither foot is on the ground, the
software interprets this period as a jump. There
are several different ways to create a jumping
animation. In this set of procedures, you’ll move
footstep keys in Track View to make the jump.

• Open footsteps_jump_start.max.

This is a slightly longer version of the same file
you’ve been working on. It has 15 footsteps
instead of 11.

Move footstep keys in Track View:

1. Select Bip01. On the Motion panel, in the
Biped rollout, turn on Footstep Mode, if it isn’t
already on.

2. In the viewport, right-click and choose Curve
Editor from the quad menu.

Track View is displayed.

3. On the Track View menu bar, choose Modes >
Dope Sheet.

The Bip01 Footstep track is displayed in Track
View.

Tip: If this track is not displayed, turn on
Footstep Mode, and the track will appear as
long as you’re in the Dope Sheet editor.

Dope Sheet shows special footstep keys.

In the illustration above, each blue block
represents a left footstep, and each green block
represents a right footstep. The length of the
blocks is the period of time that the foot is in
contact with the ground during the footstep.
The spaces between the blue and green blocks
represent periods in which the biped is not
supported by the left or right foot.

4. Navigate the viewport using Zoom and Pan
until you can see the biped and the footsteps, as
well as the Footstep keys in Track View.

5. Resize the Track View window, or zoom into
the track so you can see the start and end frame
numbers on each footstep.

6. Select footsteps 11 through 15 by drawing a box
around them in Track View, or by dragging a
selection region in the viewport.

In Track View, notice that footstep number 11
starts at frame 165.

7. On the Track View toolbar, click the
Slide Keys button.
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8. In Track View, click in the center of footstep
11 and drag it to the right until the number
166 (indicating the first frame of footstep 11)
increments to number 180. Release the mouse
button.

This creates a gap between step 10 and 11. The
keys in the other biped tracks adjust to the
change in the footstep track.

The keys shifted to the right to create a gap

By creating an area in the footstep track where
neither foot is supporting the biped, you have
changed a walking step into a jumping step

9. Play the animation.

The gap between footsteps creates a jump.

10.In the viewport, move footstep 10 so it is next
to footstep 9.

11.In the viewport, move footsteps 11 through 15
so there is more of a gap for the jump. Move
these footsteps about 5–7 units in the X-axis
direction.

More gap for the jump

Now, if you shorten the duration of footstep 10,
you can accentuate the jump.

12. On the Track View toolbar, click Move
Key.

13.In Track View - Dope Sheet, click the right edge
of footstep 10.

A white dot appears only on the right side of the
key to show it’s selected.

14.Drag the right edge of footstep 10 to the left to
shorten the duration of the key. Change the key
so it ends at frame 160.

Shorten the duration of footstep 10.

15.Play the animation and observe the jump.

16.Turn off Footstep Mode.

Make the biped crouch before the jump:

The preparation for the jump, between footsteps 9
and 10, looks a little stiff because the biped is not
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crouching enough before jumping. Resetting a
vertical key will fix this.

1. On the Motion panel, in the Track
Selection rollout, click Body Vertical.

2. Move the time slider to frame 153, where there
is a Body Vertical track key.

3. On the Motion panel, in the Key Info
rollout, click Set Key.

4. Press H and select Bip01, the center of mass.

5. Move the center of mass down approximately
-5 units. If the biped jumps back to its original
position, click Set Key and try again. Click Set
Key when you have a crouching position as
illustrated here.

Lower the center-of-mass object using the Body Vertical
track.

6. Move the time slider to view the animation.

There appears to be a glitch in the motion.
There are two Body Vertical keys next to each
other that are causing this problem.

7. Move the time slider to frame 153.

8. In the Key Info rollout, click the Next Key arrow
to move to the next key at frame 154. Click
Delete Key to remove this second key.

9. Select Bip01 R Foot.

10.Move the time slider to frame 167. Click Body
Vertical and raise the foot slightly, so the biped’s
knee is bent.

11. Set a free key to hold the bent knee
position. Set additional keys on the foot if it
hyperextends before it hits the ground, or if it
goes through the ground at takeoff.

12.Play back the animation and observe the
motion.

13.In the Track Selection rollout, click Body
Rotation. Move the time slider to frame 160.
Using the Transform gizmo, rotate the center of
mass so the body pitches forward.

The jump looks more natural now. The
result should be similar to the jump in
footstep_jump_final.bip.
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Making a Biped Stop and Start
Walking

In just a few key strokes, you can generate multiple
footsteps to make a biped walk. But what if you
want the biped to stop and pause? To do that, you’ll
use a simple manipulation of the footstep keys
in the Track View - Dope Sheet. Just stretching
the length of the selected footsteps changes the
animation so the biped pauses in its path.

Make the biped stop and start:

1. Open standstill_start.max.

2. In the viewport, select any part of the biped.

3. Open the Motion panel.

The Biped controls are displayed in the rollouts.

4. Play the animation of the biped by pressing the
Play Animation button in the VCR controls.

The biped walks seven steps forward without
stopping.

You’ll use footsteps 4 and 5 as the footsteps
where the biped pauses.

5. In the Biped rollout, turn on Footstep
Mode.

6. In the Perspective viewport, select footsteps
5–7, then right-click and choose Move.

7. Move the footsteps so that footstep 5 is next to
footstep 4.
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8. Play the animation to observe the change.

The animation looks a little funny right now;
something’s not quite right.

It’s good practice to deactivate the footsteps,
and then create new keys from the moved
footsteps. This will recreate the correct upper
body motions. You’ll do that next.

Create keys to correct upper body motions:

1. Select footsteps 4–7 in the viewport. On the
Motion panel, in the Footstep Operations
rollout, click Deactivate Footsteps.

To manipulate the footstep keys, you’ll use
Track View in Dope Sheet mode.

2. On the 3ds Max menu bar, choose Graph
Editors > Track View - Dope Sheet.

The Dope Sheet opens, and the footstep tracks
are displayed.

3. Right-click the top of the Track View window
and choose Dock > Bottom.

The Dope Sheet moves out of the way of the
viewports.

4. Make adjustments as needed to your viewport
so you have a clear view of the footsteps and
the biped. When you select footsteps in the
viewport, you also select footstep keys in Dope
Sheet.

5. Select footsteps 4–7 in the viewport, if they
aren’t already selected.

In the Dope Sheet, the selected keys appear
with white dots on them.

6. Press ALT and click the white dot at the left side
of footstep key 4. This deselects the left side of
that footstep key. Repeat for key 5, deselecting
the left side of the key.

Keys 4 through 7 are selected, but keys 4 and 5
display only one white dot.

7. From the right side of key 5, drag to the right so
the key ends at frame 200.

8. On the keyboard, press ALT+R to extend the
animation to match the footstep keys.

Frames are automatically added to the
animation.

The light grey background extends behind the
footstep keys. The time slider now shows that
there are 230 frames in the animation.

9. Play the animation and observe the biped
motion.

The biped walks, then stops and waits, and
then walks again. The motion seems a bit odd,
though, as he steps off around frame 180.

Tip: There are a number of different ways to play
and observe biped motion. One way is to drag
the time slider to play the animation. For more
control, press the < and > keys on the keyboard.
This lets you stop instantly if you see a problem,
and is more like a traditional animator flipping
through the pages of drawings.

10. In the Footstep Operations rollout, click
Deactivate Footsteps.

In the Dope Sheet, the footstep keys change
color .

11. In the Footstep Operations rollout, click
Create Keys For Inactive Footsteps.
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In the Dope Sheet, the footstep keys change
back to their earlier color.

12.Play the animation again.

The motion is better. When new keys are
created, the software applies a new upper body
motion.

Tip: For this reason, when animating starting
with footsteps, work out the foot motion before
you worry too much about the upper body
motion.

13.Save your work as my_standstill.bip, or open
standstill_final.max to check the completed file.

Animating a Gymnastic Flip

In this lesson, you learn to animate a biped to
produce two realistic back flips, including the
windup and proper in-air motions for the legs,
arms, and upper body. As a final step, you add a
twist to the flips.

In the startup file, the jump sequence has already
been set up for you. It’s a basic, eight-footstep
backward jump produced with the Create Multiple
Footsteps dialog. The last pair of steps have been

moved in to reduce the jump height of the final
hop.

Set up for this lesson:

1. Open flip_start.max.

2. Select any part of the biped, then open the
Motion panel.

3. Activate the Front viewport. Play the
animation using the Biped Playback button on
the Biped rollout. Observe the movement of
the stick figure, then click the button again to
turn off Biped Playback.
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Biped playback

4. Activate the Perspective viewport. Play the
animation by clicking the Play Animation
button on the 3ds Max status bar.

Notice that the upper body appears mechanical,
although the biped leans slightly into the jump
and bends its knees in anticipation of the jump.

Animation playback

5. Click the Time Configuration button to
open the Time Configuration dialog. In the
Playback group turn on Real Time, and set the
Speed to 1x. Click OK to close the dialog, then
play the animation again.

This slows down the playback step so you can
see the animation motion better.

Next, you will add two flips to the motion. Adding
a flip involves setting rotation keys for the body
by rotating the center of mass objectBip01 while
the body is in the air. If the feet are not touching
the ground, rotating the center of mass rotates the
entire body. If the feet are planted on the ground,
rotating the center of mass rotates only the upper
body.

You want the biped to rotate 360 degrees during
a flip. To do this, you need to define at least two
turning keyframes in the air to make the biped flip
all the way around in the same direction.

Add the first flip:

1. On the Motion panel, in the Track
Selection rollout, click Body Rotation to select
rotation track for the center of mass (COM).

The Rotation Transform gizmo appears in the
viewport, with the COM automatically selected.

2. Move the time slider to frame 31, at the top of
the first jump.

3. In the Perspective viewport, rotate the biped
approximately –94 degrees about the Y-axis, so
he is facing the sky and his back is parallel with
the ground plane.

The rotation is displayed in yellow above the
Transform gizmo as the biped rotates.
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Rotation at frame 31

4. On the Key Info rollout, click Set Key to
set a rotation key at frame 31.

5. Move the time slider to frame 42.

The biped rotates back as a result of continuity
with other keys. The next step corrects the
rotation to continue the flip.

6. Rotate the biped -196 degrees about the Y-axis.

The biped is upside down with its feet about to
come back down.

Rotation at frame 42

7. Click Set Key to set a rotation key at frame
42.

This completes the first flip.

8. Scrub the time slider slowly to examine the flip.

You can use the body keys you just created to
produce the second flip. Since the second flip is
similar to the first, you can copy body positions
from the first flip to equivalent frames in the
second flip.

Produce the second flip:

1. Move the time slider to frame 31.

2. Open the Copy/Paste rollout.

3. Make sure Posture is turned on,
then select the Copy Rotation button.

4. Click Copy Posture to copy the body
rotation to the list of copied postures.

The pose from frame 31 is copied to the buffer.
In the Copied Postures list it appears as Rot1.

5. Move the time slider to frame 42 and click Copy
Posture again.
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The pose from frame 42 is copied to the buffer.
In the Copied Postures list, it appears as Rot2.

6. Move the time slider to frame 74, at the top of
the second jump.

7. On the Copied Postures list, choose Rot
1, and then click Paste Posture.

The biped body rotates into the same position
at frame 74 as at frame 31.

8.

Click Set Key to create a roation key for the
copied posture.

9. Move the time slider to frame 85. Choose Rot2
from the list, then click Paste Posture.

10.Click Set Key again.

11. Move the time slider to frame 0, and play
the animation.

Now you have two complete flips in the jump
sequence.

12. Save your motion data. On the Biped
rollout, click Save File, and name the file
myflip2.bip.

Verify your work:

1. On the Biped rollout, click Load File to
open another Biped motion file. On the Open
dialog, choose tutorials\character_animation\
tutorial_3\flip2.bip and click Open.

This motion file contains the same movements
that you created in the opening procedures of
this lesson.

2. Play this version to verify that your motion
sequence is accurate.

You can continue this lesson with this prepared
motion file to insure that you are starting from a
known point. If your motion sequence is correct,

and you would rather use your own file, you can
reload myflip2.bip and proceed with the following
procedures.

Create the basic windup (or angular momentum) for
the flip:

So far, you’ve set keys for the body turning in
midair. Now, to create the impression that the
body is preparing for the back flip by whipping
itself backward just before liftoff, you need to alter
the rotational keys of the body about its center of
mass on the ground. Because the feet are planted
on the ground, rotating the center of mass rotates
only the upper body.

The whipping action also involves the spine
and arms, but you’ll begin by setting the body’s
rotation keys about the center of mass.

1. Select any part of the biped.

2. On the Motion panel, in the Track
Selection rollout, click Body Rotation.

This selects the center of mass using Select And
Rotate.

3. Move the time slider to frame 0. Turn Auto Key
on.

4. In the Perspective viewport, rotate the biped
approximately 35 degrees about the Y-axis, so
the biped bends his upper body forward.

Because the feet are planted on the ground,
only the upper body is affected.
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Only the upper body rotates.

5. Next, you will add rotation keys to the center of
mass at five different frames.

At Frame: Do this:

10 Rotate the biped 30 degrees
about the Y-axis.

20 (liftoff ) Rotate the biped –25 degrees
about the Y-axis.

53 (touch-down) Rotate the biped 15 degrees
about the Y-axis.

63 (second liftoff ) Rotate the biped –30 degrees
about the Y-axis.

96 (second
touch-down)

Rotate the biped 15 degrees
about the Y-axis.

6. Scrub the time slider slowly to see the windup
and landing for each flip.

7. Save your motion data. On the Biped
rollout, click Save File, and name the file
myflip3.bip

Verify your work:

1. On the Biped rollout, click Load File to
open another Biped motion file, flip3.bip.

This motion file contains the same movements
that you just created in the previous procedure.

2. Play this version to verify that your motion
sequence is accurate.

Now that you’ve made the biped wind up and flip,
the next procedures show you how to improve the
quality of the movement, to make it look more
natural. You do this by working on one body track
at a time.

Adjust the first flip:

1. Select any part of the biped. Go to frame 10.

2. On the Motion panel, in the Track
Selection rollout, click Body Vertical.

3. Turn on Auto Key. In the Perspective
viewport, move the COM down on the Z-axis
so the biped bends his knees a little.

4. On the 3ds Max menu bar, click Select By
Name. select all the biped spine objects from
the selection list, then lock the selection (press
SPACEBAR on the keyboard).

5. Right-click in the Perspective viewport and
choose Rotate from the quad menu.

6. On the Biped rollout, expand the
expansion bar. Then, in the Modes group, turn
on the Bend Links Mode button.

7. Go to frame 0.

8. Rotate the spine object 30 degrees about the
Z-axis to bend the biped forward.



324 Chapter 3: Getting Started

Rotation at frame 0

9. Move to frame 20 where the lift for the jump
begins. Rotate the spine –30 degrees about the
Z-axis to bend the biped further backward.

Rotation at frame 20

10. On the expanded Biped rollout, in the
Display group, turn on Leg States.

In the viewport, the status of both feet is
displayed as Lift on the footsteps. (You may
have to zoom in to be able to read this.)

11.Move to frame 42. Rotate the spine 60 degrees
about the Z-axis.

Notice that the biped’s back tucks in. This alters
the biped’s position during the first flip. Next,
you’ll alter its position during the second flip.

Rotation at frame 42

Adjust the second flip:

1. Move to frame 53. Rotate the spine 20 degrees
about the Z-axis.

This is when the biped lands after the first flip.
Notice that the status of both feet is Touch.
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Rotation at frame 53

2. Move to frame 63. Rotate the spine –20 degrees
about the Z-axis, so the biped’s spine is thrown
back in preparation for the next flip. If the
biped raises up off the ground, move the COM
so his feet touch again, and the knees are bent.

At frame 63, the status of both feet is Lift.

Rotation at frame 63

3. Move to frame 85. Rotate the spine 60 degrees
about the Z-axis.

The biped changes from a straight posture to
a tucked posture.

4. On the Biped rollout, in the Modes group,
turn off Bend Links Mode. Turn off Auto Key.

5. Go to frame 0 and play the animation.

Notice that the biped’s upper body now bends
as though it was being used to power the
motion.

6. Save your motion data. On the
Biped rollout, click Save File, and name the
filemyflip4.bip.

Adjust the legs:

1. Press SPACEBAR to unlock the selection.
Move to frame 37.

2. Turn on Auto Key.

3. In the Perspective viewport, right-click and
choose Rotate.

4. Select either biped foot.

5. On the Track Selection rollout, click
Symmetrical to select both feet.

6. Rotate the feet approximately 50 degrees about
the Z-axis, so the toes point up a little more.

7. Right-click and select Move. Use the Transform
gizmo corners to move the feet so the knees
move between the hands. You might need to
readjust the spine rotations to get the hands
and knees to match.
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Move the feet to bend the knees.

8. Move to frame 80, the equivalent frame in the
second jump. Move the feet again so the knees
tuck, and the pose compresses.

Use the file flip4.bip for reference and backup.

Tucked knee pose

Until now, the biped’s arms have been relatively
immobile. In a real flip, the arms would begin
the flip. In general, arm movement is timed to
the spine movement. For the first jump, the arms

begin moving at frame 0 and finish moving at
frame 20. They accelerate through that period.

Rotate the arms:

1. Make sure Auto Key is still on.

2. In the Perspective viewport, right-click and
choose Rotate.

3. Select an upper arm object (named Bip01 R
UpperArm).

4. On the Motion panel, in the Track
Selection rollout, click Symmetrical to select
both arms.

5. At frame 20, rotate the arms –150 degrees about
the Z-axis.

This makes the arms nearly vertical.

Arms rotated up at frame 20

6. Move to frame 10, the midpoint of the
rotation. click Set Key to lock the rotation. Or
you can also right-click the time slider, and use
the Create Key dialog to set the keys for the
arms.

7. Move to frame 0. Rotate the arms 60 degrees
about the Z-axis.
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This places the arms just behind the back.

Arms rotated back at frame 0

8. Play the animation.

Tip: On the Time Configuration dialog, in the
Playback group, turn on Real Time, and set the
Speed to 1/4. This slows the animation playback
in the viewport, so you can watch it carefully.

Adjust the arm swing:

At this point, the motion is fine, but the arms
should accelerate more. To do this, you’ll copy the
arm posture from the first third of the motion onto
the arms in the middle of the time sequence. The
result will be slower motion in the first half of the
sequence and faster motion in the second half.

1. Turn on Auto Key if it isn’t on already.

2. At frame 6, double-click an upper arm to select
the entire arm.

3. On the Track Selection rollout, click
Symmetrical to select both arms.

4. On the Copy/Paste rollout, turn on Posture and
click the Copy Rotation button.

5. Click Copy Posture.

The posture of the arms is copied into the list.
It is named RotLARmRArmLFingRFing.

6. Move to frame 10. Click Paste Posture.

7. Play the animation.

8. Move to frame 53. Right-click the time slider,
turn off Position and Scale, then click OK to
create keys for the arms.

9. Deselect both arms. Then select an upper arm
object, and click Symmetrical.

10.Move to frame 63, the liftoff point. In the
Perspective viewport, right-click and choose
Rotate.

11.Rotate the arms -150 degrees about the Z-axis,
so the arms raise up.
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Rotation at frame 63

Move the head:

In general, the head will bend with the spine as it
tucks, but will be more vertical when the feet are
planted.

1. Move to frame 20. Make sure that Auto Key is
still on.

2. Select and rotate the head –40 degrees about
the Z-axis.

3. Scrub the time slider forward and watch the
head rotation.

As a result of spine and center of mass rotations,
the head is thrown back too far at frame 42.

4. Move to frame 42. Rotate the head 40 degrees
about the Z-axis.

Biped head rotation at frame 42

5. Move to frame 53, a touch-down point, where
the biped would be looking up from the tuck.
Rotate the head –12 degrees about the Z-axis.

Head rotated up at frame 53

6. Move to frame 63, where the head would be
thrown back as part of the jump. Rotate the
head -40 degrees about the Z-axis.

The biped is looking straight up at the sky.
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Head thrown back at frame 63

7. Move to frame 71. Rotate the head 15 degrees
about the Z-axis.

8. Move to frame 85, the same point in the flip as
frame 42. Rotate the head 40 degrees about the
Z-axis.

This tucks the chin into the chest between the
arms.

Chin tucked in at frame 85

9. Turn off Auto Key. Go to frame 0, and
play the animation.

There is a problem with the arms at frame 85.
You can fix that by copying the posture of the
arms at frame 84, and then pasting it at frame
85 with Auto Key turned on.

You can also add additional keys to change the
arm movement as you like. In the provided file,
the biped tries to keep his hands on his knees,
but during the second flip he lets go and his
arms flip around.

10.Save your motion data as myflip5.bip.

You can load flip5.bip to check your changes.

Now that you have a good-looking jump and
flip, it’s time to add a twist. The easiest way to
accomplish this is to rotate selected footprints and
let the biped automatically adapt.

Twist the footsteps:

1. On the Biped rollout, turn on
Footstep mode.

2. In the Top viewport, region-select footsteps 2
and 3.

3. Drag up on footstep 2 to rotate the footsteps
-180 degrees about the Local Z-axis.

4. Right-click and choose Move. Move footsteps
2 and 3 about the Y-axis, in line with the other
footsteps.
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Footsteps rotated and moved

5. Play the animation.

You’ll see the biped do a half twist in the first
jump. It will also do a backward half twist in the
second jump. You’ll fix that next.

6. In the Top viewport, right-click and choose
Rotate. Region-select footsteps 4, 5, 6, and 7.

7. Drag up on footstep 6, and rotate the footsteps
-180 degrees about the Z-axis.

8. Right-click and choose Move. Drag the
footsteps so footstep 6 is on top of footstep 0.

9. Play the animation again.

The biped does a half twist in the first jump.
The second jump is a simple flip ending with
the biped facing the opposite direction.

10.Load flip6.bip to verify that your motion
sequence is accurate.

In the following procedure, you’ll move some of
the footsteps to simulate a jump from higher to
lower platforms.

Add height to the flip:

You’ll use a Track View selection technique to
select footsteps 0 and 1, because they are covered
by footsteps 6 and 7.

1. Make sure Footstep mode is still on.

2. On the Graph Editors menu choose Track View
– Dope Sheet.

The Dope Sheet editor opens. Bip01Footsteps
are displayed in the track as blue and green
blocks.

3. Region-select the blue and green footstep
blocks numbered 0 and 1 to select the footsteps.
Then close the Dope Sheet window once the
selection is made.

4. Click Move. In the Perspective viewport, ,
drag footsteps 0 and 1 up 80 units on the Local
Z-axis.

5. Select footsteps 2 and 3. Move the footsteps up
40 units on the Local Z-axis.
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6. Select footsteps 4 and 5. Move the footsteps up
15 units on the Local Z-axis.

Footsteps 6 and 7 remain at ground level.

7. Turn off Footstep mode and play the animation.

The biped jumps from a height, twists, lands
on a lower level, continues the jump, flips,
and comes to a stop on the lowest level. The
levels make the acrobatics more believable and
interesting.

Jump and twist from a height

8. Load flip7.bip if you want to verify that
your motion sequence is accurate.

To add to the realism, you could create a
complete scene by constructing a series of
platforms under each set of footsteps.

You could also try flipping the Dr. X character.
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Animating a Pratfall

In this lesson, using both Auto Key and Set
Key animation methods, you’ll animate a biped
slipping on a virtual banana peel. You’ll learn
to change rigid footsteps to sliding ones, and to
create a freeform period in a footstep animation
using Track View. Other procedures help you to
fine-tune and troubleshoot the animation.

Set up for this lesson:

1. Open slip_start.max.

2. Right-click the viewport name, and change the
display to Wireframe.

3. Select any part of the biped.

4. Open the Motion panel.

The Biped controls are now available.

Understand the animation:

1. Play the animation by dragging the time slider.

The biped walks about 5 steps

The plan is to make the biped slide and fall
on footstep 5. Imagine a banana peel on that
footstep.

2. Drag the time slider to frame 75, where the heel
hits the ground for footstep 5. Zoom into the
viewport so you can see the foot easily.

3. In the viewport, select the blue Bip01 L Foot
object.

The pivot point displays.

Heel touches down

4. On the Motion panel, open the Key Info rollout.
Expand the IK bar so you can see IK Blend and
other controls.

In the viewport, the pivot point is displayed as
a red dot, and the track bar displays keys. The
key for the foot at frame 75 is a planted key.
This means IK Blend is set to 1, and the Join To
Prev IK option is on.

IK Blend at 1 locks the pivot and the foot to the
ground plane. Join To Prev IK Key considers
the rotation of the foot at the previous key and
attempts to match it.

5. Drag the time slider to continue to scroll
through the animation, watching the pivot
point move.
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Pivot point animates over time.

• At frame 78, the pivot shifts to the outside
of the heel.

• At frame 84, the pivot moves to the toes.

• At frame 93, the heel is lifting in the air.
After this frame the foot is off the footstep
and in the air.

Tip: In the 3ds Max status bar, turn on the
Key Mode Toggle button to jump from key
to key. This makes it easier to understand
the animation. On the time slider, click the
forward and backward arrows to move to
the next or previous keys. You can also use
the Next Key and Last Key buttons in the
VCR Controls, or the < and > keys on the
keyboard.

Create a sliding footstep:

1. Make sure the Bip01 L Foot object is still
selected.

2. Turn on Key mode, and go to frame 75.

3. In the Key Info rollout, click Set Sliding
Key.

4. Advance to the next key (at frame 78).

5. Rotate the foot so the toes remain up in the air.

Rotated foot

6. Move the foot forward, so it slides forward on
the footstep gizmo.

Sliding footstep

7. In the Key Info rollout, click Set Sliding
Key.

The pivot point jumps to the foot’s new
position. The footstep is now displayed with a
line through it. This indicates that it’s a sliding
footstep: the foot can slide over or off the
footstep, as well as the ground plane.



334 Chapter 3: Getting Started

Pivot point jumps to footstep.

8. Advance to the next keyframe at frame 84.
Set a sliding key.

9. In the Key Info rollout, in the IK group of
controls, click the Select Pivot button. Then, in
the viewport, click the blue pivot at the center
of the back of the heel.

The pivot turns red to show it has been selected.

Pivot selected at back of heel

10.Turn off Select Pivot.

11.Rotate the foot, then raise it up in the air, so the
foot is starting to kick upward.

The foot rotated and raised at frame 84

12. Set a sliding key.

Again the pivot point jumps from the footstep
to the foot.

Tip: If the foot is off the footstep and in the air,
use a free key. A sliding key, however, will also
let you lift the foot off the footstep.

13.Move the time slider to play the animation.

The biped’s left foot slides over and off footstep
5.

Next, you’ll create a freeform period, so you can
freely animate the biped’s movement in the air.

Create a freeform period:

Using a freeform period in a footstep animation
allows you to suspend the automatic systems Biped
uses during footstep animation.
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If you set up a freeform period between footsteps 5
and 6, you’ll be able to animate the biped slipping,
falling, and bouncing on the ground plane.

1. In the Biped rollout, turn on Footstep Mode.

2. Right-click in the viewport and choose Curve
Editor.

Track View opens.

3. On the Track View menu bar, choose Modes >
Dope Sheet.

The footstep keys are now visible in Track View.

4. In Track View, double-click footstep 6.

In the viewport, footstep 6 highlights in white.

5. In Track View, move footstep 6 so it is directly
under footstep 7.

This creates a gap for a freeform period.

The footsteps in Track View display the starting
and ending frames. As you move the footstep
in Track View, these frame numbers change.

Tip: You can also change the duration of the
footstep by using the Footstep Edge Selection
arrows in the Footstep Mode dialog. Click
the left or right arrow to select that edge for
movement. Select the dot between the arrows
to move the footstep in time, without changing
its duration.

6. In Track View, right-click anywhere in the
Footstep track.

The Bip01 Footstep Mode dialog is displayed.

7. In this dialog, turn on Edit Free Form (No
Physics).

In Track View, a hollow yellow box appears to
the right of footstep 5.

8. Click inside the hollow yellow box.

The box becomes solid yellow. This indicates
that it’s a freeform period.

9. Scrub the time slider and watch the animation.

The biped floats from footsteps 5 to footstep 6.

Change the timing of the slip:

The slip happens too slowly. You can change
the timing of the sliding footstep so the freeform
period starts sooner. Also, you need more time for
the body to rotate and bounce on the ground.

1. Click Time Configuration in the time
controls on the 3ds Max status bar.

2. In the Time Configuration dialog, change End
Time from 123 to 150. Click OK.

This extends the animation by adding 27 blank
frames.

3. In the Bip01 Footstep Mode dialog, turn on
Edit Footsteps

If you’ve closed this dialog, right-click the solid
yellow freeform period in the Track View –
Dope Sheet.

4. In Track View, drag a selection rectangle
around footsteps 6 and 7.

5. Move footsteps 6 and 7 to the right, so the
yellow period is extended and footsteps 6 and 7
start later, at frame 140.

6. In Track View, notice that the last two footstep
keys extend beyond the end of the animation,
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into the darker gray area. To extend the
animation, press ALT+R.

The end of the animation now matches the end
of the footsteps. The time slider now shows the
animation has been extended to 158 frames,
as does the change in the background behind
the footstep keys.

Tip: If the Biped keyboard shortcuts won’t work,
turn on the Keyboard Shortcut Override Toggle
on the Main toolbar.

7. In Track View, click footstep 5.

8. In the Footstep Mode dialog, in the Footstep
Edge Selection group, click the right arrow.

A white dot appears at the right side of the box
for footstep 5.

9. Adjust the right side so the footstep ends at
frame 83. You’ll probably need to zoom in so
you can see the frame numbers. Use the Zoom
button at the lower-right corner of Track View.

10.Play the animation. The biped slides faster over
the footstep.

Since you’re still in Footstep mode, you can also
move the footstep’s position in the viewport.

11.In the Perspective viewport, select footstep 6
and move it next to footstep 7.

12.Move the time slider to observe the animation.

Now you have enough time and space for the
pratfall.

Keyframe the fall:

In this procedure, you’ll turn off Dynamics Blend,
so Biped physics is not used in the animation. To
keyframe the fall, you’ll rotate the center of mass,
so the biped moves from vertical to horizontal.
You’ll also move the center of mass, so the biped
rises up and then falls to the ground plane.

1. In the Bip01 Footstep Mode dialog, turn on
Edit Free Form (No Physics). Close the Track
View window.

2. Turn on Auto Key.

Since the center of mass doesn’t use planted,
sliding, or free keys, you can use the Auto Key
button to set keys automatically.

3. Turn off Footstep mode to display other Biped
rollouts.

4. In the Track Selection rollout, click the
Body Vertical button.

Now you can see keys in the track bar.

5. Move the time slider to frame 78. In the Key
Info rollout, click Set Key.
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6. In the Key Info rollout, expand the Body bar,
then change Dynamics Blend to 0.

This turns off Biped Dynamics and applies
Spline Dynamics instead. Biped Dynamics,
available only on Body Vertical track keys,
adds physics to the animation, while Spline
Dynamics does not.

7. Move to frame 83.

The left foot has a planted key at this frame.

8. In the viewport, move the center of mass
forward a little.

9. Rotate the center of mass slightly (-15 degrees)
so the biped begins its pratfall.

COM moved and rotated at frame 83

10. Select the blue foot. In the Key Info
rollout, set a sliding key.

11.Move to frame 86. In the Track Selection
rollout, turn on Body Rotation.

12.In the viewport, rotate the center of mass so the
biped is horizontal.

Rotation at frame 86

13. Select and move each foot so it’s raised up
and spread apart. After you move each foot,
rotate it so it’s pointing upward, then click the
Set Free Key button in the Key Info rollout.

Whenever you keyframe the hands and feet, try
to use the Set Key options rather than Auto Key.
This gives you added control.

14. Select and move each arm so it’s
positioned out from the body, and then click
the Set Free Key button.

View of biped from overhead
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Next, the biped’s feet need to swing up for a
frame or two after the rest of the biped begins
to descend.

15. Move to frame 88. Move each arm and
foot up some. Rotate each leg and arm as well.
Rotate the feet a little, so the toes point upward.
Again, click Set Free Key after moving and
rotating each object.

This adds some secondary motion to the
animation.

16.Move to frame 97.

The next step creates the descent of the
horizontal biped to the ground.

17.In the Track Selection rollout, turn on Body
Vertical. In the viewport, move the center of
mass so the biped is on the ground. Use a Left
viewport to gauge the ground plane (optionally,
you can create a box for this purpose). Rotate
the center of mass so the biped is horizontal
again.

Biped on ground plane in Left viewport

As you work, you’ll notice that the green foot
keeps trying to point toward the ground. This
is due to the settings on the keys for footstep
7. You’ll fix that next.

18. Select the green foot, and press the > key
to move to the next keyframe. In the Key Info
rollout, click Set Free key. Repeat for all the
remaining keys from here to frame 158.

19.Correct any foot rotations that still seem out of
place, setting free keys for them as you do.

20. At frame 97, position the feet so they are
flat on the ground. Click Set Free Key for each
foot. Rotate the hands so they are flat on the
ground as well, and again click Set Free Key for
each.

21.Use the time slider to flip through the biped’s
slipping motion. Notice that the biped
magically rises up after the fall; you’ll change
that later in the lesson.

Next, you’ll add a slight bounce to the body.

Add a bounce:

You’ll add keyframes to make the biped strike the
ground and bounce once. There’s a Body Vertical
key set at frame 111 you need to reset.



Animating a Pratfall 339

1. In the Track Selection rollout, turn on
Body Vertical. Move the time slider to frame
111.

2. In the Key Info rollout, expand the IK bar, and
change Dynamic Blend to 0.

Note: If Dynamic Blend is unavailable, click
Set Key first. Dynamic Blend is only available
where there are Body Vertical keys.

3. Rotate the biped so it’s horizontal.

4. Move the biped back down to the ground.

Since Auto Key is still on, you are already
setting keys for the COM.

5. At frame 101, keyframe the center of mass so
the biped lifts off the ground.

Optionally, add secondary movement by
keyframing the hands to trail the movement
of the center of mass.

6. A few frames after the center of mass lifts off,
raise the hands.

7. A few frames after the center of mass strikes
the ground, make the hands and feet strike the
ground. You can set planted keys for the hands
and feet.

Next, you’ll keyframe the spine. This biped
only has two spine links, so it’s easy to do.

8. At frames 95 and 110, rotate the spine so the
shoulders touch the ground .

Spine rotated so shoulders touch ground

Next , you’ll keyframe the head.

9. At frame 95, rotate the head so the chin tucks
in. At frame 102, rotate again so the head rocks
back.

Head rotated

10.At frame 97, in the Track Selection rollout, turn
on the Body Rotation button.

11.In the Key Info rollout, expand the TCB bar.
Change both Tension and Continuity to 0.

This sharpens the bounce, as shown in the
curve diagram.
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Tension and Continuity at zero

Tip: If the Tension and Continuity curves are
not available, click Previous key, then Next
key to return to this keyframe with the curves
displayed.

12.Play the animation.

The biped bounces more crisply.

13.Create a box under the area of the slip and use
it to gauge if you need to raise any part of the
biped that sinks into the floor. If you turn off
Wireframe viewport shading, you’ll be able to
visualize the intersection of the biped and box
more clearly.

14.Save your work as myslip.bip. Compare your
work to slip_with box.bip.

As noted earlier, the biped miraculously stands
back up when the animation finishes. This
is a consequence of the last footsteps. Since
3ds Max lets you change back and forth between
footstep and freeform modes, you’ll convert
between animation modes to correct this.

Convert from footstep to freeform:

You can convert between the footstep and freeform
modes without any loss of motion. The motions
remain identical (within some limitations),
whether you convert from footstep to freeform,
or freeform to footstep.

1. Continue in the current file, or open
slip_convert_start.max.

2. Turn on Auto Key.

3. In the viewport, select any biped body part.

4. On the Motion panel, in the Track Selection
rollout, click either Body Horizontal, Body
Vertical, or Body Rotation.

5. In the Biped rollout, choose Convert.

6. In the Convert To Freeform dialog, click OK.
Do not turn on “Generate a keyframe per
frame”.

The footsteps disappear from the viewport, but
the animation is the same as before.

Next, you’ll delete the keys that raise the biped
back to standing position.

7. At frame 111, select the entire biped.

8. In the track bar, select all the keys after frame
111.

9. Delete all the selected keys.

Now play the animation. The biped walks, slips
quickly, and then lays completely still.

Change the timing:

1. Be sure Auto Key is still on.

2. Select the entire biped.

3. In the track bar, drag a box to select all the keys
from frame 86 to the end of the animation.

4. Move the time slider to frame 90.
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5. Slide all the keys down, so the keys from frame
86 are now at frame 90.

Tip: To move keyframes to a precise location,
first select the keys. Then move the time slider
to the desired location, and then move the keys.

The pratfall lasts a little longer now.

If you like, you can add some more rotations
to the head after frame 115. While the biped
is laying on the ground, make his head shake
with disbelief. Also try keyframing some small
movements in the feet, placing the feet flat
on the ground and sliding them toward the
pelvis, raising the knees. Put planted keys on
the hands and feet, then rotate the COM for an
interesting effect.

6. Save your work as myslip.max, or
loadslip_final.bip to see the results.

Changing Footsteps Using IK Keys

Footstep and Freeform modes both use the same
underlying inverse kinematics (IK) to animate the
biped skeleton. Footstep gizmos are a method for
manipulating sequences of IK keys.

In this lesson, you’ll learn how making changes to
the IK keys affects the footsteps.

Set up for this lesson:

• Open footsteps_keys_start.max.

A biped is displayed with four footsteps in the
viewport.

Set IK Keys to create footsteps:

1. Drag the time slider to play the animation.

The biped hops on his right foot. Notice that
there is no footstep for the right foot between
footsteps 2 and 3.

2. At frame 45, select Bip01 R Foot.

3. In the Key Info rollout on the Motion
panel, click Set Planted Key.
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The pivot point is displayed in the viewport. If
you can’t see it, change to Wireframe viewport
shading, or navigate the viewport so you can
see beneath the heel.

4. On the 3ds Max status bar, turn on Key
Mode Toggle.

5. Click next key to go to frame 48, and then
click Set Planted Key.

The pivot point shifts to the toe.

Note that the lowest IK pivot is selected by
default for cases where IK is applied to new
keys.

6. At frame 54, click Set Planted Key.

The biped is moved back to the ground. A
footstep is displayed beneath the biped’s foot.

A footstep has been created, because there is
now an interval of time where IK is applied
between the two planted IK keys. However, if
you drag the time slider to play the animation,
you will see that the walk still needs work.

Change the duration of footsteps using IK keys:

1. At frame 60, click Set Planted Key.

2. Play the animation now. The walk cycle is much
better.

3. Right-click on the foot and choose Dope Sheet.

4. On the Dope Sheet tool bar, turn on Edit
Keys if it is not on already.

5. In the Biped rollout, turn on Footstep
Mode to easily locate the track in Dope Sheet.
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6. Expand the Footsteps track and notice that
footstep 3 extends for 15 frames, from frames
45 to frame 60.

7. Turn off Footstep Mode.

8. Select Bip01 R Foot.

The keys for the foot are displayed in the Dope
Sheet

9. At frame 63, set another planted key.

10. Turn on Footstep Mode.

The Dope Sheet editor again displays the
Footsteps track.

The duration of the footstep now is 18 frames,
from frames 45 to 63.

11. Turn off Footstep Mode.

Remove footsteps using IK keys:

1. At frame 45, select the Bip01 R Foot object
in the viewport, then set a free key.

2. At frame 48, set a free key.

3. At frame 54, set a free key.

Note: The body vertical position is modified.
The biped now floats up into the air at frame 54.

4. At frame 60, set a free key.

The footstep disappears.

There is only one IK key left. With no IK
interval defined, there is no duration, and
therefore no footstep.

The animation could be made more realistic by
adding arm movement to the hopping steps, or
by creating a freeform period for the hop, then

adding poses for a crouch, spring and landing.
The point of this lesson, however, has been
to demonstrate that footsteps can actually be
created or removed by changing the IK keys.

Summary

In this tutorial, you learned how to animate a
biped using footsteps, and make a biped, walk,
run, do flips, jump, and take a fall. You also
learned how to add a freeform period to a footstep
animation, convert a footstep animation to
freeform animation, and change the duration of a
footstep animation using IK keys.

Animating with Freeform
This tutorial shows you how to animate a biped
using the freeform technique. This method does
not use footsteps; instead, you are responsible
for animating every part of the biped. Freeform
animation gives an animator fine control over the
biped’s motion.
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In this tutorial, you’ll learn how to:

• Create a simple animation of a biped swimming
in place

• Use planted, sliding, and free keys

• Create a traditional walk cycle using animated
pivot points

• Create a stretchy leg and a shaky walk using
Biped SubAnim controllers

• Create animated 3ds Max bones from a biped
animation

Skill level: Beginner to Intermediate

Time to complete: 2 hours

You can find the files for this tutorial in the
tutorials\character_animation\freeform_
animation folder on the Tutorial Files CD that
ships with 3ds Max. Before starting the tutorials,
copy the \tutorials folder from the CD to your
\3dsmax8 local installation.

Creating a Simple Freeform
Animation

This tutorial is an introduction to using freeform
animation techniques with Biped.

In this tutorial, you will animate a biped swimming
in place. You’ll use freeform animation methods to
produce the kicking legs and arm strokes.

In order to create this motion, you’ll use a
combination of rotations and moves. You’ll also
make use of Copy and Paste Posture Opposite to
animate one arm and copy its tracks to the other.

Note: The illustrations and steps below were
created using the World coordinate system.

Set up the lesson:

1. Reset 3ds Max.

2. From the Create panel, click the Systems
button.

Create a biped and load a FIG file:

1. Click the Biped button and create
a biped in the Front viewport.

2. Open the Motion panel.

3. Turn on Figure Mode and click
Load File.

The Open dialog displays.

4. Open the file cs4_tut_rtgame.fig.

The biped takes on new structural elements
saved in the FIG file. This simplified figure has
one large toe on each foot and one large finger
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on each hand; its spine contains two segments
instead of four.

The biped with FIG file applied

5. Turn off Figure mode.

Tip: You cannot animate in Figure mode.

6. Select all the biped objects, then click
Zoom Extents All.

7. Save the scene as MySwimmer01.max.

Start a freeform animation:

You start a freeform animation by clicking the
Auto Key button and transforming any part of the
biped.

1. Right-click in the Left viewport.

This activates the Left viewport and does not
affect selected objects in the scene.

2. Press ALT+W to maximize the viewport for a
closer view of the biped.

The biped should be in wireframe. Change the
shading display of the Left viewport if it is not
wireframe.

3. Turn on Auto Key.

The button turns red, and the active viewport
is outlined in red.

4. From the Track Selection rollout on the
Motion panel, click Body Rotation.

Tip: The center of mass object is automatically
selected when the movement and rotation
buttons in the Track Selection rollout are used.

Rotation transform gizmo

The rotation transform gizmo lets you easily
rotate an object about a chosen axis. As
you move your cursor over the gizmo in the
viewport, the axis circles will turn yellow
indicating which axis the rotation will occur
around.

Note:

• The red circle, displayed as a vertical line in
this viewport, affects the X-axis.

• The green circle affects the Y-axis.

• The blue circle, displayed as a horizontal line
in this viewport, affects the Z-axis.

• The light gray circle, displayed around the
green circle, allows free rotation around all
three axes.

5. Move your cursor over the green circle.
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The cursor changes to yellow, meaning that any
rotation is locked to that axis

6. Rotate the center of mass approximately 90
degrees about the Y-axis. Watch the coordinate
readout near the gizmo to see how far you’re
rotating the biped. Rotate until the biped is
lying prone.

Tip: Press A on the keyboard to turn on Angle
Snap to easily rotate to 90 degrees.

An animation key appears at the far left of the
track bar, at frame 0.

You can select all three COM tracks under Track
Selection to create keyframes simultaneously.
Try this:

7. In the Track Selection Rollout click
on both the Body Horizontal and Body Vertical
tracks so that both tracks are selected.

8. Expand the Key Info rollout and click Set
Key.

9. In the Track Selection Rollout click Lock
COM Keying, then click the Body Rotation

button. All the multiple
tracks for the COM are now selected at once.

10.In the Key Info rollout, click Set Key again,
and you can set a key for all the COM tracks
at frame 0.

The trackbar key shows a multi-color display
indicating that both position and rotation keys
have been created.

11.Click the Lock COM Selection to unlock the
COM tracks, then click the Body Rotation
again to return to the previous state.

Tip: It’s a good idea to set a key at the start of
your animation for the 3 COM tracks.

Pose one leg:

Now that the biped is prone, you’re ready to
animate the swimming motion. First, you’ll
position the legs. You’ll work on the right leg first,
setting up its position at frame 0.

1. Press ALT+W so you can see all four viewports
again.

2. Select Bip01 R Thigh by clicking the lines of the
thigh in the Left viewport.

Tip: As you hold your cursor over an object in
the viewport, the object’s name is displayed in
a tooltip, or you can press the H key to choose
objects from the selection list.

The right thigh is selected.

3. Rotate Bip01 R Thigh approximately 30
degrees about the Z-axis.

The right leg is rotated, but the right foot is
pointing straight down.
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4. Click PAGE DOWN twice to select the right
foot.

Tip: The PAGE UP and PAGE DOWN keys are a
quick way to navigate through the objects that
make up a biped.

5. Rotate Bip01 R Foot about –50 degrees around
the Z-axis.

The foot looks better in this position.

In these rotations, you’ve just used 3ds Max
“forward kinematics.” Next you’ll use the Select
And Move tool on the foot to move the entire
leg.

6. Right-click the same foot and select Move from
the quad menu.

Tip: You can choose the transform tools either
from the Main toolbar or by right-clicking to
open the quad menu.

The Transform gizmo switches to an axis tripod
showing two of three arrows in this viewport.
They are displayed at right angles with the
Z-axis pointing up and the Y-axis pointing left.

Ready to move the foot

7. In the Left viewport, move the cursor over the
Y-axis of the gizmo until it turns yellow, then
move the foot a little to the right.

The knee bends to accommodate the new
position of the foot.

The knee bends

In this move, you’ve just used “inverse
kinematics.” The foot, calf, and thigh are linked
together in a hierarchical chain. By moving the
end of the chain, the foot, you rotated the lower
and upper leg objects.

8. Save the scene as MySwimmer02.max.

Animate the leg:

Everything you’ve done so far has been at frame 0.
Now you’ll move forward in time and animate the
pose at frame 10.

1. Move the time slider to frame 10.

2. Move the foot down in the Z-axis until the knee
straightens out.
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3. Press PAGE UP twice to select Bip01 R Thigh.

4. Right-click and choose Rotate from the
quad menu, then rotate the Bip01 R Thigh
approximately 10 degrees about the Z-axis.

Rotating the thigh

5. Move the time slider back and forth between
frame 0 and frame 10.

The leg moves up and down.

Use copy and paste:

Now you’ll use some specialized Biped tools to
pose and animate the opposite leg.

1. Return the time slider to frame 10.

2. Double-click Bip01 R Thigh.

The entire leg is selected from the thigh down
to the toes.

3. From the Motion panel, open the Copy/Paste
rollout.

The Copy/Paste functionality includes the
creation of Collections . You must first create
a Collection before you can start creating
Postures.

4. In the Copy/Paste rollout click the Create
Collection button. This creates a collection
named Col1. Rename this to Swim – Crawl.

5. Make sure Posture is turned on.

6. Also make sure
that Capture Snapshot from Viewport is turned
on just above the Paste Options group. This
forces the thumbnail of the pose to be taken
from the active viewport. This particular
posture, for example, is better seen from the left
rather than the front viewport.

7. Click Copy Posture.
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The posture of the right leg is copied into a
buffer. Change the name of the Copied Posture
to RLegRToe01 – downkick.

8. Move the time slider back to frame 0.
Choose Paste Posture Opposite.

The left leg rotates downward. The right leg
hierarchy is still selected.

9. At frame 0, choose Copy Posture again.

10.Move the time slider to frame 10.

11. Click Paste Posture Opposite again.

Now the left leg is raised, and the right leg is
down.

12.Move the time slider back and forth between
frames 0 and 10 and watch the legs kick.

Now you‘ll repeat this process to make the legs
kick several times.

13.Save the scene as MySwimmer03.max.

Use Paste Posture to create multiple kicks:

You can use the Copy Posture tools to quickly
duplicate all the leg keys from one frame to another
to create repeated kicking motions.
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1. Make sure Auto Key is still on and
move the time slider to frame 0.

2. On the Track Selection rollout, choose
Symmetrical.

Now both legs are selected.

3. Click Copy Posture at frame 0. Name the
copied posture R up L down.

Both legs are added to the collection.

4. Move the time slider to frame 20.

Tip: You can type in the frame number in the
Current Frame time control.

5. At frame 20, click Paste Posture .

6. Go to frame 30 and click Paste Posture
Opposite. From this point forward you can
choose to either Paste or Paste Opposite as you
create a kicking cycle. For a smooth kick cycle,
simply alternate the posture every 10 frames up
to frame 80. The track bar displays a total of
nine keys for the animation of the legs.

7. In the Copy Collections group click the Save
button to save your collection. Name the
collection Swim – Crawl. The CPY extension is
automatically added to the name.

8. Save the scene as MySwimmer04.max.

Tip: If you have AutoBackup turned on, the
software will automatically save your work at
regular intervals to the \autoback\ folder in
your 3dsmax root directory.

Animate one arm:

Animating a kicking leg was fairly easy, requiring
only two poses: one with the leg up, and one
with the leg down. Animating the arms is more
complex. To animate the stroke of an arm, you’ll
need five poses:

• The arm outstretched

• The arm down

• The arm back

• The arm drawn up out of the water near the ear

• The arm entering the water

When one arm is animated correctly, you’ll use
Copy Track and Paste Opposite Track to animate
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the second arm. You’ll adjust the timing of the
second arm by sliding the keys in the track bar.

1. Make sure Auto Key is still on and
move the time slider to frame 0.

2. Press H and select Bip01 L UpperArm from the
Select Objects dialog.

3. In the Left viewport, select and rotate
Bip01 L UpperArm approximately 160
degrees about the Z-axis, until it is extended
in front of the biped.

4. Right-click in the Top viewport and press PAGE
UP to select Bip01 L Clavicle and rotate it 20
degrees about the Y-axis.

This should prevent the arm from passing
through the head.

5. In the same viewport, press PAGE DOWN
three times to select Bip01 L Hand. Rotate it
approximately 90 degrees about the X-axis so
the palm is facing down.

This completes the first arm pose.

6. This completes the first arm pose. Let’s save it.
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7. Double-click the Bip01 LClavicle to select the
entire left arm hierarchy

8. Activate the perspective viewport so that the
snapshot will be easier to identify, and then
choose Copy Posture. Name the pose LArm
extended.

Thumbnail snapshot from perspective viewport.

9. Move the time slider to frame 10.

10. On the Main toolbar, choose Select And
Move, then change the Reference Coordinate
System to World, if it’s not already set.

This will facilitate working with the Transform
gizmo in different viewports.

11.Right-click in the Left viewport. Move Bip01
L Hand down on the Z-axis and back on the
Y-axis until it points straight down.

This completes the second arm pose.
Double-click the Bip01 LUpperArm to select
the arm hierarchy and then click Copy Posture.
Name the pose LArm down.

Tip: If you grab the Move gizmo by the corner
where the two axes meet, you can move selected
objects in both axes at once.

12.Move the time slider to frame 20.

13. Press PAGE DOWN three times to select
Bip01 L Hand. Move the hand along the Y-axis
toward the legs.

14. Activate the Front viewport and press
PAGE UP three times to select Bip01 L Clavicle.
Rotate this part about 24 degrees around the
Z-axis.
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Tip: Right-click and choose the Rotate Settings
box, then you can type in the transform amount
of the rotation.

This completes the third arm pose. Save it
by double-clicking the Bip01 L Upper arm
in the top view to select the hierarchy, then
choose Copy Posture. Name the pose LArm
back. If you activate the Perspective viewport
before you copy the posture, you can adjust
the viewport so the pose is clearly visible in the
thumbnail.

15.Move the time slider to frame 30.

16.Activate the Top viewport.

17. Press PAGE DOWN three time to select
Bip01 L Hand. Move the hand in the X and
Y-axes until the hand is level with the shoulder.

18.In the Left viewport, move Bip01 L Hand along
the Z-axis so it is near the ear.

19.Finally, rotate Bip01 L Hand about the X-axis
so the palm is flat.

This completes the fourth arm pose. Save it to
the Collection by double-clicking the upper
arm to select the entire hierarchy, then choose
Copy Posture. Name it LArm-up.
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20.To create the fifth pose go to frame 37.

21.In the Left Viewport move the Bip01L Hand
object on the Y-axis so it is in front of the head,
and is level with the shoulders. Double-click
the Bip01 L Upperarm to select the entire arm
hierarchy , activate the Perspective viewport
and then choose Copy Posture. Name the
posture LArm stroke.

Note: The fifth pose is used to ensure that the
rotation of the arm is correct going from the
out of water pose to the extended pose.

22.Save the scene as MySwimmer05.max.

Applying a twist pose:

Twist poses can be used to correct upper arm
rotations . Twist poses are primarily used to
correct arm twisting, but in this case we’ll use it to
simply position the arm efficiently.

1. Turn off Auto-Key if it is on.

2. Select the Bip01 L Upperarm.

3. Move the timeslider to frame 33.

4. Expand the Twist Poses Rollout.

5. In the dropdown Twist Pose List, choose each
pose and observe the change to the arm in the
viewport. Consider the five default poses the
same as additional copied postures that can be
used to “straighten out” problems by defaulting
to fixed rotations.

Twist Poses

6. When pose 5 is selected the arm will be rotated
and positioned correctly. Expand the Key Info
rollout and click Set Key to keyframe the twist
pose

Default Twist pose 5
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Tip: Twist poses are really designed to help you
fix twisting that occurs in the mesh attached to
the biped. If you go to Figure Mode, you can
enable Twist Links by turning on the Twists
checkbox, then set the number of Twist links
you would like for the upper arm, forearm,
thigh, calf or “horse-link” (the extra link in the
Leg if Leg Links are set to 4). Unfreeze and
Unhide all and you will be able to see the twist
bones that have been added using this method.
Once Twist Links are enabled you can play with
the Twist and Bias settings.

Copy the Arm pose:

To complete the arm cycle in the next few steps,
you’ll copy the arm pose from frame 40.

1. Make sure Auto Key is still on.

2. In the Top viewport, double-click Bip01 L
Clavicle to select the entire left arm.

3. Advance the time slider to frame 40 and
click Paste Posture.

If you see any unusual rotations or out-of-place
movements, you can set additional keys to
refine the animation.

4. Move the time slider and watch the animation.

Repeat the animation:

If the animation is going to be 80 frames in length,
you’ll need to repeat the arm movement.

1. Double-click Bip01 L Clavicle, to select the
entire left arm, if it’s not already selected.

2. In the trackbar drag a selection window
around the keys for frames 10 – 40.

3. Hold down the SHIFT key and copy these keys
by dragging them to the right. When the first
key is over frame 50, release the mouse button.

4. Play the animation. The biped should perform
two complete strokes with its left arm.

5. Save your scene as MySwimmer07.max.

Add rotation to the spine:

Next you’ll add some rotations for the spine
to make the animation more convincing. This
biped figure (cs4_tut_rtgame.fig), only has a
two-segment spine. You’ll rotate the large section
representing the upper torso.

1. Make sure AutoKey is still on.

2. Select Bip01 Spine1.

Note: The first spine object is Bip01 Spine. The
large second spine object is Bip01 Spine1.

3. Right-click in the Front viewport.

4. Move the time slider to frame 10 and rotate
Bip01 Spine1 approximately 15 degrees about
the X-axis.

This will create the appearance that the body
follows the movement of the arm.
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Spine rotation

5. Move the time slider to frame 0 and rotate
Bip01 Spine1 15 degrees about the X-axis.

This sets a start key for the rotation.

6. In the track bar, click the key at frame 0 to select
it, then hold down the SHIFT key and drag a
copy to frame 30. Watch the status area to know
when you are at frame 30.

The spine now rotates once in the 40-frame
cycle.

7. Select the Bip01 Pelvis.

8. Move the timeslider to frame 10 and rotate
the pelvis a few degrees in X so it follows the
movement of the left leg.

Rotate the Pelvis

9. Move the timeslider back to frame 0 and rotate
the pelvis -3 degrees around the X axis to key
frame it.

10.Repeat for frames 20 and 30.

Tip: You can also add a few degrees of rotation
around the Y axis as well for the pelvis if you
like.

Next you’ll copy the pelvis and spine rotation
keys to repeat the motion.

11.Move the time slider to frame 40.

12.Make sure the pelvis is still selected, then hold
down the CTRL key and click on the Bip01
Spine01 object (the large torso spine object).

13.

14.In the track bar, drag a selection rectangle
around the three visible keys.

15.Hold down the SHIFT key and drag the keys so
the leftmost key is copied to frame 40. Move the
time slider back and forth to see the animation.

16.Copy the key from frame 0 to frame 80 to
complete the set of keys.
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The final set of Bip01 Spine1 keys

Animate the head:

The biped can breathe while he swims, if you rotate
the head appropriately.

1. In the Left viewport, select the biped’s head,
Bip01 Head.

2. Move the time slider to frame 0 and rotate the
head about 70 degrees around the X-axis, so
the biped’s left ear is pointing down.

Rotate the head for breathing motion.

Tip: Watch the Perspective viewport while
rotating in the Left viewport.

3. At frame 20, rotate the head back down.

4. Hold down the SHIFT key and drag to copy the
key at frame 0 to frame 40. Watch the status
area to know when you are at frame 40.

5. Move the time slider to observe the head
rotation.

Actually, it would look better if the head were
turned up at frame 30.

6. Slide the key you made at frame 20 along the
timeline to frame 30. Do not hold down the
SHIFT key for this step.

The biped lifts and lowers it’s head once in the
40 frame cycle.

Tip: You can move the time slider to frame 30,
then slide the key on top of it.

7. To explore another way to copy keys, right-click
the time slider.

The Create Key dialog is displayed. This lets
you create keys by choosing a source and a
destination.

Tip: You don’t have to turn on Auto Key, to set
keys this way.

8. Set the Source Time to 30 and the Destination
Time to 70, then click OK.

9. Right-click the time slider again.

10.Set the Source Time to 0 and the Destination
Time to 80, then click OK.

11.Right-click the time slider again. Choose 0
as the Source Time and 80 as the Destination
Time, then click OK.

This completes the head motion, but the right arm
motions still need work. That comes next.

Animate the other arm with Copy Tracks:

Copy Tracks lets you copy and paste the animation
tracks of selected objects to other objects, or to
opposite body parts.

1. Make sure Auto Key is still on.
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2. In the Top viewport, double-click Bip01 L
Clavicle to select the entire left arm.

3. Activate the Perspective Viewport

4. In the Copy/Paste rollout, turn on the
Track button.

5. Choose Copy Tracks.

The track is copied to the buffer. Name the
track LArm – Crawl.

6. Click Paste Track Opposite.

7. Play the animation.

The biped is swimming the butterfly stroke.
The two arms move together.

Next you’ll change the timing so the arms
alternate.

8. In the Top viewport, double-click the Bip01 R
Clavicle.

The entire right arm is selected in the viewport.

9. Drag a box around all the keys in the track bar
to select them. Slide all the keys 20 frames to
the right.

The biped swimming a freestyle stroke

10. Play the animation.

Now the beginning and end are not quite right.
The easiest way to correct this is to copy and
paste poses.

Fix the beginning and end:

1. Make sure Auto Key is still on.

2. In the Top viewport, double-click the Bip01 R
Clavicle to select the entire right arm, if it’s not
already selected.

3. On the Copy/Paste rollout, click the
Posture button.

4. Move the time slider to frame 50 and click
Copy Posture.

5. Move the time slider back to frame 10 and
click Paste Posture.
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6. At frame 40, click Copy Posture, then at frame
0, click Paste Posture.

Now the arms alternate.

To correct the other end of the animation, you
can crop the animation to 80 frames.

7. In the time controls, click Time
Configuration.

The Time Configuration dialog is displayed.

8. In the Animation group, change the End Time
to 80. Click OK.

Warning: Do not click Re-scale Time.

9. Click Play Animation.

Save your work:

1. In the Biped rollout, click Save File and
save the motion as MySwimmer.bip.

2. Also save your final scene as
MySwimmer08.max.

Perfecting the animation:

• If you like, you can improve the animation
by adding some rotation keys to the pelvis
and spine and by adding secondary motion
to the feet and hands. Stagger the rotations
of the extremities a few frames following the
movement of the hands and feet.

Animating a Freeform Walk Cycle

While 3ds Max has a dedicated method (Footstep
mode) for creating quick and easy walking
animations, you can also create walk cycles with
freeform animation.
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In this tutorial, you’ll use animated pivot points
and IK blend keys to constrain the feet to the
ground plane.

Set up the lesson:

1. Restart or reset 3ds Max.

2. From the Create panel, click the Systems
button.

Create a biped and load FIG file:

1. Click the Biped button and create
a biped in the Front viewport.

2. Open the Motion panel.

3. Turn on Figure Mode and click
Load File.

The Open dialog is displayed.

4. Open the file, cs4_tut_rtgame.fig.

The biped takes on new structural elements
saved in the FIG file. This simplified figure has
one large toe on each foot and one large finger
on each hand; its spine contains two segments
instead of four.

5. Turn off Figure mode.

Note: You cannot animate in Figure mode.

6. Select all the biped objects and click Zoom
Extents All Selected.

7. Save the scene as mywalk01.max.

Set a key:

1. Change the Perspective viewport to wireframe
and zoom in so the feet are clearly visible.

Tip: In the display controls, use Field
Of View and Pan to zoom in on the feet.

2. Select Bip01 R Foot.
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3. On the Motion panel, in the Key Info
rollout, click Set Key.

The foot is highlighted in white, and a key
appears in the track bar at frame 0. You have
just started a freeform animation.

Track bar key at frame 0

Set different types of keys at frame zero:

There are two methods to set character animation
keys in 3ds Max. You can use the standard method
of keyframing that involves turning on Auto Key
and transforming objects. It is quick and easy, but
if you forget that Auto Key is on, you may set keys
unintentionally.

The second method uses the Set Key buttons on
the Key Info rollout. The Set Key buttons set up
several parameters at once. This is the method
you’ll use for the following lessons.

1. In the Track Selection rollout, choose
Body Vertical.

This selects the biped’s center of mass, Bip01,
and activates the Move tool in one step. You’ve
set a key for the foot, but there is a problem.

The foot can go through the ground plane. See
for yourself in the next several steps.

2. Right-click to activate the Left viewport
without changing the selection set.

3. Select the Body Vertical Track in the Track
Selection rollout, then move the center of mass
down in the Left viewport.

The biped moves down through the ground
plane (as indicated by the grid in the Perspective
viewport).

4. Press CTRL+Z to undo.

Set planted keys:

Now you’ll set a planted key. A planted key does
three things: it sets IK Blend to 1, turns on Join to
Previous IK Key, and also turns on Object Space.
Together, these three settings ensure that the foot
will not pass through the ground plane.

For more information about IK Keys, refer to the
“Key Info Rollout” topic in the User Reference.

1. In the Perspective viewport, select Bip01 R
Foot, if it’s not already selected.

2. On the Key Info rollout, click Set Planted
Key.

The red pivot point becomes more pronounced.
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3. On the Track Selection rollout, click Body
Vertical, and move the biped down in the Left
viewport.

The foot stays on the ground plane, and the
knee bends to accommodate the vertical
movement of the biped.

Planted foot stays on ground.

4. Press CTRL+Z again to reverse the movement
of the center of mass and return the biped to its
original position.

Now you’ve seen the effect of the planted key on
the foot. You can use the same Set Key buttons
on pivot points for the feet and hands. Next,
you’ll replace the key at frame 0 with a new one,
changing the pivot point.

Set pivot keys:

1. At frame 0, right-click in the Perspective
viewport and select Bip01 R Foot.

2. On the Key Info rollout, click Set Planted
Key.

3. On the Key Info rollout, open the IK expansion
bar and click Select Pivot.

All pivot points for the foot are now visible as
blue and red dots. The pivot at the ankle is red,
showing that this is the currently active pivot
point.

Wireframe mode lets you clearly see and select
the pivot points.

4. Choose the pivot point on the ball of the foot,
at the base of the toes.

The new pivot point is displayed in red.

Note: You don’t have to set a key each time you
choose the pivot point. However, you should
use the Set Key buttons if you want to change
the Key parameters.

5. Advance the time slider to frame 5, and
click Set Key.

6. Right-click the foot and choose Rotate
from the quad menu. On the main toolbar,
make sure you are set in Local Coordinate
System.
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7. Rotate the foot up approximately 15 degrees
about the local Z-axis to make the heel raise
and click Set Planted Key.

The heel lifts off the ground, the foot rotates on
the ball, and the toes stay on the ground.

Now, you can animate the pivot point to the toes,
as the ball of the foot lifts off the ground.

Animate the pivot points:

1. Move the time slider to frame 10, and
click Set Key.

2. Click Select Pivot and choose the pivot on the
end of the toe.

3. Click Set Sliding Key to keyframe the
pivot.

4. Click Select Pivot again, to turn it off.

5. In the Perspective viewport, right-click the foot
and choose Rotate from the quad menu.

6. Rotate the right foot about 25 degrees around
the Z-axis so the heel continues to raise and roll
off the toes.

7. Click Set Sliding Key to keyframe the foot
rotation.

The sliding key does not join to the previous
key, but has IK Blend set to 1, which keeps the
foot above the ground plane. If you had set a
planted key, the foot would jump to a different
location as it attempted to join to the previous
key.

Now, you can animate the pivot point to the toes,
as the ball of the foot lifts off the ground.

Lift the foot off the ground:

When the foot lifts off the ground completely,
you’ll set a free key.

1. Move the time slider to frame 15.

2. In the Left viewport, right-click the foot and
choose Move from the quad menu. Move the
foot up off the ground and forward.
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By moving the foot, you are seeing an example
of biped’s IK system. You are creating rotations
for the upper and lower leg links as you move
the foot.

3. From the Key Info rollout, click Set Free
Key to keyframe the lifted position of the foot.

4. Move the time slider back and forth to observe
the animation so far.

5. Save the scene as MyWalk02.max.

Lock down the opposite foot:

1. Move the time slider back to frame 0 and select
Bip01 L Foot.

2. On the Key Info rollout, click Set Key.

3. Turn on Select Pivot and pick the pivot point
at the ball of the foot.

The left foot with a new pivot point

4. Click Set Planted Key to set a the initial
key for the left foot at frame 0.

This key locks the foot down for any subsequent
movement in upcoming frames. If you were to
grab the center of mass and move it down, both
legs would bend instead of moving below the
ground plane.

5. Click Select Pivot to turn it off.

Keyframe the center of mass:

1. From the Track Selection rollout, click
Body Horizontal. Bip01 is automatically
selected.

2. At frame 0, click Set Key for Bip01.

This creates a start key for the center of mass.

3. Move the time slider to frame 15.

4. In the Left viewport, use the Move Transform
gizmo to move the center of mass so the torso
shifts forward, then set another key.
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Note: Because the center of mass is the root
node, use Set Key, rather than one of the
specialized IK keys.

5. Use the Move Transform gizmo to move the
center of mass down a little, so the left knee
bends slightly, then set another key.

The left leg bends automatically as the center
of mass moves down.

6. Select Bip01 L Foot.

7. On the Key Info rollout, set a planted key
for the ball of the foot.

8. Right-click the left foot and choose Rotate from
the quad menu. Rotate the foot so the heel
is lifting up off the ground, and set another
planted key.

The heel is rotated off the ground.

9. Move the time slider to frame 22 and click
Set Key
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10.Right-click in the Perspective viewport and
turn on Select Pivot, then pick the pivot at the
end of the toes of Bip01 L Foot.

11. From the Key Info rollout, click Set Sliding
Key, then turn off Select Pivot.

12.In the Left viewport, rotate the left foot up a
little more and set another sliding key.

13. On the Track Selection rollout, click Body
Horizontal. Move the center of mass forward
again, and set a key.

Keyframe the right heel hitting the ground:

1. At frame 22, select Bip01 R Foot and move
it forward, then set a sliding key.

2. Turn on Select Pivot. Pick the point at the ankle
that lies at the gizmo intersection, then set a
sliding key.

3. Turn off Select Pivot. Rotate the foot so it’s
parallel to the ground, then set a sliding key.

4. Turn on Select Pivot, and set the pivot to the
heel. Set another sliding key.
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The pivot point moved to the heel

5. Turn off Select Pivot. Move the time slider to
frame 27.

6. In the Left viewport, move the right foot
forward a little.

Notice that the foot moves away from the pivot
point in the viewport.

Sliding Key lets foot move away from pivot

7. Set a sliding key.

The pivot point in the viewport moves to the
heel of the foot.

8. Move the right foot down so it touches the
ground, and set another sliding key.

9. Turn on Select Pivot. Pick the pivot at the ball
of the right foot.

The pivot moved to the ball of the right foot
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10. Click Body Horizontal, move the center of
mass so that it is over the heel of the right foot
and set a key.

11. At frame 27, select Bip01 L Foot and set
a free key.

12.Move the time slider and watch the animation
of the foot and the pivot points.

13.Save the scene as MyWalk03.max.

Continue the walk cycle:

1. At frame 27, click Body Vertical so you
can move the center of mass.

2. Lower the body slightly, so the biped sinks
a bit as the right foot flattens onto the floor. Set
a key for the center of mass.

3. Move the time slider ahead to frame 32. Move
the center of mass so it’s over the ball of the
right foot. Set a key for the center of mass.

4. Move and rotate Bip01 L Foot so the heel
swings above the ground. Set a free key.
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Use this procedure throughout this exercise:
lock one foot by setting planted or sliding keys,
move the center of mass, then move the other
foot and set a key.

Complete the walk cycle:

1. Move the time slider to frame 37 and
click Body Horizontal. Move the center of mass
forward and set a key.

2. Select Bip01 L Foot and move it so the leg
is extended in front of the biped. Set a free key.

3. Rotate the left foot so the heel is down and the
toes point upward. Set another free key.

Now the foot looks better.
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4. With the left foot selected, click Select
Pivot and select the pivot at the heel. Set a
planted key for the pivot.

5. Turn off Select Pivot.

6. Move to frame 39, and rotate the left foot so it
is flat on the ground.

7. Set a planted key for the left foot.

8. Click Body Horizontal and move the
center of mass so the body moves forward.

9. Set a key for the center of mass.

10. At frame 41, rotate the left toes so they are
flat on the ground. Set a planted key.

11.Select Bip01 R Foot and move the time slider
back to frame 30. Set a planted key.

12.At frame 32, rotate the right toes so they are
flat, and set another planted key.

13.Move the time slider to frame 37 and rotate the
right foot up a little, then set a planted key.

14.Move the time slider and review the motion.
Add rotations for the toes as needed.

15.Save the scene as MyWalk04.max.

Display trajectories:

Biped has its own trajectory display. You can use
it to observe the movement of the center of mass
in the walk cycle. You can also edit the keys on the
trajectory directly in the viewport.

1. In the Track selection rollout, click Body
Horizontal.

2. From the Key Info rollout, turn on
Trajectories.

3. Scrub the time slider, and watch the biped
center of mass moving along its trajectories.

4. Choose Select And Move on the Main
toolbar. Turn on Sub-Object Trajectories, and
then click any key on the trajectory.

5. Use the Move Transform gizmo to move the
keys to correct the trajectory.

Edit keys in biped trajectory

6. Turn off Biped Trajectories.

Warning: Don’t use the 3ds Max Trajectories with Biped.

Use the Trajectories button in the Display expansion bar

or the Key Info rollout.
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Add arm swings:

The character is starting to look like it’s walking,
but it’s still pretty stiff. Adding arm swings will put
some life in the animation.

The arms swing opposite to the legs. When the
right leg is forward, the left arm is forward. Arms
bend at the elbow on the forward swing, and
stretch out straight on the backward swing.

1. Move the time slider to decide where to place
the arm swings.

The right leg stretches out at frame 27, and
you’ll keyframe the left arm to swing there.

2. Turn on Auto Key.

3. At frame 0, select and move the left hand
slightly, to set a key.

4. At frame 0, select and move the right hand
slightly, to set a key.

5. At frame 27, select and move the left hand so it
swings forward.

Position the arm so there is a slight bend at
the elbow. Since Auto Key is on, you have
keyframed the arm by moving it.

6. On the Track Selection rollout, click
Opposite.

The right hand is selected.

7. Move the right hand back slightly, so the arm
is stretched out.

The left arm is forward and bent a little, while
the right arm is back and straight.

8. In the Front viewport, double-click on Bip01
R UpperArm.

The entire right arm is selected.
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9. On the Motion panel, open the Copy/Paste
rollout and click Copy Posture.

10. Click Create Collection. Name the
Collection walkcycle1.

11.Turn on Create Snapshot from Viewport, just
above the Paste Options group.

12. Click Copy Posture. Name the Copied
Posture RArm back.

13. At frame 37, click Paste Posture Opposite.

The left arm swings behind the biped.

14.At frame 27, double-click Bip01 L UpperArm.

The entire left arm is selected.

15. On the Copy/Paste rollout, activate the
Perspective viewport and click Copy Posture
again. Name the posture LArm forward.

16. At frame 37, click Paste Posture Opposite.

The right arm swings in front of the body.

17.Turn off Auto Key.

18.Move the time slider back and forth to evaluate
the animation.

19.Save the scene as MyWalk05.max.

Add sway to the shoulders and hips:

You’ve animated the character by moving its hands
and feet and center of mass. But the spine, hips,
and head are still stationary. You’ll add some
rotations to the shoulders and hips to complete the
walk cycle.

1. Select Bip01 Pelvis and move the time slider to
frame 15.

The left foot is locked at this frame with a
planted key.

Be careful where you add the hip rotations.
Don’t inadvertently disturb the work you’ve
done on the feet so far.

As the legs extend and swing forward, the hips
rotate slightly in the direction of the movement.

2. Rotate the pelvis about the Y-axis
approximately -2 degrees and set a key.

Note: You can only rotate the pelvis about all
three axes.
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Rotation added to the hips from the Front view

The pelvis will not accept too much rotation.
When you set the key, the pelvis corrects itself
to account for the locked foot.

3. Move the time slider back to frame 0.
Rotate the pelvis back 2 degrees about the
Y-axis and set a key. Rotate the pelvis back
about -3 degrees about the X-axis and set a key.

4. Move the time slider to frame 32. Rotate the
pelvis about 4 degrees around the Y-axis, then
set a key. Repeat for the X axis and set a key

5. Move to frame 39 and rotate the pelvis -2
degrees around the Y-axis again, then set a key.

The procedure is the same for the spine. At
frame 27, the arms swing out in one direction.
At frame 37, they swing in the opposite
direction.

6. Select the biped spine object, Bip01 Spine.

7. At frame 27, rotate the spine in the direction of
the arm swing and set a key. It should be about
-6 degrees around the X-axis.
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8. At frame 37, rotate the spine approximately 12
degrees about the X-axis and set a key.

The spine can freely rotate about all three axes.
You can make adjustments on each one. Rotate
about the Z-axis for a more stooped walk.
Increase rotation about the X-axis to make the
walk loose and floppy.

Instead of animating the spine, you can also
animate the clavicles to raise or lower the
shoulders.

Twist links mode:

The Bend Links rollout includes tools you can use
for animation. You can use either the Bend Links
or the Twist Links to animate the bending and/or
twisting of the spine.

1. Choose Figure Mode.

In the Structure Rollout change the Spine Links
to 5. You can have up to ten spine links but you
will use five to observe the effect.

2. Turn off Figure Mode.

3. Turn on Auto Key.

4. In the Bend
Links rollout turn on Twist Links mode.

5. Select the Bip01 Spine object. This is the lowest
spine object in the biped. 6. Go to frame zero
and rotate the object very slightly about the X
axis to add a key. Do the same about the Y axis.

6. Go to frame zero and rotate the object very
slightly about the X axis to add a key. Do the
same about the Y axis.

7. Move the time slider to frame 27 and rotate
approximately 10 degrees about the X axis to
the spine rotates following the swing of the
arms. The blue arm is swinging forward, so
rotate the spine to match.

8. You can also rotate -1 degree about the Y axis.
Notice that very small rotation of the first spine
object results in a larger effect further up the
hierarchy.

9. Repeat at frame 37 in the opposite direction to
match the swinging of the green arm outward.

10.Save the scene as MyWalk06.max.

You have animated a simple walk cycle using
freeform animation and IK constraints.

You can use the techniques found in the swimmer
tutorial (page 1–344) to refine and finish the
animation motions. Be sure to do that tutorial as
well, if you’ve skipped it.

You can use the footstep method of animation to
create a walk cycle automatically. To learn about
this technique, see Creating a Distinctive Walk
(page 1–303).
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Using Controllers with Biped

You can add controllers on top of Biped animations
to create a wide variety of effects. You can use
scale controllers to create stretchy legs or arms
for cartoon animation, or create the illusion of
breathing by adding a scale controller on the spine
objects in the chest. You can add noise rotation
controllers to the spine to make a biped shake
while he walks, or to create twitching or random
motion in the limbs or head.

Controllers can be added in the Motion panel,
Assign Controllers rollout, or by using the
Workbench. For more tutorials with Controllers,
see the Workbench lesson Adding Controllers to
Multiple Biped Objects (page 2–631).

Although this lesson is performed with footsteps,
it could have been accomplished just as easily with
a freeform animation.

Create stretchy legs with controllers:

In this exercise, you will add a scale controller to
a biped’s legs to stretch them during a portion of
an animation.

1. Open stretchyleg_start.max.

2. Play the animation.

The biped walks for 10 paces, zooms to a lower
level, and then walks another five steps. You’ll
add the scale controller, then animate the biped
so that its legs stretch during the period of the
downward leap.

3. Move the time slider to frame 162, then select
the Bip01 L Thigh object, the blue leg.

4. On the Motion panel, open the Assign
Controller rollout.

5. In the controller list window, expand the Biped
SubAnim entry.

Now you can see the three list controllers.

6. Click the plus sign (+) next to BipScaleList
to expand this controller. Select the entry
marked Available, then click the Assign
Controller button.

The Assign Scale Controller dialog appears.

7. Choose Scale XYZ from the list, and click OK
to close the dialog.

8. On the 3ds Max Main toolbar, click the
Select And Scale button.

The Scale gizmo is visible on the thigh in the
viewport.

9. Turn on Auto Key.

First, you will set a key to start the stretch. You
don’t want the stretch to start before frame
162. You want the biped to have a normal leg
(unstretched) from the start of the animation
up to this frame.

10.Using the Scale gizmo, stretch the leg very
slightly in the X-axis at this frame, so the final
value in the Coordinate rollout is 100 (no
stretch).

The leg at frame 162 (no stretch).
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11.Move to frame 164, and stretch the leg so the
foot reaches the footstep.

12.Move to frame 167, and again stretch the leg
in the X-axis, so the foot stays on the footstep
gizmo.

Leg stretch at frame 167

13.Move to frame 169. Here, you begin to shorten
the leg stretch.

Leg shortens at frame 169

14.Move to frame 181 and stretch the leg back to
normal. Adjust it visually until the leg looks
correct.

Leg at frame 181 appears normal.

15.Play the animation. The biped’s back foot stays
on the footstep and the leg stretches out as the
biped descends to the lower set of footsteps.
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For extra credit, add a scale controller to the
green thigh, and stretch that leg out , roughly
between frames 161 and 171.

16.Save your work as mystretchy_leg.max, or
open stretchyleg_final.max for comparison.

Once you have controllers added to the biped
body parts you can animate their parameters, or
animate their weights. Here’s an example that
shows animation of parameters.

Animate the weights of SubAnim controllers:

1. Open shake_and_walk_start.max.

2. Play the animation.

The biped takes a few steps, then pauses for a
moment or two, then walks on.

3. In the Perspective Viewport, select Bip01 Spine,
the lowest spine object.

4. On the Motion panel, open the Assign
Controller rollout.

5. In the Assign Controller window, expand
the Biped SubAnim so you can see the list
controllers.

6. Expand the BipRotationList, and highlight the
entry marked Available.

7. Click the Assign Controller button.

The Assign Rotation Controller dialog appears.

8. Choose Noise Rotation in the list, and click OK.

The Noise Rotation Properties dialog is
displayed. Don’t close this dialog.

9. Play the animation in the viewport.

The biped shakes drastically as it walks.

10.In the Properties floater, turn Fractal Noise off.

11.As the animation plays, change the Frequency
in the Properties dialog, using the spinner.
Lower the value until the shake becomes slower
and more rhythmic. Probably a value of 0.2 or
less will be good to use, but you can choose
whatever you like.

12.As the animation plays, change the X, Y and Z
values. Set the three values to 0, then change
them individually, one at a time.

To create a shimmy effect, set X Strength to be
2, Y and Z Strength to 0.
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13.Close the Noise Rotation Properties dialog.

In this example, the biped should shake only while
walking. The frames between 69 and 191 should
not have any shaking. To complete this effect, you
will animate the weight of the noise controller.

Animate the weight of the noise controller:

1. On the Motion panel, expand the Weight entry
of the Noise Rotation controller you added to
the spine object. Highlight Weight 0.

There is a trick to accessing the weights.

2. Open the Keyframing Tools rollout and
click the Manipulate SubAnims button.

The Motion panel now displays additional
rollouts for Position List, Scale List, and
Rotation List.

3. Scroll to the Rotation List and select the
Layer->Noise Rotation.

Now you’re ready to animate the Weight field.

4. Turn on Auto Key

5. Move the time slider to frame 70.

6. Near the bottom of the Rotation List rollout,
right-click the Weight field spinner. This sets
it to zero.

Tip: Right-clicking any spinner resets it to its
lowest possible value.

7. Move the time slider to frame 69.

Tip: Use the < and > keys on the keyboard to
move from frame to frame.

8. Change the Rotation List Weight field to 100.0.

The spinner is outlined in red to show it is
animated.

9. Drag the time slider back and forth from frame
0 to frame 100 to see the animation. The biped
shakes while walking and stops shaking during
the pause.

10.Next, you make the biped start shaking again
at frame 191. At frame 190, set a key with the
Noise Rotation Weight set to 0, and to100 at
frame 191.
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Tip: At frame 190, hold down the SHIFT key
while you right-click on the spinner. This will
set a key without having to change the value.

11.In the Keyframing rollout, turn off Manipulate
SubAnims when you’re done.

12.Play the animation.

13.Save your file as myshake_and_walk.max,
or open shake_and_walk_finished.max for
comparison.

If you are exporting to a game engine, or if you
want to use this animation with Layers or in the
Motion Mixer, you will need to collapse the list
controller animation (see following procedure).
This will add the controllers animation keys to the
tracks of the Biped SubAnim.

Note: 3ds Max has different behaviors for
controllers and constraints. The controller
animation will be layered onto the existing keys
in the Biped SubAnim track. If you have used
a constraint, however, it will replace the Biped
Subanim tracks.

Collapse the list controller track:

1. Continue from before, or open
shake_and_walk_finished.max.

2. If you open the file, select the Bip01 Spine
object in the viewport, open the Motion panel,
and expand the Assign Controller rollout.

3. In the Assign Controller window, highlight
Biped SubAnim and then right-click.

4. Choose Properties from the right-click menu.

The SubAnim Property dialog appears.

5. In the Enable options, turn off Position List
and Scale List, so the Rotation List is the only
one active.

6. In the Collapse options, turn off Position, and
turn on Rotation List, Don’t Delete, and Per
Frame.

7. To collapse the rotation track, click the Collapse
button at the bottom of the SubAnim Property
dialog.

Wait while the calculations take place.

When the collapse is completed, the dialog
closes and the track bar fills with keyframes.
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8. Save your work as mycollapsed_shaking.max,
or open shake_and_walk_collapsed.max for
comparison.

You can use the Workbench to reduce the keys that
you’ve created. For a lesson on this technique, see
Filtering Animation (page 2–628).

Creating Animated Bones with
Biped

You can take the animated biped skeleton and use
it to generate a 3ds Max bone structure that follows
the same animation, by using the File Export and
Import capabilities. In just a few steps you will
be able to take your biped animation and use it
without the biped attached.

Create animated bones from bipeds:

1. Open createbones_start.max.

Biped takes a bow

2. Play the animation.

Observe the biped and its movement.

3. On the File menu, choose Export.

4. On the Save As Type list, choose FiLMBOX
(*.FBX).

The Export FBX dialog appears.
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5. Accept all the default values and click OK.
Name the file mycreatebones.fbx.

Wait while the export calculates the TRS
animation.

6. On the File menu, click Reset.

The biped disappears, the viewports reset.

7. On the File menu, choose Import.

Select the file you just exported.

An import dialog appears

8. Click the More button next to the Bones entry.

In that dialog, set the Bone Width and Length
to be 3.0000.

9. Click OK to close the dialog. Click OK again to
import the FBX file and create the bones.

A bone skeleton appears in the viewport.
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10.Play the animation. The skeleton has the
identical animation as the original biped.

11.Save your file as mycreatebones.max or open
createbones_final.max for comparison.

Adjusting the Biped to the
Model

Getting Started with Physique

This tutorial shows you how to use the Physique
modifier to associate a biped with a mesh and
fine-tune the association.

In this tutorial, you will learn how to:

• Customize the biped structure

• Pose the biped to fit the mesh

• Adjust vertex assignments with envelope
parameters

• Use control points to fine-tune the shapes and
sizes of envelopes

• Adjust envelopes in shoulder and hip areas for
the best deformation
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Skill level: Beginner

Time to complete: 2.5 hours

You can find the files for this tutorial in the
tutorials\character_animation\physique_basics
folder on the Tutorial Files CD that ships with
3ds Max.

In This Tutorial

Working with Biped Parts (page 1–383)

Aligning the Biped to the Model (page 1–386)

Applying the Physique Modifier (page 1–396)

Adjusting Envelopes (page 1–400)

Fixing Shoulders and Hips (page 1–404)

Working with Biped Parts

The process of animating a character starts with
a biped. In this lesson, you will learn to work
with biped parts, creating a skeleton with the
appropriate body parts to fit your mesh.

Set up for this lesson:

• Reset 3ds Max.

Create a biped:

1. On the Create panel, click Systems.

2. On the Object Type rollout, click Biped.

The Biped button turns gold.

3. If you can’t see the Height spinner in the Create
Biped rollout, scroll to the bottom of the
command panel.

4. In the Perspective viewport, place your cursor
over the center of the grid. Press and drag
upward.

A biped appears and grows with your cursor
movement.

5. Drag upward until the Height value is
approximately 70 units. A biped appears in the
viewport.

The biped is a hierarchy of special objects. Its
parent object (Bip01) is also called the center
of mass or COM. The COM is displayed in
the viewports as a small tetrahedron, initially
centered in the biped’s pelvis. After you create a
biped, only the center of mass object is selected
(not the entire biped).

After creating the biped, you change the values
on the Create Biped rollout to give the biped the
appropriate links for your mesh.

Change the number of fingers and toes:

1. Change the Fingers parameter to different
values. You can see the number of fingers
changing in viewports.
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Five fingers

2. Set the number of Fingers to 5. This gives the
biped four fingers and a thumb.

3. Change the Finger Links parameter to different
values. Observe the finger links as they change
in viewports.

Five fingers with three finger links

4. Experiment with the number of Toes and Toe
Links, and observe the changes in viewports.

Add a tail and ponytails:

For non-human characters such as animals, you
will need tail and ponytail links to control the
mesh.

1. Change the Tail Links value to 5.

In the Left viewport, you can see the biped
growing with a tail.
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Biped with tail

As long as this biped remains selected, you can
make changes to the biped parameters and see
the effects.

2. Change the Tail Links spinner to 0.

3. Change the Ponytail1 Links value to 5.

In the Left viewport, you can see the ponytail
growing from the base of the head. If necessary,
two ponytails can be added.

Biped with one ponytail (in blue)

4. Change the Ponytail1 Links value to 0.

Add props:

Props are extensions of the biped skeleton. Props
are linked to the COM, and can be animated to
pass from hand to hand. You can use props to
animate objects the biped is holding, such as tools
or weapons.

1. Turn on Props 1, 2 and 3, and turn them off
again.
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Biped with Prop 1 activated

Once you have determined the appropriate
parts for your biped, the next step is to align
the biped to the mesh.

2. If you like, you can save this scene to the file
my_biped.max.

Aligning the Biped to the Model

In this lesson, you’ll pose a biped to fit a specific
character by moving, rotating, and scaling biped
parts.

When correctly posed, the biped’s torso, arms,
and legs fit just inside the mesh. Fingers and toes
extend just beyond the mesh to make skinning
easier later on.

When posing the biped, Figure mode must be
turned on. This mode tells 3ds Max that you are
posing the biped rather than animating it.

The character you’ll use in this lesson has a human
form, and will not require a tail, ponytails, or props
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Set up for this lesson:

1. Load the file align_wilson_start.max.

This scene contains a model of a man named
Wilson.

The Wilson model

2. Inspect the model to see the number of fingers
and toes. This model has three fingers and a
thumb, and the fingers are short. Wilson is
wearing shoes, so no toes are visible.

Prepare the model:

Your work with the biped will be much easier if
you make a selection set for the model, make it
see-through, and freeze it.

1. Select the entire model.

2. In the Named Selection Sets entry area on the
Main toolbar, enter the name Wilson Mesh.

3. On the Display panel > Display Properties
rollout, turn on See-Through.

The model turns gray and becomes
see-through. Making the model see-through
will allow you to see the biped as you pose it
inside the model.

4. On the Display panel > Display Properties
rollout, turn off Show Frozen in Gray.

This lets the model retain a little of its shading
when frozen.

5. On the Display panel > Freeze rollout, click
Freeze Selected.

You freeze the model so you won’t accidentally
select it while working with the biped.

Create a biped:

1. Choose Create panel > Systems > Biped.

2. Click near Wilson’s feet in the Front viewport
and drag upward to create a biped about the
same size as the model.
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Because Wilson is wearing shoes, there’s no
reason to have separate toes. You’ll give the
biped just one toe with one link, which will
control the entire ball and toe of the shoe.

3. Near the bottom of the Create Biped rollout,
change Toes to 1 and Toe Links to 1.

When you inspected the model earlier, you
found that Wilson has three fingers and a
thumb for a total of four fingers. The fingers are
short, so only two finger links are needed.

4. Set Fingers to 4 and Finger Links to 2.

Wilson’s neck is rather stubby, so he needs only
one neck link.

5. Set Neck Links to 1.

Position the biped:

1. Open the Motion panel.

2. In the Biped rollout, click Figure mode
to turn it on.

If the Biped rollout doesn’t appear on the
Motion panel, select any part of the biped to
make it appear.

Important: Be sure to turn on Figure mode before

continuing. Figure mode will retain the pose you are

about to create.

3. Select the center of mass (COM), the blue
tetrahedron at the center of the biped’s pelvis.

Tip: You can quickly select the
COM by clicking any of the selection buttons in
the Track Selection rollout: Body Horizontal,
Body Vertical, or Body Rotation.

4. In the Front viewport, move the COM to the
center of the model’s hips.

5. Check in all viewports and move the COM as
necessary to put it inside the character’s hips.
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COM placed correctly in Left view

Pose the legs:

1. Select both the upper and lower parts of both
legs.

2. In the Front viewport, scale both legs so the
bottoms of the biped’s feet align with the
model’s feet.

3. Select both thighs. Rotate the thighs to make
the biped’s legs parallel to the mesh legs.

The goal is to make the biped’s legs go down
the centers of the mesh legs, but you can’t do it
until you scale the pelvis.

4. Select the biped’s pelvis, the orange triangle
around the COM.

5. Scale the pelvis on its local Z-axis so the biped
legs go down the centers of the mesh legs.
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You might need to rotate the legs again, and
scale the pelvis again. Work back and forth
between scaling the pelvis and rotating the legs
until the legs go straight down the middle of
the mesh legs.

Scale the legs:

1. In the Left viewport, right-click the viewport
label and turn on Edged Faces so you can see
the knee detail on the pant legs.

2. Scale and rotate the thighs so the knee joint falls
at the center of the knee detail on the pants.

So far you have been posing both legs at the
same time. It is possible to pose one leg or arm
first, then copy and paste it to the other side.

3. In the Front viewport, select one calf. Scale
the calf so the ankle joint falls just above the
bottom of the pant leg.

4. Scale the foot so its bottom reaches the bottom
of the mesh foot.
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5. Select both the foot and calf you just scaled.

6. In the Copy/Paste rollout, turn on
Posture. Click Copy Posture.

7. Click Paste Posture Opposite.

Now the two legs match.

8. In the Left viewport, check to see if the ankle
joint meets the bottom of the leg. If not, change
the Ankle Attach parameter on the Structure
rollout to 0.2 or 0.25 to make the ankle match
the leg.

9. In the Left viewport, rotate the thighs, calves
and feet so they align as well as possible with
the model.

The file align_wilson_legs.max contains the
biped posed up to this point.

Position the arms and spine:

1. Select one of the biped’s upper arms.

2. In the Front viewport, rotate the upper arm
upward to make the arm parallel with the
model’s arm. Don’t be concerned with fitting
the arm at this time; simply make it parallel.
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3. Select all the spine links and make a selection
set called Biped Spine.

4. In the Front viewport, scale the spine upward
or downward to make the upper arm fall into
place.

5. Select the posed upper arm. In the
Copy/Paste rollout, copy and paste this pose to
the other side of the biped using Copy Posture
and Paste Posture Opposite.

6. Use the Biped Spine selection set to select the
spine links. In the Left viewport, rotate the
spine links slightly so they follow the curvature
of the spine. You might need to move the lowest
spine link to align the spine correctly.

Important: Don’t rotate the COM when posing the

biped. Instead, move the lowest spine link to adjust

the position of the spine and upper body.

Now that the spine is curved correctly, the arms
might be out of place again.

7. Use the named selection set to select the entire
spine. In the Front viewport, scale the spine
again to make the arms fall into place.

8. Check the spine again in the Left viewport to
ensure it still follows the shape of the character’s
torso.
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As with the legs and pelvis, you have to work
back and forth between the spine and the arms
to make both fall correctly inside the mesh.

9. In the Front and Left viewports, scale the
widths of the spine bones to make them fit the
mesh more closely.

Make each spine bone about two-thirds the size
of the mesh. You will have to scale some spine
bones more than others.

Pose the arms:

The posing of the arm starts with the clavicle
bone, which connects the arm to the torso. Proper
scaling of this bone leads to easier skinning of the
underarm and shoulder areas later on.

1. Select one clavicle. In the Front viewport,
scale the clavicle slightly along its X-axis so the
biped’s shoulder joint falls in the center of the
mesh shoulder.

Left (blue) clavicle scaled slightly

2. In Top viewport, work with the upper and lower
portions of the same arm. Scale and rotate the
arm bones as necessary to fit it to the mesh,
taking care to align the biped’s elbow and wrist
joints with the same joints on the mesh.

Posed arm in Top viewport

Tip: You can move quickly between parent and
child bones by pressing PAGE UP and PAGE
DOWN on the keyboard.

3. In the Front viewport, rotate the arm if
necessary to make it go down the center of the
mesh.

4. Select the clavicle, upper arm, and lower arm,
and copy and paste the pose to the opposite
side of the biped.

The file align_wilson_arms.max contains the
biped posed up to this point.

Pose the hands:

Positioning the fingers is the most challenging
part of posing the biped. Each finger joint must be
moved and rotated separately.

You can rotate each finger and thumb joint, but you
can move only the base of each finger and thumb.

You’ll have an easier time posing the fingers if
you work with the bases of fingers first, moving
each one into place before rotating and scaling the
finger joints.

1. In Top, Front, and User viewports, zoom in on
one of the hands.

2. In the Top viewport, rotate the hand slightly if
necessary to make it fit the mesh better.

3. Scale the biped hand so the palm nearly reaches
the point where the pinky finger starts.
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4. Check the hand in the Left viewport, and if
necessary, rotate it to fit the center of the mesh
hand.

5. In the Top viewport, move the base of the
thumb and each finger to match the base of
the corresponding digit on the mesh. Don’t
concern yourself with the rotation of the fingers
just yet.

6. Rotate base of each finger and the thumb so
each goes up the length of the corresponding
mesh finger. You might find you have to move
the base of the finger again to make it align
correctly.

7. Scale the lengths of the finger joints so the first
goes about halfway down the finger, and the last
extends just beyond the mesh fingertip. This
will help later on when skinning the character.

8. Using the Top and Front viewports, scale the
width and height of each biped finger to about
two-thirds the size of the corresponding mesh
finger.

9. In the User view, rotate the finger joints to fit
the fingers. You can also move each finger base
up or down to improve the fit. Look at the hand
from various angles to check the fit.
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Tip: To rotate the view around the hand, select
one or more finger bones and use Arc Rotate
Selected in the User viewport.

There is no shortcut to posing the hand
correctly. You must look at the hand carefully
from all angles to ensure the bones are centered
down the mesh fingers and thumb. The thumb
bones can be challenging to pose because they
rotate differently from the fingers.

10.When the hand pose looks good, select all the
hand bones, and copy and paste the posture
to other hand.

11.Check the fit of the bones on the other hand. If
necessary, scale or rotate the lower arm to make
the fingers fit on the other side.

When a mesh is symmetrical, the hand bones
should make an exact fit when pasted to the
other side. However, meshes are not always
perfectly symmetrical. In addition, if the center
of mass is slightly off center, the hand will not
fit exactly.

The file align_wilson_fingers.max contains the
biped posed up to this point.

Pose the head and feet:

1. In the Left viewport, rotate and scale the neck
link so the biped’s chin aligns with Wilson’s
chin. Do not rotate the head.

2. In the Front viewport, scale the head to about
half the width of Wilson’s head, and to its full
height.

3. In the Top viewport, rotate the biped’s feet to
match the angle of Wilson’s feet.

4. In the User and Left viewports, scale the foot
and toe bones to represent the bulk of the shoe
and the toe portion of the shoe. If you have
difficulty selecting the toe bone, select the foot
and press PAGE DOWN.
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Complete the posing process:

1. As necessary, scale biped parts so they are
about two-thirds the width of the mesh.

Wilson’s pose is now complete.

2. Select the entire biped, and create a named
selection set called Wilson Biped.

Tip: It’s best to wait until you’ve finished posing
the biped to make a biped selection set. If you
change parameters on the Structure rollout and
add more parts while you’re posing, any parts

added in this way will not be part of a selection
set made at the start of the posing process.

3. In the Biped rollout, click the expansion bar to
display the Name field.

4. Enter Wilson Biped in the Name field.

All biped parts are now preceded by the words
Wilson Biped. Naming the biped in this way
greatly assists the process of merging characters
into scenes with multiple bipeds.

Tip: Giving each of your bipeds a unique name
is a good practice. For example, if you decide to
merge the character into a scene that contains
other bipeds, the merge process won’t ask you
about duplicate names, and you’ll be able to tell
them apart easily when selecting objects.

Save the pose:

1. Choose the named selection set Wilson Mesh,
and click Yes on the warning dialog.

2. On the Display panel, turn off See-Through.

3. Save the scene to the file my_wilson_pose.max.

A finished version of the pose can be found in
the file align_wilson_complete.max.

Applying the Physique Modifier

After the biped is posed to match the character
mesh, you apply the Physique modifier to the
character mesh and associate it with the biped.
The Physique modifier makes it possible to control
the mesh with the biped’s motion.
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The Physique modifier makes the biped act as a
skeleton under a mesh “skin”. Physique assigns
each vertex in the mesh to one or more bones in
the biped. When the biped bones are animated,
appropriate vertices in the mesh will move along
with each biped part.

The process of applying and adjusting Physique
is called skinning.

Set up for this lesson:

1. Load the file my_wilson_pose.max that you
created in the lesson Aligning the Biped to the
Model (page 1–386). Alternately, you can load
the file physique_wilson_start.max from the
CD.

This scene contains the character Wilson and a
completely posed biped.

The Physique modifier will be applied to
Wilson’s head and body, but not his eyes or hair.
These objects will be dealt with in a different
fashion later on.

In general, the skinning process is easiest
when models are as low-poly as possible.
Both Wilson’s head and body have been
smoothed with the MeshSmooth modifier.
If you were applying Physique to just one of
these objects, you could simply apply it below
the MeshSmooth modifier on the modifier
stack. Because you’ll be applying it to two
objects at the same time, you’ll need to remove
MeshSmooth from both objects and reapply
it later.

2. Select the object Wilson Mesh Body.

3. Open the Modify panel.

4. Highlight the MeshSmooth modifier on
the modifier stack, and click Remove Modifier
From The Stack.
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5. Select Wilson Mesh Head and remove the
MeshSmooth modifier from its stack.

Turn on Figure mode:

1. Press the H key and select Wilson Biped. This
selects the biped’s center of mass.

2. Open the Motion panel.

3. If Figure mode isn’t already on, turn
it on.

Apply Physique:

You apply Physique as you would any modifier in
3ds Max.

1. Select the objects Wilson Mesh Body and
Wilson Mesh Head.

2. On the Modify panel, choose the Physique
modifier from the Modifier List to apply it to
the selection.

The Physique modifier appears on the stack in
italics to indicate that it is instanced (applied to
more than one object at a time).

Attach the biped and mesh:

1. In the Front viewport, zoom in on the biped’s
center of mass.

2. In the Physique rollout, click Attach To
Node.

3. In the Front viewport, click the biped’s center
of mass.

The Physique Initialization dialog appears.

4. Click Initialize on the dialog.

An orange skeleton line appears throughout the
mesh. If Physique has been properly applied,
the line should extend up through the head,
down through all the fingers and through to
the ends of the toes

If the orange skeleton line does not go to the
ends of the head, fingers, and toes, this means
you picked an object other than the center of
mass after clicking Attach To Node. If this
happens, click Attach To Node and repeat the
last few steps until the orange skeleton line
appears correctly.

Create a test animation:

Physique assigns vertices to specific biped bones
based on the size of each bone and its proximity
to vertices. With careful posing of the biped, the
default assignments can be quite accurate, but
some adjustment is always needed.

The fastest way to check vertex assignments is to
make a simple animation with the biped and watch
how the mesh responds. You’ll hide the mesh while
animating the biped to minimize the distraction.

1. Select the named selection set Wilson Mesh,
and hide the selected objects.
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2. Select any part of the biped and go to
the Motion panel.

3. Turn off Figure mode.

4. Expand the Key Info rollout. On frame 0, select
the biped’s upper arms and thighs, and click
Set Key.

5. Go to frame 10.

6. Turn on Auto Key.

7. Pose the biped with one arm up and one arm
down, and with legs split front and back slightly.

8. Scrub the time slider to see the simple
animation.

9. Turn off Auto Key.

Check the default vertex assignment:

1. Go to frame 0.

2. Unhide the mesh.

3. Scrub the time slider to see how the mesh
responds to the animation.

A few difficulties are immediately apparent:

• Parts of the pant legs are left behind when
the legs move

• Parts of the sleeves are left behind when the
arms move

• Hips are slightly crumpled

Note: If you used your own version of the posed
biped, your problems with the mesh might be
slightly different.

You will fix these problems by adjusting
envelopes in the next lesson.

4. Save your work in the file my_physique_
wilson.max.

A finished version of this lesson can be found
in the file physique_wilson_complete.max.
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Adjusting Envelopes

The bulk of the work in Physique consists of
adjusting the size and overlap of envelopes to
fine-tune mesh behavior as the character moves.

For the best results, each area of the mesh requires
some attention.

• Each envelope should encompass its
surrounding vertices

• Hip and shoulder areas must be adjusted for
smooth deformation when the biped walks or
stretches

• The head requires a rigid envelope for minimal
deformation

As you adjust the envelopes, inspect the mesh from
various angles. A test animation will also reveal
different flaws in the mesh as the biped posture
changes.

Set up for this lesson:

1. Load the file my_wilson_physique.max that
you created in the lesson Applying the Physique
Modifier (page 1–396). Alternately, you can
load the file envelopes_wilson_start.max from
the CD.

This scene contains the character Wilson
and a posed biped. MeshSmooth has been
removed from the character for the time being.
Physique has been applied to the model, but the
envelopes haven’t been adjusted.

The biped isn’t needed for envelope adjustment,
so you can hide it for now.

2. Select the Wilson Mesh Body object.

3. Open the Modify panel.

4. In the Physique Level Of Detail rollout, turn on
Hide Attached Nodes.

The biped is hidden, and you have a better view
of the mesh.

Tip: Turning on Hide Attached Nodes has the
same effect as hiding the biped with the controls
on the Display panel.

5. Scrub the time slider to frame 10.

The biped is animated very simply, just enough
to show you the main problem areas. The
problems with the mesh are:

• The sleeves don’t go with the upper arm
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• The pant legs don’t go with the legs as they
split

• The hips do not deform smoothly

If you’re using scene you created with the last
two lessons, it’s possible that your biped pose
differs slightly from the file included on the CD,
producing different problems with the hands,
fingers, legs, or feet.

In this lesson, you’ll learn to fix the first two
problems listed above. You can apply the same
principles to other body parts, such as fingers
and toes.

Tip: To get a better look at the envelopes and
vertices as they change shape, change the
Perspective view to a User view and turn on
Edged Faces .

Adjust the arm envelopes:

1. In the Front viewport, zoom in on the upper
body. The time slider should be at frame 10.

2. Go to the Modify panel.

3. Expand the Physique modifier listing on the
stack, and choose the Envelope sub-object.

The links in the body turn yellow.

4. Click the link for the left upper arm.

Two envelopes appear around the arm link.
The vertices inside the envelopes are influenced
by the bone. The inner red envelope indicates
the area of most influence. The link’s influence
decreases until it reaches the purple outer
envelope. Vertices outside the envelopes are not
affected at all by the bone.

Vertices affected by the currently selected
envelope turn various colors to show they are
influenced by the envelope.

The radius of each envelope can be changed
with the Radial Scale parameter. Increasing
the radius enlarges the envelope to encompass
more vertices, increasing the number of vertices
affected by the bone.

Tip: To see the envelopes’ influence in color in a
shaded viewport, turn on the Shaded option in
the Blending Envelopes rollout > Display group.

5. In the Blending Envelopes rollout > Envelope
Parameters group, increase the Radial Scale
parameter until all the vertices in the sleeve pop
into place.
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To make the other arm’s envelope the same, you
can copy and paste the envelope settings.

6. In the Edit Commands group, click Copy.

7. Select the right upper arm link and click Paste.

The sleeve pops into place for the opposite arm.

Note: It is possible that the right arm envelope’s
Radial Scale will have to be increased slightly to
encompass the sleeve on that arm. Even with

a symmetrical model, there can be very slight
differences between the biped pose on each
side, causing differences in the initial envelope
size and placement.

Adjust the leg envelopes:

The envelopes for the lower legs don’t fully
encompass the entire pant leg near the ankle.

1. Select lower right leg link, and increase the
Radial Scale.

When you increase the Radial Scale enough
to encompass the entire pant leg, the outer
envelope includes some of the vertices on the
other leg. You will solve this problem my
moving control points.

The process of moving control points is easier if
you put the character back into its figure pose.

2. In the Display group, turn on Initial Skeletal
Pose.

The character jumps back to its figure pose.

3. In the Blending Envelopes rollout >
Selection Level group, click the Control Point
button.

Control points appear on each envelope.

4. In the Front viewport, select the control points
on the side of the envelope that overlaps the
left leg, and move them to the left until the
envelopes no longer affect the left leg’s vertices.
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5. In the Blending Envelopes rollout >
Selection Level group, click the Link button.

6. Select the lower left leg link. Increase its Radial
Scale so the envelopes encompass the entire
left pant leg.

7. Click Control Point.

Control points appear on each envelope.

8. Adjust the control points as you did before,
so the lower left leg envelopes don’t affect the
lower right leg’s vertices.

Adjust foot envelopes:

1. Turn off Initial Skeletal Pose.

2. In the Blending Envelopes rollout >
Selection Level group, click the Link button.

3. Select one of the foot links, and increase the
Radial Scale until any parts of the foot that were
sticking out are now following along with the
foot bone.

4. Copy and paste the envelope settings to the
other foot, or adjust them manually.

Fine-tune the ankle area:

1. Click the Link button, then click the calf link
on the left leg.

In looking at the pose on frame 10, you can
see that parts of the shoe are affected by the
calf link, causing spikes to appear on the shoe.
You’ll fix this problem by adjusting the Child
Overlap parameter. This value changes the
length of the envelopes in the direction of the
child link. In this case, the foot link is the child
of the calf link.

2. In the Envelope Parameters group, decrease the
Child Overlap setting until the calf envelope no
longer affects the vertices at the back of the heel.

Note: The Parent Overlap parameter works in
the opposite direction, increasing or decreasing
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the length of the envelopes in the direction of
the parent link.

3. Copy and paste the envelope settings to the
opposite calf link.

Although the hips are not deforming correctly
just yet, the arms and legs should now deform
properly without vertices being left behind
or making unsightly spikes. If any problems
remain, fix them by working with the Radial
Scale, Parent Overlap, and Child Overlap
parameters.

Assign a rigid envelope to the head:

The head is not expected to deform when the
biped is animated. To keep it from deforming,
you’ll assign rigid vertices to it.

1. Select the character’s head mesh, Wilson Mesh
Head.

Note: Because the Physique modifier is
instanced on both the mesh and head, it doesn’t
matter whether the head, the mesh, or both
objects are selected when you adjust the head
envelopes. Any changes to envelopes will take
place on both objects regardless of the current
selection. You select the head at this time only
because it will be easier to see how vertices are
affected when you change the envelopes.

2. Access the Envelope sub-object level for the
Physique modifier.

3. Click the head link to select it.

4. In the Active Blending group, turn off
Deformable and turn on Rigid.

Vertices on the head turn green to indicate they
are rigid.

5. Adjust the outer envelope so it encompasses the
head and a little of the neck, but no more.

Save your work:

• Save your scene as my_wilson_envelopes.max.

A scene with adjusted envelopes can be found
in the file envelopes_wilson_complete.max.

Fixing Shoulders and Hips

When adjusting Physique envelopes for a mesh,
the shoulder and hip areas present the greatest
challenges.
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Envelopes for these areas must be adjusted
carefully to ensure the character moves the way
you’ve envisioned.

An important part of character animation is
smooth deformations between joints. For elbows,
knees, and other joints with only two adjacent
links, this is usually a simple matter of making the
outer envelopes overlap slightly at the joint.

However, with shoulders and hips, there are
several joints at work in the same area. Making
these links work well together is the key to smooth
deformation in the hip and shoulder areas.

Set up for this lesson:

1. Load the file my_wilson_envelopes.max that
you created in the lesson Adjusting Envelopes
(page 1–400). Alternatively, you can load the
file hips_wilson_start.max from the CD.

This scene contains the character Wilson.
Physique has been applied to the model and
some envelope adjustments have been made,
but there are still some problems with the hips.
The biped has been hidden to make it easier to
work with the model.

When fine-tuning envelopes as in this
lesson, it’s easier to see what’s happening if
MeshSmooth is applied to the model.

2. Select the body mesh, Wilson Mesh Body.

3. On the Modify panel, apply the MeshSmooth
modifier above the Physique modifier.

Applying MeshSmooth above Physique means
Physique will affect vertices from the lower-poly
version of the model. This will retain the ease
of adjusting envelopes for fewer vertices, while
MeshSmooth will make the final model smooth
in appearance.

4. In the Subdivision Amount rollout, change
Iterations to 1

5. In the User viewport, zoom in on the hip area.

6. Scrub the time slider back and forth between
frames 0 and 10.
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A few problems are apparent with the hip area:

• The bottom of the shirt deforms with the
legs.

• The front part of the hip doesn’t move with
the leg.

• The top of the leg creases a great deal when
the leg moves forward.

You’ll solve these problems by adjusting the
envelopes in the hip area.

Adjust the center hip link:

1. In the modifier stack, choose the Envelope
sub-object level under the Physique modifier.

It will be easier to work with the hip envelopes
in the initial skeletal pose.

2. In the Blending Envelopes rollout > Display
group, turn on Initial Skeletal Pose.

3. In the Front viewport, zoom in on the hip area.

There are three links in the hip area, one in the
center of the pelvis and a link to each leg.

4. Select the center link to see its current envelope.

This link should affect vertices that will move
very little or not at all when the hips move. For
example, Wilson’s shirt shouldn’t move very
much when his hips move, so this link should
control the bottom of the shirt.

5. In the Envelope Parameters group, turn on
Outer.

This will cause any changes to the Radial Scale,
Parent Overlap, or Child Overlap values to
affect only the outer envelope.

6. Adjust the Radial Scale and Parent Overlap
parameters until the outer envelope
encompasses the bottom of the shirt.
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Adjust the hip links:

1. In the Envelope Parameters group, turn on
Both.

This will color the envelopes red and purple
again so you can clearly distinguish between
them in the next step.

2. Select the left hip link to see its envelopes.

This link looks somewhat twisted. This
happens because the hip links actually go
around a small corner at the top of the link. You
can work with this link more easily if you first
straighten out the envelopes by decreasing the
Parent Overlap value. This slides the envelopes
down the link and away from the bend.

3. Reduce the Parent Overlap value until the
envelopes straighten out.

Recall that one of the problems in the animation
was that the hip was affecting the shirt but
not the hip portion of the leg. You’ll work
further with this set of envelopes to correct this
problem.

4. Increase the Child Overlap value to move the
envelopes down to the top of the leg.

5. Decrease the Parent Overlap more so the inner
envelope just reaches the bottom of the shirt.

6. Choose Inner, and reduce the Radial Scale
for the inner envelope to lessen the envelope’s
effect in this area.
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7. Choose Outer, and reduce the Parent Overlap
more until the outer envelope just reaches the
top of the shirt.

8. Copy and paste this envelope to the other hip.

9. Turn off Initial Skeletal Pose and check the
animation on frame 10. The movement of the
hips should no longer affect the bottom of the
shirt. If it does, make further adjustments to
the center link and hip envelopes.

Adjust the leg envelopes:

The leg envelopes also affect the hip area. One of
the most common problems is each leg’s influence
(or lack of influence) on the buttock area.

1. In the User viewport, rotate and zoom the view
to show the character’s buttocks area.

2. Select each upper leg link, and change the
Radial Scale parameter for the inner and outer
envelopes to see the effect on the hip area.
Adjust the envelopes until the deformation
looks smooth and realistic on frame 10.

This is perhaps the most challenging step
in working with Physique. If you have
difficulty with this step, save your work
to my_temp_hips.max, and load the file
hips_wilson_complete.max to study the leg and
hip envelopes. Then reload my_temp_hips.max
and try again.

Adjust the shoulders:

When the biped’s arms move, the arm, clavicle,
and chest bones come together to affect the
vertices in the shoulder area.

Ideally, for a human character, envelopes would be
adjusted to achieve this setup:

• The chest bone affects all vertices in the chest
area, and a few vertices in the armpit area

• The arm bone affects all vertices in the upper
arm, and some vertices around the shoulder
and armpit area

• The clavicle bone affects all vertices between
the neck and shoulder, and some vertices in the
shoulder area

To locate problems with the shoulder area, animate
your biped to the most extreme arm motions you
plan to use in your animation. For example, if
you plan to animate the character with its arms
swinging by its sides as it walks, you should move
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the arm to the character’s side and check the
deformation in this pose.

For the Wilson character, you’ll increase the
MeshSmooth iterations to further smooth the
model before working with the shoulder areas.

1. Choose the MeshSmooth modifier on the stack.
In the Subdivision Amount rollout, change
Iterations to 2.

2. Choose the Physique modifier on the stack. In
the Physique Level Of Detail rollout, turn off
Hide Attached Nodes to unhide the biped.

3. Go to frame 20 and turn on Auto Key.

4. Move the biped’s left hand down until the
character’s arm is at his side.

5. Work with the clavicle, chest, and arm
envelopes until the deformation is smooth.

When working on the shoulder, check these
links and correct any obvious problems such as:

• Arm bone affects vertices in the chest,
causing the chest to cave in when the arm
is rotated downward

• Chest bone does not affect the entire chest
area

If you have difficulty adjusting the
shoulder envelopes, save your work to
my_temp_shoulders.max, and load the file
hips_wilson_complete.max to study the leg and
hip envelopes. Then reload my_temp_hips.max
and try again.

Save your work:

The model is now ready to be animated. As you
pose the biped in various positions during the
animation process, it’s not uncommon to find
additional small problems with envelopes. You
now know enough to correct these problems as
they crop up.

1. Select the Wilson Mesh Head object, and apply
the MeshSmooth modifier to the head with an
Iterations value of 1.

2. Save the file as my_wilson_hips.max.

The Wilson model with adjusted shoulder
and hip envelopes can be found in the file
hips_wilson_complete.max.

Rendering

Introduction to Lighting
Lights are objects that simulate real lights such as
household or office lamps, the light instruments
used in stage and film work, and the sun itself.
Adding lights to a scene can help give it a more
realistic appearance. If a scene contains geometry
but no light objects, 3ds Max provides default
lighting. When you add a light object to the
scene, the default lighting is turned off. Setting up
lighting is not difficult, but to do it well, it is a good
idea to plan ahead, and to experiment.
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How you set up lights for a scene, depends on the
purpose of your rendering or animation. Lighting
situations fall into two broad categories:

• Lighting a space; for example, an architectural
model.

Lighting an outdoor daylight scene is a special
case of this, because 3ds Max has special
features for daylight. These are demonstrated
in Rendering a Daylight Scene (page 1–448).

Lighting an interior space

• Lighting a specific subject; for example, a
talking head.

Whether the subject is a character, a still life, or
other detail, the principles of lighting are much
the same.

Lighting a subject

Skill level: Beginner

Time to complete: 30 minutes

Lighting an Interior Space

To light an interior space, the guidelines are
simple: use light objects with realistic values, and
place them where you would in the actual building.
Photometric lights are preferred for this, but to use
photometric lights, it is essential that the model
have realistic dimensions.

Set up the scene:

• In the \tutorial\lights directory, open the file
interior_unfinished.max.

The scene shows an interior living-room space,
with a fireplace and entrance alcove. The walls,
floor, and ceiling of the room have been frozen
to make them difficult to select accidentally.

Tip: If the walls are hard to see, use Customize >
Customize User Interface > Colors to make the
viewport background a lighter gray.

If you were to render the scene now, you would
see a plain, bare room. This is the default
lighting from a single light source.

Room rendered with default lights

Add a light with a preset value to the entryway:

1. Choose Create > Lights > Photometric Lights
> Presets > 75W Bulb.

3dsmax.chm::/colors_panel.html
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This creates a light object with a typical wattage.

2. In the Top viewport, move the cursor over the
alcove, and then click to position the light.

The light is now in the alcove.

Positioning the alcove light

If you look at the Left viewport, however, you
will see that the light is on the floor.

By default, the alcove light is created at the level of the
floor.

3. Right-click the Left viewport to activate
it. Turn on Move, and then move the new light
up to the level of the ceiling.

Alcove light moved to ceiling level

If you were to render the scene now, it would
be very dim.

Adding a light turns off the default lighting.
Once you add a light, all the lighting for the
scene must come from light objects that you
place yourself. (The rendering also shows what
appears to be a bit of a light leak above the door
frame. Don’t worry about this: it won’t be
apparent once you add more lights.)

Add an overhead fixture:

For overhead lighting in the living room, you will
use a prepared light assembly from a separate
MAX file.

1. On the Create panel, turn
on Lights. Choose Photometric from the
drop-down list, turn on one of the light object
buttons, and then turn on the AutoGrid toggle.

It doesn’t matter which button you turn on.
You are not going to create a light from scratch.
However, AutoGrid should be on so the merged
light-fixture assembly will align with the ceiling.

2. Move or resize your 3ds Max window so you
can also see a Windows Explorer window.

3. Right-click a viewport and choose Unfreeze All
from the Display (upper-right) quadrant of the
quad menu.

AutoGrid doesn’t work well when the geometry
is frozen.
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4. Drag the file ceiling.pendant.max from the
\tutorial\lights directory onto the Camera02
viewport in the 3ds Max window.

A pop-up menu appears, giving you the choice
of opening, merging, or cross-referencing the
scene with the ceiling pendant.

5. Choose Merge File.

The ceiling pendant geometry appears. It is
selected and because of AutoGrid, it is aligned
to faces in the scene.

6. Drag the light fixture until it is aligned with
the ceiling, and move it to a position near the
fireplace.

Top plan position of the ceiling pendant fixture

Camera view of the pendant light

Now that you have a single light in the living
room, you can make instances of it to provide
the room with more light.

Freeze the room again:

1. Click to select the room object (Box01).

2. Right-click a viewport and choose Freeze
Selection from the Display (upper-right)
quadrant of the quad menu.

This keeps you from selecting and moving the
entire room, when you are trying to clone the
light fixture.

Make an array of light instances:

1. Activate the Top viewport and turn on
Move.

2. While holding down the SHIFT key, move
the light to the right along the X axis. (Watch
the Camera02 viewport so the light ends up
hanging from the ceiling, and not from the
skylight.)

Top plan position of the first cloned light
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Camera view of the first cloned light

The Clone Options dialog appears.

3. In the Object group, choose Instance, and then
click OK.

4. Repeat steps 2 and 3 two more times, so you
have a row of four light fixtures.

The first row of cloned lights

5. On the toolbar, make sure that the
Window/Crossing toggle is set to Window, then
drag in the Top viewport to select all four lights.

6. While holding down the SHIFT key, drag the
four lights up along the Y axis to add another
row, near the far wall.

The Clone Options dialog appears.

7. Make sure Instance is still chosen, and then
click OK.

Top plan view with two rows of ceiling lights

Render the scene:

• On the main toolbar, click Quick Render.

3ds Max renders the room.

Room lit by all lights (direct lighting only)

Now the living room is illuminated, and you
can see the colors on the walls. It still looks
rather shadowy, but this is only because the
rendering shows direct light only. In real life,
objects are illuminated by both direct light and
reflected (“bounced”) light. In 3ds Max, you
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can add reflected light by calculating the scene’s
radiosity.

Room with radiosity calculated to provide bounced
(indirect) light as well as direct light

The radiosity solution shows that in fact,
you might want to turn down the level of
the living-room lights before making a final
rendering. Radiosity is demonstrated in the
Advanced Lighting and Global Illumination
tutorial (page 1–437). The lesson that follows,
Managing Multiple Lights (page 1–419), shows
some ways to manage an array of instanced
light objects such as those you just created.

Save your work:

• Save the file as room_with_lights.max.

Note: The scene interior_with_lights.max
contains the completed version, and the
scene interior_with_lights_and_radiosity.max
contains both the completed version and a
radiosity solution.

Summary

These are the main points of this lesson:

• If the model is to scale, use photometric lights.

• If you are lighting an indoor scene, position the
lights and fixture assemblies as you would in
the actual building, and use radiosity to model
bounced light.

See Advanced Lighting and Global Illumination
(page 1–437) for a demonstration of radiosity.

Outdoor lighting is a special case. See
Rendering a Daylight Scene (page 1–448).
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Lighting a Close-Up of a Head

To light a subject, such as a talking head or a still
life, it helps to think in terms of how you would
light the same subject if you were working on a
stage set or in a photo studio. In other words, you
can place the lights wherever you want, adjust their
intensity, tint their color, and so on. There are
some widely used guidelines to lighting this way,
and this section introduces them briefly.

Note: As with architectural lighting, you can use
photometric lights, but they do the job only if
the scene has been modeled to a real-world scale.
In this exercise, you will use Standard lights to
simulate a 3-point lighting scenario like they do in
photo studios and television sets.

Set up the scene:

• In the \tutorial\lights directory, open the file
pito_head_shot.max.

The scene has a camera that is set up to render a
head shot of the 3D cartoon character named
Pito.

Look at the default lighting:

• On the main toolbar, click Quick Render.

3ds Max renders the camera view.

Default lighting of Pito

This is not a bad rendering of Pito, but we can
do better.

Add a light:

1. On the Create panel, turn on
Lights, and then click Target Spot to turn it on.

2. In the Top viewport, drag from the bottom left
corner of the viewport to create a light that is
aimed at Pito’s head.

Aiming a target spot light at Pito

3ds Max creates the light. However, it is at
ground level.
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Light is created initially at ground level.

3. In the Front view, use the Move tool to
move the spotlight so that it is slightly higher
than Pito’s head.

4. Select the spotlight target (small yellow square
and move it up to Pito’s eye level.

5. Select the spotlight again (the yellow cone).

Go to the Modify panel, and on the
General Parameters rollout, turn on Shadows.
(The default method of Shadow Map will work
fine.)

6. In the Intensity/Color/Attenuation rollout, set
the Multiplier value to 1.5 to increase the light’s
intensity.

7. Right-click the Camera view to make it
current, and then click Quick Render.
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We can see that Pito is illuminated on one side,
but the shadow areas are too dark. In general,
faces look better and more interesting if they
are lit at an angle, but one has to compensate
with a fill light to get rid of the dark areas. This
is why flash photos usually don’t look as good
as studio portraits.

Add a fill light:

1. On the Create panel, turn on
Lights, and then click Target Spot to turn it on.

In the Top viewport, click and drag to create a
target spot on the right side aiming at Pito. The
two lights can form about a 90-degree angle
with Pito’s face.

2. In the Front view, move the fill light and its
target to about Pito’s eye level.

3. In the Modify panel, set the Fill light’s
multiplier value to about 0.6. A fill light is
usually less intense than a main light as its
purpose is to simulate global illumination
(bouncing light).

4. Make the Camera view current, and then
click Quick Render.

Here is a good, balanced portrait of Pito.
Compared to the default light, it is brighter and
you can see more detail, but there are shadows
enough to make Pito look three dimensional.
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Add a Back Light

A back light’s sole purpose is to separate the
character from the background. It is a light you
place behind the character to emphasize the
silhouette against the background. This can be
especially useful when shooting a dark-haired
character against a dark environment.

1. On the Create panel, turn on
Lights, and then click Target Spot to turn it on.

2. In the Left viewport, drag from above and to
the left of the character to create a light that is
aimed at Pito’s head.

3. With the back light selected, go to the Modify
panel and notice that the back light’s intensity
retained the Multiplier value of 0.6 used on the
last light in the scene. Set the Multiplier value
to 0.4 as a back light is typically the least intense
of all lights in a scene.

4. Make the Camera view current, and then
click Quick Render.

The brighter light, which you created first, is
known as the key light. The dimmer light,
which you added next, is known as the fill
light. For most subjects, you want to have a
single key light only, but you can add additional
fill lights to illuminate the background or
other hard-to-see places to simulate global
illumination. You can also vary the position of
the key light, to make the image clearer or more
dramatic. Finally, you added a back light to
separate your character from the background.

Experiment:

The best way to understand how an individual
light is affecting your scene is to turn off all other
lights that are present. Try this:

1. Select the Main light (the first light you
created) and in the Modify panel, turn the light
temporarily off.
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2. Repeat the procedure with the Fill light (the
second light you created).

3. With the Camera view current, click
Quick Render.

You can now see the individual effect on the
back light in the scene.

4. Experiment by turning off or on the three lights
you created. When you are done, turn all three
lights back on before saving your file.

The effects of the individual lights on Pito: the Main light
(Left), Fill Light (Center) and Back light (Right).

Save your work:

• Save the scene as pito_lit.max.

Note: The 3-point light version of the scene is in
pito_head_shot_final.max.

Summary

If you are lighting a single subject such as a head,
use a single key light and one or more fill lights.

The key light is the brightest; the fill lights have a
lower intensity.

You can get different effects by changing the angle
of the light. Avoid lighting a subject directly from
the front.

Managing Multiple Lights

Interior architectural models typically have a large
number of light objects. This lesson demonstrates
some ways to manage lights, both when they are
instanced, and when they are not.

Managing Instanced Light Objects

In architectural modeling, it’s common to use
instanced lights. Instancing allows you to control
the properties of all lights of a particular type
by editing the properties of just one of them.
However, you sometimes want to control lights
individually. This section shows you how.

Set up the scene:

• In the \tutorial\lights directory, open the file
instanced_light_array.max.

The scene shows a row of six light fixtures and
standard free spotlights, aimed at a wall. The
lights are instanced.

Render the scene:

• On the main toolbar, click Quick Render.

Wall illuminated by instanced light objects
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Turn off one light:

1. Click to select the leftmost light
(Fspot01), and then go to the Modify panel.
On the General Parameters rollout, in the Light
Type group, click the On toggle to turn it off.

2. Click Quick Render.

Turning off an instance

Because the lights are instanced, turning off a
single light turns off all of them at once.

Hide some lights:

1. On the Modify panel, turn FSpot01 back on.

2. On the main toolbar, click
Window/Crossing to choose window
selection, and then in the Camera01 viewport,
drag a selection window to select the leftmost
three lights and their fixtures.

Tip: If the toggle is set to Crossing, then you
might select the box object as well. Avoid this.

Lights and fixtures selected

3. Right-click, and choose Hide Selection from
the Display (upper-right) quadrant of the quad
menu.

The lights are now hidden.

4. Click Quick Render.

Rendering hidden lights

Although the lights are hidden, they still
illuminate the wall. Hiding a light has no effect
on its light-casting properties.

Turn off some lights by making them nonrenderable:

1. Right-click the Camera01 viewport, and choose
Unhide All from the Display quadrant.

2. Use click and CTRL+click to select the leftmost
three lights, but not their fixtures.

Light objects selected, but not their fixtures

3. Right-click again, and choose Properties from
the Transform (lower-right) quadrant of the
quad menu.

The Object Properties dialog is displayed.
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4. On the General panel, in the Rendering Control
group, turn off the Renderable toggle.

5. Click Quick Render.

Lights turned off using the Renderable property

Now you have the desired result. The
Renderable toggle can control whether an
instanced light casts light in the scene.

Save your work:

• Save the scene as render_toggle_light_
array.max.

Using the Light Lister

The Light Lister tool is a sort of master dialog
for lights in the scene. For individual lights, it
is a shortcut to controls on the Modify panel.
(Its General settings also include settings on the
Environment panel.)

Set up the scene:

• In the \tutorial\lights directory, open the file
light_array.max.

The scene is the same as in the previous section,
but in this case, the lights are independent
objects, not instances.

Use the Light Lister to dim some lights:

1. Choose Tools > Light Lister.

The Light Lister dialog is displayed. There
is an entry for each unique light in the scene
(instances don’t appear on this dialog).

You might have to expand the dialog vertically
to see all the rows. As the dialog shows, the
scene contains six free spotlight objects, one
omni light, and one skylight.

Note: The Light Lister cannot control more than
150 unique light objects at a time. If there are
more than 150 unique lights in your scene,
the Lister displays controls for the first 150 it
finds, and a warning that you should select
fewer lights. Select fewer lights and then use the
Selected Lights configuration.

2. Change the Multiplier value to equal 0.3 for
all the free spotlights except the fifth one
(Fspot05). Leave the Multiplier for Fspot05 set
to 1.0.

Tip: You can use the standard Windows
CTRL+C and CTRL+V to copy and paste
values from one spinner field to another.

3. Click Quick Render.

Only the fifth light casts a full-strength beam.

Use the Light Lister to change light colors:

1. On the Light Lister, change the Multiplier value
for all the free spots back to 1.0.
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2. Click the color swatch for the second light,
Fspot02.

The Color Selector is displayed.

3. Change the color of the second spotlight to a
light gold: R=255, G=191, B=52. Then click
OK.

4. On the Light Lister, drag the Fspot02 color
swatch to the Fspot04 color swatch.

A Copy Or Swap Colors dialog is displayed.

5. Click Copy.

6. Drag the Fspot04 color swatch to the Fspot06
color swatch. Once again, click Copy when
prompted to copy or swap colors.

7. Click Quick Render.

Now alternating lights have alternating color.

Save your work:

• Save the scene as light_array_with_color.max.

Summary

• To control whether a light instance casts a
beam, you can use the light object’s Renderable
property, which is set from the Object
Properties dialog.

• The Light Lister is a convenient overall
“console” for adjusting lights in your scene.

Both photometric and standard lights use
shadow-mapped shadows by default. 3ds Max
offers some alternate ways to generate shadows, as
this lesson demonstrates.

Set up the scene:

• In the \tutorial\lights directory, open the file
shadows.max.

The scene is a classical sculpture against a
plain white background. It is lit by three
omni lights, but only one of them, Omni01, is
shadow-casting.

Render the scene:

• On the toolbar, click Quick Render.

The statue’s shadow is shadow mapped. It has a
fairly sharp-edged outline.

Create a soft-edged shadow:

1. On the main toolbar, click Select By
Name. Use the Select Objects dialog to select
Omni01, and then go to the Modify panel.

2. Open the Shadow Map Parameters rollout.
Change the value of Sample Range to 10.0.

3. Click Quick Render.

3dsmax.chm::/object_properties_dialog.html
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The edge of the shadow is softer.
Shadow-mapped shadows can have soft
edges, but ray-traced shadows cannot.

Use a ray-traced shadow:

1. On the General Parameters rollout, in the
Shadows group, choose Ray Traced Shadows
from the drop-down list.

2. Click Quick Render.

This time the shadows are very hard edged.

Note: 3ds Max offers two kinds of ray-traced
shadows: Advanced and “regular.” The
advanced option has more ways to adjust
shadow quality; otherwise, their behavior is
similar.

Make the shadow lighter:

1. On the Shadow Parameters rollout, in the
Shadow Parameters group, change the value of
Density to 0.4 (equivalent to 40 percent).

2. Click Quick Render.

The shadow is now lighter. Options on the
Shadow Parameters rollout are independent of
which kind of shadow you are generating.

Use an area shadow:

1. On the Shadow Parameters rollout, change the
value of Density back to 0.85.

2. On the General Parameters rollout, in the
Shadows group, change the shadow type from
Ray Traced Shadows to Area Shadows.

3. Open the Area Shadows rollout, which is now
displayed. In the Basic Options group, make
sure that Rectangle Light is chosen. In the Area
Light Dimensions group, change the Length
and Width to both equal 5.0.

4. Click Quick Render.
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This time the results are even more diffuse than
a soft-edged shadow-mapped shadow. Area
shadows simulate shadows cast by an area of
light, such as a window or skylight, rather than
from a point source like a spotlight.

Tip: Photometric lights also provide true area
lights and linear lights.

Save your work:

• Save the scene as my_area_shadow.max.

Summary

Photometric and standard lights both have
the same options for generating shadows. The
main choices are shadow-mapped (the default),
ray-traced, or area. Shadow-mapped shadows
can have a soft edge; ray-traced shadows are
always sharp edged; and area shadows are diffuse,
simulating shadows cast by a light-emitting area.

Each kind of shadow generator has its own
settings. The settings not demonstrated in this
lesson are mainly for adjusting shadow quality.
They are described in the User Reference.

Introduction to Rendering
To view the final results of your work in 3ds Max as
a two-dimensional image or movie, you render the
scene. By default, when you render, the software
produces a still image at a specific resolution using
the default scanline renderer, and displays it in a
separate window on the screen. But a wide variety
of rendering alternatives is available, and this
tutorial will introduce you to some of them.

Skill level: Basic

Time to complete: 2 hours.

Features Covered in This Tutorial

In this tutorial, you will learn how to:

• Render a still image to the screen and to a disk
file in different formats and resolutions

• Use different renderers and presets.

• Render a high-resolution image using multiple
computers.

• Render an animation and combine still images
into a movie file.

• Use a network farm to simultaneously render
different images from an animation.

• Use rendering to create textures for use in
games.

Tutorial Files

All the necessary files to do the tutorials can
be found on the Tutorial Files CD, in the
\tutorials\intro_to_rendering folder, unless
otherwise specified. Before doing the tutorials,
copy the \tutorials directory from the CD to your
\3dsmax8\ local installation.
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Rendering Still Images

In some ways, 3ds Max is like a photography studio.
You arrange and manipulate three-dimensional
objects, lights, and a camera, with the ultimate
goal of producing an image that illustrates your
message. The act of creating that image is called
rendering. In this lesson, you’ll learn some of the
different ways you can use 3ds Max to render.

Set up the lesson:

• On the File menu, choose Open and navigate
to the \tutorials\intro_to_rendering folder.
Highlight rendering_still_images_start.max
and click Open.

The scene contains a textured model of an
apple, plus a shadow-casting spotlight, a fill
light, and a ground plane.

Render the scene:

1. Make sure the Perspective (lower-right)
viewport is active; that is, it has a yellow
border. If not, right-click anywhere inside the
Perspective viewport.

2. Press F9 or click Quick Render on the
toolbar to render the viewport.

In a few moments, a default rendering of the
apple scene appears on the screen.

This rendering has several characteristics, all of
which you can change:

• It appears in the rendered frame window.
The text in this window’s title bar tells you
that you’re currently viewing frame 0 as
rendered from the Perspective viewport,
and the window is displaying the image at a
zoom ratio of 1:1, or normal magnification.

• Its resolution is 320 pixels in the horizontal
dimension and 240 pixels in the vertical
dimension, or 320 x 240 for short.

• It uses the default scanline renderer. This
is the renderer that most 3ds Max artists
employ, but others are available. One of
these is mental ray, a powerful renderer that
is included with the software. You’ll take a
quick look at mental ray shortly.

3. Close the rendered frame window by clicking
the X button in its upper-right corner.

The most efficient way to work with 3ds Max is
to use keyboard shortcuts whenever possible.
The default shortcut for the Quick Render
command is easy to remember.

4. On the keyboard, press SHIFT+Q.

The scene is rendered again, exactly the same
as before.
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Use the rendered frame window tools:

The rendered frame window has a number of tools
you can use to work with the image and view it
in different ways. Most of these are available as
buttons in the toolbar, which is highlighted in the
illustration above. In this procedure, you’ll try out
a few of the other, mouse-related functions. You’ll
find detailed descriptions of all of the controls in
the Rendered Frame Window topic.

1. Click in the window to activate it, and then
rotate the mouse wheel forward and back.

If you’re not using a wheel mouse, you can
zoom the window by pressing and holding the
CTRL key and then clicking the left mouse
button to zoom in, or the right mouse button
to zoom out.

The rendered frame window zoomed in

This zooms the image in and out about the
mouse cursor position. The current zoom
ratio appears at the right end of the text in the
window title bar. You can zoom between 1/8
and 64 times actual size.

You can change the window size using standard
Windows methods, such as by dragging the
lower-right corner.

2. When zoomed in, you can pan the image by
pressing and holding the middle mouse button

(or wheel button), and then dragging in the
window.

If you’re not using a three-button mouse,
pan the image by pressing and holding the
SHIFT key and the left mouse button, and then
dragging in the window.

3. Return to the 1:1 zoom ratio, and then, without
holding down any keys, right-click and hold in
the image portion of the window.

A temporary window appears, showing general
image data such as the resolution, as well as
specific information about the pixel currently
under the mouse cursor.

4. Still holding down the right mouse button, drag
the mouse so that the cursor is over a lighter
part of the image, such as the specular highlight
on the apple.

The color swatch at the right end of the toolbar
changes visibly to a light red color. This color
remains when you release the mouse button.

5. Close the rendered frame window.

Render with a different keyboard shortcut:

Did you notice that the apple is off-center? There
are different ways to fix this; you’ll do so by moving
the apple. You’ll also learn about using the Render
Last command.

1. On the toolbar, click the Select And
Move button, and then move the mouse cursor
into the Top viewport.

3dsmax.chm::/rendered_frame_window.html
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2. Position the mouse cursor over the apple (the
round, wireframe object), press and hold the
left mouse button, and then drag slowly to
the right. As you drag, watch the apple in the
Perspective viewport. When the apple is near
the center of the viewport, release the mouse
button.

Because you were working in the Top viewport,
it is now the active viewport.

3. Render the image by pressing SHIFT+Q.

The program renders the view from
the Top viewport. The Quick Render
command always renders the active viewport.
However, you probably wanted to see the
Perspective-viewport image. This is a common
error in 3ds Max. Fortunately, the program
offers a way around it, called Render Last.

4. Activate the Perspective viewport and render
again.

The new image replaces the previous one in the
rendered frame window.

5. Close the rendered frame window.

6. Activate any other viewport, and then press
the key.

This executes the Render Last command, which
renders the same viewport that you rendered
most recently in the current session, no matter
which viewport is active. It’s not available from
the toolbar, but if you remember the keyboard
shortcut, you can save time when working in
different viewports.

7. Press CTRL+Z to undo the apple move. You
might need to press it more than once.

Explore rendering options and presets:

In this procedure, you’ll try a couple of options for
rendering objects that don’t normally appear. The
scene you loaded contains a hidden object and an
object that faces away from the camera. Neither
has shown up in the renderings so far.

1. Press F10 to open the Render Scene dialog.

The dialog opens to the Common tab. Available
here are controls for changing output size,
rendering to disk, and more. You’ll look at some
of these shortly. Right now, we’re interested in
the rendering options.

2. In the Options group, turn on Render Hidden
Geometry.
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3. Render the Perspective viewport. If the
Perspective viewport is active, you can do this
by clicking the Render button at the bottom of
the dialog. If a different viewport is active, first
choose Perspective from the drop-down list to
the left of the Render button.

A second, green apple appears in the rendered
image. If your scene contains objects that you
want to appear in the rendered image but not
in the viewport, you can hide them, and then
use this option when rendering.

4. In the Options group, turn on Force 2-Sided.

5. Render the Perspective viewport again.

The ground plane appears in the rendering,
with the apples casting shadows on it. This
object isn’t hidden, but because it’s facing away
from the “camera,” it doesn’t normally show
up when you render. This option is a handy
way to make sure all objects in the scene show
up in the rendered image, no matter which way
they’re facing.

A handy feature in 3ds Max lets you save a
custom rendering setup as a preset for use with
other scenes. You’ll try it now.

6. At the bottom of the Render Scene dialog, click
the Preset drop-down list, and then choose
Save Preset.

The Render Presets Save dialog appears.

7. Enter Hidden+2-Sided, and then click Save.

The Select Preset Categories dialog appears,
with a list of the different tabs on the Render
Scene dialog. You can store any combination
of tab settings in a preset. By default, all
are highlighted, but for this exercise, you’re
interested in saving only the settings on the
Common tab.
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8. Click Common, the first item in the list, and
then click Save.

The preset is saved, and then appears in the
Preset list.

9. In the Options group, turn off both Render
Hidden Geometry and Force 2-Sided.

10.Click the Preset list, and then choose the
Hidden+2-Sided item.

The Select Preset Categories dialog appears,
showing only the Common item. If you save
a preset with multiple tabs, you can choose
specific ones for selective loading.

11.Click the Load button.

The software loads the preset, and according
to its settings, turns on both Render Hidden
Geometry and Force 2-Sided again.

Change the output size:

Until now, you’ve been rendering to the screen at a
relatively small size: 320 x 240. 3ds Max lets you
render at any size up to 32,768 x 32,768, however,
and in a number of different file formats.

1. Still on the Render Scene dialog, in the Output
Size group, click the 640x480 button.

The new output resolution appears in the
Width and Height fields.

2. Render the Perspective viewport.

The software renders the image at the new,
larger size. It takes a bit longer, but is much
easier to see.

The Image Aspect value, below the Width and
Height fields, is currently 1.333. This is the ratio
of width to height. You can alter it by changing
one of the dimensions.

3. Increase the Height value to 640.

The Image Aspect is now 1.0, which means that
the width and height are the same, resulting in
a square image.

4. Render the Perspective viewport.

The software divides the added height evenly
between the top and bottom of the image, so
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there are now 80 additional pixels both above
and below the original image.

Tip: When rendering to nonstandard aspect
ratios, the Safe Frame option helps you preview
exactly how the final render will appear.
Right-click the viewport label (“Perspective”),
and then choose Show Safe Frame from the
menu. The outer frame shows you the area that
will render; the others are used when creating
video content.

You can also change the dimensions by
adjusting the Image Aspect value; this always
affects only the Height value. If you try it now,
be sure to set Image Aspect back to 1.0 when
you’re done.

You can lock the aspect ratio so that changing
one dimension automatically adjusts the other.

5. Click the lock button to the right of the Image
Aspect field.

Image Aspect becomes a read-only field.

6. Set the Height value to 480.

Both Height and Width change to 480.

7. Render the Perspective viewport.

The output image is still square, but smaller.

Change the output location:

Until now, you’ve been rendering only to the
screen. In this procedure, you’ll learn about
rendering to a disk file, and find out how to turn
off screen output.

1. In the Render Output group, near the bottom
of the Common Parameters rollout, click the
Files button.

The Render Output File dialog appears.

2. If necessary, change the output location to
\3dsmax8\images\.

3. Click the drop-down-list next to Save As Type,
and choose BMP Image File (*.bmp).

This is the Windows Bitmap file format,
commonly used for image files in Windows.

4. Click in the File Name field, and type apples.
Press the ENTER key.

5. The BMP Configuration dialog appears. Accept
the default choice of RGB 24 bit by clicking OK.

The dialog closes. Nothing has rendered yet,
but in the Render Output group, Save File is
now available and enabled, and the read-only
below it shows the output path and file name.
These features become available only after you
specify file output properties with the Files
button.

6. Render the Perspective viewport using any of
the methods you’ve learned so far.
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The software renders the image to both the
rendered frame window and the specified file.
You can see the latter with the View Image File
command.

7. From the File menu, choose View Image File.
Use the View File dialog to open the apples.bmp
file.

A new window opens showing the rendered
image. It’s exactly the same as the rendered
frame window, except that its title bar shows
the name of the file rather than the rendered
viewport.

8. Close both windows.

The software automatically appended the .bmp
filename extension when you specified the file
type. You can also specify the file type explicitly
by including the extension in the file name.

9. Click the Files button again, and change Save
As Type back to All Formats (at the top of the
list). Then change the file name to apples.tga.
Press ENTER.

10.The software recognizes that you want to render
the image in Targa format, and displays the
Targa Image Control dialog. The Targa image
format supports the alpha channel, which
allows transparency effects when compositing
the rendered image.

11.Click the OK button to accept the Targa image
defaults.

12.Near the bottom of the Render Output group,
turn off Rendered Frame Window.

13.Render the Perspective viewport.

The software renders the image to the specified
file, but not the rendered frame window. You
can see the Targa image file with the View
Image File command.

If you click the Display Alpha Channel
button on the window toolbar, you can see
a tiny bit of transparency (black) in the

upper-right corner. This is where the ground
plane ends, showing the background, which is
usually transparent.

14.Close the image window.

Use a different renderer:

Included with 3ds Max is a powerful, sophisticated
renderer called mental ray. Full exploitation of its
capabilities is beyond the scope of this tutorial,
but basic usage is straightforward. You can find
more-detailed tutorials on using mental ray in
Using the mental ray Renderer (page 2–805).

1. In the Render Output group, turn off Save File
and turn on Rendered Frame Window.

2. Scroll down to the Assign Renderer rollout and
click the rollout title bar to expand it.

3. Click the top Choose Renderer button, to the
right of Production.

The Choose Renderer dialog appears.

4. In the list, click the mental ray Renderer entry
to highlight it, and then click OK.

”mental ray” appears as the production
renderer.

5. Render the Perspective viewport.
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The software renders the image to the rendered
frame window. During the rendering process,
you can see the small rectangles, or “buckets,”
into which mental ray subdivides the image,
appear one by one.

In the final image, the red and green apples and
the ground plane all appear, because mental
ray supports the same options as the default
scanline renderer.

Other renderers are available as plug-ins;
after installation, they appear on the Choose
Renderer dialog.

6. Restore Default Scanline Renderer as the
production renderer.

Rendering an Animation

There are some specific techniques to learn for
rendering your animation into a movie file. You
can render directly to a movie format such as
AVI, or you can render a sequence of still image
files to file formats such as TGA and then use the
RAM Player to save them as a movie. The latter
method is recommended. It requires a few more
steps than rendering directly to a movie format,
however it gives you more control over the file size
and quality of the output. In addition, if you have
frames that have artifacts or other errors, you can
repair or remove them.

The next lesson will take some time to render.
Depending on the speed of your computer,
rendering may take a few minutes to several hours.

Set up the lesson:

• From the \tutorials\walkthrough folder, open
great_wall_render.max.

Tip: If the Units Mismatch dialog displays,
choose Adopt The File’s Unit Scale and then
click OK.

This file is similar to the Animation
Walkthrough tutorial. A bobbing motion
has been added to the camera to simulate the
up-and-down effect of someone jogging along
the path. Two omni lights have been added
to create additional lighting but there are no
settings for Global Illumination in order to
decrease rendering time.

Rendering an image sequence:

1. If the Camera viewport isn’t active, right-click
in it to activate it.

2. From the Rendering menu, choose Render.

Next, you’ll define the animation range and
output size.

3. On the Common tab of the Render Scene
dialog, in the Time Output group, choose
Active Time Segment.

This option automatically renders all currently
playable frames. In this case, it should display 0
to 3000. Alternately, you could choose Range
or Frames and set the frame range to render.

4. In the Output Size group, change the output
resolution to 320x240.

5. In the Render Output group, click the Files
button.

The Render Output File dialog opens.

6. Navigate to a directory where there is enough
disk space to save the rendered files. You can
use the Create New Folder button to establish a
new location, if necessary.

Next you’ll define the type of still image file to
render.

7. In the Save As Type field, click the drop-down
arrow and choose JPEG File (*.jpg).

Note: In a production environment, you may
want to use a high-quality, lossless format such
as TGA or TIF. However, for the purposes of
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this tutorial, you will use the JPG format to
keep the size of the output files small.

8. In the File name field, type my_jog.jpg, then
click Save.

After you click Save, a format-specific dialog
asks you to specify attribute and information
settings. Accept the default values, and then
click OK.

When you render a still-image sequence,
as in this case, the software automatically
appends the first part of the file name with a
four-digit frame number. So, the first frame
will be my_jog0000.jpg, the second is named
my_jog0001.jpg, and so on.

9. Make sure Save File is turned on in the Render
Output group. Also check that the Viewport
field at the bottom of the Render Scene dialog
is set to TargetCam (not Top, Front, or Left),
then click Render.

Note: A sky background is rendered. The dome
representing the sky is an object that is hidden
in the scene. However, the renderer is set to
take hidden geometry into account.

10.The Rendering Progress dialog displays. Wait
for a short while as the first frame is rendered.
You will see the Last Frame Time, Elapsed
Time, and Time Remaining values change after
the first frame finishes.

Allow at least four frames to render.

At this point, you can work on something else
while your animation is rendered.

Tip: You can also watch the rendering for errors
or observe to see where you want to make
changes. This is generally a good practice so
that you can study the scene as it is rendered.

After the rendering has completed, you will
have 3000 JPG files in the folder you specified.

Convert an image sequence into a movie:

The RAM Player loads still image sequences into
memory and plays them so you can watch them
as a movie. It actually lets you load two different
sequences and then compare them visually, but
you won’t use that functionality here. You’ll simply
use the RAM Player to save the files into an AVI
file.

1. From the Rendering menu, choose RAM Player.

2. On the RAM Player toolbar,
click Open Channel A.

3. In the Open File Channel A dialog, navigate to
the sequence of JPG image files. Highlight the
name of the first file in the sequence and then
ensure the Sequence option is turned on. Click
Open.

The RAM Player will now load the image files in
sequential order starting with the first file you
selected. The Image File List dialog appears.
Here you can use the Every Nth and Multiplier
fields if you need to speed up or slow down
your animation. If your animation is too slow,
change Every Nth to 2 or 3. If your animation is
too fast, increase the Multiplier.

4. Click OK.

The RAM Player Configuration dialog appears.
Here you can observe and adjust your memory
usage. There are also tools here to resize your
animation, specify a range of frames to use, and
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split the alpha (transparency) information into
a separate file.

Note: In order to use transparency, the image
file specified has to be able to process an
alpha channel. JPG files do not contain any
transparency information the way TGA, TIF
and PNG images often do.

5. Increase the Memory Usage to its maximum for
your system, and then press OK.

The RAM Player loads the rendered files into
memory. In the Loading dialog, observe how
much memory is being used and remains
available.

If it looks like you are about to run out memory,
click Stop Loading. If you have a low-memory
system, reduce the number of frames to load
and try again.

6. On the RAM Player toolbar, click the Play
button and watch the movie play.

7. On the RAM Player toolbar, click the
Save Channel A button.

The Save File dialog appears.

8. Choose AVI as the file type, and name the
animation my_jog.avi. Click Save.

The AVI File Compression Setup dialog
appears. Here you can choose a codec
(compression/decompression type) and adjust
the quality of the file. Choose the default
Cinepak Codec. To reduce file size, lower the
quality to 75%.

9. Click OK to continue.

Summary

You have learned how to render your animation
to a sequence of still image files. This allows
you better control for later correction of your
animation. You also learned how to assemble a
still image sequence into a movie file, such as AVI
or QuickTime using the RAM Player.

Creating an Animated Shadow
Study

In addition to animating a camera, you can
animate the Daylight system’s time of day. This is a
good way to create a shadow study.

Set up the scene:

• From the \tutorials\high_rise\ folder, open
cityscape.max. If you encounter a File Unit
Mismatch message, choose Adopt Unit Scale,
the second choice.

This is a scene of nine city blocks, with a
skyscraper at the center. The scene contains a
Daylight system. The Daylight system is set
to position the scene at the latitude of San
Francisco, California, and the sun is set at 0700
hours, about the time of dawn on a winter day.
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Tip: Rendering a Daylight Scene (page 1–448)
takes you through the steps of creating a
Daylight system.

Animate the daylight:

1. Make sure Select Object is active on the
toolbar.

2. In the Left viewport, click the sun object in the
viewport to select it.

Daylight01 appears in the name field on the
command panel.

3. Open the Motion panel.

4. On the Motion panel, scroll if necessary to the
Control Parameters rollout.

5. Turn on the Auto Key button.

The button, the track bar, and the
border of the active viewport all turn red.

6. Drag the time slider to frame 5, and then on the
Control Parameters rollout, change the Hours
value to 8.

The spinner arrows of the Hours, Minutes,
and Seconds fields are now bracketed in red,
indicating that you have set a key to animate
the time of day.

7. Drag the time slider to frame 10, and then
change Hours to 9.

8. Continue dragging the time slider in five-frame
increments, then increasing the time of day by
one hour at each increment. Stop when the time
is 17 hours (5 P.M.). This should be at frame 50.

You have set 10 keyframes (and 3ds Max has
automatically set one at frame 0, as well) to
track the course of the sun through a day. Drag
the time slider and watch the Left viewport.
The sun moves smoothly: 3ds Max interpolates
from one keyframe to the next so each frame is
different, even if it doesn’t have a key on it.

Set the animation range:

As the animation only lasts 51 frames (0 to 50),
you don’t need the full default range of 101 frames.

1. Click Time Configuration.

The Time Configuration dialog is displayed.

(This button is at the extreme lower right of the
3ds Max window.)

2. In the Animation group, change the value of
End Time to 50, and then click OK.

Now the range of frames is no greater than the
length of the animation.

Save your work:

• Choose File > Save Copy As. In the file dialog,
name the file my_shadows.max, and then click
Save.

Important: Save Copy As does not open the copy.

The active file is still cityscape.max.

Tip: Always save your scene file before you
render.

Render the animation:

Rendering the animation takes about half an hour
on a high-speed system. If you want, you can skip
these steps and just view the file shadow_study.avi,
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provided with the other tutorial files. See “View
the animation,” below.

1. Choose Rendering > Render.

The Render Scene dialog is displayed, with the
Render panel active.

2. On the Common Parameters rollout, in the
Time Output group, choose Active Time
Segment: 0 To 50.

In the Output Size group, make sure that the
resolution is 640x480.

A smaller size would render more quickly, but
the shadows don’t show up as well.

3. On the Render Output rollout, click the Files
button.

A Render Output File dialog is displayed.

4. Enter a name for the animation, and choose
one of the animation formats from the Save As
Type drop-down list, and then click Save.

You can render an animation to either the AVI
or MOV (QuickTime®) formats. After you click
Save, you see a format-specific dialog that asks
you to specify the animation’s compression.
You can accept the default values, and then
click OK.

Note: In practice, it’s a good idea to avoid
rendering directly to movie formats such as
AVI or MOV. Instead render to sequentially
numbered still image frames, and then convert
them to a movie format as a second step.
This has practical value if you need to correct
mistakes in individual frames, without having
to re-render the entire animation.

5. Open the Assign Renderer rollout and confirm
that the Default Scanline Renderer is the
production renderer. If you see mental ray
renderer click Choose Renderer and change the
renderer back to the Default Scanline Renderer.

Note: The mental ray renderer does not support
the IES Sun lighting.

6. Leave the other Render Scene settings as they
are, make sure Camera02 is the active viewport,
and then click Render.

3ds Max renders the animation. This takes a
while (about a half hour on the high-speed
system), so this is a good point to take a break.

View the animation:

1. When rendering is done, choose File > View
Image File.

A View File dialog appears.

2. Choose the file you just rendered, and then
click Open.

Tip: You can also choose shadow_study.avi,
which is provided with the other tutorial files.

Depending on the movie type, a Media Player
or a QuickTime viewer is displayed, which lets
you play the animation.
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Summary

You can create a shadow study by animating the
time of day of a Daylight system. To do so, use the
Auto Key button, and change the hour at regular

intervals of frames. (The longer the interval, the
slower the animation will play.)

Advanced Lighting and
Global Illumination
The lessons in this section demonstrate some the
advanced lighting features of3ds Max. Advanced
lighting is a blanket term for global illumination
options. “Global” illumination is light that has
been reflected off other objects. When you
render using global illumination, the amount of
ambient light in the scene increases, and colors
of one object can “bleed” onto other objects.
The two global illumination options available to
the scanline renderer are radiosity and the Light
Tracer. Radiosity is the more accurate of the two
options, and it works in concert with exposure
control.

Radiosity combined with override material creates glowing
colored light in a gallery scene.

Note: The mental ray renderer has its own method
of global illumination. For lessons on this renderer,
see Using the mental ray Renderer (page 2–805).

Skill Level: Intermediate

Time to complete: 45 minutes
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Features and Techniques Covered in This
Section

• Using photometric lights with radiosity to
render an indoor scene.

• Using the Advanced Lighting Override material
to increase the realism of self-illuminating
materials.

• Using a Skylight and light tracing to render an
outdoor scene.

• Using a Daylight system and radiosity to render
an outdoor scene with control over time and
global location, and physically accurate light
levels.

• Using exposure control to handle the extreme
brightness of outdoor daylight.

Creating a Radiosity Solution

In this lesson, you create a rendering, then create
a radiosity solution and render it to view the
difference in lighting levels. Finally, you polish the
rendering a bit.

Set up the scene:

1. From the \tutorials\adv_lighting\ directory,
open library_rendering_intro.max.

3ds Max displays a single viewport, with an
interior view of a design for a library building.

Note: All the necessary files to do the tutorials
can be found on the Tutorial Files CD that ships
with 3ds Max. Before doing the tutorials, copy
the \tutorials directory from the CD to your
\3dsmax8 local installation.

2. A warning might appear, pointing out that
the scene’s units are different from the default
3ds Max units. Choose Adopt The File’s Unit
Scale, and then click OK.

3. The wireframe view is somewhat hard to read.
Right-click the viewport label (in the upper-left

corner). Choose Smooth + Highlights from the
pop-up menu.

Now the room is easier to read.

Render the model:

1. On the main toolbar, click Render Scene.

A Render Scene dialog is displayed, with the
Common panel visible.

2. On the Common Parameters rollout, in the
Output Size group, make sure the output size
is 320x240.

Rendering can be a slow process, so use the
small size at first. If you are happy with the
image, you can render it at a higher resolution
later.

3. Click Render.
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The completed rendering is very dark. This is
because it shows direct light, but not bounced
light. Direct light is light cast by the lights in
the scene, with no bouncing off of surfaces.
In reality, light continues moving after it hits
a surface (at least, most kinds of surfaces),
and much ambient light is created by bounced
light. Recessed lighting, as in the library model,
depends on the effect of bounced, indirect light.
In the procedures that follow, you will make
3ds Max generate the indirect light in the scene.

Clone the rendered frame:

First, make a “clone” of the rendered frame so you
can compare the rendering you just made, with
the next one.

• On the toolbar of the rendered frame
window, click Clone Rendered Frame Window.

3ds Max displays a cloned copy of the frame
window. Cloning the window is often useful
when you are doing a series of test renderings.

Generate a radiosity solution:

To model the effect of bounced light in the scene,
you generate a radiosity solution. Radiosity
models the effect of diffuse light bouncing among
surfaces.

1. On the Render Scene dialog, click the Advanced
Lighting tab.

The Advanced Lighting panel is displayed.

2. On the Select Advanced Lighting rollout,
choose Radiosity from the drop-down list.

Various rollouts for radiosity are now displayed
on this panel.

3. Open the Radiosity Meshing Parameters
rollout, and turn on Enabled under Global
Subdivision Settings.

4. Turn the Use Adaptive Subdivision option
off. This simply ensures that all objects are
treated in the same way when the solution is

generated. When on, this option allows for finer
subdivision only in areas where it is needed.

5. In the Radiosity Processing Parameters rollout,
under the Interactive Tools group, set both
the Direct and Indirect Light Filtering options
to 2. This will smooth off any noise patterns
generated by the radiosity solution.

6. Open the Rendering Parameters rollout, and
choose Re-Use Direct Illumination From
Radiosity Solution.

This option will speed up rendering.

7. On the Radiosity Processing Parameters
rollout, set Initial Quality to 60 per cent.

This helps limit the time to generate the
solution.

8. Also on the Radiosity Processing Parameters
rollout, click Start.

As the progress bar shows, 3ds Max processes
radiosity in several passes, each with a higher
percentage of the total. Generating the
radiosity solution usually takes several minutes.
You might want to take a coffee break while
3ds Max calculates. When the calculation of
the radiosity solution is done, the Stop button
will be disabled, but Reset All, Reset, and Start
will be enabled.
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Stop button is available while the generation of a
radiosity solution is in progress.

After the radiosity solution has been generated, the
Reset All and Reset buttons become available.

9. Click Render.

You can click the button at the bottom of the
dialog without going back to the Common
panel.

The new rendering appears quickly, and the
room is now filled with indirect light.

If you change the viewport display mode back to
wireframe, you see a busier scene than you saw
before.

The radiosity solution adds geometry to your
scene. The additional mesh you see in the
wireframe view is known as the radiosity mesh.
Light levels are stored in this mesh. Generating
a radiosity solution adds complexity to your
scene and increases the size of your MAX file.
Offsetting these costs, the radiosity gives you some
advantages:

• If you turn on Re-Use Direct Illumination From
Radiosity Solution, as you did in this exercise,
the renderer gets its lighting information from
the radiosity mesh, so rendering proceeds very
quickly.

• The radiosity mesh is three-dimensional. You
can move the camera, or change the view, and
rendering with Use Radiosity turned on will
show the radiosity from a different point of
view.

In fact, if the only animation in your scene is a
moving camera, then you only need to calculate
radiosity once, at the first frame. (You do need
to recalculate radiosity for other frames if the
animation includes moving objects that cast
shadows.)

Note: Unlike radiosity, reflections and refractions
depend on your point of view. (If you look at a
mirror from different angles, you see different
reflections in it.) When you render a scene with
reflective or refractive materials, 3ds Max generates
the reflections and refractions using ray-tracing,
which complements the radiosity solution.

Use antialiasing to improve the rendering’s
appearance:

You might have noticed some jaggedness in the
rendered scene, particularly along the window
frame halfway up the exterior wall. This is easy
to fix.

1. On the Render Scene dialog, click the Renderer
tab to go to the Renderer panel.

2. On the Renderer panel’s Default Scanline
Renderer rollout, click to turn on Antialiasing
in the Antialiasing group.

3. Click Render again.

The scene renders a bit more slowly, but it
appears smoother.
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In general, when you render there is always a
trade-off between speed and quality. The lesson
Speeding Up Rendering (page 1–441) explains
some other ways to manage rendering speed.

Save your work:

• Choose File > Save As. In the file dialog, name
the file my_library.max, and then click Save.

Summary

To sum up what this lesson has covered:

• To model the indirect lighting in a scene,
generate a radiosity solution.

The radiosity controls are on the Advanced
Lighting panel of the Render Scene dialog.

The radiosity solution stores lighting levels in a
3D radiosity mesh, which you can render from
different points of view.

• The Antialiasing toggle on the Renderer
panel > Default Scanline Renderer rollout >
Antialiasing group gives a smoother rendering
at a cost of some rendering time.

In general, rendering involves a trade-off
between speed and quality.

Speeding Up Rendering

There are a number of ways to get a quicker
rendering for draft purposes. This lesson shows
you a few. In general, these are the methods you
can use:

• Use a small image size, such as 320 x 240, for
draft renderings.

• Turn off antialiasing and mapping.

(Turning off shadows also helps if you are not
reusing direct illumination from the radiosity
solution.)

• Turn off layers with inessential objects.

• Use one of the “Draft” rendering presets.

Set up the scene by doing one of the following:

• Open my_library.max, which you created in the
previous lesson.

• From the \tutorials\adv_lighting\ directory,
open library_with_radiosity.max.

If you see the File Load: Units Mismatch dialog,
choose the option Adopt The File’s Unit Scale.
This will change your system unit, so be sure
to reset your system unit after completing this
tutorial.

To reset your system unit, go to the Customize
menu and choose Units Setup > System Unit
Setup > System Unit Scale > Inches.

Note: All the necessary files to do the tutorials
can be found on the Tutorial Files CD that ships
with 3ds Max. Before doing the tutorials, copy
the \tutorials directory from the CD to your
\3dsmax8 local installation.

Turn off antialiasing and maps:

1. Choose Rendering > Render.

The Render Scene dialog is displayed.

2. Go to the Renderer panel. On the Default
Scanline Renderer rollout, in the Antialiasing
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group, turn off Antialiasing. In the Options
group, turn off Mapping as well.

3. Click Render.

The rendering goes quickly, but edges are
jaggy, and the rendering doesn’t show details
provided by texture maps.

Note: The radiosity in this scene was created
with the option Re-Use Direct Illumination
From Radiosity Solution. Because of this, the
shadows in the scene come from the radiosity
mesh. (Sometimes shadows from the mesh
can be grainy and inaccurate.) If you had
generated radiosity with the option Render
Direct Illumination instead, then turning off
Shadows in the Options group would also help
speed up render time.

Using a layer to hide objects:

Hiding more complicated objects, especially if
they aren’t essential to an overall visualization, is
another way to speed up rendering time.

1. On the Layers toolbar, click the
downward-pointing arrow at the left of
the Layer List to display the list.

(If the Layers toolbar is not visible, right-click
a blank area of another toolbar, and choose
Layers from the pop-up menu.)

2. Click to turn off the Visible icon of the
Furniture layer.

The eyeball icon indicates whether a layer is on or off.

The bookcase, chairs, and end tables are now
hidden in the scene.

3. Click Quick Render.

The scene renders without the geometry of
chairs, tables, and bookcase.

Note: The shadows of the furniture, especially
the bookcase, are still there. This is a
by-product of reusing direct illumination from
the radiosity mesh.

Use the “ Draft” presets:

The Render Scene dialog provides preset
parameters for different levels of rendering.

1. Turn the Furniture layer back on.

2. At the bottom of the Render Scene dialog,
choose Load Preset from the Preset drop-down
list. A file dialog is displayed. Choose the preset
named 3dsmax.scanline.radiosity.draft.rps,
and then click Open.

A Select Preset Categories dialog is displayed.
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3. On the Select Preset Categories dialog,
CTRL+click to remove the highlight from
Environment and Raytracer. Make sure Default
Scanline Renderer and Advanced Lighting are
highlighted, then click Load.

An alert warns you that this preset will
recalculate the radiosity solution. Click Yes.

4. Go to the Advanced Lighting rollout, and click
Start to recalculate radiosity using the preset
values.

This doesn’t take long, because the draft preset
specifies an Initial Quality of only 10.0 percent.

5. Click Render.

This time there is a bit of a delay. The
draft preset for radiosity has Render Direct
Illumination chosen. Even so, it doesn’t take
too long to get an overall idea of how a polished
version of the rendering might look.

If you want to experiment with the other rendering
presets, go ahead. Options on the presets
drop-down list also let you create your own
presets.

Save your work:

• Choose File > Save As. In the file dialog, name
the file my_radiosity_renderings.max, and
then click Save.

Summary

To sum up what this lesson has covered, when you
need a draft or a preview of a rendering, you can
speed up the rendering process in a number of
ways:

• Using a small image size, such as 320 x 240.

• Turning off antialiasing and mapping, and
turning off shadows if you are not reusing direct
illumination from the radiosity solution.

• Turning off layers with inessential objects.

• Using one of the “Draft” rendering presets.

Adjusting the Quality of Radiosity

As the previous lesson described how to obtain
renderings more quickly, this lesson describes how
to obtain a radiosity solution more quickly. It also
describes how to obtain more polished renderings
that use radiosity.

Quicker Solutions

There are two strategies for speeding up the
generation of a radiosity solution:

• Lowering the percentage of Initial Quality.

Radiosity is generated in multiple passes. The
lower the quality, the quicker the solution is
generated.

• Excluding objects from the radiosity
calculations.

Large surfaces in a scene contribute most to the
bouncing of light. Smaller, fussier objects, on
the other hand, contribute less bounced light
but take a long time to calculate, because of
their complexity.

Setting a lower value, such as 30 or 40 per cent, for
Initial Quality is straightforward, so we won’t walk
you through that step.

Set up the scene by doing one of the following:

• Open my_radiosity_renderings.max, which
you created in the previous lesson.

• From the \tutorials\adv_lighting\ directory,
open library_with_radiosity.max once again.

If you see the File Load: Units Mismatch dialog,
choose the option Adopt The File’s Unit Scale.
This will change your system unit, so be sure
to reset your system unit after completing this
tutorial.

To reset your system unit, go to the Customize
menu and choose Units Setup > System Unit
Setup > System Unit Scale > Inches.
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Note: All the necessary files to do the tutorials
can be found on the Tutorial Files CD that ships
with 3ds Max. Before doing the tutorials, copy
the \tutorials directory from the CD to your
\3dsmax8 local installation.

Choose the objects to exclude:

In this model, the walls, windows, floor, columns,
and ceiling contribute the most bounced light. The
“fussier” geometry such as furniture and lighting
sconces are the objects that take calculation
time without adding a lot of indirect light to the
solution.

1. Click Select By Name.

The Select Objects dialog is displayed.

2. In the list of objects, use CTRL+click to
highlight [books], [chair] through [chair12],
[sconce1] through [sconce3], and [table]
through [table03].

3. Click Select.

The objects are highlighted in the viewport.

Exclude the objects from radiosity calculations:

1. In a viewport, right-click one of the selected
objects.

Tip: The foremost chair is an easy one to use.

The quad menu is displayed.

2. On the Transform (lower-right) quadrant of the
quad menu, choose Properties.

The Object Properties dialog is displayed.

3. Go to the Advanced Lighting panel. In the
Radiosity-Only Properties group, click to turn
off Diffuse.

4. Turn off Exclude From Regathering as well, and
then click OK.

The bookcase, chairs, lighting sconces, and
tables are now excluded from radiosity
calculation.

See the effect of excluding geometry from radiosity
calculations:

1. Choose Rendering > Advanced Lighting >
Radiosity.

The Render Scene dialog is displayed, with
the Advanced Lighting panel active and the
radiosity rollouts visible.

2. Make sure Initial Quality is still set to 10 per
cent or less.

3. Open the Rendering Parameters rollout, and
choose Re-Use Direct Illumination From
Radiosity Solution.

4. On the Radiosity Processing Parameters
rollout, click Reset All, and answer Yes to the
warning.

5. Click Start.

Processing radiosity still takes some time, but it
goes more quickly than it would if the excluded
geometry were part of the calculations.

If you render the scene, you see that the result
is little different from the radiosity solution you
obtained in previous lessons.

The differences are subtle. Unless they are directly
lit, surfaces near the furniture and sconces are a
little dimmer than they appear when the entire
scene contributes to the radiosity solution, but the
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rendering is an acceptable draft, and it took a few
minutes less to generate the solution.

Better Solutions

Eventually, you will want to create a polished
rendering that uses radiosity. In this case, you
should use the Rendering Parameters rollout to
choose Render Direct Illumination. The radiosity
solution still provides indirect light, but the effect
of direct light is calculated at render time. So are
shadows, which become more fine-grained and
accurate as a result.

Set up the scene:

• From the \tutorials\adv_lighting\ directory,
open the file library_direct_render.max.

This is the same scene you have been using, but to
save time it contains a radiosity solution generated
with the Render Direct Illumination option.
The radiosity mesh stores the scene’s indirect
illumination. When you render, the renderer will
generate direct illumination and shadows “on the
fly.”

Render the scene and its shadows and direct lighting:

1. Choose Rendering > Render.

The Render Scene dialog is displayed.

2. Click Render.

The scene renders more slowly than when the
Re-Use Direct Illumination option was active.
However, it shows more accurate and more
subtle lighting.

In particular, the “scallops” from recessed
lighting on the wall on the left did not appear
in previous renderings. As with shadows,
sometimes the radiosity mesh is not fine
enough to capture details accurately.

Save your work:

• Choose File > Save As. In the file dialog, name
the file my_finished_library.max, and then
click Save.

Regathering

The final, optional step of generating a radiosity
solution is known as regathering. Regathering
is an additional check for, and elimination of,
unrealistic artifacts of the radiosity and rendering
calculations. It is especially useful for eliminating
the “leaks” of light and shadows that can occur
when the geometry of, for example, a floor and
a wall, is not accurately and tightly joined in the
model.

The Regather Indirect Illumination option is on
the Rendering Parameters rollout of the Advanced
Lighting panel. It is available only when the active
option is Render Direct Illumination. There are a
number of options that control how regathering
is calculated. These are described in the User
Reference.
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Regathering can greatly increase rendering time.
Because of this, and because regathering doesn’t
significantly improve the rendering of the library
model, we won’t walk you through the steps.

Summary

You can generate a “rough” radiosity solution to
get a preview of a rendered scene, or a polished,
physically accurate solution and rendering.

• To get a quick and rough radiosity solution,
lower the Initial Quality percentage.

• To get a less accurate but quicker solution, you
can also select geometry that won’t contribute
much bounced light, and set this geometry’s
Rendering Properties to not contribute diffuse
light.

• To get a more polished and accurate rendering,
increase the Initial Quality percentage. On the
Rendering Properties rollout, choose Render
Direct Illumination as the active option.

Also, on the Renderer panel > Default Scanline
Renderer rollout, make sure that Antialiasing,
Mapping, and Shadows are all turned on.

Changing How Objects Behave
Under Global Illumination

The global illumination options, radiosity and
light tracing, use object colors when they calculate
the color and energy of bounced light. Sometimes
you want to change how an object behaves in
the globally illuminated scene. In this example,
you set up some objects to emit light that affects
radiosity. The way to adjust a material’s behavior
under global illumination is to give it an Advanced
Lighting Override material.

Set up the scene:

1. Navigate to tutorials\adv_lighting\ and open
gallery_no_override.max.

Note: All the necessary files to do the tutorials
can be found on the Tutorial Files CD that ships
with 3ds Max. Before doing the tutorials, copy
the \tutorials directory from the CD to your
\3dsmax8 local installation.

2. If the File Load: Units Mismatch dialog is
displayed, select Adopt the File’s Unit Scale,
and click OK to continue.

The scene shows another part of the gallery,
with two sculpture installations surrounded
by neon lights. These neon lights are modeled
simply as cylinders with self-illuminating
materials.

Render the scene:

• Make sure the Camera02 viewport is
active, then on the toolbar, click Quick Render.

The rendered scene shows the neon lights
with glowing colors, but their glow has no
effect on the scene around them. An object’s
self-illumination color has a glowing look to it,
but doesn’t actually emit light in the scene.

Scene with self-illuminating neon but no true light
emission

Get the materials from the neon lights:

1. Open the Material Editor. Scroll to a
couple of unused sample slots. (Unused sample
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slots show a plain gray sphere, and have no
angle brackets in the corners.)

2. Activate one sample slot. Turn on Pick
Material From Object (the eyedropper button),
then click one of the cylinders that surround
the stack of spheres on the left. These neon
light objects are Cylinder02, Cylinder03, and
Cylinder04.

The material Neon Red No Override is loaded
into the sample slot.

3. Activate another empty sample slot and do
the same for one of the cylinders surrounding
the wavy triangle. These neon light objects are
Cylinder05, Cylinder06, and Cylinder07.

The material Neon Green No Override is
loaded into the other sample slot.

Turn the materials into Advanced Lighting Override
Materials:

1. Click the Neon Red No Override sample slot to
activate it. Then click the Material Type Button
(which now says Standard).

The Material/Map Browser appears.

2. In the Material/Map Browser, highlight
Advanced Lighting Override, and then click
OK. In the Replace Material dialog that is
displayed, make sure to choose Keep Old
Material As Sub-Material, and then click OK.

Now the red self-illuminating material is
contained within the Override material.

3. On the Advanced Lighting Override Material
rollout, in the Special Effects group, change
Luminance Scale from 0.0 to 1000.0.

Now the material will emit light in the scene.

You might notice that the controls in the
Override Material Physical Properties group
are for adjusting how much light the material
reflects and transmits.

4. Repeat steps 1 to 3 for the Neon Green No
Override material.

Recalculate the radiosity solution:

Because you got the materials directly from the
objects, they are “hot” materials and you don’t
need to reapply them in the scene. However, if
you render the scene again now, you will see no
change. This is because you need to recalculate the
radiosity solution as well.

1. Choose Rendering menu > Advanced Lighting
> Radiosity.

The Render Scene dialog appears, opened to
the Advanced Lighting panel.

2. On the Radiosity Processing Parameters
rollout, click Reset All, and click Yes in the
warning dialog.

3. Click Start.

The radiosity solution is recalculated. This
is a good time for you to take a break: the
recalculation can take several minutes. The
progress bar below the Start button shows
the progress of each pass, and the quality
percentage each pass achieves.

Render the scene:

• Make sure the Camera02 viewport is
active, then click Quick Render again.

The effect is subtle, but the neon now glows,
tinting the alcoves and the sculptures that stand
in them.



448 Chapter 3: Getting Started

When neon objects emit light energy, they contribute
colored light to the scene.

Save your work:

• Save the file as my_neon_gallery.max.

Rendering a Daylight Scene

In this lesson, you add daylight to a scene, and
render it using radiosity in conjunction with
exposure control.

Set up the scene:

• From the \tutorials\adv_lighting\ directory,
open library_daylight.max.

If you see the File Load: Units Mismatch dialog,
choose the option Adopt The File’s Unit Scale.
This will change your system unit, so be sure
to reset your system unit after completing this
tutorial. To reset your system unit, go to the
Customize menu and choose Units Setup
> System Unit Setup > System Unit Scale >
Inches.

This model is the interior of a library you used
in earlier lessons.

Note: All the necessary files to do the tutorials
can be found on the Tutorial Files CD that ships
with 3ds Max. Before doing the tutorials, copy
the \tutorials directory from the CD to your
\3dsmax8 local installation.

Look at the default view of the library:

• Activate the Camera viewport, and then
click Quick Render.

The default lighting of the library appears
rather flat.

Note: If a dialog appears displaying Raytrace
messages, you can disable it in the Render
dialog by going to the Raytrace tab and turning
Show Messages off.

Add daylight to the scene:

You will use a Daylight system to model the sun.
The Daylight system includes several components:

• A compass object to orient the scene.

• A sun light to model the sun itself.

• A sky light to model scattered light in the
atmosphere.

You can set the sky to be Clear, Partly Cloudy,
or Cloudy.

• Motion control that sets the geographic location
and the time of day.

(There is no point in rendering a view when the
sun is below the horizon!)
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1. Go to the Create panel, and click
Systems to turn it on. On the Object Type
rollout, click Daylight to turn it on.

2. In the Top viewport, drag to position the
compass rose. Release the mouse, drag and
then click to set the height of the sun object.
Right-click to end the creation process.

Drag in the top viewport to create the compass rose.

You can see the sun’s height in the Left
viewport. It doesn’t really matter how high you
position the sun object, as long as it is above
the ground plane. The sun’s position affects the
scene, but sunlight is treated as parallel rays, as
if they came from an extreme distance.

You can see the sun’s elevation in the left viewport.

The orientation of the compass rose does affect
the scene.

Orient the daylight system:

1. Turn on Select Object.

2. In the top viewport, click to select the
Daylight01 object if it is not already selected,
and then go to the Motion panel.

3. Change the North Direction angle to 140
degrees.

Ensure the daylight system is photometric:

1. Make sure the Daylight System (Daylight01) is
still selected

2. In the Modify panel, set the Sunlight
and Skylight types to IES Sun and IES Sky
respectively if this is not done already.

Note: The IES Sun and IES Sky are the
photometric versions of sunlight and skylight.

Change the time of day:

• Go the Motion panel. On the Control
Parameters rollout, in the Time group, change
the value of Hours to 15.
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The Daylight system uses a 24-hour clock, from
0 (midnight) to 23 (11 P.M.). So 15 Hours
corresponds to 3 P.M.

With this orientation and time of day, the view
of the library in the camera view will show fairly
good lighting effects.

Look at the result:

• Click Quick Render.

The image of the library in sunlight appears
washed out. This is because of the considerable
intensity of the photometric sunlight that is
part of the Daylight System. Photometric lights
provides physically based simulation of the
propagation of light through an environment,
but you need to use Exposure Control to
compensate for that intense energy.

Adjust the exposure control:

Exposure control adjusts the brightness and
contrast of the scene, along with some other
settings. You can think of it as working like
the controls on a camera. The main reason for
controlling exposure is that monitors have a range
of about two orders of magnitude: the brightest
color on a display is about 100 times brighter
than the dimmest. By comparison, the eye can
perceive a range of about 16 orders of magnitude:
the brightest color we can see is about 1016 times
brighter than the dimmest.

Another reason for exposure control is simply to
adjust the appearance of a rendering to make it
easier to read or more appealing.

1. On the Rendering menu, choose Environment.

The Environment And Effects dialog is
displayed. Exposure controls are on the
Environment panel > Exposure Control rollout.
An additional rollout contains the controls
specific to the type of exposure control you
choose.

Notice that on the Exposure Control rollout,
Logarithmic Exposure Control is chosen, and
the Active toggle is turned on. 3ds Max did
this silently when you added a Daylight system
to your scene. Daylight almost always requires
an exposure control, as you will see in the
following steps.

2. Right-click the camera viewport to make sure
it is active.

3. On the Exposure Control rollout, click Render
Preview.

After a pause, the thumbnail image shows a
preview of the rendered scene.

As you might expect, levels in the thumbnail
are like those in the rendered frame.

4. Click to turn off the Active toggle.

More of the thumbnail image is burned to
white. Now you cannot see the furniture or the
outside terrain anymore.

One advantage of the thumbnail on this rollout
is that it is interactive. Once you have rendered
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it, changing the exposure control changes the
preview without requiring you to render again.

Rendering with radiosity uses correct physical
scale. Without exposure control, the extreme
intensity of sunlight burns out exterior scenes.

5. From the drop-down list, notice that you
have different exposure types to choose from.
Arguably, Logarithmic Exposure is the best
choice as it does a better job at compressing
a huge range of brightness levels into the
limited range of a monitor. This is why it is
recommended for the Daylight System.

6. Leave the Exposure type to Logarithmic
and turn on the Active option again. In the
Logarithmic Exposure Controls Parameters
rollout, click to turn on Exterior Daylight.

The thumbnail now shows much better levels of
brightness and contrast. The Exterior Daylight
toggle compensates for direct sunlight.

Generate a radiosity solution:

1. Click Render Scene to display the Render
Scene dialog.

2. Go to the Advanced Lighting panel. On the
Select Advanced Lighting rollout, choose
Radiosity from the drop-down list.

Various rollouts for radiosity are now displayed
on this panel.

3. Open the Radiosity Meshing Parameters
rollout, and turn on Enabled under Global
Subdivision Settings.

4. Turn off Use Adaptive Subdivision. This option
subdivides the geometry in a finer grid only
where needed, but you will not use it in this
lesson.

5. On the Radiosity Processing Parameters
rollout, set Initial Quality to 50.0 per cent.

You don’t need a high-quality solution to see
the general effect in this scene.

6. In the Interactive Tools group, set both the
Direct and Indirect Light Filtering to 2.. This
will smooth out some of the noise patterns
resulting from the radiosity calculation.

7. On the Radiosity Processing Parameters
rollout, click Start.
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Wait till the radiosity solution is created. (The
Stop button becomes unavailable, and the Reset
buttons become available.)

8. Click Render.

Reflected light illuminates the ceilings, and
other areas that were much darker prior to the
radiosity calculation.

Adjust the logarithmic exposure control:

When you use Logarithmic Exposure with the
Daylight System, the Exterior Daylight setting
sometimes overcompensates and leaves the scene
somewhat darker than anticipated. This is easy to
fix.

1. On the Logarithmic Exposure Control
Parameters rollout, change the Brightness value
to 80.0.

The thumbnail updates accordingly.

As you know if you have worked with
image-editing applications, increasing
brightness can wash out an image, so bump up
the contrast as well.

2. Change the Contrast value to 60.0.

The change in the thumbnail is slight, but the
effect will be apparent in the rendering.

3. Click Render once again.

The library is now convincingly lit, and shows
details that weren’t apparent before.

Save your work:

• Choose File > Save As. In the file dialog, name
the file my_sunlight.max, and then click Save.

Summary

To simulate natural sunlight, you can use a
Daylight system. Daylight lets you set the
geographic location of a site, the site’s orientation
(north, south, east, and west), and the time of
day. It also lets you set whether the sky is clear or
cloudy.

Use the Logarithmic exposure control for most
purposes, as this type does a better job at
compressing a huge range of brightness levels
into the limited range of a monitor. Turn on the
Logarithmic exposure control’s Exterior Daylight
toggle when using a Daylight object or a light
type with a very strong intensity. If this setting
overcompensates for the sun, you can adjust the
Brightness and Contrast to correct this.

Using Radiosity with Standard
Lights

For their accurate realism and their ease of use
with radiosity solutions, we encourage you to use
photometric lights when you create new models.
However, if you use older models, or if you want
to create a quick lighting study that doesn’t rely on
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physical realism, you might find yourself working
with standard lights. There are some differences
in the use of the two kinds of lights. The most
important of these are described in this lesson.

Standard Light Intensity

Instead of the physical intensity that you specify
for photometric lights in candelas, lumens, or lux,
standard lights have a Multiplier value. At 1.0
(the default), the light is at its full intensity. Lower
Multiplier values express a normalized percentage
of the full intensity. You can also increase the
multiplier to be greater than 1.0, but this is not
recommended because large Multiplier values
tend to create “burned out” areas that don’t look
realistic and often don’t transfer well to video.

Standard Lights and Radiosity

Whether you use photometric or standard lights
for an indoor scene, direct illumination alone
usually results in a dim rendering. You need
to generate a radiosity solution to get a fully lit
scene. Standard lights can generate radiosity. The
exposure controls provide an additional setting,
Physical Scale, to compensate for the inaccuracy
of standard lights, as shown in the demonstration
that follows.

Set up the scene:

• From the \tutorials\adv_lighting\ directory,
open interior_unfinished_std_lights.max.

Note: All the necessary files to do the tutorials
can be found on the Tutorial Files CD that ships
with 3ds Max 8. Before doing the tutorials,
copy the \tutorials directory from the CD to
your \3dsmax8 local installation.

This model is the interior of a house, with no
furniture added.

View the lighting of the scene:

The lighting consists of standard lights: two
unique omni lights in opposite corners of the
room, and a row of four spotlight instances down
the center of the room.

• Choose Tools > Light Lister.

The Light Lister is displayed.

Only one spotlight, Fspot01, appears on
the light lister, because the other three spots
are instances of it. As you can see from the
Multiplier fields, the lights are not at full
intensity.

Note: More information about the light lister
is provided in the lesson Managing Multiple
Lights (page 1–419), which follows.

Render the scene:

• On the main toolbar, click Quick Render.

As usual when only direct light is rendered, a
lot of the scene remains in shadow.
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Generate a radiosity solution:

1. Choose Rendering > Advanced Lighting >
Radiosity.

The Advanced Lighting panel of the Render
Scene dialog is displayed.

2. Open the Rendering Parameters rollout, and
make sure that Render Direct Illumination is
chosen.

Warning: If Re-Use Direct Illumination is chosen,

and direct illumination is “baked in” to the radiosity

solution, then adjusting exposure control will have

no effect on renderings. And as you will see in the

steps that follow, you need to adjust the exposure

control when you work with standard lights.

3. On the Radiosity Processing Parameters
rollout, click Start.

Although the Initial Quality is set to 85 percent,
this is a fairly simple model, so the solution is
generated quickly.

4. Click Quick Render.

In the case of this scene, the initial solution is
rather too bright. You will adjust that in the
next procedure.

Use exposure to adjust the physical scale:

1. Choose Rendering > Advanced Lighting >
Exposure control.

The Environment panel of the Environment
And Effects dialog is displayed. The
Logarithmic exposure control is active.

2. On the Exposure Control rollout, click Render
Preview.

3ds Max renders a thumbnail of the scene.

The colors in the thumbnail look more realistic
than the rendering. In this case, it appears that
the Physical Scale is too great.

3. On the Logarithmic Exposure Control
Parameters rollout, change the value of Physical
Scale to 500.0.

The preview thumbnail automatically updates
to show the change.

4. Click Quick Render.
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Now the rendering, especially the floor, doesn’t
look quite as washed out, but areas lit by
reflected light still have detail.

If you like, experiment with other Physical Scale
values. The differences can be subtle, and the
preview tends to show more dramatic changes
than the actual rendering. You might also
experiment with the Linear exposure control.
Linear exposure is sometimes useful for indoor
scenes, but it doesn’t work well with this one
because of the large contrast between directly
lit areas and the areas in shadow.

Summary

The Physical Scale value is multiplied by each
standard light’s Multiplier value to obtain a value
in candelas that the exposure control can use.
Adjusting the Physical Scale adjusts the lighting
level of the scene to obtain a useful rendering.
The default Physical Scale value of 1500 turns a
standard omni light with a Multiplier of 1.0 into
an isotropic photometric light of 1500 candelas.
However, when you work with standard lights,
you should remember that the solutions and
renderings you obtain are always approximate.

Rendering a Panorama
In addition to rendering image files and
animations, you can render a three-dimensional
panorama. The panorama actually consists of
a flat bitmap that encloses the scene, but when
viewed with the Panorama Viewer, the view
appears to be 3D.

Set up the scene:

1. From the \tutorials\adv_lighting directory,
open library_with_radiosity.max.

The File Load: Units Mismatch dialog appears.

This scene was created with meters as the
system unit. This dialog appears every time
you open such a file, unless you have previously
set meters to be the system unit in the current
3ds Max session. You can either adopt meters as
your system unit, or you can rescale the scene
geometry to match your current unit settings.

In this case, you will rescale the file. For the
purposes of the tutorial, it doesn’t really matter.

2. In the File Load: Units Mismatch dialog, make
sure Rescale The File Objects To The System
Unit Scale is selected, then click OK.

Render a panorama:

1. Choose Rendering > Panorama Exporter.
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3ds Max displays the Utilities panel, with the
Panorama Exporter rollout active.

2. On the Panorama Exporter rollout, click
Render.

The Render Setup dialog appears. Settings on
this dialog are similar to those on the regular
Render Scene dialog.

3. On the Interactive Panorama Exporter
Common Parameters rollout, click to set the
solution to 1536x768.

Unless you are creating a quick, low-quality
test, we recommend you render a panorama
with high resolution. The default resolution of
512x256 is very grainy indeed.

4. Make sure Camera.View.P1 is the active
Viewport (in the list at the lower-left of the
dialog), and then click Render.

Important: This drop-down list shows only cameras.

A panorama is always based on a camera view. If no

camera is in the scene, you can’t render a panorama.

3ds Max renders the panorama in multiple
passes, and then displays the Panorama
Exporter Viewer.

Even at the high resolution, the panorama is
not as detailed as a still-image rendering.

Tip: Before you render, you can save the panorama
to a file. On the Interactive Panorama Exporter

Output rollout, find the Render Output group
and click the Files button. Enter a name for the
file, and choose one of the image file formats. The
panorama is a single bitmap, but distorted for
viewing in 3D.

Flat view of a rendered panorama

View the panorama:

1. Move your mouse near the center of the
Panorama Exporter Viewer window, and hold
down the left mouse button.

The panorama rotates, as if the camera were
panning or tilting.

You can control the direction of the pan or tilt
by dragging the mouse in that direction.

2. Experiment with navigating the panorama. You
can right-click and then drag to rotate or tilt the
camera. If your mouse has a middle button or
wheel, you can use this to zoom in or out.

Note: The Panorama Viewer is modal. When it
is displayed after rendering, you can’t close the
Render Setup dialog until you close the Viewer.
You can also open the Viewer by clicking
Viewer on the Panorama Exporter rollout on
the Utilities panel. Use the Viewer’s File menu
to open a rendered panorama file.

Summary

The Panorama Exporter is a 3ds Max utility. Based
on a camera view, you can render a 3D panorama
and view it interactively using the Panorama
Exporter Viewer.
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F/X

Particles

Creating Cigarette Smoke

In this tutorial, you use a particle system to create a
stream of cigarette smoke trailing from an ashtray.
The animation relies on space warps to affect the
movement of the smoke. For example, you use a
Wind space warp to model the fan in the scene
blowing the smoke around.

Animation techniques used in this tutorial:

• Creating a particle system.

• Creating space warps that affect the motion of
the particles.

• Choosing appropriate particle geometry.

• Creating a material that models smoke when
applied to particles.

Time to complete: 30 minutes

Set up the scene:

• Open cigarette_smoke.max.

Files for this tutorial are in the
\tutorials\simple_particle_effects\ directory.

Note: All the necessary files to do the tutorials
can be found on the Tutorial Files CD that ships
with 3ds Max 8. Before doing the tutorials,
copy the \tutorials directory from the CD to
your \3dsmax8 local installation.

The scene contains a simple table, an ashtray,
and a fan. To make the animation easier to
adjust, the fan’s geometry (except for the fan
motor) is frozen.

Create the particle system:

1. Activate the Top viewport.

2. If you need to, select the ashtray and
click Zoom Extents Selected to fit the ashtray
in the viewport.

3. In the Create panel, make sure
Geometry is active, and choose Particle Systems
from the drop-down list.

4. On the Object Type rollout, click Super Spray.

5. In the Top Viewport, click and drag in the
ashtray near the tip of the cigarette object.

Super spray particle system in the Top viewport
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Super spray particle system in a user view

You have now created a Super Spray particle
system. The icon you see is called the emitter. The
emitter doesn’t render, but it shows the location
in the scene where particles will be emitted. The
arrow points up, indicating that initially particles
will move upward out of the center of the icon.

When you create a Super Spray system, the
particles are emitted toward you in the viewport
you click. That is, they move along the Z axis in
the positive direction. This is why we used the Top
viewport to create the system.

(Different kinds of particle systems have differently
shaped emitters, and different emission behavior.)

• Activate the Camera02 viewport, and
then click Play.

A burst of particles leaves the emitter rapidly,
moving in a vertical line. Each particle is
displayed as a plus sign or “tick.” By frame 40,
all of the particles have moved out of the frame.
This doesn’t look much like smoke.

You are seeing the default behavior and settings
for Super Spray. To get a more smoke-like effect,
the first thing to do is adjust the Super Spray
parameters.

Slow the particles down and make them easier to
visualize:

1. With the Super Spray particle system
selected, go to the Modify panel.

Tip: Particle systems have a large number
of rollouts. If you like, you can expand the
command panel to see more rollouts and
controls at once. Move your mouse to the
border between the command panel and the
viewports, and drag the command panel to
create multiple columns. The command panel
can be widened whether it is floating or docked.
To dock or float a command panel, right-click
to one side of the tabs, and choose Float or
Dock from the flyout menu.

2. In the Basic Parameters rollout > Viewport
Display group, change the display type to Dots
rather than Ticks.

For the purpose of working in viewports,
especially when particles are very close
together, Dots give a better preview than the
plus-sign Ticks.

3. In the Basic Parameters rollout > Particle
Formation group, set the Spread value for Off
Axis to 2.0.

(This is the Spread spinner immediately below
the Off Axis spinner, and not the Spread value
associated with Off Plane.)

4. In the Particle Generation rollout > Particle
Motion group, set Speed to 1.5.

Now if you play the animation, you see the
particles stream upward more slowly. The slight
increase in the Spread value means they don’t
move in a completely straight line. (Spread is
measured in degrees. Higher Spread values create
a more fan-like pattern.)

However, the particles stop emitting at frame 30
and completely disappear from the scene at frame
100. To get a smoke effect, you also need to change
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the default values that govern particle generation
and lifetime.

Adjust particle generation:

1. In the Particle Generation rollout > Particle
Quantity group, set Use Rate to 30.

This increases the number of particles
generated per frame from 10 to 30.

Note: When you play the animation in the
Camera02 viewport, you don’t see 30 particles
being emitted per frame. By default, in
viewports, Super Spray displays only 10 percent
of the particles actually being emitted. This
keeps viewport playback fast. You can adjust
the preview value in the Viewport Display
group of the Basic Parameters rollout, but we
recommend you keep it low. Previewing a large
percentage of particles in a system can seriously
slow down 3ds Max. When you render the
animation, the rendering uses the full number
of particles.

Tip: A better way to preview the effect of all
particles is to use the command Rendering >
Make Preview.

2. Also on the Particle Generation rollout, in the
Particle Timing group, set both Emit Stop and
Display Until to 300.

The animation is 300 frames long. Setting Emit
Stop to 300 means that particles continue to
be emitted throughout the animation. Setting
Display Until to the same value means that all
particles that haven’t died remain in the scene
until the end of the animation.

3. Continuing down, set the Life value to 180.

A particle in this system dies 180 frames after
it is emitted. Not all of the particles will last
until frame 300.

Now the particles emerge in a denser cloud that
doesn’t move right out of the scene. This is more

reminiscent of smoke. But the movement of the
particle system still looks artificial.

Adding Wind, Turbulence, and Drag

Particles are not smart. Like sheep, you need
to herd them. Space warps such as Wind and
Gravity add directional fields that affect particle
motion. In this simulation of cigarette smoke,
you’ll associate the fan with a Wind space warp
that models the breeze from the fan.

Create a wind space warp to simulate a breeze from
the fan:

1. Go to the Create Panel and turn on
the Space Warps button.

2. Make sure Forces is the active space warp type.

3. In the Object Type rollout, click Wind.

4. Drag in the Left viewport to create the Wind
space warp.

Wind space warp created in Left viewport (facing away
from user)

Position the wind space warp:

• Activate the Top viewport. Using
Rotate and Move transforms, align the Wind
space warp roughly to that of the fan. The arrow
should point in the direction of the particles.
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Wind space warp in Top viewport, before aligning to fan

Wind space warp in Top viewport, after aligning to fan

You don’t have to be too accurate about aligning
the Wind icon with the fan motor. The wind
direction, and linking it to the motor’s motion,
are the important things.

Link the wind to the fan so their motion is
coordinated:

• With the Top viewport still active and the
Wind space warp still selected, click Select And
Link, then drag from the Wind space warp to
the FanMotor object.

Now if you play the animation, the Wind space
warp rotates with the oscillating fan. Nothing
has changed the animation of the particles.
They are unaffected by the Wind space warp
until you explicitly bind them to it.

Bind the wind space warp to the smoke particles:

1. Select the Super Spray particle system.

2. Click Bind To Space Warp, then click the
Super Spray system, and hold the button down
as you drag to the Wind space warp.

When Bind To Space Warp is active and the
cursor is over a selected object, the cursor
changes to the space warp icon to inform you
that this object can be bound to a space warp.
Then when you drag from the object to the
space warp, a line is drawn to show which object
is being bound. Once off the object, the cursor
changes again until it’s over a suitable space
warp. Then it reverts to the space warp icon to
inform you that this binding is legal. When you
release the mouse, the bound space warp briefly
highlights to indicate the binding is complete.

3. Activate the Camera02 viewport, then
play the animation.

The effect of the wind is much too strong. The
smoke is whipped around dramatically.

Adjust the strength of the wind:

By default, the Wind space warp’s Strength value is
1.0. Reducing the Strength value makes the effect
of the fan look more realistic.

1. Select the Wind space warp.

2. In the Modify panel, set the Strength
value to 0.03.

3. Activate the Camera02 viewport, then
play the animation.

The smoke is more gently wafted now. But
you can make the smoke’s appearance more
realistic still, by giving it a bit of inertia. To do
so, you use another space warp.
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Add a drag space warp:

1. Go to the Create panel and click
the Space Warps button.

2. Make sure Forces is the active space warp type.

3. On the Object Type rollout, click Drag.

4. In the Top viewport, drag to create a Drag space
warp near the Super Spray.

Drag space warp created in the Top viewport

Set the drag space warp parameters:

The Drag space warp has a large number of
parameters. For the purposes of this animation,
you need to set only a few of them: Time Off, and
the Axis percentages for Linear Damping.

1. With the Drag space warp selected, go
to the Modify panel. Set Time Off to 300.

By default, the Time Off value is 100, but you
need Drag to be active for the duration of the
animation.

2. With Linear Damping the active damping type,
set the X and Y Axis percentages to 1.0, and the
Z Axis percentage to 2.0.

As with Wind, the Drag space warp doesn’t
affect the particles until you bind them to it.

Bind the drag space warp to the smoke particles:

1. Click Bind To Space Warp, then in the
Top viewport click the Super Spray system, and
hold the button down as you drag to the Drag
space warp.

Now a drag force is applied to the particles. The
force is non-uniform: there is more drag along
the Z-axis (up and down in the scene) than in
other dimensions.

2. Activate the Camera02 viewport, then
play the animation.

The effect of the Wind space warp is decreased.
The Drag warp slows down the particles.

Add turbulence to the wind:

The smoke looks better, but its motion is still
unnaturally uniform. The solution is to make the
Wind more turbulent.

1. Select the Wind space warp.

2. On the Modify panel, go to the Wind
group box in the Parameters rollout. Set
Turbulence to 0.03, Frequency to 0.12, and
Scale to 0.1.

The Turbulence value controls how much the
particles are perturbed from their position.
Frequency causes random variation in the
turbulence, and Scale adjusts the size of the
turbulence field.

Why such low values? Actually, a good rule of
thumb for turbulence settings is to start very
low and work your way up. Turbulence creates
a fractal noise field that is localized to the Wind
space warp icon. The scale of this field needs to
match the scale of your scene. The easiest way
to do this is to start with low values and then
increase them as needed.
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3. Activate the Camera02 viewport, then
play the animation.

The particles move much more like cigarette
smoke, with wispy sways and curls.

Also, the particles are blown in the current
direction of the Wind space warp on a given
frame. The effect is not conical with attenuation
as it would be for an actual fan; instead, the
effect of the wind and its turbulence is parallel.

Particle Geometry

While the movement of the smoke is now good,
the particle geometry needs some adjusting.

Preview the particle system:

• Activate the Camera02 viewport, then
choose Animation > Make Preview. A Make
Preview dialog appears. Leave the settings
at their defaults, and click Create. A Video
Compression dialog appears. Use this dialog’s
default settings as well, and click OK.

When the preview completes, use Animation >
View Preview to view it as an AVI movie.

The particles still appear as a bunch of
solid-looking dots (by default, they render as 3D
triangles). To make them more convincing as
smoke, first you adjust the particle geometry, then
you apply an appropriate material to them.

Change the particle geometry:

1. Select the Super Spray particle system.

2. Go to the Modify panel.

3. If one of the space warp bindings is chosen in
the modifier stack, click the Super Spray entry
so you can see the particle system’s rollouts.

4. In the Particle Type rollout > Standard Particles
group, choose Facing.

Facings are square particles that are constantly
oriented towards the camera. If you rendered
them as solid, they wouldn’t appear realistic,
either. But facing particles are meant to have
a material applied to them. When facings are
clumped together and a material gives them a
degree of transparency, you can achieve a fairly
realistic smoke.

The size of the particles is uniform. In general,
when you want realistically to model natural
phenomena, you want to avoid uniformity.

Make the particle geometry more random:

Ideally, the particles should increase in size after
they are born, and then fade out as they die. The
Grow For and Fade For parameters let you do this.
Also, to break up the unrealistic uniformity of the
particle size, you need to add some variation to
the size.

1. With Super Spray still selected and the Modify
panel still active, go to the Particle Size group
near the bottom of the Particle Generation
rollout.

2. Set the Size to 2.0 and the Variation to 30 %.

3. Set the Grow For value to 90 and Fade For to 30.

In these last steps, you have increased the
overall size of the particles and randomized this
size by plus or minus 30 per cent. Each particle
now grows for 90 frames, from an initial size
of zero to the full size it will achieve. Thirty
frames before it dies, it begins to shrink back
down to a size of zero. (Remember that you
have set each particle to live for 180 frames.)
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Cigarette Smoke Material

Now that you’ve adjusted the particle geometry,
you can shade the particles to look like smoke. The
trick to this is to use a soft, partially transparent
material that allows the particles to blend together
and form a wispy smoke pattern. Because the
particles are rendered as square facing geometry,
a radial gradient with transparent edges can
accomplish this.

Set up the material:

1. Open the Material Editor.

2. Choose an unused sample slot.

3. On the Blinn Basic Parameters rollout, click
the Diffuse color swatch to display the Color
Selector.

4. Set the Diffuse color to pure white (Value=255).

5. Set both the Specular Level and Glossiness
values to 0.

6. Turn on the Self-Illumination Color check box.

The Self-Illumination control changes from a
spinner to a color swatch.

7. Click the Self-Illumination color swatch. In the
Color Selector, set the self-illumination color to
a medium gray (Value=144).

8. On the Shader Basic Parameters rollout, turn
on the Face Map toggle.

Use Face Map shading with Facing particles, so
that each rendered particle displays the entire
map.

You now have a material that is pure white,
partially self-illuminated with a medium gray
color, and face mapped for particles.

Assign the material to the smoke particles:

• Click Assign Material To Selection, or drag
from the sample slot to the Super Spray particle
system.

A rendering would show that the smoke is now
more smoke-colored, but has hard, jagged
edges from the square facing particles.

Smoke particles without transparency appear too solid
and jaggy.

To soften the smoke, you create a radial gradient
with transparency at its edges.

Make a radial gradient map for the smoke particles:

1. In the Material Editor, open the Maps rollout
and click the Opacity map button.

2. In the Material/Map Browser, choose Browse
From: New, click Gradient, and then click OK.

3. On the Gradient Parameters rollout, change the
Gradient Type to Radial.

4. Click Go To Parent to return to the base
level of the material.

5. On the Maps rollout, change the Opacity
Amount value to 5.

The Gradient map determines only five per
cent of the opacity. Ninety-five percent of the
opacity is still controlled by the base Opacity
parameter. For smoke, make the particles as
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soft and semi-transparent as possible, especially
with high particle counts. So the Gradient map
should be the only thing that sets the Opacity
of the particles, but you also want the overall
Opacity to be very low. For this animation, you
turn off the base Opacity value completely.

6. In the Basic Parameters rollout, set the Opacity
value to 0.

The rendered scene now has very soft smoke
that rises up, grows gradually in size, and is
blown around and perturbed by the wind from
the fan.

The Final Animation

You are now ready to activate the Camera02
viewport and render the entire animation.
Even at low resolution, this can take about half
an hour. Alternatively, you can play the file
cigarette_smoke.avi, provided on the Tutorial Files
CD.

Creating an Explosion with
Fragments and Bubbles

This animation shows a depth charge sinking
towards a submarine, then exploding. One particle
system generates the fragments, and another
generates the bubbles. As in the previous particle
systems tutorials, several space warps help control
particle motion.

Animation techniques used in this tutorial:

• Using the PArray particle system’s Object
Fragments option to model fragments from the
explosion.

• Using parameter wiring to control both
geometry and lighting.

• Using PCloud, a particle system that emits
particles from the volume of an object or an
emitter icon.

• Adding fog and a volume light to enhance the
atmosphere.

Time to complete: 60 minutes

Set up the scene:

• Open sub_scene.max.

Files for this tutorial are in the
\tutorials\simple_particle_effects\ directory.

Note: All the necessary files to do the tutorials
can be found on the Tutorial Files CD that ships
with 3ds Max 8. Before doing the tutorials,
copy the \tutorials directory from the CD to
your \3dsmax8 local installation.

Some portions of the scene are already set up,
including the animation of the submarine and
the depth charge. The depth charge already has
an Omni light and a Gravity space warp linked
to it. These don’t yet affect the rendered scene.
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Exploding the Depth Charge

You will use PArray to emit particles from the
surface of the depth charge. PArray has an option
to generate particles out of fragments of the emitter
object, so it’s suited to model explosions.

Create the particle array:

1. On the Create panel, click
Geometry, then choose Particle Systems from
the drop-down list.

2. Click PArray, then drag in the Top viewport to
create the PArray icon.

PArray created in Top viewport, near depth charge

Adjust the particle array parameters:

1. With the PArray selected, go to the
Modify panel.

2. At the top of the Basic Parameters rollout, click
the Pick Object button, and then select the
DepthCharge object by clicking it in a viewport.

Now PArray is set to use the DepthCharge
object as an emitter. You need to adjust the
emission parameters to synchronize them with
the animation.

3. In the Particle Generation rollout, set the Emit
Start value to 200, Display Until to 301 (just
after the last frame in the animation), and Life
to 101.

These values guarantee that the emitted
particles will remain in the scene for the
duration of the animation.

4. In the Particle Type rollout, set the particle type
to Object Fragments.

5. Just below, in the Object Fragment Controls
group, choose Number Of Chunks (as opposed
to All Faces, which is the default), and then set
Minimum to 50.

At this point, if you preview the animation in a
viewport, you can see that particles are blasted
out of the depth charge at frame 200. However,
you can’t see any fragments. PArray is still
using the default viewport display setting of
Ticks. You can change this to Mesh to see the
geometry in viewports.

6. Go to the Basic Parameters rollout, and in the
Viewport Display group, choose Mesh.

Now if you play the animation in a viewport, you’ll
see the actual fragments displayed on particle
emission. This is a fairly good preview of how the
fragments will appear when you render.

Fragment particles in a wire view
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Though this isn’t apparent in wireframe viewports,
the depth charge object has a Visibility track that
turns it off after frame 200. This is a standard
technique for exploding objects.

At this point, the motion of the fragments would
be appropriate for a space scene, but not for
underwater. They don’t rotate or sink, nor do they
slow down after they’re emitted. This is a subtle
point, but it destroys the sense of scale in the scene.

To fix these problems with the fragment motion,
you will use three space warps: a Drag space warp
to dampen the particles’ velocity, a Gravity space
warp to cause the particles to sink in the water,
and the Gravity space warp that’s already linked to
the depth charge object, to temporarily suck the
particles inward after the explosion.

Add a drag space warp to slow the depth charge
fragments:

1. On the Create panel, click Space
Warps, and select Forces from the drop-down
list.

2. Click Drag, and then drag in the Top viewport
to create a Drag space warp.

Drag space warp created in Top viewport

Adjust the drag space warp parameters:

1. With the Drag space warp selected, go
to the Modify panel.

2. In the Timing group, set Time On to 200 (when
particles are born) and Time Off to 300 (when
the scene ends).

3. In the Damping Characteristics group, Linear
Damping should be chosen by default. Adjust
the X Axis, Y Axis, and Z Axis values to 5.0 %.

Add a gravity space warp to make the fragments
sink:

1. Go back to the Space Warps section
of the Create panel. Click Gravity, and then
drag in the Top viewport to create the Gravity
space warp.

By default, this Gravity space warp is planar.

2. Set the Gravity space warp’s Strength value to
0.01.

Gravity space warp created in Top viewport (pointing
away from user)

Bind the space warps to the PArray:

1. Click Bind To Space Warp.

2. Drag from the PArray particle system to the
Drag space warp, then release the mouse
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button. The Drag space warp should briefly
highlight to show that the binding is complete.

3. Drag from the PArray particle system to the
planar Gravity space warp, then release the
mouse. Like the Drag warp, the Gravity warp
should briefly highlight.

4. Drag from the PArray particle system to the
spherical Gravity space warp that surrounds
the depth charge object, then release the mouse
button.

Tip: If you aren’t sure that a bind operation
succeeded, you can always check the particle
array’s modifier stack. After these bindings, the
PArray stack should look like this:

Now if you preview the animation, you see that the
particles explode outward from the depth charge
but quickly slow down (water is denser than air).
Then they are sucked inward toward the depth
charge (the explosion collapses from the pressure
of the surrounding water), and finally they begin
to sink.

Using Wiring for Animation

The particles are sucked inward toward the
explosion source, but only for a short time. This
is because the Strength parameter of the spherical
Gravity space warp is animated.

Function curve for the Strength parameter

With the parameter wiring feature, you can use
the Strength animation to control the explosion
itself (burning gas), and the light the explosion
generates. Using the Gravity Strength to control all
three components (fragment motion, explosion,
and light) ensures that they are synchronized in
the animation.

Create the geometry for the actual explosion, and
wire it to the Strength parameter:

1. Go to the Create Panel and click
Geometry. Choose Standard Primitives from
the drop-down list. Click Sphere, and then
drag in the Top viewport to create a sphere of
any size.

2. Go to frame 200, and if necessary, move
the sphere so it is centered on the DepthCharge
object.

3. Right-click the Sphere, and choose Wire
Parameters from the quad menu (in the
lower-right Transform quadrant). A series of
pop-up menus follows.

4. From the first pop-up menu, choose Object
(Sphere) and then Radius.

The pop-up menu goes away, and the cursor is
now attached to a wiring line.

5. Move the mouse, with the wiring line following
along, from the sphere object to the spherical
Gravity space warp, and click. Another pop-up
menu appears.
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6. From the new pop-up menu, choose Object
(Gravity) and then Strength.

The Parameter Wiring Dialog appears. In this
dialog, you can create relationships between
parameters. These relationships can be
directional, with one value influencing another,
or bi-directional, allowing each parameter to
influence the other.

After you wire the sphere’s Radius to the
Gravity space warp’s Strength, the dialog shows
the first parameter in the upper-left window,
and the second in the upper-right window.

The first thing you need to do is define the
direction of the relationship; in this case, from
the Gravity space warp’s Strength value to the
sphere’s Radius value. You also need to modify the
value. As you can see from the function curve, the
Strength value ranges from zero to 1. The sphere
that models the explosion must be larger than
that. With parameter wiring, you can multiply the
Strength value to obtain a larger value.

Choose the wiring direction and adjust the value:

1. Click the Control Direction arrow that points
to the left (from Radius to Strength).

In the Gravity02 expression text box, at the
bottom of the dialog, Radius is grayed out.
Strength will control the Radius, but the Radius
will have no effect on Strength.

2. In the text field for expressions (at the lower
left, below the Sphere’s tracks), append the text
*25 to the Strength variable. The final text in
this window should read: Strength*25.

3. Click Connect.

By adding a multiplier to the Strength value,
the sphere will have a radius of 25 units when
the Strength reaches 1. While Strength equals
0, the sphere has a radius of 0 and is invisible.
At frame 200, it rapidly grows and then shrinks
back to 0 by frame 220.

4. Close the Parameter Wiring dialog.

Animate the illumination:

You’ll use the same technique to animate the Omni
light that’s linked to the depth charge object.
Currently it has a Multiplier value of 0 and casts no
light. By wiring the Strength value to the Omni
light’s Multiplier, the light will grow and fade
in unison with the growth and shrinking of the
sphere.
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1. Press H to display the Select Objects dialog.
Choose Omni01 in the list, and then click
Select.

2. Right-click the Omni light and choose Wire
Parameters from the quad menu.

3. In the first pop-up menu, choose Object (Omni
Light) and then Multiplier.

4. Drag the wiring line from the Omni light to the
spherical Gravity space warp (Gravity02), and
click the space warp.

5. In the second pop-up menu, choose Object
(Gravity) and then Strength.

6. In the Parameter Wiring dialog, click the
control direction arrow that points to the left.

You have now connected the Strength value to
the Multiplier value.

7. In the Multiplier’s expression window, append
*200 to the Strength variable so that it reads:
Strength*200.

8. Click Connect.

Now the Omni light’s Multiplier, like the radius
of the sphere, is tied to the Gravity space warp’s
Strength. When the Strength increases, so does
the power of the light.

Note: As a general lighting technique, usually
you don’t want to increase a light’s Multiplier
too much, because this washes out colors. In
the case of the explosion, however, washing out
color is exactly what you want to do.

9. Close the Parameter Wiring dialog.

If you preview the animation in a shaded viewport,
you see that the depth charge explodes into
fragments, a sphere grows outward then shrinks to
nothing, and the Omni light flashes on then off.

Creating Bubbles from the Explosion

A blast of bubbles from the explosion enhances the
realism of the animation. To create the bubbles,
you use PCloud, a particle system that emits
particles from the volume of an object or an
emitter icon.

Create the particle system to model the bubbles:

1. On the Create panel, click
Geometry, then choose Particle Systems from
the drop-down list.

2. Click PCloud, then drag in the Top viewport
to create a PCloud emitter. After releasing the
mouse button, click again to set the emitter
height (like creating a Box).

3. With the PCloud selected, go to the
Modify panel. In the Viewport Display group of
the Basic Parameters rollout, change Percentage
Of Particles to 10 %.

PCloud displays all of its particles by default,
but as previously mentioned, displaying this
many particles in viewports considerably slows
down 3ds Max.

4. Go to a frame where the sphere is visible.

5. In the Particle Formation group, choose
Object-based Emitter (changing from the
default, which is Box Emitter).

6. In the Object-Based Emitter group, click Pick
Object, and then select the sphere.

You have now assigned the sphere to be the
PCloud emitter. Particles will be emitted not
from the surface of the object, but instead from
within its volume.
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PCloud created in Top viewport, after assigning the
sphere as its emitter

Next, you need to set a few basic parameters.

Adjust the bubble settings:

1. On the Particle Generation rollout > Particle
Quantity group, make sure the Particle
Quantity radio button is set to Use Rate.

2. In the Particle Motion group, set the Speed
value to 1.0. Choose Direction Vector (instead
of Random Direction), then set the X value to
0.0 and the Z value to 0.5.

This tells the bubble particles to emit at a
constant rate (which you will change in a later
step) and speed along the Z axis: in other
words, vertically within the scene.

3. In the Particle Timing group, set the Emit Start
to 210 and Emit Stop to 260. Set the Display
Until value to 301, and the Life value to 101.

Particles are emitted from frame 210, which
is the peak of the explosion, to 260, after the
explosion has ended, and they live for the
remainder of the animation.

Set up the bubble geometry:

1. On the Particle Generation rollout, in the
Particle Size group, set Size to 3.0, Variation to
25.0 %, and Grow For to 30.

This causes the particles to grow from size 0 to
size 3, with 25 percent random variation, over
the first 30 frames of their life.

2. On the Particle Type rollout, change the
Standard Particles setting to Sphere.

This sets up the particles to render as spheres.

Use parameter wiring to control the emission rate
of the bubble particles:

1. Go to frame 211 so the sphere is visible.
Right-click the PCloud icon, then choose Wire
Parameters from the quad menu.

2. From the first pop-up menu, choose Object
(PCloud) and then Birth Rate.

3. Move the wire line to the sphere, and click the
sphere.

4. From the second pop-up menu choose Object
(Sphere) and then Radius.

5. In the Parameter Wiring dialog, click the
Control Direction arrow that points left (from
the Sphere object to the PCloud object; the
names are above the parameter lists).

6. In the box under the PCloud’s parameters list
(current contains “Radius”), change the Birth
Rate’s expression to read 1+(Radius*5).

This expression accomplishes two things:

• The value of Radius, 0 to 25 to 0, doesn’t
give us as many bubbles as we want, so we
multiply it by 5, just as earlier we obtained
the radius by multiplying the Gravity space
warp’s Strength.

• Over the period of emission, from frame
210 to 260, we want particles to be emitted.
But the Radius returns to 0 at frame 220. So
adding 1 to the value ensures that particles
will be emitted at a rate of 1.0 from frames
220 to 260.

7. Click Connect.

8. Close the Parameter Wiring dialog.

The power of creating relationships with parameter
wiring is that instead of keyframing all of the
tracks by hand, you can create a dependency on
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certain tracks so that when you change one, the
rest follow. This can make animating and adjusting
complex scene much faster and easier.

Finally, you’ll add turbulent motion to the bubbles
to enhance their realism. To do this, you’ll use a
Wind space warp with turbulence but no strength.

Add turbulent motion to the bubbles:

1. On the Create panel, click Space
Warps and choose Forces from the drop-down
list.

2. Click Wind, then drag in the Top viewport to
create the Wind space warp.

Wind space warp created in Top viewport

3. With the Wind space warp selected,
go to the Modify panel. Set Strength to 0.0,
Turbulence to 0.02, Frequency to 0.12, and
Scale to 0.07.

Setting the Strength to zero turns off the
directional force of the wind, but the turbulence
settings are still active.

4. Click Bind To Space Warp.

5. Drag from the Wind space warp to the PCloud
particle system (or vice-versa), then release the
mouse button.

If you play the animation at this point, you see the
depth charge explode into fragments as a spherical
explosion blows out and then sucks inward as

bubble particles are emitted from it. These bubbles
float slowly upward in a turbulent fashion.

Assigning Transparent Materials

At this point, both the explosion itself and the
bubbles would render as solid objects. To make
them appear as gas in water, you assign materials.

Assign pre-made materials to the effects in your
scene:

1. Go to a frame where the explosion sphere is
visible in viewports.

2. Open the Material Editor.

3. Select the Explosion material in the upper-left
sample slot and drag it onto the sphere.

The Explosion material uses maps to
create a translucent material with a lot of
self-illumination.

4. Select the Bubbles material, to the right of
the Explosion material, and drag it onto the
PCloud particle system.

The Bubbles material is simply a Standard
material with a light blue color and advanced
transparency settings (found on the Extended
Parameters rollout). The transparency settings
include opacity falloff, which makes the bubbles
look hollow, and additive opacity, which
brightens colors behind the bubbles.

5. Close the Material Editor.

Enhancing the Atmosphere

The final touches to the animation are to add a Fog
atmosphere to the scene, making the water look
murky, and a Volume Light atmosphere to the
Omni light, making the light from the explosion
diffuse throughout the water, as if reflected by
particles in the water.
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Add the fog:

1. Choose Rendering > Environment to open the
Environment and Effects dialog.

2. On the Atmosphere rollout, click Add.

3. In the Add Atmospheric Effect dialog, choose
Fog from the list, then click OK.

4. On the Fog Parameters rollout, click the color
swatch, and use the Color Selector to specify
a dull blue color: Red=131, Green=166,
Blue=178.

5. In the Standard group of the Fog rollout, change
the Far value to 75 % and turn on Exponential.

Add the volume light:

1. Press H to display the Select Objects dialog.
Choose Omni01 in the list, and then click
Select.

2. Go to the Modify panel, and open the
Atmospheres & Effects rollout.

3. Click Add.

4. In the Add Atmosphere Or Effect dialog, choose
Volume Light from the list, then click OK.

5. Go back to the Environment dialog and in the
Atmosphere rollout choose the Volume Light
entry.

6. On the Volume Light Parameters rollout, set
Density to 3.0.

The Final Animation

You are now ready to activate the Camera01
viewport and render the entire animation. Even at
low resolution, this can take about half an hour.
Alternatively, you can play the file sub_scene.avi,
provided on the Tutorial Files CD.

Further Animation

If you played the animation, you might have
noticed that the camera appears to shake when the
depth charge explodes. This is an "easter egg" in
sub_scene.max. Specifically, a Noise controller
has been assigned to the Z Position track of the
camera target, making it shake between frames
200 and 219.

Summary

These tutorials show how the non-event-driven
particle systems in 3ds Max, while not as
sophisticated as Particle Flow, are capable of a
wide range of effects, including a stream of smoke
drifting in the air, water gushing from a fire
hydrant onto the pavement, and a depth charge
blowing up upon impact with a submarine. They
also show how to apply forces such as wind and
drag to particle streams, and to use parameter
wiring to automatically animate different effects
in concert to create more convincing particle
animations.
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Modeling Whipped Cream
BlobMesh is a compound object in 3ds Max that
creates a set of spheres from geometry, shapes, or
particles, and connects the resulting mesh together
as if the spheres were made of a soft substance.

When the spheres are animated and come within
a certain distance of one another, they connect
together. When they move apart, they become
spheres again.

BlobMesh is particularly powerful with particle
systems such as Particle Flow, where you can use it
to make the particles appear thick and viscous.

Here, you will use an existing particle flow
animation, and add BlobMesh to the particles to
make them look like a thick, liquid substance.

Set up for this lesson:

1. Open the file tut_blobmesh_start.max from the
tutorials\blobmesh folder.

This file contains animation of a can of
whipped cream spraying particles onto a bowl
of strawberries.

2. Play the animation.

The particles are tetrahedrons. There are
deflectors on the strawberries, the bowl, and
the tabletop, and the particles are set up to stop
moving when they hit any deflector.

Create the blobmesh:

1. Choose Create panel > Geometry
> Compound Objects.

2. Click BlobMesh, and click anywhere in the
scene to create one blobmesh sphere.

3. Go to the Modify panel.

4. In the Parameters rollout > Blob Objects group,
click Add. Select PF Source 01, then click Add
Blobs.

This adds the particles to the blobmesh object.

5. Play the animation.

The particles are replaced by blobs. The blobs
obtain their sizes from the particle sizes.

In the viewport, some of the smaller particles
will appear not to be surrounded by blobs. This
is because BlobMesh uses a different level of
detail for viewports and renderings.

6. Press M to open the Material Editor. Select the
material named Whipped Cream, and drag it
over BlobMesh01 in the scene.
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The whipped cream changes in the viewport
when the material is assigned to it.

7. Render a frame to see how the blobs look in the
final rendering.

Tip: You can add a Relax modifier to the
BlobMesh01 object to make the blobs look
softer.

You can find a finished version of this scene in
the file tut_blobmesh_finish.max. You can also
see an animation created with this scene in the
file tut_whippedcream.mov.

Summary

The BlobMesh compound object provides an easy
way to make soft, liquid substances, especially
when used in conjunction with a particle system.

Lens Effects

In this tutorial, you’ll create a glowing sun using
Lens Flare, Glow, and Star.

Skill Level: Intermediate

Time to complete: 30 minutes

Features Covered in this Tutorial

• Creating and manipulating a camera viewport

• Using omni lights to light your scene

• Creating and manipulating a Glow lens effect

• Using multiple Glow lens effects to create an
ambient lighting effect

• Creating and manipulating a Ring lens effect

• Creating and manipulating a Star lens effect
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Tutorial Files

All the necessary files to do the tutorials can
be found on the Tutorial Files CD, in the
\tutorials\lens_flares folder. Before doing the
tutorials, copy the \tutorials directory from the CD
to your \3dsmax8 local installation.

Adding a Camera View
Set up your scene:

Files for this tutorial are in the \tutorials\lens_flares
directory.

1. On the File menu choose Open, and then
choose tut_marsandsun.max.

2. Activate the Top viewport and zoom out.

3. On the Create panel, click the Cameras
icon and click Target in the Object Type rollout.

4. Click near the bottom of the Top viewport, drag
toward Mars, and release.

This creates a target camera pointing at the
center of Mars.

5. Activate the Perspective viewport. Change it to
a camera viewport by pressing C.

6. Click Truck Camera. In the Camera
viewport, pan the viewport to the left so there
is space for the sun on the right side of Mars.
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Adding Lights

There are no lights in the scene. In this step, you’ll
add two Omni lights: one to light Mars, and the
other to be the Sun.

Light your scene:

1. From the Create menu, choose Lights >
Standard Lights > Omni.

2. In the Top viewport, click to create an Omni
light to the right and below Mars. Name it
marslight.

3. Create a second omni light to the right and
above Mars. Name it Sun.

4. Select Sun and at the top of the Modify panel,
click the color swatch. The Color Selector
appears. Change the color to a yellow-orange
and click OK.

Note: Both lights are adding illumination to
the scene. With the camera in front of Mars,
the lighting of the sun doesn’t really add to the
illumination on the dark side of the planet. If
this becomes a problem later, you can exclude
this light from illuminating any objects in the
scene.

5. Move marslight left or right to create a lighting
effect you like for the dark side of Mars.

Now use contrast to add some drama to your
light.

6. In the Modify panel, go to the Advanced Effects
rollout > Affect Surfaces group, and increase
the Contrast setting for marslight to 77.

You won’t see the changes until you render the
scene.

7. Activate the Camera viewport, then on
the toolbar, click the Quick Render button.

You still don’t see the light that will be your Sun
in the rendered image. It won’t appear until you
add effects in the next topic.

Tip: Try different contrast values and render
each one. The higher the value, the sharper the
edge of the light.
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Adding a Glow to the Sun Using
Lens Effects

In this topic, you’ll create a simple glow effect and
add a ring and a star effect to it. This will allow the
Sun to glow in the sky above the planet.

You can add as many different effects as you like
to create the sun’s glow. Try this effect, and then
experiment with others.

Create a glow effect:

1. In the Camera viewport, select the Omni light
named Sun.

2. Go to the Modify panel and click the
Atmospheres & Effects rollout title to open it.

3. Click the Add button. The Add Atmosphere Or
Effect dialog appears.

4. In the list, click Lens Effects, and then click OK.

Lens Effects is now listed in the Atmospherics
and Effects window.

5. Click the Lens Effects name in the window and
click Setup.

The Environment and Effects dialog appears.
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6. In the Name field, name this lens effect Sun.

The name is changed in the windows in the
rollout and the dialog.

7. In the Preview group, turn on Interactive.

A rendered frame window appears. This lets
you see the lens effect as you make changes.

Tip: You should turn off Interactive when
working in a complex scene, but it’s useful for
experimentation.

8. On the Lens Effects Parameters rollout, choose
Glow in the list on the left. Click the right arrow
to move the effect into the list on the right.

After a brief delay, the light source appears as a
glowing sphere in the virtual frame buffer.

9. Scroll down to the Glow Element rollout. In the
Name field, enter Main Sun.

To change the look of your Sun, try the
following settings in the Glow Element rollout:

• Set Size to 50.0.

• Set Intensity to 200.0, producing a very
bright glow.

• Set Use Source Color to 50.0.

• In the Circular Color group, set Mix to 50.0,
giving the Sun a soft red glow.
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Tip: With Interactive on, you’ll get faster
results by changing numeric settings with
the keyboard, rather than using the spinners.

Adding a Ring Effect

Now you’ll add a ring effect to the Sun’s glow.

Enhance your sun with a ring effect:

1. In the Effects tab of the Environment and
Effects dialog, scroll up to the Lens Effects
Parameters rollout. Choose Ring and move it
to the list on the right. A ring appears around
the Main Sun in the Effects Preview window.

2. Scroll down to the Ring Element rollout and
make the following settings to define the ring:

• Set Size to 22.0.

• Set Thickness to 33.0, giving the ring more
of a glowing perimeter.

• Set Use Source Color to 50.0.

These changes make the ring more
dramatic-looking, but it still needs some
intensity to make it look like a glowing Sun.
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Adjust the ring effect:

By increasing the intensity of the main glow and
juggling the size and thickness of the ring, you can
control the size of the white-hot center of the sun.

1. Increase the intensity of the Ring Element to
133.0.

2. Lower the size of the ring to 14.0.

3. Increase the thickness of the ring to 65.0.

4. Turn on Glow Behind to place the glow from
the Sun behind the planet.

Now the Sun looks more realistic.

Adding a Star Effect

Now you will add a star effect to the Sun’s glow.

Add a star effect to your sun:

1. In the Effects tab of the Environment and
Effects dialog, scroll up to the Lens Effects
Parameters rollout. Choose Star from the
effects list and move it to the list on the right.
A Star effect appears over the Main Sun in the
Effects Preview window.

2. Scroll down to the Star Element rollout, and set
the following:

• Set Qty (the number of points in the star)
to 8.

• Set Intensity to 50.0

• Set Sharp to 5.0.

• Turn on Glow Behind.

• Experiment with Width and Taper before
setting them to 1.0 and 0.1, respectively.

You might find that your effects are incorrect if
the Sun moves behind the planet. You can fix
this by adjusting the effect’s Occlusion settings.
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Improve the star effect by adjusting occlusion
settings:

1. In the Camera viewport, move the Sun omni
light so it’s just on the edge of the planet.

Because Interactive is turned on, the rendered
frame window updates automatically.

2. Go to the Lens Effects Parameters rollout and
select main sun from the right-hand window.

3. Scroll down to the Glow Element rollout and
set Occlusion to 0.0.

4. Return to the Lens Effects Parameters rollout
and select Ring from the effects list in the
right-hand window.

5. Scroll down to the Ring Elements rollout and
set Occlusion to 0.0.

Adding Another Glow

The effects you’ve added to the Sun have included
the Glow Behind option, so they are not adding a
glow to the planet, which is in front of the light.
Now that your Sun is glowing in the sky, you need
to add glow to the planet itself.

Add a second glow to your scene:

1. Select the planet in a viewport. Right-click and
choose Properties in the Transform quadrant
of the quad menu.

2. In the Objects Properties dialog > G-Buffer
group, change Object Channel to 1 and click
OK to close the dialog.

3. In the Environment and Effects dialog > Lens
Effects Parameters rollout, add another Glow to
the list of effects.

Note: If you closed this dialog you need to
select the Sun omni light and click Setup on the
Atmospheres & Effects rollout.

4. In the Glow Element rollout, rename this effect
Glow on Planet.

5. Click the Options tab and in the Image Sources
group, turn on Object ID.

Notice that the number is set to 1 by default.

The planet now renders with a bright white
glow. This is too intense.

6. Click the Parameters tab. Set Occlusion to 0.0
and turn off Glow Behind.

7. Change Intensity to 45.0 and Source Color to
50.0.

8. In the Radial Color section, change the white
color swatch to a darker brick red.

The planet is looking better now.
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Tip: If the planet is still shadowy, move the
marslight closer to the planet in the Top
viewport.

Make global adjustments:

On the Lens Effect Globals rollout, you can make
global adjustments to control the whole effect.

1. Experiment to see what happens when you
change Size to 11.0, 22.0, and 33.0.

As an additional exercise, try animating the
effects’ settings.

2. Save the scene as mymarsandsun.max.

Summary

This tutorial has shown how to create Glow, Ring,
and Star lens effects, and how to adjust their
settings. It also showed how multiple Glow effects
can create the effect of ambient lighting, how to
create and navigate a camera viewport, and the use
of omni lights for scene illumination.
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biped with freeform animation 1–291
carrying and dropping 2–530
climbing a ladder 2–522
crowds 2–638
facial expression targets 2–481
mechanical design 2–58 to 2–59
pool table surface 3–132
render effects 3–90, 3–92
rotation changes 3–23
spacefighter 1–241, 1–246
still life 3–26
still life objects 3–23
using the move transform 1–223
walk cycle with IK constraints 1–359
watch 1–270
with camera map 3–132 to 3–133
with dummies 1–223

Index
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animation
animated still life 3–16
animating a walk cycle for a character 2–452
character 2–576
character rigging 2–361, 2–377, 2–379
creating 1–255, 3–16
creating keyframes 1–270
creating track sets 1–270
daylight 1–434
dummies 1–255
dummy objects 1–230
freeform 2–576
ghosting 1–227
HI solver 2–361
IK 2–361
inheritance 2–377
keyframe 1–223
keyframing 1–224, 1–255
look-at controller 2–379
loop 2–612
mars 1–255
mirroring 2–335
play animation 1–224
quadruped 2–576
rendering 3–26
space station 1–255
suspension 2–64
synchronizing with video 3–126
wire parameters 2–379

animation controllers 1–237
copying 1–270

animation tracks 1–270
anisotropic shader 1–119
antialiasing and rendering quality 1–440 to 1–441
appearing and disappearing 3–85
apple

adding a stem to 1–112
applying skin to 1–106
creating 1–106
positioning 1–110
shaping 1–108
tapering 1–106

applied IK 2–74
apply an architectural material 1–169
applying

avoidance 2–644
logic to crowd behavior 2–646

arcade 2–176
Architectural Desktop

editing material definitions 2–149
sharing materials with 2–146

Architectural Desktop drawings
file link 2–139

import 2–139
architectural material 1–169
architecture

materials 1–155
area lights

mental ray renderer 2–838
area shadows 1–437
arms

applying a matte/shadow material to 3–130
creating a matte object for 3–129
rendering 3–130

array 2–12
assembly, luminaire 2–53
asset tracking

adding files to vaults 2–942
Asset Tracking Systems 2–937
checking files into vaults 2–944
checking out files from the vault 2–945
checking version history 2–945
creating new vaults 2–940
logging into vaults 2–941
modifying files 2–944
revising asset paths 2–938
working folders 2–942

asteroid 2–885, 3–28, 3–33
atmospheric effects

volume fog 3–10
volume light 3–10

attach to node 1–396
audiences 1–1
AutoCAD drawing (DWG) file 2–86
AutoCAD drawings

file link 2–82, 2–105
import 2–82
preparing for import 2–83

AutoCAD import 2–154
AutoCAD links 2–153
AutoCAD, importing 3D DWG files 2–101
Autodesk Vault 2–937
avi 1–432
avoidance behavior 2–644

B
background

movie 3–137
specifying the background for rendering 3–7

background - for camera match
checking the rendering resolution 3–119
displaying in the viewport 3–120
displaying using different files 3–120
setting up for rendering 3–118

background image 2–1
setting up 1–48

bake texture 2–293
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ball
animating 1–223
bouncing 1–230

ballistic tension 1–319
baseboard 3–62
basic materials - creating/changing 1–119
basic rendering 1–424
basketball

biped interacting with 2–506
batch render 3–72
batch rendering 3–61
beetle - speaking 2–476
beginning user 1–1
behaviors 2–638
bend modifier 1–112
bezier position 1–223
binding kinematic chains 2–70
biped

animating with footsteps 1–294
create 1–383
creating 1–282
euler rotations 2–502
freeform animation 1–291
function curves 2–502
posing 1–283
retargeting motion 2–493
skeleton 1–282
transferring animations 2–493
twist links 2–498

biped retargeting
about 2–493
adjusting the animation 2–495
retargeting bipeds 2–494
retargeting limbs 2–494

blending
forward and inverse kinematics 2–506

blinn shader 1–119
blobmesh 1–473
bones

arms 2–345
bone tools 2–337, 2–342, 2–348, 2–361, 2–377, 2–379
character rigging 2–349
color 2–337
creating 2–300
creating and editing 2–337
hands 2–345
mirroring 2–335
renaming 2–337
rig 2–349

boolean
creation 2–45
subtraction 2–45

boolean subtraction 1–29, 2–168

booleans
2D 2–9
3D 2–9

bottle shape
applying multi/sub-object materials to 1–136
applying raytrace materials to 1–139

box modeling 2–199
boxes, using for a pool table surface 3–132
bubbles - and particle systems 1–464
bulge angle deformer 2–425, 2–439
bump maps

normal 2–251

C
camera

script 2–925
camera constraint 1–276
camera map modifier 3–125, 3–133
camera match

about 3–114
adjusting the match 3–124
assigning 2D screen points 3–121
camera match points 3–139
checking the rendering background resolution 3–119
creating a camera for testing 3–121
displaying the background using different files 3–120
guidelines for using 3–115
installing the software driver 3–121
modifying camera position 3–121
placing CamPoints 3–116
placing the camera 3–121, 3–124
preparing the scene 3–115
selecting reference points 3–115
setting up a rendering background 3–118
setting up a viewport background 3–120
troubleshooting 3–124

camera shader
mental ray 2–849

camera tracker 3–136 to 3–137, 3–139, 3–144
loading the movie 3–141
matching a moving camera 3–146
smoothing and compositing 3–147

cameras using for fly-by 2–180
CamPoints 3–139

matching to the background image 3–121
placing 3–116
troubleshooting 3–124

carrying and dropping motions 2–530
caustics (reflective)

mental ray renderer 2–826
caustics (refractive)

mental ray renderer 2–831
channel info utility 1–204
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character
animation 2–446, 2–576
arms 2–345
assembly 2–447
bone tools 2–361, 2–377, 2–379
bones 2–337, 2–342
hands 2–345
head bones 2–348
legs 2–337
mapping 2–236
modeling 2–361, 2–377, 2–379
monkey head 1–92
multilegged 2–576
pelt mapping 2–243
quadruped 2–576
rigging 2–299, 2–361, 2–371, 2–377, 2–379, 2–383,

2–390 to 2–391, 2–447
skin pose 2–379, 2–390
spline IK 2–342
walk cycle 2–446
xref 2–446

character modeling
low polygon 2–199

character rig 2–349
IK solver 2–305

character rigging
script controller 2–383
wrist twist 2–383

character studio
included in 3ds Max 8 1–281

chess set
modeling 1–21
modeling a bishop 1–29
modeling a knight 1–35
modeling a pawn 1–21
modeling a rook 1–31

child overlap 1–400
cigarette smoke 1–457
climbing motion 2–522
clip creation

motion flow 2–607
clone object 2–47
clone rendered frame window 1–439
cloning 3–80
cloning a door 3–107
close-up of a head

lighting 1–415
close-up shot 1–144
cloth

tutorials 2–766
cloth modifier 2–793
collision effect 2–886

color
changing 3–20
for pool table surface - selecting 3–132
of basic materials - changing 1–119

columns, creating 2–2, 2–12
comics rendering 1–215
comparing trajectories 2–623
compound object

boolean 2–45
compound rigid bodies 2–686
connection rollout

mental ray 2–856
constraints and controllers 1–246
contour shading

mental ray renderer 2–856
contours and NURBS head 1–93
control point 1–400
controller

bezier position 1–223
changing controller types 1–237, 3–3 to 3–4
character rigging 2–321
noise 1–223, 1–237
position list 1–223, 1–237
weighted list 1–223

controllers
applying to multiple biped objects 2–631
applying using Workbench 2–631

controlling in-betweens 1–227
converting a shape to 3D geometry 3–129
converting footstep to freeform 1–332
cool material - identifying 1–118
coordinate system, local 2–42
copy

motion 2–614
copy object 2–47
courseware 1–3
crash and splatter effects 2–885
create

biped 1–383
create camera from view 3–124
creating

a boolean 2–45
a cylinder 2–42
an architectural material 1–169
crowd of swimming bipeds 2–657
distinctive walk 1–303
explosion 2–904
illusion of weight 2–534
layers 3–95
motion flow script 2–608
objects in AutoCAD 2–86
particle system 2–905
simple freeform animation 1–344
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terrain 2–156
the museum building 2–2, 2–9, 2–17

creating skin material 1–151
crowd

with animated non-biped objects 2–649
crowd animation 2–638
cue ball - animating 3–126 to 3–127
Curve Editor 1–223, 1–230

function curve 1–227
keyframes 1–229
parameter curve out-of-range types 1–229
Track View 1–227

curves (Track View), animating a ball with 1–230
custom attributes

character rig 2–317, 2–321, 2–349
cylinder - creating 1–112

D
daylight

animation 1–434
daylight system 1–448

decay parameter - adjusting 1–110
deformable bodies tutorial 2–719

cloth 2–719
deforming meshes 2–737
ropes 2–728
soft bodies 2–731

delete
operator (particle flow) 2–915, 2–921

DEM files 2–182
depth of field (DOF)

mental ray renderer 2–822
design visualization 1–169, 1–448, 2–1, 2–12, 2–58, 2–153
DGS material shader

mental ray 2–863
dielectric material shader

mental ray 2–867
diffuse color - changing 1–119
displace modifier 1–110
displacement effect - adjusting 1–110
displacement mapping 1–144
display proxies 2–689
distortion shader

mental ray 2–854
DOF (depth of field)

mental ray renderer 2–822
doors

animating 3–108
applying materials to 3–104
cloning 3–107
creating 3–101

Dope Sheet editor 1–236
Dope Sheet mode 1–236
drawing (DWG) file, editing a 2–86

drawing files
missing maps 2–117
origin setting 2–117
smoothing 2–117
thickness setting 2–117
troubleshooting 2–112 to 2–113, 2–117

drawing lines 1–21
drivers

switching 3–121
dummy objects

animation 1–230
linking a ping-pong ball to 1–230

dwf
export 2–79

DWF
exporting 2–78

dwf viewer 2–80
dwg 2–133
DWG files 2–86

file link 2–82, 2–105, 2–139
importing 2–82
linking 2–139

E
e-learning 1–3
ear

modeling 1–101
edit

AutoCAD drawings 2–86
drawing (DWG) file 2–86

edit normal
modifiers 1–90

editable patch modifier - modeling facial expression
targets 2–481

editable poly 1–78, 1–80, 2–199
editable polygon

bevel 2–24
chamfer 2–31
convert 2–24
cut 2–24
extrude 2–24, 2–31
slice 2–24

editing
motion flow 2–606
with layers 2–626

enclosure 3–98
envelopes 2–426

adjusting 1–400
overlapping 1–404

environment shader
mental ray renderer 2–860

errors
finding and fixing 2–634

euler rotations 2–502
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explosions 1–464, 2–904, 2–919, 3–74
adding light 3–87
and particle arrays 3–82, 3–84

export 2–133
exporting

DWF 2–78
exposure control 1–448
expression target 2–481
extrude modifier 3–129
eyedropper - selecting materials with 1–115
eyes

modeling 1–98

F
facial expression

creating with the morpher modifier 2–475, 2–481
modeling with the editable patch modifier 2–475,

2–481
targets for 2–481

fall - animating 1–332
fast skin shader 2–874
FFD modifier 2–476
figure mode 1–386
file link 2–133
File Link 2–132
file link manager 2–133

Architectural Desktop materials 2–146
linking drawings 2–105

File Link Manager 2–137
file link to drawing (DWG) files 2–82, 2–105, 2–139
film and broadcast 2–925, 3–1
filters

using 2–628
final gathering

mental ray renderer 2–835
find target test (particle flow) 2–904, 2–910 to 2–911
Finishing the Plane 1–76
fixing animation

errors 2–634
fixing drawings 2–112 to 2–113, 2–117
fixing DWG files 2–112 to 2–113, 2–117
FK - using with IK 2–446
flames effect 2–902
flare effect 3–14
flex 1–223, 1–240

secondary motion 2–444
flips 1–319
floors

adjusting tiles with UVW map modifier 1–180
materials 1–174

flying a camera around the design 2–180
flying the spacefighter 1–241
foliage 2–182

foot
pinning to objects 2–511

footstep animation
bipeds 1–294

footsteps 1–302
and IK keys 1–341

force operator (particle flow) 2–921
forward kinematics 2–64

blending with IK 2–506
foundation, creating a building 2–9
fracture 2–696
fragments - and particle systems 1–464
freeform

animation 2–576
freeform animation

animating bipeds 1–291
freeze layers 2–168

G
game production 2–293
garment maker modifier 2–793
getting started with crowds 2–638
getting started with design visualization 3–93
ghosting frames, changing 1–223
gizmos - adjusting 1–110
glass material

mental ray 2–862
glass, creating 2–12
global illumination 1–437

mental ray renderer 2–835
globe

material 3–1
rotating 3–1

glow 1–481, 3–88 to 3–90
glowing objects 1–446
Goco character head 1–92
gondola - airplane 1–68
gravity effect 2–889
grid - setting up 3–129
groups

animating 2–638
gymnastic motion flips 1–319

H
hand

pinning to object 2–506
hand animating with reactor 2–694
head

modeling 1–93, 1–97, 1–102, 1–105
HI solver

arms 2–371
shoulder 2–391

hiding unselected objects 1–106, 1–112
hierarchical linkage 1–223
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hierarchical subdivision surface modifier 1–89
hierarchy 2–134
high frequency data 2–624
hinge from edge tool 1–80
hips

envelopes 1–404
hot material - identifying 1–118
hub, revolving door 3–95

I
IK

mirroring 2–335
solver 2–305
with FK 2–446

IK blend 2–506
with feet 2–511
with hands 2–506

IK chain
parent space 2–305, 2–335

IK object
using with feet 2–511
using with hands 2–506

importing
3D AutoCAD models 2–101
3D DWG files 2–101
an AutoCAD file 2–82 to 2–83, 2–154
drawing files 2–82
DWG files 2–82
motion capture data 2–621

in place mode 2–546
in-betweens 1–223
ink ’n paint material 1–215
install 1–3
installing drivers 3–121
installing the software driver 3–121
instanced geometry 2–905
instanced lights 1–419
interactive IK 2–73
interior materials 1–155
interpolation 1–230

changing 1–223
introduction 1–1

to materials and mapping 1–114
introduction to rendering 1–424
introductory tutorials 1–1
Inventor interoperability 2–125

importing assemblies 2–127
importing assemblies with materials 2–128
mesh resolution option 2–125
vertical axis direction, controlling 2–130

inverse kinematics 2–64
inverse kinematics - mirroring 2–335
iron

biped interacting with 2–506

J
joint angle deformer 2–425, 2–439
jpg 1–432
jumping

and running 1–312

K
keyframe animation

applying to a matte object 3–130
controlling in-betweens and 1–223
dummy objects and 1–230
move transform and 1–223

keyframing
IK blend 2–530

keys
for lip sync 2–481
for the cue ball - adding 3–127
reducing 2–628

kinematics 2–64
knife - applying raytrace material to 1–139
knight chess piece 1–35

L
ladder

animating climbing 2–522
biped climbing 2–506

land planning 2–153
landXML files 2–182
laser blast 3–74
layer manager 2–56
layered animation 1–223, 1–237
layers 2–134

use of 2–612
layers, creating 3–95
layout mode 1–230
learning 3ds Max 1–3
learning and training cd 1–3
legs

envelopes 1–404
lens effect 1–477
lens flare

creating sun with 1–474 to 1–477, 1–479 to 1–481
level design 2–264

adding mapping and materials 2–267
adding trees with object painter script 2–282
creating a building 2–265
merging content into a scene 2–272
painting vertex color 2–280
using xrefs to add streetlight 2–274

light lister tool 1–419
light tracer 1–437
lighting

advanced lighting override material 1–437
area shadows 1–437
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close-up of a head 1–415
global illumination 1–437
light tracer 1–437
radiosity 1–437
spotlight 3–8

lights
adding to a scene 1–409
adding to explosions 3–87
introduction 1–409
multiple instances 1–419
standard 1–452

Limit Controller 2–187
Link 2–137
linked data 2–134
linking 2–133

character rigging 2–311
DWG files 2–139

linking drawing files 2–82, 2–105, 2–139
linking to dummies 1–223
lip sync 2–475

creating with the morpher modifier 2–481
expression targets 2–481
requirements for 2–481
setting keys for 2–481
with modifiers 2–476

list controller
character rigging 2–321

local coordinate system 2–42
lofting 1–102
logarithmic exposure control 1–448
logic and crowd behavior 2–646
lookat constraint

wiring weights 2–391
loop

animation 2–612
motion flow 2–612

looping 2–624
low-polygon character

creating arms 2–219
creating boots 2–203
creating pants 2–208
creating the helmet 2–225
creating the neck 2–233
creating the oxygen mask 2–230
creating the torso 2–214
creating the visor 2–229
modeling 2–199
scene setup 2–200
smoothing 2–235

luminaire 2–53

M
managing

an Architectural Desktop file 2–139

drawing files 2–139
managing interior materials 1–155
map paths 2–132
mapped materials 1–159
mapping 1–141

adding to an object 2–267
characters 2–236
flat mirror 1–141
mapping coordinates 1–128
opacity 3–79
pelt 2–243
raytrace 1–139
reflection 1–141
synchronizing animated maps 3–80

mapscaler 2–135
mapscaler, object space 1–181, 1–186
mapscaler, world space 1–186
mask material 1–174
mass distribution 2–688
match camera to view 3–124
material

assigning to objects 3–7
skin 1–151

Material Editor 1–141, 3–1
materials 1–107
moving materials to 1–115
using 1–118

material operators
dynamic 2–918

material picker 2–135
materials 1–141, 3–104

about 1–115
adding mask material 1–174
adding to an object 2–267, 3–22
adding to terrain 2–158
and particle arrays 3–83
applying 3–133
applying in particle flow 2–918
architectural 1–169
assigning 3–1
assigning to objects 1–118
basic - creating 1–119
changing color 1–119
creating for explosion 3–78
exporting to Architectural Desktop 2–146
floor material 1–174
for architecture 1–155
for laser blast 3–75
getting from the scene or from 3ds Max files 1–115
hot and cool 1–118
ID numbers 1–136
in Architectural Desktop 2–149
ink ’n paint 1–215
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introduction 1–114
loading libraries 1–115
multi/sub-object 1–136
multiple materials to one object 1–162
of one color 1–155
raytrace 1–139
texturing the chessboard 1–141
translucent 1–221

matte object
applying a matte/shadow material to 3–130
creating 3–126, 3–129
keyframing 3–130

matte/shadow material
camera map animation and 3–133
creating and applying 3–130

MAXScript 2–282
camera manager 2–925
for effects 2–925
unhide 2–930

mechanical design, animating 2–58 to 2–59
mental ray

camera shaders 2–849
contour shading 2–856
DGS material shader 2–863
dielectric material shader 2–867
distortion shader 2–854
environment shader 2–860
glass material 2–862
materials 2–862
mental ray material 2–863
night shader 2–852
ocean shader 2–871
submerge shader 2–871
using a shader as a map 2–846
water surface shader 2–871
wraparound shader 2–849

mental ray connection rollout 2–856
mental ray material

mental ray 2–863
mental ray materials 2–862
mental ray renderer

area lights 2–838
depth of field (DOF) 2–822
final gathering 2–835
global illumination 2–835
motion blur 2–818
reflections 2–810
reflective caustics 2–826
refraction 2–814
refractive caustics 2–831
sampling 2–806
trace depth 2–810

mental ray shaders 2–867, 2–871

merging content into a scene 2–272
merging files 3–111
mesh select modifier 1–108, 1–110
metal shader 1–119
mirror

skin settings 2–426
mirroring 1–102, 2–335
modeling

a bishop 1–29
a chess set 1–21, 1–29
a pawn 1–21
a rook 1–31
airplane 1–46
align 1–255
bones 2–361, 2–377, 2–379
dummy object 1–255
ear 1–101
editable poly 2–199
eye 1–98
facial expression 2–481
head 1–92 to 1–93, 1–97, 1–102, 1–105
improvements 1–78
level design 2–264
move/rotate/scale 1–255
planets 3–29
space scene 3–28 to 3–29

modes
in place 2–546
motion flow 2–607

modifiers 1–78
bend 3–4
cloth 2–793
editable patch 2–475
extrude 3–4
FFD 2–475 to 2–476
garment maker 2–793
hsds 1–89
mesh select 1–106, 1–108
morpher 2–475
parametric deformers 1–107
skin 2–426
spline IK control 2–330
surface 1–35
unwrap uvw 1–192
vertex weld 1–79

modifying
biped structure in figure mode 1–386
footsteps 1–312

monkey head 1–92
moon - creating for close-up shot 1–144
morph

morph objects and topology change 1–212
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morph targets
lip sync 2–481

morpher modifier - creating lip sync and facial
expression 2–481

morphing animation 1–204
motion

copy 2–614
random 2–617
transfer 2–614

motion blur 3–86
mental ray renderer 2–818

motion capture
importing data 2–621
layers 2–626

motion flow
add clip 2–607
clip creation 2–607
editing 2–606
loop 2–612
script 2–608
shared 2–614, 2–617
tutorial 2–606 to 2–608, 2–612, 2–614, 2–617

motion flow script
create 2–608

motion mixer 2–547
motion-capture

working with 2–621
mound on pool table surface - animating 3–133
mouth-shape targets for speech 2–481
move transform, animating a ball with 1–223
multi-layer shader 1–119
multi/sub-object materials - applying to a label and

bottle 1–136
multilegged

character 2–576
multiple booleans 2–171
multiple delegates and behaviors 2–641
multiple materials to one object 1–162
multiplier curves 1–223

N
naming

a sphere 3–20
selections 1–108

new feature in v8
animation tracks 1–270
asset tracking 2–937
biped retargeting 2–493
cloth modifier 2–793
euler rotations 2–502
function curves on bipeds 2–502
garment maker modifier 2–793
Inventor interoperability 2–125
Limit Controller 2–187

pelt mapping 2–243
twist links 2–498
vertex selection tools 2–442
Weight tool 2–435

night shader
mental ray 2–852

noise controller 1–223
noise controller, adjusting 1–237
nonlinear animation 1–223, 1–237
normal bump maps 2–251
normals 1–90
NURBS

creating contours 1–93
creating ear 1–101
creating eye 1–98
head - completing 1–105
head - mirroring and lofting 1–102
head - previewing 1–97
modeling with 1–92

O
object painter script 2–282
object space mapscaler 1–181, 1–186
object-space camera map modifier (OSM) 3–133
objects

assigning materials to 1–118
available for modeling 3–16
matte objects 3–126, 3–129 to 3–130
parametric objects 3–16
primitive objects 3–16
unselected - hiding 1–106, 1–112

ocean shader
mental ray 2–871

online support 1–3
online tutorials 1–4
opacity value of basic materials - changing 1–119
orange

applying basic materials to 1–119
creating orange 3–20
creating orange peel 3–20

oren-nayar-blinn shader 1–119
orientation constraint

character rigging 2–371

P
painting - vertex color 2–283
painting - with vertex color 2–280
panorama exporter 1–455
parameter collector 2–189

animating parameters 2–194
organizing 2–190
selecting parameters 2–190

parameter out of range curves 1–223
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parameter wiring
character rig 2–317, 2–321, 2–349
character rigging 2–371, 2–391

parametric objects - types of 3–16
parent overlap 1–400
particle flow

with blobmesh 1–473
particle systems

and explosions 1–464, 3–82, 3–84
and materials 3–83
creating cigarette smoke 1–457

path constraint 1–276, 2–330
paths 1–242
pelt mapping 2–243
Perforce 2–937
performance, rendering 1–441
phoneme targets for speech 2–481
phong shader 1–119
physique

applying 1–396
getting started 1–382
problem areas 1–404

ping-pong ball
adding squash and stretch to 1–240

pivot points
character rigging 2–311
joining 1–112
repositioning 1–230

pivots 2–67
plane 3–76
planets

modeling 3–28
player

ram 3–138
pool table surface

animating 3–133
applying a material to 3–133
applying an affect region modifier to 3–133
creating 3–132
creating and animating 3–132

pose
biped 1–386

position constraint
wiring weights 2–371

position list controller 1–223, 1–237
pratfall 1–332
preview window 2–691
previewing NURBS head 1–97
previewing reactor 2–683
primitive objects 3–16

move/rotate/scale 3–29
props

biped using 2–506

prow and the spire 2–172
proxy geometry 2–685

Q
quadruped

animation 2–576
character 2–576

quaternion rotation 2–383
quick render 1–107

R
radial blur 3–92
radial scale 1–400
radiosity 1–437

advanced lighting override material 1–446
and camera animation 1–440
creating a radiosity solution 1–438
glowing objects 1–446
improving quality 1–443
radiosity mesh 1–440
speeding up 1–443

radiosity adaptive subdivision 3–61
advanced lighting 3–68

rag doll tutorial 2–700
creating the animation 2–718
hinge constraint 2–706, 2–708
making objects physical 2–702
rag doll constraints 2–712
setting up hips back neck and shoulders 2–716
setting up knees elbows ankles and wrists 2–708

ram player 1–432, 3–138
random motion 2–617
raytrace map type 1–139
raytrace materials - applying to a bottle and knife 1–139
reaction manager 2–467
reactor

accuracy 2–691
assigning physical properties 2–682
compound rigid bodies 2–686
create animation 2–695
creating a deforming mesh 2–737
creating animation 2–683
creating cloth 2–719
creating ropes 2–728
creating soft bodies 2–731
deformable bodies tutorial 2–719
display proxies 2–689
fracture 2–696
hand animation 2–694
introduction to 2–681
keyframing 2–695
preview window 2–691
previewing animation 2–683
proxy geometry 2–685
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rag doll tutorial 2–700
reducing file size 2–695
rigid bodies 2–682
rigid body collections 2–683
simulating mass distribution 2–688
simulation accuracy 2–691
simulation geometry 2–684
simulations 2–683
substeps 2–691
unyielding rigid bodies 2–694
updating 3ds Max 2–691
using proxies 2–685

real-world map scale 2–135
real-world map size 3–65
real-world mapping 3–61
reduce mesh memory footprint 1–204
reducing keys 2–628
reference points for use with camera match 3–114 to 3–115
reflected light

global illumination 2–835
reflections

mental ray renderer 2–810
trace depth 2–810

refraction
mental ray renderer 2–814

region-select technique 1–108
relax tool 1–202
Reload 2–137
rename objects 2–337
render effects 1–477, 1–479 to 1–481, 3–88 to 3–90, 3–92
render to texture 2–80, 2–293
rendering 1–224

an arm 3–130
and antialiasing 1–440 to 1–441
animations - using render scene 3–26
checking resolution of background - for camera

match 3–119
creating a rendering 1–438
improving 1–441
introduction to 1–424
rendering daylight 1–448
setting up background - for camera match 3–118
speeding up 1–441
using environment 3–118

requirements for lip sync 2–481
resources 1–3
revit 2–133
Revit 2–132, 2–137
revit material 2–135
revolving door 3–95, 3–98, 3–101, 3–104, 3–107 to 3–108
rig

animation controllers 2–321
arms 2–371

custom attributes 2–317, 2–349
IK solver 2–305
legs and feet 2–349
pivot points 2–311
script controller 2–383
shapes 2–311
shoulder 2–391
skin modifier 2–325
wiring 2–317, 2–321, 2–349
wrist twist 2–383

rig - character 2–349
rigging

introduction 2–299
rigid body collections 2–683
rigid body properties 2–682
rigid vertices 1–400
ring effect 1–479
roof 2–165
roof, creating for museum 2–2
rotation - animating rotation changes 3–23
rotation boosting 2–628
rotation list 2–321
rotation smoothing 2–628
rotation windup 3–3
running

and jumping 1–312

S
sample files 1–3
sampling

mental ray renderer 2–806
scale operator (particle flow) 2–916
scaling maps in object space 1–181, 1–186
scaling maps in world space 1–186
scene state 3–61
scene states

restore 3–70
save 3–70

scenes, saving 1–282
schematic view 2–411

frozen objects 2–337
screen points - assigning in camera match 3–121
script

create 2–608
motion flow 2–608
use of 2–608

script controller
character rigging 2–383

scripting
camera manager 2–925
effects 2–925
unhide 2–930

secondary motion 2–444
seeking targets 2–904
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select region
circular 2–47
rectangular 2–47

selections - naming 1–108
self-illumination value of basic materials - changing 1–119
set key 2–452
shader

mental ray 2–846
shaders 1–119, 1–125, 1–221
shadow study 1–434, 2–18
shadows

choosing a shadow type 1–422
shape operators (particle flow)

shape facing 2–915
shapes

character rigging 2–311
shared

motion flow 2–614, 2–617
shock wave effect 2–892
shoulders

envelopes 1–404
simulating fractures with reactor 2–696
simulation accuracy 2–691
simulation geometry 2–684
site planning, conceptual modeling 2–162
site-specific design 2–153
skateboard

biped interacting with 2–506
skeleton

create 1–383
skin

applying to an apple 1–106
material 1–151

skin modifier 2–425 to 2–426
angle deformer 2–439
character rigging 2–325

skinning 1–396, 2–325
character 2–425

smoke trails effect 2–900, 2–912
smoothing

and compositing (camera tracker) 3–147
snaps 3–94
soft selection 1–29, 1–85, 1–108, 1–110

with flex modifier 2–444
software driver - installing 3–121
SourceSafe 2–937
spacing tool 2–12
spawning particles 2–912 to 2–913
special effects 2–925, 3–1
specular color - changing 1–119
speech target requirements 2–481
sphere 1–107

spheres
changing color of 3–20
creating 1–106, 3–20
naming 3–20
tapering 1–106
viewing 3–20

spline IK 2–330, 2–337, 2–342
spline IK solver 2–330

splines
placing around an arm 3–129

splines, drawing 1–21
split tests (particle flow) 2–893
sponsons - airplane 1–61
squash - adding to a ball 1–240
squash and stretch 1–223
stabilizer and rudders - airplane 1–57
standard lights 1–452
standard materials 1–155
standard primitives 3–16
star effect 1–480
stars 1–148
stem

adding to an apple 1–112
positioning with 3D Snap 1–112

still life
animating 3–26
creating 3–16

stop and start walking 1–317
strauss shader 1–119
streetlight using xrefs 2–274
strength parameter spinners - adjusting 1–110
stretch - adding to a ball 1–240
sub-object selections 1–108, 1–110
sub-surface scattering

fast skin shader 2–874
submerge shader

mental ray 2–871
substeps 2–691
substitute modifier 2–139

creating a substitute 2–141
support files 1–3
surface properties and displacement mapping 1–144
surface tools 1–35
sweep modifier 3–61 to 3–62
symmetry modifier 2–199
synchronizing animation with video 3–126

T
taper modifier 1–107

applying to a cylinder 1–112
applying to a sphere 1–106

targets for lip sync 2–481
TCB rotation 3–3
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terrain
adding materials to 2–158
creating 2–156

text 3–4
text - bending 3–1
texture coordinates

managing 1–192
texture mapping 1–202
textures

texture baking 2–293
texture coordinates 1–193
texture mapping 1–193

time tags - adding to video 3–126
topology changes and morph objects 1–212
trace depth

mental ray renderer 2–810
Track View 1–223, 1–230

and setting lip sync keys 2–481
training centers 1–3
trajectories 1–223
transfer

motion 2–614
transitions

use of 2–612
translucent shader 1–221
transparency (materials) 1–119, 1–123
trees 2–282
troubleshooting - camera match 3–124
troubleshooting drawing files 2–112 to 2–113, 2–117
tutorial

motion flow 2–606 to 2–608, 2–612, 2–614, 2–617
tutorial files cd 1–3
tutorials 2–766

audiences 1–1
introductory 1–1
sample files 1–3
where installed 1–3

twist links 2–498
adding 2–499
setting twist poses 2–499

U
unhide

scripting 2–930
uniform textures 1–181, 1–186
units 3–94
unwrap UVW 1–193, 1–202

mapping a character 2–236
unyielding rigid bodies 2–694
updates 1–3
use of

layers 2–612
script 2–608
transitions 2–612

users
beginning with 3D 1–1
familiar with other 3D programs 1–2

using
freeform animation 1–343

using filters 2–628
using in place mode 2–546
UVW

mapping characters 2–236
UVW map modifier, using to adjust floor tiles 1–180
UVW mapping 1–193

V
vaults

adding files 2–942
checking in files 2–944
creating 2–940
logging in 2–941
working folders 2–942

vertex color 2–283
vertex tangent handles - shaping a facial expression target

and 2–481
vertex weights 2–426
vertices

rigid 1–400
video

adding time tags to 3–126
synchronizing animation with 3–126

video post 3–1, 3–14
viewport background

setting up 1–48
viewport image 2–1
viewports

navigating 3–17
setting up background for camera match 3–120

visibility keys 3–85
volume fog 3–1
volume light 3–1

W
walk

creating 1–303
walk cycle 2–446
walking

stop and start 1–317
walkthrough 1–276
water surface shader

mental ray 2–871
weight

giving biped illusion of 2–506
weighted list controllers 1–223, 1–237
wings, airplane 1–51
wireframe material controls 1–119
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wiring 1–464
character rig 2–317, 2–321, 2–349
character rigging 2–391
particle systems 1–464

workbench 2–627
working online 1–4
world space mapscaler 1–186
world-space camera map modifier (WSM) 3–133
wraparound shader

mental ray 2–849
wrist

automatic twist 2–383
twist bones 2–345
twist rig 2–371

X
XML files 2–182
xrefs

and animating a spaceship 1–259
and merging 2–446






